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• This Service Manual is available in English only.

• If a customer’s service provider requires a language other than English, it is the 
customer’s responsibility to provide translation services.

• Do not attempt to service the equipment unless this service manual has been con-
sulted and is understood.

• Failure to heed this Warning may result in injury to the service provider, operator 
or patient from electric shock, mechanical or other hazards.

• Ce Manuel de maintenance n’est disponible qu’en anglais.

• Si le technicien du client a besoin de ce manuel dans une autre langue que l’ang-
lais, c’est au client qu’il incombe de le faire traduire.

• Ne pas tenter d’intervention sur les équipements tant que le manuel Service n’a pas 
été consulté et compris.

• Le non-respect de cet avertissement peut entraîner chez le technicien, l’opérateur 
ou le patient des blessures dues à des dangers électriques, mécaniques ou autres.

• Dieses Kundendienst-Handbuch existiert nur in englischer Sprache.

• Falls ein fremder Kundendienst eine andere Sprache benötigt, ist es Aufgabe des 
Kunden für eine entsprechende Übersetzung zu sorgen.

• Versuchen Sie nicht, das Gerät zu reparieren, bevor dieses Kundendienst-Hand-
buch nicht zu Rate gezogen und verstanden wurde.

• Wird diese Warnung nicht beachtet, so kann es zu Verletzungen des Kundendienst-
technikers, des Bedieners oder des Patienten durch elektrische Schläge, mecha-
nische oder sonstige Gefahren kommen.

• Este Manual de Servicio sólo existe en inglés.

• Si algún proveedor de servicios ajeno a GEMS solicita un idioma que no sea el 
inglés, es responsabilidad del cliente ofrecer un servicio de traducción.

• No se deberá dar servicio técnico al equipo, sin haber consultado y comprendido 
este manual de servicio.

• La no observancia del presente aviso puede dar lugar a que el proveedor de servi-
cios, el operador o el paciente sufran lesiones provocadas por causas eléctricas, 
mecánicas o de otra naturaleza.

WARNING

AVERTISSEMENT

WARNUNG

AVISO



• Este Manual de Assistência Técnica só se encontra disponível em Inglês.

• Se qualquer outro serviço de assistência técnica, quE não a GEMS, solicitar estes 
manuais noutro idioma, é da responsabilidade do cliente fornecer os serviços de 
tradução.

• Não tente reparar o equipamento sem ter consultado e compreendido este Manual 
de Assistência Técnica.

• O não cumprimento deste aviso pode por em perigo a segurança do técnico, opera-
dor ou.

• Il presente manuale di manutenzione è disponibile soltanto in inglese.

• Se un addetto alla manutenzione esterno alla GEMS richiede il manuale in una lin-
gua diversa, il cliente è tenuto a provvedere direttamente alla traduzione.

• Si proceda alla manutenzione dell’apparecchiatura solo dopo aver consultato il pre-
sente manuale ed averne compreso il contenuto.

• Non tenere conto della presente avvertenza potrebbe far compiere operazioni da 
cui derivino lesioni all’addetto alla manutenzione, all’utilizzatore ed al paziente per 
folgorazione elettrica, per urti meccanici od altri rischi.

ATENÇAO

AVVERTENZA
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Foreword

RadWorks workstation is highly configurable. The user interface can 
be adapted to specific needs and workflow. You can connect the work-
station other workstations, to image archives and to HIS-RIS systems, 

create reports to particular specifications, and much more.

This guide describes how to configure these many aspects of RadWorks. It 
also describes how to initially install RadWorks, and how maintenance it and 
troubleshooting if necessary. 

The guide is meant to be used by system administrators rather than end users. 
For general information on how to make user-specific settings and actually 
use RadWorks, see the RadWorks User Guide.

Chapters 1 and 2 describe how to install RadWorks. Chapters 3 through 11 
show you how to configure the optional RadWorks modules. Information on 
how to maintain the RadWorks system is contained in Chapters 13, while 
chapter 14 provides useful information on how to troubleshoot particular 
issues. Appendix A provides a list of error messages while Appendix B offers 
lists of DICOM tags you may find it useful to refer to when making DICOM-
specific settings. 

When installing RadWorks on multiple systems, you can often save a great 
deal of time and effort by copying the configuration information from one sta-
tion to others - see chapter 12 for more on this. 

We wish you every success with setting up and configuring your RadWorks 
system.

The RadWorks development team
Zeist, The Netherlands

March 2002

A
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Conventions used in this guide

In instructions, where you must select a submenu from a menu, these selec-
tions are listed as Menu → Submenu. 

Buttons and other items you must click are Bold. 

The root directory for RadWorks is given as %ROOT%. So the path to the 
\bin subdirectory in the RadWorks root directory is rendered as 
%ROOT%\bin. The default root directory is C:\AMI_60, but you can install 
into a different directory.

Key to note icons

A note offering 
additional informa-
tion on an aspect 

described in the text.

An aspect of 
particular 
importance to 
take note of. 

Read this.

A tip or trick to help 
you get more out of 
Centricity DA.
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This chapter lists the different versions of RadWorks and the hardware and 
software they require, and describes what needs to be done prior to installation on 
a Windows workstation.

RadWorks versions and modules ............................16

Recommended hardware.........................................21

Software requirements .............................................23

Before you install RadWorks on a Windows 2000 
workstation ...............................................................24

Before installing on Windows NT 4.0 .......................25
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ince medical imaging requirements differ widely between locations and 
types of use, RadWorks comes in a number of versions and offers many 
optional modules. This means that each system need only have the func-

tionality its particular users need. Systems can range from just basic viewing 
stations through to powerful multi-monitor radiology workstations including 
all the functionality described in this manual.

This means that system requirements may vary. More complex RadWorks set-
ups require more capable hardware, and some options require optional Win-
dows components to be installed. This chapter describes the hard- and 
software required for various RadWorks systems, and it guides you through 
preparing the workstation for installing RadWorks. 

Part of those preparations are changes to Windows’ configuration (networking 
and dial-in setup). For in-depth information on these subjects, see Windows 
reference books, Microsoft TechNet and on-line documentation, such as “The 
Windows 2000 FAQ” by John Saville (www.windows2000faq.com) and the 
“The Windows NT FAQ” by John Saville (www.ntfaq.com).

RadWorks versions and modules

This section lists the available RadWorks versions and modules. 

Versions
RadWorks systems are available in several versions intended for particular 
types of use. Diagnostic is the high-end system positioned specially for diag-
nostic use by radiologists. It supports multiple high-resolution monitors (2000 
x 2500 pixels), printing and MPR/MIP. Review is a more basic system for 
referring physicians. The Standard version is generally used in wards, operat-
ing theaters and ICUs and for the radiologist on call.

The Educational version is similar to Diagnostic, but is meant for educational 
purposes only. 

S

To allow systems pre-
cisely tailored to specific 
needs, there is a vast 

range of options when configur-
ing RadWorks. Please consult 
your distributor with your exact 
requirements if you are consider-
ing changing your system.
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Workgroup Server allows multiple users to access a single, shared database 
and work much more flexibly as a team. Once a study has been sent to the 
Workgroup Server, all clients will be able to see it in the Data Selector and 
view it. When one client opens the study to work on it, the other clients can 
still open the study for viewing only (they can add presentation states, key 
notes and structured reports). Study status changes made by the editor are 
automatically transmitted to the viewers. The Workgroup Server can also be 
used as a workstation. You cannot run the Quality Control Module or the Data 
Acquisition Module on a Workgroup Server, and we do not recommend run-
ning the Single Media Archive Module on the server. 

The users have Workgroup Clients to access the server. A Workgroup Server 
supports up to ten Clients. You cannot run the Quality Control Module, Single 
Media Archive or the Data Acquisition Module on a Workgroup Client. 

Modules
Each type of RadWorks system can be further enhanced by additional mod-
ules which cover specific tasks. Some modules are included as standard in 
some versions. If a module is not included in a version, it can often be added 
to it.

Multi-Monitor module
This allows RadWorks to use multiple monitors in various configurations. It is 
included as standard in RadWorks Diagnostic and is optional for the other ver-
sions.

Print module
This supports background printing to DICOM 3.0-compliant imagers. Both 
color and monochrome printing are supported. The module also offers a file 
export option to BMP and TIFF file formats which is useful for reporting, 
teaching files, creating slides and presentations. You can print series or studies 
in pre-defined film layouts which can be selected from the layout pool. The 
virtual film sheet (presentation sheet) offers the ability to compose and post 
process print jobs on the fly. A single film sheet can be made up of images 
from different modalities, and images can be included more than once on the 
same sheet with different settings. Printing to Windows-supported printers is 
included in RadWorks; you do not need the Print module for that. 
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Single Media Archive module
This allows archiving patient and study data on any media supported by Win-
dows 2000/NT (CD-R, Jaz/zip disks etc.). An indexing tool provides archive 
and media management, allowing you to keep a record of which patients stud-
ies are located on which disk. The data is written to the media in the DICOM 
3.0 Part 10 format, thus, guaranteeing a growth path towards mass archiving 
in the future.

Data Acquisition module
This can be used to acquire data from systems that are not DICOM 3.0 com-
pliant. It supports film digitizers from several major vendors (Lumisys, How-
tek and Vidar), frame-grabbers, document scanning and graphics file import.

MPR/MIP module
This allows Multi Planar Reconstruction (MPR) and Maximum Intensity Pro-
jection (MIP) on 3D data sets of MR and CT slices. MPR is an algorithm that 
computes cross-sections as if the slices had been acquired in a different direc-
tion. MIP computes images that primarily show the pixels with the highest 
values and is excellent, for example, at showing blood vessels in angiography.

MPR/MIP cines can be created, saved to disk and sent to other systems for 
review. Collections of individual MPR or MIP frames can also be created and 
saved along with the original images.

MPR and MIP only works with specific data set types, see ‘Requirements for 
MPR and MIP’ in chapter 6 for details.

Quality Control module
This allows various quality control tasks to be undertaken at designated work-
stations within the hospital. 

Images that are acquired in certain modalities are routed to such quality con-
trol workstations before they enter the network. Studies can be opened for 
adding or changing patient demographics before they are saved and stored in 
the hospital’s archive, or before they are routed to other clinical workstations 
for viewing and reporting. Previous studies can also be (pre-)fetched from the 
hospital’s archive and used, for example, to adjust the window width and level 
settings or orientation of a CR image to comply with previously acquired CR 
studies. You can also re-sort images within a series, or delete images that have 
no clinical relevance.

If the hospital information system is capable of generating a DICOM 3.0 
Modality Worklist, part of the quality control work can be automated. For 
example, the patient demographic information that is part of a worklist entry 
can be automatically inserted in a study.
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Wavelet compression
This option allows you to use the compression based on the Wavelet algorithm 
when sending studies using teleradiology.

Integration module
This permits custom tooltabs, menus and pop-up menus (customizable for 
each user) to be added to RadWorks. They will typically provide single-click 
access to other applications such as a word processor, a web browser (with a 
particular HTML page loaded) or HIS/RIS functions, all from within Rad-
Works. It is particularly powerful as the basis of close integration between 
RadWorks and other systems.

Availability of modules
The following table lists the RadWorks versions, and the modules that can be 
added to them.

Modules that are part of all RadWorks versions are:

• Windows Print,

• JPEG compression / decompression,

• Teleradiology.
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RadWorks version

Options Standard Review Diagnostic Workgroup 
Server

Data Acquisition Option Option Option Not available

Integration Option Option Option Option

Multi-Monitor (up to 4) Option, up to 2 Option Included Option

Single Media Archive Option Option Option Clients only

Quality Control Option Option Option Not available

DICOM Print Option Option Included Included

Wavelet Compression/Decompression Option Option Option Option

MPR/MIP Not available Option Included Option

Viewing & reporting limitations

Filters 2 10 10 10

Cine 1 16 16 16

Save alterations annotation/report
(in general: saving changes)

No Yes Yes Yes

Viewing Matrix
RadWorks supports a resizable application 
matrix that begins at 800 x 600 pixels. 

max. 1200 x 1600 These have been successfully tested with a matrix of 2000 x 2500 pixels per 
monitor.

Modules available with RadWorks versions 
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Recommended hardware

Depending on the RadWorks license you have, Applicare recommends mini-
mum hardware specifications. This is a guideline, and the final choice will 
depend on budgets, available hardware on site, etc. If you decide to run Rad-
Works on a less capable hardware configuration than our recommendation, 
you will most likely experience degraded performance.

When you add one or more RadWorks Modules to an existing system, you 
may need to upgrade the hardware. 

Although RadWorks will run on systems with slower processors and/or less 
memory, the following hardware is recommended for good performance:

• 800 MHz Pentium III processor. When you upgrade an NT 4.0 sys-
tem from RadWorks 5.1 without changing the hardware, you can 
expect performance similar to RadWorks 5.1. 

• 128 MB RAM minimum for Windows NT 4.0, 256 MB recom-
mended (see ‘Memory and disk space requirements’ on page 22).

• 256 MB RAM minimum for Windows 2000, 512 MB recommended 
(see ‘Memory and disk space requirements’ on page 22).

• 6-9 GB SCSI hard disk, preferably, Ultra Wide or Ultra-2. 
(see ‘Memory and disk space requirements’ on page 22). 

• Fast graphics card with at least 8 MB RAM and capable of display-
ing 256 shades of gray. For color display, 16 million colors are 
required, 16 MB RAM is recommended.

• A non-interlaced monitor with a refresh rate of at least 70 Hz and a 
resolution of at least 800 x 600 pixels is required, although a resolu-
tion of 1024 x 768 or greater and a 19-21 inch monitor size is recom-
mended.

• Keyboard and mouse.

• A high-speed analog modem, ISDN terminal adapter, 100 Mbit/s 
Ethernet or ATM connection if teleradiology is used.

• A RadWorks-compatible frame grabber board if frame grabbing is 
used.

• SCSI card for digitizer connectivity if a digitizer is used.

• Special graphics adapters if multi-monitor capabilities are used.

RadWorks perfor-
mance will increase on 
a multi-processor 

machine, because the software 
supports Symmetric Multi Pro-
cessing (SMP).

You should increase your RAM if 
you plan to run RadWorks concur-
rently with other Windows appli-
cations or on a multi-monitor 
configuration.
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Memory and disk space requirements
If you plan to regularly view large studies like CR images, multiframe studies 
or MPR/MIP, use the ‘recommended’, rather than the ‘minimal’ amount of 
RAM specified. Increasing the amount of RAM will always improve perfor-
mance – the more memory the better. RadWorks’ image caching feature will 
use all available RAM for better viewing performance.

The optimal capacity of the hard disk depends on the usage of the PC. If it is 
used for medical imaging only, a capacity of a few GB will be sufficient for 
normal usage. If you want to store many images and studies for a longer 
period of time, you might consider using disks with higher capacity. Rad-
Works itself takes up about 300 MB, the demo data takes up another 360 MB. 
You need the disk space mainly for studies; the amount of space you need 
depends on how you use RadWorks. 

Hardware recommended for Workgroup systems
For a Workgroup Server/Client system, you need the same hardware as for a 
stand alone system, with these exceptions:

Server
• If the server will also be used as a client, a dual processor system is 

recommended. 

• 512 Mb RAM.

• 9 Gb hard disk (10,000 rpm or faster).

Client
Same as for a RadWorks stand-alone system.

Network
100 Mbps or faster.
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Software requirements

RadWorks 6.0 runs under the following computer operating systems:

• Microsoft Windows 2000 Professional with Service Pack 2, or 

• Windows NT 4.0 with Service Pack 6a or later. 

Windows 2000 is preferred. RadWorks 6.0 will not run under any other Win-
dows version. 

If you wish to use hanging protocols and /or reporting, install a scripting host 
(JavaScript or VBScript). You can add these by installing Microsoft Internet 
Explorer 5.01 or higher, or the Windows Scripting Host.

If you want to use a Word template in reporting, you must also install 
Microsoft Word 2000. 

RadWorks has built-in teleradiology capabilities. In order to be able to use 
them, the following Network Protocols need to be set up, depending on how 
the computer is connected (will it move images via a LAN/WAN, or via a 
modem link?):

You can add these during the Windows installation, or you can add them to an 
existing installation. 

Windows service packs can be downloaded from the Microsoft web site.

Software recommended for a Workgroup Server
• Microsoft Windows 2000 Server with Service Pack 2, or Microsoft 

Windows NT 4.0 Server.

Make sure you have a sufficient number of client connection licenses with 
your Windows license. 

TCP/IP For LAN and WAN communications, and use of modem / ISDN. DICOM 3.0 can only 
communicate using this protocol.

RAS For use of modem / ISDN.

Network protocols
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Before you install RadWorks on a Windows 2000 
workstation

Before you install RadWorks, you must set up networking. If you have a mul-
tiple-monitor setup, you must also (install and) configure your monitors.

Below are described the preparatory steps for a Windows 2000 system. If you 
are installing on Windows NT, see ‘Before installing on Windows NT 4.0’ on 
page 25.

Configuring multiple monitors
1111 Install the video adapters and monitors. 

2222 In the Display configuration applet in the Control Panel, configure 
your monitors: Arrange the monitors the way you will use them, and 
set the resolution, color depth and refresh frequency for each moni-
tor. 
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Before installing on Windows NT 4.0

Before installing RadWorks on your Windows NT workstation, you will need 
to configure networking and also possibly the multi-monitor settings.These 
are described in this section.

If you are installing on a Windows 2000 workstation, see ‘Before you install 
RadWorks on a Windows 2000 workstation’ on page 24.

Network configuration
Once the TCP/IP Protocol has been installed during Windows NT Setup, you 
can modify its properties if and when necessary.

1111 Open the Control Panel.

2222 Open the Network manager. 

3333 Click the Protocols tab.

4444 Select TCP/IP Protocol.

Consult with your net-
work administrator 
about network settings
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5555 Click Properties.

6666 During Windows NT Setup you will have been prompted to enter the 
IP settings. Check to see whether the settings are still correct.

7777 Click the DNS tab.

8888 Add the IP address of the DNS Service.

9999 After adding or editing network settings, restart the computer for the 
changes to take effect.

Remote Access Service configuration
The Remote Access Service (RAS) has to be set up if RadWorks is to receive 
and/or send images using an analog modem or an ISDN interface card. RAS is 
not necessary for receiving or transmitting images if the RadWorks system 
will only be connected to a local area network.

Adding an analog modem to the PC can be done during Windows NT setup or 
at a later stage using the Modems Properties in the Control Panel folder. Run 
the ‘Install New Modem’ wizard to install a new analog modem.
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Adding an ISDN interface card is best done after installation of Windows NT 
by using the Network Properties icon in the Control Panel.

If Windows NT detects any RAS capable devices they will be listed here.

Once a RAS device has been added it needs to be configured to either transmit 
(Dial out only) or receive (Receive calls only) or both (Dial out and Receive 
calls).

The choice made in the Configure Port Usage window will determine the con-
tents of the Network configuration.

DICOM transmissions use the TCP/IP protocol.
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Setting up RAS to transmit

Setting up RAS as a dial out service you need to choose which Dial out Proto-
col will be used in the Network Configuration of the RAS device.

The encryption settings can be set when a RAS Address Book entry is created. 
This is described later on in this chapter.

Setting up RAS to receive calls

The Network Configuration window changes as soon as you have set the RAS 
device to Receive Calls.

Prior to setting up the system to receive calls from another system determine 
which Dial out Protocol to use. Make sure both systems are configured for the 
same Protocol(s).
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The Server Settings allow you to configure the network accessibility:

Then depending on the local situation you can activate DHCP to assign 
remote TCP/IP client addresses. If DHCP is not being used it is necessary to 
use a static address pool.

Since the client will dial directly into a system you may choose any IP address 
you see fit, provided it does not conflict with IP addresses being used within 
the local area network.

The encryption settings can be set in the last section of the Network Configu-
ration. Make sure the client uses the same as is set here. This will be described 
later on during the RAS installation.

Setting up local host information
If you are able to connect to the other computer using its IP address, but you 
are not able to connect to the other computer using its host or NetBIOS name, 
there may be a name resolution problem. There are many methods to accom-
plish name resolution on a network, including the following:

The first address will 
always be assigned to 
the RAS Server and the 

second to the client.
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• Domain Name Service (DNS)

• Windows Internet Name Service (WINS)

• HOSTS files

• LMHOSTS files.

Detailed information about setting up and troubleshooting local host informa-
tion is included in this chapter.

To prepare a RadWorks system for receiving images via a remote connection 
start the Remote Access Service and configure the Remote Access Server.

Activating the Remote Access Server
1111 Open the Services control panel.

2222 Select the Remote Access Server in the list. By default, the startup 
for this service is set to Manual. The service needs to be started in 
order to receive calls. 
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3333 Click Startup..., and change the startup setting to Automatic. That 
way the Server will always be available, and you won’t have to start 
it manually.

To start the Server, you can also use the Remote Access Admin (Startup 
menu →Programs → Administrative Tools).

Setting dial in permissions
If the Remote Access Admin has been started and the Server has not, a mes-
sage will be displayed.

From the Server menu, start the Remote Access Server.

You can set dial-in permissions for users to protect a Windows NT system 
from unwanted callers. From the Users menu, select the Permissions option 
to set these permissions.

Users listed here have been added either by the System Administrator or soft-
ware installation programs.



P R E P A R I N G  F O R  I N S T A L L A T I O N

RadWorks 6.0 installation and configuration guide

32 chapter 1

RadWorks creates several users. One of them, CN_Service, is part of the Con-
nection Service and needs to have dial-in permission on the Server. To set per-
missions:

1111 Select the user in the list.

2222 Check the Grant dial-in permission to user check box.

Applicare recommend you test the RAS connection prior to installing Rad-
Works. The next section describes how to create a Phonebook entry for dialing 
the remote system.

Creating a RAS Phonebook entry
The client system needs to know which phone number to dial. Use Dial-Up 
Networking in the ‘My Computer’ folder, to set this up.

For detailed information on all options not discussed in this section, refer to 
the Windows NT help files and manuals.

1111 When you create a new entry, a wizard will guide you through creat-
ing the entry.

Once these steps have been completed (name, phone number and device to 
use) you can edit the entry to refine its settings.



GEMS IT Applicare

33

2222 Click More and select the option Edit entry and modem properties 
from the menu. 

Make sure you have all the relevant information at hand before proceeding to 
edit the Phonebook Entry.

3333 For ‘Entry name’, type a descriptive name; make clear which site 
will be called. RadWorks uses this name to add a Teleradiology des-
tination. 
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4444 Use the next tab in the dialog window to configure the server settings 
of the remote site. The default server type is displayed in the illustra-
tion and doesn’t usually need to be changed.

5555 Typically, the network protocols will be TCP/IP . If the remote sys-
tem is configured to assign an IP address to the client, then the 
default TCP/IP settings will not need changing.

6666 The Security setting in the Phonebook Entry should be the same as 
was set in the Network Configuration on the Remote Access Server.

7777 RadWorks does not need any login script; such a script is sometimes 
used to logon to the server of an Internet Provider. If you ever con-
nect to an X.25 network, refer to the appropriate documentation.
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Testing Remote Access Server
Once RAS has been setup on both client and server, test the modem communi-
cation between the two systems. 

1111 Use Dial-Up Networking to dial the remote computer with the entry 
you just created.

2222 Verify that the Remote Access Server on the system that will receive 
the call has started correctly.

3333 Select the remote systems’ Phonebook Entry and dial: click Dial. 
Enter CN_Service as the user and Service20 as password. If both 
systems have been setup correctly with RAS and RadWorks the 
remote system will authorize the dialing system to access it.

Configure multiple monitors
1111 Install the video adapters and monitors. 

2222 In the Display configuration applet in the Control Panel, configure 
the monitors: Arrange the monitors the way you will use them, and 
set the resolution, color depth and refresh frequency for each moni-
tor. 
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RadWorks licensing

The RadWorks software requires an electronic license file. This contains the 
codes which enable you to access those parts of RadWorks you have pur-
chased.

Whenever the RadWorks’ Services are started or accessed, a license check is 
performed. If the requested license is not available, the Service(s) will not 
start and RadWorks also may not.

Electronic licensing and the MAC address
When placing an order for an electronic license, the MAC address (physical or 
Ethernet address) of the network interface card in the license server or stand-
alone computer is required so the necessary license file can be created.

To obtain the MAC address, either �

Open a Command Prompt window and type the command:

ipconfig /all

or

Run the Lmtools executable, supplied on the RadWorks 6.0 CD-ROM, and 
open the System Settings property sheet. This is the preferred method.

The program files and documentation for Lmtools are included on the Rad-
Works 6.0 CD-ROM (\3rdparty\flexlm directory).

FLEXlm toolkit
RadWorks uses the FLEXlm toolkit for electronic licensing. It consists of four 
parts. 

1111 Lmtools.exe:
FLEXlm tool to obtain MAC address, install the FLEXlm Services, 
perform diagnostics, etc.

2222 Lmgrd.exe:
The license manager program, which starts a Windows service when 
the server is started.

3333 Amidmn.exe:
Applicare-specific program, which validates the license file.

4444 Lmutil.exe:
Command Prompt version of Lmtools.

These steps are not 
required when using a 
local license file. You 

only need the FLEXlm toolkit for 
license server installations.
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Installing the FLEXlm Service
The Lmtools program allows you to configure the FLEXlm Service for Rad-
Works 6.0. Copy the four files (Lmtools.exe, Lmgrd.exe, Amidmn.exe, 
Lmutil.exe) from the CD-ROM to a permanent directory (e.g. C:\FLEXlm) on 
your hard disk.

1111 Start Lmtools.

2222 On the first tab (Service/License File), select Configuration using 
Services.

3333 On the last tab (Configure Services), select an appropriate service 
name.

4444 Provide the paths to the requested files, lmgrd.exe and the server 
license file. Applicare supplies license files with the extension *.dat. 

5555 Check the Use Services and Start Service at Powerup checkboxes.

6666 On the fourth tab (Start/Stop/Reread), the service is now displayed. 
Click Start Service. The service is started as soon as the message 
‘Using license: <license file name>’ is displayed. 

The FLEXlm license server is now installed.

In the Services control panel, the service will be displayed as being started and 
will automatically start at boot time.

To see if the service is functioning and how many licenses it has issued, use 
the Server Status and Server Diagnostic tabs.

About license files

Dependencies
If the Database, Connection and Print service do not start automatically with 
the license file when the computer restarts, do the following.

1111 Use regedt32 to edit the HKEY_LOCAL_MACHINE\System\Cur-
rentControlSet\Services keys for the Database, Connection and Print 
Services.

2222 Double-click DependOnService and add:

• LanmanWorkstation if you are using Windows NT 4 Server.

• LanmanServer if you are using Windows NT 4 Workstation

• Lmhosts.
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3333 Repeat this for all three Services.

When the computer is restarted, all services should start.

MAC address only contains zeros
If your computer is not connected to the network the MAC of your Ethernet 
card will be displayed as zeros. 

Running lmhostid will return "000000000000". You need to disable the Media 
Sense on your system.

See the web page: ‘How to Disable Media Sense for TCP/IP in Windows 
2000’. The Internet address is:

http://support.microsoft.com/support/kb/articles/Q239/9/24.asp

Multiple MAC addresses
If you run lmhostid or lmtools on a Windows 2000 system with one network 
card, and you get multiple Ethernet addresses, remove the NetBeui and IPX/
SPX protocols. Alternatively, use the Ethernet address that does not change 
when you restart the computer.

Using a dongle
If your setup does not allow the use of electronic licensing, you can order a 
dongle (hardware license key) from your distributor instead. 

A dongle is a piece of hardware that has to be connected to the parallel port of 
the computer. Always use LPT1 if more than one parallel port is available.

Normally, licenses do not expire. However, demonstration and evaluation 
dongles have an expiry date. A warning dialog box will appear when you start 
RadWorks and the license is due to expire in seven days or less.

You may need to 
access the BIOS set-
ting of the PC in order 

to change the parallel port setting 
to bidirectional or ECP/EPP.
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his chapter describes the procedure for installing the RadWorks soft-
ware. It is recommended that you read this chapter carefully before 
installing RadWorks on your system.

Who should install RadWorks?
To install RadWorks you need to log on as a user with administrator rights. 
This will ensure that all configuration settings performed by the administrator 
and the rights to install RadWorks will be available to all RadWorks users.

Check your logon rights using the User Manager in the Start Programs 
Administrative Tools Group. Double-click the Administrators Group to 
see if your logon name is in the Member list. If you start the setup without the 
necessary rights you will not be able to install RadWorks.

If in doubt about your logon rights, contact your system administrator.

Before you start...
Make sure you have the correct license file, or dongle, before you install Rad-
Works.

Running RadWorks Setup

If all the hardware and software requirements for using RadWorks 6.0 are met, 
you can run the RadWorks Setup program (setup.exe on the RadWorks instal-
lation CD). 

Welcome
1111 After Setup has started, a Welcome screen is displayed. Click Next > 

to continue.
The Setup may update the Windows Installer on your computer. If 
this happens, you will be prompted to reboot the computer. 

Destination folder
2222 By default, Setup will install your RadWorks program files in 

C:\AMI_60. To place these files in another folder, click Change... 
and specify a different location. It is recommended that you select a 
folder directly at the root level, not inside another folder. 

3333 Click Next > to continue. At any time during the installation, you 
can click < Back to return to previous screens and change settings.

T



GEMS IT Applicare

41

RadWorks type and role

4444 Choose the RadWorks product you want to install by clicking the 
appropriate selection button under Choose the RadWorks type. You 
should have the appropriate license for whatever version of Rad-
Works you select.

5555 In Choose the RadWorks role, the difference between a Stand-
alone and a Workgroup server installation is that the server’s data-
base and services will be shared so the Workgroup clients can access 
them.

6666 Indicate under Choose the RadWorks role whether you want to 
install RadWorks on a standalone computer or a Workgroup client. 
Only select Workgroup client if the machine is to be connected 
solely to a Workgroup server.

When you install a Workgroup client, this enables you to view stud-
ies stored on the Workgroup server. During the Workgroup client 
setup you will be asked to enter the hostname of the Workgroup 
server.

A Workgroup client 
cannot use the Quality 
Control, the Data 

Acquisition Module or the Single 
Media Archive module. 
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RadWorks licensing mechanism
7777 If you are using a license file, select License file and then Browse... 

to specify the path on your local hard disk of the license.

8888 If you are using a license server, select the License server option, 
specify the file name for the local copy of the license, and enter the 
name of the server with the license.

9999 If you are using a dongle, select Dongle. 

Modules 
10101010 Click the icons of the modules you want to install, and, either, select 

This feature will be installed on local hard drive to install the 
module, or This feature will not be available, if not. ‘X’ is dis-
played next to modules that will not be installed. Only mark licensed 
modules for installation.
Note that you don’t actually select the Acquisition module itself but 
options in that module.

Transmit 

The Transmit screen is not displayed when you install a Workgroup 
client. 

11111111 Specify in the DICOM AE title field the Application Entity Title of 
the computer you are installing RadWorks on. 

If you use a local 
license file, we recom-
mend you disconnect 

your computer from the network 
during installation. If you install 
the license while the computer is 
connected to the network, the 
license will only be valid while the 
computer is connected to the net-
work. 

Only install the modules 
you have a license for. 
The setup program does 

not check the license content of 
the Dongle or license file.

Don’t select the actual Data Acqui-
sition module but the options it 
contains.

DICOM AE Titles have to 
be uniqe in a network 
environment. 
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12121212 Use the DICOM port number field to indicate the port number 
your system will use to send and receive data. This number does not 
have to be unique.

13131313 Enter the Teleradiology name and Teleradiology description, to 
name and describe the computer you are installing RadWorks on.

14141414 Check the Use modem for remote connections check box, if you 
use a modem to connect to the network. 

15151515 Click Next > to continue.

Miscellaneous
16161616 Check the Tools check box if you want RadWorks Setup to install 

vendor-specific tools (this option may not be present in your ver-
sion). 

17171717 Check the Demo Data check box, so RadWorks Setup includes sam-
ple studies when it installs RadWorks. These studies, which are not 
required for everyday use of RadWorks, contain images from a wide 
range of modalities and are useful for learning about RadWorks. 
However, they do take up a significant amount of disk space - about 
350 MB.

18181818 Check the Configure Multi Monitor check box, if you want to use 
RadWorks on more than one monitor. 

19191919 Click Next >.

20202020 If you previously checked the Configure Multi Monitor check box, 
select your monitor configuration. This will prepare the multi-moni-
tor settings in RadWorks. If your configuration is not listed, select 
one that is similar. You can always change the multi-monitor settings 
from within RadWorks. If you did not select the Configure Multi 
Monitor check box, this screen will be appear. 

21212121 Click Install. 
The progress bar displays how far RadWorks Setup has progressed.
The installer may start up separate installers for e.g. the VOB CD-
writing package. Go through these installers: the default choices are 
acceptable. 

Installation complete
22222222 Click Finish, to complete the setup. 

The sample studies will 
also significantly extend 
the installation time for 

RadWorks. You can also install 
these studies after setting up Rad-
Works by copying them from the 
RadWorks installation CD to the 
RadWorks Database\Input folder.
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System check
Setup will check whether the Remote Access Manager services have been 
installed. 

RAS 
The following only applies to Windows NT 4.0. RAS is automatically 
installed with Windows 2000.

The Remote Access Service Manager must be installed on the system if you 
want to use a modem for remote connections. If the setup does not find the 
service, you will be unable to use a modem after RadWorks is installed. You 
can also install RAS after installing RadWorks. To setup and install the 
Remote Access Service Manager, see ‘Remote Access Service configuration’ 
on page 26 for more information.
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Upgrading from a previous version

When you run the setup on a system that has RadWorks 2.1, 4.0, 5.0 or 5.1 
installed, the setup will automatically upgrade the existing installation to Rad-
Works 6.0.

If Setup detects a previous version on the system, you will be asked whether 
you wish to continue and have Setup upgrade your existing version. You can-
not have two versions installed on the same system.

If you choose to continue with the upgrade, the previous RadWorks settings 
(remote views, destinations, origins, etc.) and the image data will be automat-
ically migrated during the installation; you will also be able to keep the 
DICOM AE Title and port number. If you don’t have RadWorks 5.1 installed, 
the RadWorks 6.0 default port number will be 3140 when you install it.

The services of the previous version will be removed during the upgrade pro-
cedure.

Setup will detect which services and modules were installed; these will 
already be selected in the Setup screens. Run Setup with only these modules. 
If you want to add new modules, in the Windows Control Panel select Add/
Remove Programs → RadWorks and click the Change button.

All image data will be migrated (moved) to the \%ROOT%\Database\Local 
directory (including archiving directories).

All local database files will be converted to the DICOM part 10 format. 

RadWorks 6.0 does not support Converters. If your installation relies on Con-
verters you have created, you should not upgrade to RadWorks 6.0. 

After the upgrade, the old RadWorks services will have been removed. 

Multi-monitor settings will also be migrated to RadWorks 6.0.

RadWorks 6.0 will be installed in the same folder as the previous version.

Even if you do not have 
a previous version of 
RadWorks installed the 

setup will search for it. Depending 
on the hard disk size this might 
take a few moments.
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Modifying or removing a RadWorks installation

To modify or remove your current installation of RadWorks, use Add/
Remove Programs in the Control Panel. 

To modify or remove a RadWorks installation �
1111 In the Control Panel, open Add/Remove Programs and then Rad-

Works 6.0. 

2222 Click Change to modify the installation, or Remove to remove Rad-
Works entirely. 

3333 In the RadWorks installer, click Next > and select Change to open 
the Program Maintenance screen or Remove to remove RadWorks. 

4444 Select the task you wish to perform and click Next >. 

A summary of each task is given below:

Important note if RadStore or WebViewer is also installed
When uninstalling RadWorks, its registry keys are removed as well. RadStore 
and WebViewer use the same license file. So, if you uninstall RadWorks, any 
RadStore or WebViewer installation will also also lose its license.

Task What it does

Modify Installs or removes modules from your configuration.

Repair Reinstalls your RadWorks program files.

Remove Completely removes RadWorks from your system (this is the same as using 
the ‘Add/Remove Programs’ option in the Control Panel). 

Options on the Program Maintenance screen
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Backing up system settings

You can create backups of the system settings. These can then be used to 
restore a computer’s settings after RadWorks has been reinstalled.

Examples of system settings include user profiles, destinations to image 
archives, print layouts, new printer definitions, views and auto-routing rules.

After you have configured a local machine, you can create backups of system 
settings and load them by running the RadWorks Settings Tool program 
located in the RadWorks Bin folder.

To create a backup file�

1111 Start RadWorks, adjust it as you wish and close RadWorks again.

2222 In the RadWorks Bin folder, run RadWorks SettingsTool.exe.

3333 In the RadWorks Settings Tool dialog box, click RadWorks System.

4444 In the RadWorks System Settings dialog box, click Backup.

5555 In the Save As dialog box, find the location where you want to save 
the backup file, enter its name in the File name field and click Save.

6666 Click Close in both the RadWorks System Settings and RadWorks 
Settings Tool dialog box.

To restore a previously created backup �

1111 In the RadWorks Bin folder, start the RadWorksSettingsTool.exe 
file.

2222 In the RadWorks Settings Tool dialog box, click the RadWorks Sys-
tem button.

3333 In the Available Settings section of the RadWorks System Settings 
dialog box, select the backup you want to restore, and then click 
Restore.

4444 Click Close, in both the RadWorks System Settings and RadWorks 
Settings Tool dialog box.
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Working with user groups and profiles

When RadWorks is installed, two new groups are installed in User Manager. 
One of these is RW_USER. You can add users to this group to make them 
users of RadWorks.

Creating user profiles
User profiles allow users to start RadWorks with the settings they need for 
their tasks. They allow, for example, a radiologist to have all features required 
for advanced viewing and diagnosis, while providing the radiographic tech-
nologist with the features that person needs.

You can create user profiles for different groups of users by making the appro-
priate adjustments within RadWorks and then running the RadWorks Settings 
Tool program located in the RadWorks bin folder.

To create a user profile �

1111 Log into Windows with the name of the user you want to create a 
profile for. Do not log in as an administrator. 
If you log in as an administrator, the settings you make are system-
wide, not user-specific. 

2222 Start RadWorks and adjust the user settings required for the user 
group you are creating.

3333 In the \bin folder, start the RadWorksSettingsTool.exe file.

4444 In the RadWorks Settings Tool dialog box, click User.

5555 Click Save in the RadWorks User Settings dialog box.

6666 In the Save As dialog box, enter the name in the File name field and 
click Save. 

To load a user profile �

1111 To load the profile in the registry, select the profile in the Available 
Settings section of the RadWorks User Settings dialog and then click 
Load.

2222 Select the profile with its.xml extension in the Open dialog box, and 
click Open.

3333  Click OK, to implement the selected profile in the RadWorks Set-
tings Tool message box and view the results in the Loaded Setting 
section of the RadWorks User Settings dialog.
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If you want to clear the user profile currently loaded in the registry, click 
Clear and Yes to confirm in the RadWorks Settings Tool message box.

Click Delete, to remove a profile from the list of available profiles. This does 
not remove a profile from the registry if it has been loaded earlier with the 
Load button.

When a user starts RadWorks for the first time, he will see the RadWorks dia-
log box. Here he can select a user profile, after which RadWorks starts up with 
the settings that were configured for the selected user profile. Users can also 
not select a profile (by clicking Cancel). RadWorks will then start with the 
default settings.

Each time the user, subsequently, starts RadWorks, it will automatically use 
the selected profile.
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Software patches

A few software issues may be discovered after the final release. These are reg-
istered in a bug-tracking database. Should a major issue arise, depending on 
its type and frequency of occurrence, a software update (software patch) will 
be released as soon as it has been resolved.

Patch release
As soon as the R&D department has released a patch, it is made available to 
the distributors.

A patch file is always accompanied by release notes, which should be read 
before the patch is applied.

It is also recommended that the latest software patch is applied after a new 
installation or an upgrade.

Applying a patch
When a software patch file is executed, it will stop the RadWorks Services, 
extract the binary files and copy them to their respective directories, and then 
restart the services.

Version check
The About box contains the following information:

RadWorks version, build number and Software Patch number.

Contact your RadWorks 
distributor for informa-
tion on the latest avail-

able patch. 

You may not need to apply the 
patch, unless it is labeled as man-
datory. If the latter is the case, it 
means that a serious problem, 
which can occur on the majority 
of the installed base, has been 
fixed.
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Installing workgroup servers and clients

Installation
Installation of either a Workgroup server or a Workgroup client does not 
require special steps; just select the appropriate option during the normal 
setup. 

To set up a Workgroup client, you do need to know the host name of the 
Workgroup server. 

The Workgroup server can also be used as a ‘normal’ RadWorks system. 
When doing so, it will use one of the concurrent user licenses.

If a client station is licensed to use a RadWorks module, this module has to be 
installed on the Workgroup server as well.

Limitations 
The Single Media Archive, Quality Control and Data Acquisition modules are 
not available on a Workgroup client.

Data issues
Executables and DLLs are stored on the client. Services and data reside on the 
server. Service settings can therefore only be changed on the server. 

The client uses the database on the server. When one client opens the study to 
work on it, the other clients can still open the study for viewing only (and they 
can add presentation states, key notes and structured reports). 

Performance issues
Factors which can influence the performance, are:

• Speed of the server. The server should be a fast machine with a large 
memory.

• Speed of the network. A 100 Mbit/s network is recommended.

• Network architecture. A dedicated network, physically separated 
from the LAN, will improve the Workgroup performance dramati-
cally. New technologies like Storage Area Networks based on fibre 
channel can be considered.

• Total number of clients, a maximum of ten.

• Number of clients simultaneously viewing different studies.



I N S T A L L I N G  R A D W O R K S

RadWorks 6.0 installation and configuration guide

52 chapter 2

Data updates 
Changes made to the database, queues, and other shared data are immediately 
updated on the other systems in the workgroup.

Log files
The RadWorks log is stored locally. 

Workgroup client configuration
A workgroup client needs remote access to the 
HKEY_LOCAL_MACHINE\SOFTWARE\AMI key on the server. 

If the client has administrator rights on the server, this will not be an issue. If 
not, a few changes to the registry on the server are required.

To grant the client access rights on the server �

1111 Create a domain account for the Workgroup Clients in the domain 
users group.

2222 Back-up your registry and, using REGEDT32, select the following 
registry key:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurePipe-
Servers\winreg

3333 Select Security → Permissions to add domain users and give them 
full control. (This means that this remote user has the same rights as 
if he were logged on locally).

4444 Make sure the domain users have full control to the key:

HKEY_LOCAL_MACHINE\SOFTWARE\AMI

Now a user without administrator rights can start a RadWorks Workgroup cli-
ent.
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he current version of RadWorks can send and receive images in DICOM 
format, including Keynote Objects, Structured Reports, and Presenta-
tion States. For downward compatibility, it can also receive images in 

the AMI format. 

Before you configure RadWorks to send and receive images, you should 
check that the system has been set up correctly for communications, either 
over a local area network or via dial-up networking.

Preparing the workstation for teleradiology

Receiving DICOM images requires preparation of both RadWorks and the 
sending site, whether that is another RadWorks system or a third-party system.

Testing the DICOM association
We recommend testing the association to ensure that the remote system and 
RadWorks have been correctly configured. There is a utility to test the 
DICOM association: DCMPing. (this can be found in the %ROOT%\BIN 
directory)

T

For detailed descrip-
tions of the dialogs used 
in configuration, click 

Help in the dialog.
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Setting up the Connection Service

Configuring Connection Service properties
We recommend you only alter the default settings if this is strictly necessary. 
For detailed information on the settings, see the online help (click Help in the 
configuration dialog box). 

DICOM Application Entity Title
The DICOM Application Entity Title, which is entered during RadWorks 
installation, is set in the Configuration → Generic... menu.

We recommend using unique AE Titles when setting up more than one Rad-
Works workstation in a network. The port number need not be unique across 
the network.

Receive settings
1111 Select Configuration → Connection Service from the menu bar in 

the Data Selector and click on the Receive tab. The settings on this 
tab apply to both AMI and DICOM format images.

2222 Optionally enable Verify Origin to increase system security.

3333 Enabling Auto Decompression will decrease loading time when 
viewing, but will increase storage space.

4444 Add the location of the post processing .dll in the Post Process field 
if the Quality Control Module has been installed and you want to use 
Auto Matching, or the Repair tool.

5555 The RadWorks 5.1 Receive settings on this property page usually 
do not need changing.

6666 Enable Auto Compress Studies to indicate that studies entering the 
system via the Connection Service should be compressed before they 
are actually stored in the database.

7777 The Format and Parameters drop-down lists allow you to select the 
appropriate compression format and compression specific parame-
ters for compressing incoming studies.

You need administra-
tive rights to change 
most of these settings. 

Wavelet lossy com-
pression will only be 
displayed as an option 

if the Wavelet Compression mod-
ule has been installed and a 
license for the module is present.
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After the Connection Service has received a study, after auto-decom-
pressing the study (if configured) will be auto-compressed (if config-
ured). After completion of both steps, the study will be sent to the 
Database Service for storage in the local database.

DICOM settings
8888 Select the DICOM tab of the Connection Service Properties dialog 

box. The settings in this tab apply to receiving and sending images.

9999 Set the Maximum Number of Associations if desired. This defaults 
to 4, but is essentially unlimited. The practical limit, however, is 
between 16 and 30 associations depending on CPU power, installed 
RAM and I/O speed.

10101010 Set the PDU Packet Size if required. This is a minimum of 4096 
bytes and a maximum of 4194304 bytes; the default value is 16 KB.

If for some reason the 
compression fails, a log 
message at warning 

level will appear in the con-
nect.log, and the study will be 
stored as is. Failure to compress 
will never lead to rejection of the 
received study.
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Setting up and configuring destinations

You can add new sites to send studies to, or change details of existing destina-
tions.

To add a teleradiology destination � 

1111 Select Connection → Destinations… from the menu bar in the Data 
Selector.

2222 In the Destinations dialog box, click Add. A dialog opens. 

3333 Enter the name of the new destination.
The name will be displayed in the list box on the Teleradiology 
Tooltab.
The name field must be unique. The system will check this when you 
enter a name.

4444 Enter the Host Name (DNS name) of the new destination. 

5555 Optionally, you can enter a description.

6666 If you want to access the destination via RAS: check the Use RAS 
checkbox. 
If you select this option, a new dialog window will appear for speci-
fying RAS parameters. If the Use RAS check box is grayed out, 
RAS has not been installed on the system and cannot be used for 
connecting to destinations.

To configure a new 
remote teleradiology 
site you will need to 

have administrator rights and a 
certain amount of technical infor-
mation from the new site you want 
to send to. If you are uncertain 
about configuring a destination, 
contact your system administrator 
or distributor.

Although it is possible, Applicare 
does not recommend you give 
multiple destinations the same AE 
Title, since in DICOM 3.0 the AE 
Title is considered to be unique in 
a network situation. Should you 
do so, resolving a destination 
could be difficult when, for exam-
ple, a study is retrieved from Rad-
Works by another system.
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7777 Select the Options: Study Status ID: if this is ON, RadWorks sends 
only the changes to a Study Status instead of transferring all the 
images (saving time). The status changes are sent via a DICOM 
Study Management N-Set or N-Event message. 
N-SET: requests the status change.
N-EVENT: reports that the status has been changed.
You can set the message type once you have created the destination 
(the Modify dialog has these options). 
The receiving DICOM entity must support this feature (few do at the 
moment).
When the destination is a RadWorks 5.1 workstation, select ‘Rad-
Works 5.1 format’. This will convert Presentation States, Structured 
Reports and Keynote Objects into the proprietary RadWorks 5.1 for-
mats before sending them. You can also use this option to send this 
data to other systems that do not understand this data. When the des-
tination does not understand the data, the entire study will be 
rejected. You can set these options here, and you can override them 
when you send a study. 

The Change SOP instance UID on lossy compression option 
should be ON. When it is ON, the image number (UID) is changed 
when an image is compressed with a lossy algorithm, ensuring that 
the lossy version does not overwrite the (not compressed, higher-
quality) original. There are only two cases where switching this OFF 
may be useful:
- when on the remote system Keynote Objects, Presentation States 
and Structured Reports lose their links to an image due to the UID 
change. 
- when the destination does NOT send back the images, but creates 
annotations to the compressed images and sends back the annota-
tions only: the annotations need to be associated with the original 
images, not the compressed copies. 

8888 Select the IODs that will be sent to this destination. You can select 
e.g. only the Presentation States, Key Images and Structured 
Reports: this limits the amount of data that gets transferred. The 
Other IODs are DICOM data that RadWorks will store, but cannot 
change. The IODs are optional because not all destinations can use 
these data. When the destination is a RadWorks 6.0 workstation, you 
can select all the options. 

9999 Click Next >. 

Unchecking this 
checkbox is a DICOM 
violation. There are a 

number of archives that will over-
write an image upon “repeated 
reception of the same image”, i.e. 
they will overwrite the original 
uncompressed image and replace 
it with the new (lossy com-
pressed) image, which is probably 
not intended behavior. Uncheck-
ing the box is only recommended 
in very tightly controlled work-
flows, like the two cases 
described here. 
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10101010 Enter the DICOM AE Title for the remote system. 
We recommend you give each machine a unique AE Title. 

11111111 Enter the DICOM port number for the remote system. 
The DICOM port number does not have to be unique. Most modali-
ties have a fixed port number, which can be found in the DICOM 
Conformance Statement of that modality.

12121212 If RAS is installed on the system and you have also selected the ‘Use 
RAS’ option, another dialog will appear with RAS settings. 

To change an existing site (destination) � 

1111 Select Connection → Destinations… from the menu bar in the Data 
Selector.

2222 In the Destinations dialog box, select a destination (click in the first 
column) and then click Modify.

3333 Change any of the items in the Destination Properties dialog box 
(refer to the on-line Help for details on the tabs and all parameters).

Identification
If the RadWorks system needs to be able to send to various departments 
within the same hospital you can add more details about each destination in 
the Identification tab.

Connection Parameters
The Connection Parameters tab contains the destination information.

The Backup Destination is used to provide redundancy: if sending to a desti-
nation fails, RadWorks will send the study to the backup destination. This 
makes sure the workflow remains intact (if RadWorks could not send the 
study, it could not be deleted from the sending system). To prevent an endless 
loop of directions, the redirection process will stop as soon as the Backup 
Destination equals the primary destination. You can configure circular refer-
ences, though. RadWorks will only check for a circular redirection when it 
actually transmits studies.

Transmission Parameters
The type of destination you add determines which default Transmission 
Parameters you select.

You choose the default transmission format in this tab. It is still possible to 
alter it when you submit a Send Job.

If you use the same AE 
Title on all RadWorks 
workstations on the 

same LAN and perform a retrieve 
action on one of them, the remote 
system will send the images to the 
first DICOM AE Title the remote 
system finds. 

You can also double-
click the left most col-
umn of a destination to 

modify it.

The Backup Destina-
tion drop-down list 
includes all the desti-

nations that have been defined for 
your system. If the destination 
you require is not listed, you will 
need to set it up. See ‘Setting up 
and configuring destinations’ ear-
lier in this chapter.
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The studies can be sorted according to priority set here, and a Priority column 
has been added in the Send Queue dialog window.

Format
This sets the file format for the images. With lossless compression, you can 
return to the original image quality after decompression, this is not the case 
with lossy compression.

We strongly recommend 
you test the compres-
sion parameters and 

decide which ratio is acceptable. 
The quality of the image versus 
the transmission time forms the 
basis for such a decision.
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Setting up and configuring origins

When your system is connected to a network, any properly equipped DICOM 
compliant system connected to that network could query your database and 
even send you studies. In many situations, especially, when specific security 
measures are already in place, this will not matter a great deal. But there may 
be circumstances when you want to restrict access to your system to specific 
known systems. 

In RadWorks, you do this using ‘origins’. When another system tries to com-
municate with yours, you can tell RadWorks to check the origin (specific 
details of the other system), and only allow communication if this origin is 
one of a pre-configured set of permitted origins. If not, your system will not 
accept the connection. In this case, the other system will not be able to query 
your system or send it data.

Setting up origin verification
When RadWorks is first installed, the origins feature is not active. To use ori-
gins, you will first need to turn it on.

To turn on origin verification � 

1111 Select Configuration → Connection Service… from the menu bar 
in the Data Selector. 

2222 Check the Verify Origin check box on the Receive tab of the Con-
nection Services Properties dialog box.

Once you have set up RadWorks to verify the origins of other systems, build a 
database of origins which RadWorks should accept.
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Setting up an origin
The Origins section of the Filing tooltab shows all the remote systems or sites 
that have sent studies to your RadWorks system. You can pre-configure Ori-
gins to control from which sites and systems your local system can receive 
data.

1111 Select Connection → Origins… from the menu bar in the Data 
Selector.

2222 Click Add in the Origins dialog box.

3333 Type the appropriate information in the Origin Properties dialog box. 
(The Name, Host Name and DICOM AE Title are mandatory fields). 
For more information on what you should enter here, click Help.

The New Study Status 
field in the Origin Prop-
erties dialog lets you 

specify whether an incoming 
study from the origin should be 
assigned a specific status. What-
ever status a study might have 
when arriving at your system, this 
will be overwritten by whatever 
you select here.

This is particularly useful when 
communicating with non-Rad-
Works systems to ensure that 
studies have a known status.
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Automatically locking and unlocking studies

Studies can be locked in RadWorks to prevent their accidental deletion and the 
loss of data this would cause. Locking and unlocking can be performed manu-
ally in the Data Selector (see the User Guide). It is, however, also possible to 
have RadWorks lock studies automatically as soon as they are received, thus, 
immediately protecting the data they contain.

You can set up this automatic locking for just some or all of the sites you 
receive data from (using Origins). The origins for which automatic locking is 
important, depend on your workflow. It may, for example, not be necessary to 
automatically lock studies received from an archive (since these studies will 
always remain in the archive even if deleted on the local system). On the other 
hand, it may be very important that newly-created studies received for diagno-
sis are not deleted (at least not until some further action has been taken).

To set whether or not RadWorks will lock incoming studies from a particular 
origin, you must modify the properties of that origin.

To automatically lock studies from a particular origin � 

Select Connection → Origins… from the Data Selector menu bar. In the Ori-
gins dialog box, click the first column of the origin you want to have auto-
matic locking from, and click Modify.... In the Origin Properties dialog box, 
make sure the Lock Received Study check box is checked.

Automatically unlocking studies
Automatically locking studies is very valuable in many situations. However, 
locked studies cannot be deleted manually, nor can they be deleted automati-
cally using the Delete After Send option. In some cases, it may be desirable to 
have an automatic unlocking facility to, for example, allow studies sent to an 
archive using storage commitment to be deleted.

RadWorks’ automatic unlocking feature is the counterpart of automatic lock-
ing, except that it applies to studies that are sent rather than received. For each 
destination that your system sends studies to, you can specify whether studies 
should be automatically unlocked. It may be appropriate for some destinations 
(such as an archive), but not for others (such as a radiologist’s home system or 
an ER department), which may not be safe storage sites for studies.

To set whether RadWorks unlocks outgoing studies to a particular destination, 
or not, you modify the properties of that destination:

To automatically unlock studies going to a particular destination � 

IA series or images can 
be received from an ori-
gin with automatic lock-

ing enabled. Images, which the 
user previously unlocked, could 
however be appended to a study 
stored on the receiving system. In 
this case, the automatic locking 
will override what the user did – 
RadWorks will lock the whole 
study again when it adds the 
series and/or images to it.
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Select Connection → Destinations… from the Data Selector menu bar. In the 
Destinations dialog box, click the first column of the destination you want to 
enable automatic unlocking for, and click Modify.... Click the Transmission 
Parameters tab in the Destination Properties dialog box and make sure the 
Unlock Study After Send check box is selected.

Unlocking individual studies when you send them
Apart from having RadWorks automatically unlock studies, you can specify 
for particular send jobs that the sent studies should be unlocked when you cre-
ate those send jobs. 

Prepare the send job for sending in the usual way, but before clicking OK in 
the Send To… dialog box to submit the job, click the Advanced…. Click the 
Transmission Parameters tab of the Advanced Transmission Properties dia-
log box and make sure the Unlock Study After Send check box is selected.

Overriding automatic unlocking of studies for individual studies
If RadWorks has been set up to automatically unlock studies sent to the desti-
nation you are sending to, you can have the studies for a particular send job 
not unlocked. When you create send jobs you can, as it were, ‘override’ the 
RadWorks default setting concerning unlocking studies. To do this, make sure 
that the Unlock Study After Send check box on the Transmission Parameters 
Tab of the Advanced Transmission Properties dialog box is not checked.
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Compression in teleradiology

Teleradiology is, of course, a very powerful tool for distributing image infor-
mation quickly to where it is needed. Many types of study are, however, very 
large and telecommunications links often comparatively slow, so studies can 
take a considerable time to send in uncompressed form. RadWorks, therefore, 
offers a variety of ways of compressing images before sending them (and 
decompressing them at the other end).

Lossless or lossy?
When selecting a form of compression to use when sending studies, the most 
fundamental choice is between lossless and lossy compression. As the name 
implies, lossless compression means that none of the information in images is 
lost – when decompressed on the other system, images will appear exactly as 
they were before they were sent. This is not the case with lossy compression – 
some of the image detail will be lost in the compression and decompression 
process. The advantage of lossy compression is that it achieves greater com-
pression and hence smaller and faster transmission jobs than lossless compres-
sion.

Generally, it is best to use lossless compression – when you are sending 
images over a reasonably fast network or sufficient time is available even over 
a connection of limited bandwidth. For low bandwidth connections and/or 
when time is at a premium, you may well need to use lossy compression.

RadWorks will not compress images in a lossy way if the image is already 
lossy or has been lossy compressed previously.

The options
RadWorks offers a much wider choice besides lossy or lossless. Depending on 
how your system is configured, you can choose some or all of these options 
when sending studies using teleradiology.

DICOM 3.0 � is not a compressed format at all. Images are sent in uncom-
pressed form. It is part of the DICOM standard and allows images to be trans-
ferred between systems from different manufacturers. Use for transmitting 
images with no loss of quality over relatively high-bandwidth links.

JPEG Lossy � is a lossy form of compression which, as part of the DICOM 
standard, allows images to be readily transferred between different manufac-
turers' systems. Use for sending images when bandwidth and transmission 
time are an issue.

With lossy compres-
sion, some image 
detail is irretrievably 

lost. This may render the image 
unsuitable for diagnostic pur-
poses. 

Once an image has been 
compressed with a lossy 
compression, you can-

not apply another lossy compres-
sion option. 
Images that are stored in a loss-
less compression format can be 
converted to another compres-
sion format. 
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If sent to older RadWorks (5.1 and down) versions, the actual transfer syntax 
used will be a DICOM transfer syntax (DICOM JPEG Lossy). NOTE: In that 
case only unsigned 8- & 12- bit images can be compressed.

If sent to another RadWorks 6.0 system, the actual transfer syntax used will be 
a private transfer syntax (JPEG Lossy) for images other than unsigned 8- & 
12- bit images. NOTE: In that case all images can be compressed, except for 
images containing image overlays and RGB bi-plane.

DICOM JPEG Lossless � like the lossy version, this is a format which, as part of 
the DICOM standard, allows images to be readily transferred between differ-
ent manufacturers' systems. Compression is not as high as for the DICOM 
lossy format, but image quality is not diminished. 

This transfer syntax can only handle 2-16 monochrome and 8-bit RGB 
images.

ZLIB � an all-purpose lossless compression method. 

Wavelet � lossy Wavelet compression which produces high levels of compres-
sion. It is NOT part of the DICOM standard. You need to buy a separate 
licence to use this.

If sent to older RadWorks (5.1 and down) versions, the actual transfer syntax 
used will be a plain DICOM (3.0) transfer syntax. 

JPEG and Wavelet – what compression factor?
If you are using JPEG lossy compression, the lower the quality factor, the 
higher the compression ratio used. A quality factor of 10 will, therefore, pro-
duce much higher compression but poorer image quality than a quality factor 
of 50.

As with other forms of lossy compression, the results you achieve will depend 
very much on the types of images you send. If unsure about what quality fac-
tor to use, you may wish to experiment with various settings using a selection 
of images which are typical of what you normally transmit.
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Automatically compressing and decompressing 
studies as they are received

To save disk space, you can configure RadWorks to automatically compress 
studies when they are received.

To automatically compress studies as they are received � select Configuration → 
Connection Service... from the Data Selector menu bar. On the Receive tab 
of the Connection Service Properties dialog box, check the Auto Compress 
Studies check box and select the format from the Format drop-down list. If 
the format accepts compression parameters, specify these by selecting them 
from the Parameters drop-down list.

Automatically decompressing incoming studies
While you may wish to have studies compressed as they arrive to save disk 
space, compressed studies take longer to display since RadWorks has to 
decompress the images first. If performance is a higher priority than cutting 
down on disk space requirements, you can have RadWorks decompress all 
incoming studies that have been compressed so they are ready to be displayed 
as quickly as possible. You can choose whether RadWorks should decompress 
only lossless compressed studies, only lossy compressed studies, or both.

To automatically decompress studies as they are received � select Configuration 
→ Connection Service... from the Data Selector menu bar. On the Receive 
tab of the Connection Service Properties dialog box, check the Auto Decom-
press Lossless Compressed Studies check box and/or the Auto Decompress 
Lossy Compressed Studies check box.

Automatic compres-
sion for received stud-
ies works separately 

from compression applied to 
studies that are stored (see ‘Sav-
ing hard disk space by compress-
ing studies’ in chapter 3 of the 
User Guide).

To compress studies using Wave-
let compression, your system will 
need to have the Wavelet module 
installed.

If automatic compression is on, 
RadWorks stores images it 
receives in a compressed format, 
without changing that format.
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Working with Wavelet compression

Wavelet is claimed to be one of the most effective compression algorithms for 
medical teleradiology. Clinical studies indicate that a higher compression ratio 
can be achieved while maintaining image quality than could be achieved using 
more conventional compression methods. This means that Wavelet requires 
less transmission time, which can be essential in situations where the infra-
structure is not always completely reliable or access time is at a premium. A 
further benefit is that Wavelet-compressed files use much less disk space at 
the receiving site than uncompressed files.

RadWorks provides lossy Wavelet compression. To make Wavelet compres-
sion available to RadWorks users in a form that has been clinically tested, 
Applicare has used a third party toolkit that functions transparently with the 
RadWorks software.

How to tell it you have Wavelet compression installed…
If you have Wavelet compression installed on your system, Wavelet will be 
one of the options in the Format drop-down list in the Send to… dialog box 
(click Send on the Teleradiology tooltab in the Data Selector to view this).

Compression and decompression
The Wavelet Module can compress jobs with various lossy compression fac-
tors. In addition, the receiving RadWorks 6.0 system, it will automatically 
decompress a Wavelet compressed study when it is opened for viewing. Stud-
ies, series or image selections that have been sent using Wavelet compression 
will display a non-erasable message to this effect along with the compression 
factor.

If you plan to use lossy 
Wavelet compression on 
a routine basis, you can 

experiment sending several basic 
types of studies with varying com-
pression factors to find the most 
acceptable ones for you.

If you select Wavelet as the format 
for sending, you can also select a 
compression factor in the same 
dialog box. If the supplied factors 
are not sufficient, you can config-
ure new ones in the Connection 
Service Properties of the Configu-
ration drop-down menu in the 
Data Selector.
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Configuring storage commitment

The mechanism defined in DICOM for network-based data storage, the Stor-
age Service Class, allows a sender (SCU) to transmit study images to a 
receiver (SCP). However, the Storage Service Class does not specify the safe-
keeping of data: there is no commitment that the SCP will do more than 
accept the transmitted studies.
Safekeeping is done via a separate Service Class: the Storage Commitment 
Service Class. 

The SCP implementation defines how it provides its commitment to storage. 
Certain SCPs may commit to permanently store the studies (e.g. an archiving 
system) while other SCPs may commit to provide storage for only a limited 
amount of time.

Once the SCP has accepted the commitment to store the studies, the SCU may 
decide that it is appropriate to delete its copies of the studies. DICOM Storage 
Commitment does not demand a byte-to-byte comparison of the data. Also a 
checksum of the image data is not compared. For a successful Storage Com-
mitment, it is verified that at least the following is identical at the source and 
the destination: Study UID, Series UID(s), and the number of images.

An alternative destination can be configured (at destination level) for Storage 
Commit. When the storage commit request must be sent to a different destina-
tion than the images, a new DICOM association is opened on which the Stor-
age Commit request is sent. An empty Storage Commit destination (default) 
means that the Storage Commit request will be sent to the same destination as 
the images.

Setting a time-out value
You can set a maximum time for your system to wait for an answer from the 
other system before indicating that storage commitment has not succeeded. If 
this time has exceeded, the job in the send queue receives the status Error.

To set a time-out value for storage commitment � 

1111 Select Configuration → Connection Service… from the Data 
Selector menu bar. 

2222 Click the Maintenance tab, in the Connection Service Properties 
dialog box.

3333 Set the time (in hours) in the Time Out DICOM Storage Commit-
ment field.
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Setting up auto-routing

RadWorks supports multiple auto transmit protocols. You can send to multiple 
destinations using a trigger mechanism with or without a set of rules and 
based on the origin of the study.

Use this type of transmission, for instance, when the hospital’s radiologist is at 
home on call and has access to a RadWorks system, or on a Quality Control 
workstation which allows automatic transmissions to an archive after Match-
ing and saving studies.

Only a user with administrator rights can configure the Auto Transmit Proto-
col. Other users will only be able to use and modify the Basic Protocol.

End users will only be able to select one destination for auto transmissions, 
which will be triggered as soon as the system receives studies.

The option Delete After Send overrides the setting of the Destination proper-
ties.

Setting up basic automatic routing
While you can create highly sophisticated auto transmission setups in Rad-
Works, for many users the facility of automatically forwarding incoming stud-
ies to another system will suffice. Setting up such basic automatic 
transmission is covered here. For details on setting up more sophisticated 
automatic transmission, see ‘Setting up advanced automatic transmission’ 
later in this chapter.
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To automatically forward received studies to another system � 

1111 Select Configuration → Auto Routing… from the menu bar in the 
Data Selector. If you are logged on with administrator rights, go to 
step 2. If you do not have administrator rights, go straight to step 3.

2222 Click <basic protocol>, (in the Name column) and then Modify in 
the Auto Route dialog box.

3333 Select a destination from the drop-down list, in the Auto Route Basic 
Teleradiology dialog box

4444 Click Send Immediate, to forward incoming studies immediately to 
the destination. Click Transmission Time, if you want to specify a 
particular time that incoming studies should be sent (possibly to take 
advantage of lower telephone call rates), or Delay Time if you want 
to specify a delay before the studies are sent to the destination. Set 
the transmission time or delay time appropriately.

5555 Check the Delete After Send check box, to remove the study from 
your system after it has been sent successfully.

If auto transmission has been set, this will be shown by the indicator in the 
Send section of the Teleradiology tooltab.

You can turn off the automatic sending of studies in the Auto Transmit dialog 
box.

To turn off auto-routing � Select Configuration → Auto Routing… from the 
menu bar in the Data Selector. In the Auto Route dialog box, click <basic 
protocol> (in the Name column) and then Modify. Select <none> from the 
Destination drop-down list in the Auto Route Basic Teleradiology dialog box.

End users will only be able to select one destination for auto transmissions, 
which will be triggered as soon as the system receives studies.

<basic protocol> in the 
Auto Transmit dialog 
box is a basic ‘auto 

transmit protocol’ included when 
RadWorks is installed. To create 
more sophisticated auto transmis-
sion, you will need to create new 
auto transmit protocols. See ‘Set-
ting up advanced automatic trans-
mission’ later in this chapter.

If the destination you want is not 
displayed in the Destinations 
drop-down list in the Auto Trans-
mit Basic dialog box, it has not 
been set up properly on your sys-
tem. See ‘Setting up and configur-
ing destinations’ earlier in this 
chapter.

Automatic transmission and the Auto Transmit Basic dialog box
If the text Auto Transmit to the left of the indicator on the Teleradiology tooltab is 
not active, at least one protocol besides the basic protocol is active. So if you turn 
the basic protocol off, studies may still be automatically forwarded by another 
protocol.

The Auto Transmit indicator light on the Teleradiology tooltab indicates whether 
the basic protocol is operating. The indicator is on, if studies will be automati-
cally forwarded according to the basic protocol. The indicator is off, if the basic 
protocol is switched off.
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The option Delete After Send overrides the setting of the Destination proper-
ties.

Setting up advanced auto-routing
Earlier in this chapter, there was a description of how to set up automatic 
transmission. This, however, only lets you select a single destination and a 
limited choice about how the auto-routing is to take place. In fact, you can 
create many auto-routing configurations in RadWorks to meet a wide range of 
requirements, based on filter criteria, rules, origins and triggers.

Filter criteria and rules
How auto-routing takes place is determined by filter criteria and rules.

A filter criterion might, for example, specify that the modality of a study 
should be CT or MR. This could then be used to send only CT or MR studies 
to a particular destination. Another filter criterion might be that the status of 
the study should be Authorized. Then auto-routing could be set up only for 
authorized studies.

A rule combines filter criteria. Thus, the two filter criteria given as examples 
above could be combined so that only Authorized CT or MR studies are sent 
to a particular destination. Any DICOM field can be used to specify filter cri-
teria and rules, allowing very specific and potentially very complex conditions 
for auto-routing to be created.

Auto-routing protocols
Another term used in RadWorks is auto-route protocol. This contains a rule 
specifying when auto-routing should be started as well as a list of destinations 
and origins. When performed, an auto-routing protocol generates one or more 
jobs in the teleradiology send queue. Auto-routing protocols also let you spec-
ify whether studies should be deleted from the system after being sent, the 
time at which transmission is scheduled, the delay before transmission, and 
other aspects of the transmission process.

In other words, when you create an auto-routing protocol you define exactly 
what should happen when a given event occurs.

Triggers
Events that can start auto-routing are called triggers in RadWorks. The trig-
gers currently available in RadWorks are listed in ‘Setting Auto-Transmit trig-
gers’ on page 73. 



GEMS IT Applicare

73

Working with auto-routing protocols
Setting up a system to use auto-routing involves stating what should happen 
(defining an auto-routing protocol) and under what circumstances this should 
happen (specifying a trigger for the protocol). You can set up a number of 
auto-routing protocols linked with various triggers.

You manage auto-routing protocols using the Auto Route dialog box. This 
shows a list of the auto-route protocols currently installed on the system. 

To see the auto-route protocols that have been installed � 

Select Configuration  → Auto Routing… from the menu bar in the Data 
Selector.

To create or modify an auto route protocol � 

Select Configuration  → Auto Routing… from the menu bar in the Data 
Selector. To create a new auto-route protocol, click Add. To change an exist-
ing protocol, click its name in the first column of the Auto Route dialog box 
and click Modify. In the Auto Route Protocol dialog box, set appropriate val-
ues on the General, Rule, Teleradiology, Move to folder and Archive tabs.

For detailed help on any item, click Help.

Once you have created auto route protocols, you may, subsequently, wish to 
remove them. 

To permanently remove (delete) an auto route protocol � 

Select Configuration  → Auto Routing… from the menu bar in the Data 
Selector. Select the auto route protocol you want to delete (click its name in 
the first column of the Auto Transmit dialog box) and then click Delete. 

You may, however, wish to disable the auto-route protocol without deleting it 
completely, so that you can reinstate it at some later time.

To (temporarily) disable an auto-route protocol � 

Select Configuration  → Auto Routing… from the menu bar in the Data 
Selector. Select the auto-routing protocol you want to disable (click its name 
in the first column of the Auto Route dialog box) and then click Modify. On 
the General tab of the Auto Transmit Protocol dialog box, select <disabled> 
from the Auto Transmit Trigger drop-down list.

Setting Auto-Transmit triggers
Depending on which RadWorks add-on has been installed, various triggers 
can be chosen:

You will require admin-
istrator rights to cre-
ate, modify, delete or 

disable auto transmit protocols.

Use the Copy button in 
the Auto Transmit dialog 
box to help create a new 

auto transmit protocol which is 
similar to the one that was created 
created previously.
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Setting the Auto Route Teleradiology properties
Destinations, added by selecting Connection → Destinations...and clicking 
the Add button, will be displayed on the Teleradiology tab of the Auto Route 
Protocol dialog box.

When the Priority is set to <Mixed> the study will be sent with the priorities 
defined for the different destinations. However, when you select a single 
value, such as ‘High’, the priority settings of all destinations will be overrid-
den with this new value. Likewise, the destination’s transmission format will 
not be overruled by the settings here, when the format is set to <Mixed>.

The options Send Immediate, Transmission Time and Delay Time will always 
override those of the individual destination’s settings.

Setting Auto Route Rules
In many cases, it may be necessary to add filter criteria, so only certain studies 
will be sent automatically after the Auto Route protocol has been triggered.

Adding a filter criterion allows you to use ‘AND’ or ‘NOT’ as a condition.

You can also use wildcards by typing an asterisk as prefix and/or suffix (e.g. 
*b* or *hair*). You cannot use a wildcard as part of a range.

Trigger name Description

<disabled> Disables the Auto Transmit functionality. If a Quality Control trigger has been defined and the Mod-
ule is removed from the system, the QC triggered Auto Transmit Protocol will not be removed, but 
will be disabled.

Study Received When a study from the selected origin(s) has been received

Key Images Defined When Key Images have been defined and saved with the study, and the Study Status has been set 
to ‘Authorized’.

Save after Viewing When a study has been saved after viewing it; this also applies when using Special Commands

Save after Acquisition When an acquired study has been saved (only possible if the Data Acquisition Module has been 
installed)

Save after QCM When a study from the selected origin(s) has been received and has been modified and saved (only 
possible if the Quality Control Module has been installed)

QC Match Successful When a study from the selected origin(s) has been received and the study demographics have suc-
cessfully been matched with a DICOM modality worklist (only possible if the Quality Control Module 
has been installed)

QC Match Failed When a study from the selected origin(s) has been received and a match event has failed (only pos-
sible if the Quality Control Module has been installed)

Study Status ID changed When you change the Study Status for a study in the Data Selector. 

Auto-transmit triggers and what they do
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If you type a value, then press enter, that value will be added to the grayed out 
line at the bottom of the dialog window and the Value field is emptied. Typing 
a new value using the same DICOM tag will add that value to the existing one.

You can create more complex rules by adding rules in scripts. Once a rule has 
been edited you can no longer modify it with Modify.

Duplicate jobs
You can define two or more Auto Transmit protocols for the same trigger. 
Consequently, duplicate jobs may appear in the Send Queue: the same study is 
sent twice to the same destination. There are cases when this is what the user 
wants: e.g. to send a highly compressed study immediately, and the uncom-
pressed study later during the night. However, in some cases the duplicate job 
is not submitted to the Send Queue.

The duplicate job is only submitted, if “extra data” will be sent by the dupli-
cate job. “Extra data” are:

• The whole study instead of only the key images.

• An uncompressed (or lossless compressed) study instead of a lossy 
compressed study.

• The study with the same lossy compression format, but with a lower 
compression rate (= less affected images).

• The study with a different lossy compression format than in the first 
job.

Duplicates are only detected for jobs generated by the same trigger, or jobs 
generated by simultaneous triggers (e.g. ‘Study Received’ and ‘QC Match 
failed’, or ‘Save After Viewing’ and ‘Key Images Defined’). 

The order of the jobs (“which is the first and which is the second job” in the 
description above) is determined by the job priority and the transmission time.

Auto-routing configuration examples
This section includes a number of examples of how to configure auto-routing.

Example 1
All studies received during office hours are sent to destination 1, and studies 
outside office hours are sent to destination 2.

1111 Add Destination 1 and Destination 2 by selecting Connection → 
Destinations...and clicking the Add button.
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2222 Create two Auto Route protocols, one that is activated between 9:00 
AM and 5:00 PM and the other that is activated between 5:00 PM 
and 9:00 AM. 

3333 Set the trigger as ‘Study Received’ and from all origins.

4444 Select the destinations, Destination 1 and Destination 2, respectively.

Example 2
A received study is auto routed to Destination 1 uncompressed and to Destina-
tion 2 compressed.

1111 Add Destination 1 and Destination 2 by selecting Connection → 
Destinations...and clicking the Add button.

2222 Set the default transmission parameters for the Destination 1 to 
uncompressed and Destination 2 to compressed.

3333 Create two auto transmit protocols, select Destinations 1 and 2, but 
do not change the Origins, Transmission Format and Compression 
Parameters settings (use default).

4444 Set the trigger for both to ‘Study Received’

Example 3
After viewing and authorization, CT studies must be auto transmitted to Desti-
nation 1 and MR studies must be auto transmitted to Destination 2. 

1111 Add Destination 1 and Destination 2 by selecting Connection → 
Destinations...and clicking the Add button.

2222 Create two Auto Transmit protocols with the trigger set to ‘Save 
after Viewing’. 

3333 Create rules for Destination 1: 
DICOM tag 0008.0061, value *CT* 
DICOM tag 0032.000A, value AUTHORIZED.

4444 Create a rule for Destination 2: 
DICOM tag 0008.0061, value *MR*
DICOM tag 0032.000A, value AUTHORIZED.

Example 4
When a radiologist is on call, CR studies must be sent compressed, and all 
other studies must be sent uncompressed to him.

1111 Add two Destinations by selecting Connection → Destina-
tions...and clicking the Add button.
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2222 Create two Auto Transmit protocols with the trigger set to ‘Study 
Received’ and from all origins. 

3333 For the first protocol, select a compression format and add the rule: 
DICOM tag 0008.0061, value *CR*

4444 For the second protocol, no compression format and add the rule: 
NOT (DICOM tag 0008.0061, value *CR*)

Example 5
Six remote sites transfer un-reported studies to the hub, which RadWorks 
receives. For example, CT's Bone have to be sent on to Radiologist 1, all other 
CT's to Radiologist 2, MR’s Neuro to Radiologist 3 and all other MR's to 
Radiologist 4.

Configuration: 

1111 Add the 4 different destinations by selecting Connection → Desti-
nations...and clicking the Add button.

2222 Add the 6 different origins in the Connection → Origins menu 
option. 

3333 Create 4 Auto Transmit protocols with the trigger set to ‘Study 
Received’ and select the six specific origins in each protocol.

4444 Set the rules:
Radiologist 1: 
DICOM tag 0008.0061, value *CT* 
DICOM tag 0018.0015, value Bone
Radiologist 2: 
DICOM tag 0008.0061, value *CT*’
NOT DICOM tag 0018.0015, value Bone
Radiologist 3: 
DICOM tag 0008.0061, value *CT*
DICOM tag 0018.0015, value Neuro
Radiologist 4: 
DICOM tag 0008.0061, value *CT*
NOT DICOM tag 0018.0015, value Neuro
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Troubleshooting an origin and a destination

First check your network connections to confirm the remote site information 
(even another workstation in your LAN could be set up as a remote site).

Verifying the network IP address

1111 Open the Control Panel.

2222 Double click Network.

3333 Click the Protocols tab in the Network dialog box.

4444 Double click TCP/IP Protocol. 

5555 In the Microsoft TCP/IP Properties dialog box, click the WINS 
Address tab. Check the Primary WINS server IP address to confirm 
its accuracy: if the address is accurate, you can also check that the 
connection is active by pinging it.

Pinging a remote site

1111 Open a command prompt (in NT 4: MS-DOS Prompt).

2222 At the command prompt, type ‘ping’[space][the IP address of the 
remote site].

3333 Verify the returned ‘Reply from…’ IP address. 
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Checking the Host Name to IP address mapping

1111 Go to the C:\Winnt\system 32\drivers\etc folder.

2222 Open ‘Hosts’ with Notepad. This file contains the mapping of IP 
addresses to host names.

3333 Read the instruction given in the file and, on a new line, enter the IP 
address followed by spaces and then the host name (the host name 
must be a single word) of the remote system.

4444 Save the ‘Hosts’ file.

5555 If you are concerned about security, right click the ‘Hosts’ file and 
select Properties from the pop-up menu.
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ou can define in detail how to view images in RadWorks. Some of this 
configuration depends on your monitors, the rest you can set. 

Configuring multiple monitors

While most of the configuration of multiple monitors can be done in Win-
dows, RadWorks still needs to know how to use your monitors. 

To set these properties, log on as a system administrator.

1111 Select Configuration → Generic from the menu bar in the Data 
Selector and click the Monitors tab. 

The monitor numbers in this dialog box correspond to the numbers 
on the Settings tab of the Display control panel. 

2222 For each adapter, set the arrangement: click Settings, and specify 
how many rows and columns of monitors are connected to that 
adapter. 

3333 Optionally, define monitor groups. A group must have monitors with 
the same resolution and/or color space. Monitors in a group must be 
adjacent to each other. For each group, you can set the font, the scale 
factor, and whether the monitors are portrait and/or color monitors. 

Y
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4444 Set the ‘Default Monitor’.

5555 Set the ‘Selector Monitor’ - this determines where the Data Selector 
will appear. 

6666 Restart RadWorks. 

7777 Select the Configuration → Viewing Properties menu, and click 
the General tab.

8888 If you have more than one monitor group: in the ‘Monitor Groups’ 
box, set which monitor groups will be used as the viewing area. 

9999 In the ‘Hanging Protocols group’ box, select the monitor group to 
display the Hanging Protocols on. All other monitors will display the 
default single viewport. 

The other settings on this tab are for the Viewing properties. 
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Viewing properties

You must log on as an administrator to be able to alter all the properties. If you 
do not have administrative rights you will only be able to change ‘non-
ghosted’ properties.

The next sections describe the options in the Configuration → Viewing 
Properties dialog. Refer to the online help for more detailed information 
about each tab of this dialog. 

General tab
Select the Direct View option to view images as they arrive (see below).

View Images as they arrive
This feature consists of three items:

• Direct view of items in a remote view (or archive).

• Direct view of worklist items that are not local.

• Wait mode for receiving new studies from a selected origin (monitor-
ing mode).

After restarting RadWorks, right click in the Data Selector and select ‘Receive 
new study’ in the menu that appears, to enable Monitoring mode. When you 
select this, a dialog box appears that allows you to choose the origin for the 
studies.

To view Remote View studies, select a study in the active Remote View, right 
click, and select ‘View’ instead of ‘Import’ in the menu that appears.

Pop-up menu tab
Here, both administrators and end-users can decide which menu items will be 
available in the Viewports and the Worklist windows. Select the items you 
want to be available. 

Cutlines tab
Here, you can set preferences (line color, style) for cutlines and their labels. 

Require Frame of Reference
When determining whether cutlines can be computed between multiple series 
this option decides whether those series need to have the same “Frame of Ref-
erence” UID (DICOM tag 00200052). By default this option is checked, 
meaning that multiple series need to have the same Frame of Reference UID 
for cutlines to be computed. 
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In case the Frame of Reference UIDs are different or absent, and it is known 
(as declared by the modality manufacturer) that the series are still spatially 
related to each other, this option can be disabled to still allow cutlines to be 
computed and displayed. However, this may result in the incorrect display of 
the cutlines.

Applicare will not take any responsibility for the display results of the cutlines 
if this option is disabled.

Compose set description 
Select the way you want to identify a series of images in the Cutline Sets sec-
tion of the Cutline Tooltab; e.g., by series number, study description or body 
part etc. Show Image Information tells RadWorks to indicate the number of 
images in a series when it displays the set description. 

View the results of your settings in the pane below the drop-down list and 
check box. 

Compose Label 
Compose Label determines how you want to display labels. A label consists 
of three parts. Select from the first drop-down list the first part of the label. 
Use the second drop-down list to select a separator and the third list to define 
the third part of the label. 

View the results in the pane below the drop-down lists. 

Patient Info/Cine tab
De-activate the Patient Information window if you are setting up an educa-
tional system. This will ensure the privacy of the patients. 

You may also want to disable the Viewport Annotations, or edit them so that 
patient related information will not be available in the Viewports.

You can specify the number of cines RadWorks can simultaneously run. Rad-
Works sets this to 4 by default. The minimum is 1 and the maximum is 16. 

Pictorial tab
Define the properties of the Pictorial Index. You use this tab to create more or 
less room, provide more or less information or define the fonts and style of 
study or series headers in the Viewing Section. You also define the kind of 
information that will appear in headers. 

Modalities tab
The initial zoom factor in Viewing can be clipped to a user definable value 
that is modality dependent.
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The administrator can set an upper boundary to the initial zoom factor. After 
changing the zoom settings, the clipping is disabled. The clipping is re-
enabled when the study is loaded again or if the reset button is clicked.

Viewport Annotation tab
For each modality, you can set which information is to be displayed along the 
edges of each image. Private attributes (those with an odd DICOM group 
number, for example 00191010) can also be included when the private tag is 
known from, for instance, the sending modality console. This can be useful to 
display special scanner options such as contrast settings.

Contents not enclosed by ‘@’ characters will be shown literally in the View-
ports and can be used for additional explanations.

Date Time will be shown in the format specified in the Regional Settings con-
trol panel.

The contents of a tag is displayed formatted (patient names have commas 
instead of ^). 

Tags which contain a sequence will display all items in the sequence, sepa-
rated by backslashes. You can also select one item from the sequence, using 
the syntax: 
@xxxxyyyy[n]aaaabbbb@ 
of the sequence with tag (xxxx,yyyy) display from the n-th sequence item, the 
value with tag (aaaa,bbbb). 

Nested sequences are also supported. 

Both sequence and non-sequence items can be suffixed by an index and/or be 
followed by a format string (in that order).

Index: @...[n]@: display the n-th value in a multi-valued element. 

Invalid indices will result in empty values.

Format: @...%format@: displays the value, formatted according to a C-style 
format string.

Examples:

Definition Example of 
contents Explanation

@00100010@ Sylvia Delors Patient name is displayed
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ST: @00180050@ mm ST: 3 mm @00180060@ is substituted with the image value ‘3’

@00200013%i@ 17 The value 00017 from the tag 00200013 is formatted using %i resulting in 
17

@frame@ 1 Frame number is displayed on the individual frames, since there is no 
DICOM tag available

(F@frame@/@00280008@) (F3/12) Will display frame number # of ## frames in brackets. Default setting for 
XA studies

TR: @00180080%.1f@ ms TR: 2000.0 ms The value 005.500000E+03 from the tag 00180080 is formatted using 
%.1f giving a result with one decimal

@00080008@ ORIGINAL\PRIMARY image type, the tag has multiple items as content

@00540410[0]00080104@ displays the first item in the ‘Patient Orientation Code Sequence’

@00080008[0]@ ORIGINAL Index

@00200013%04X@ 000E image number is 14 (000E hexadecimal = 14 decimal)
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Navigation buttons

You can change the position of the navigation buttons in the Viewing Area:

1111 Select Configuration → Viewing... from the Data Selector menu 
bar.

2222 Click the General tab of the Viewing Properties dialog box. 

3333 Click Configure. The Navigation Buttons dialog opens. 

4444 From the drop-down list, select where you want the buttons to be dis-
played. 

5555 You can check some of the checkboxes of the buttons to display 
them. 

The Up Series and Down Series buttons allow you to navigate between the 
series. If a study only contains one series, these buttons will not be displayed. 

The Prev and Next buttons allow you to navigate through studies in the 
Worklist. These buttons work like the ones in the bottom right area of the 
tooltab. 

The Back button returns you to the Data Selector. This button works like the 
buttons in the bottom right area of the tooltab. 
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Configuring annotations

Setting up calipers
A caliper can be added to images in the Viewing Section. The caliper will only 
be displayed if size information is present in the image (in the Pixel Spacing 
DICOM tag 0028,0030). 

The caliper is displayed in the center right side of the viewport. Other annota-
tions will not be displayed in the calipers area. 

To switch calipers on for each modality � 

1111 Select Configuration → Viewing... from the menu bar in the Data 
Selector.

2222 Click the Viewport Annotations tab.

3333 Select the modality.

4444 Check the Show Caliper check box. 

Once you have switched this on, you can use the caliper. Open a suitable 
study, click the Annotation and Measurement tooltab and check the Show 
Caliper check box. 

Setting preferences for measurements
Use the Distance tool on the Annotation and Measurement tooltab to drag dis-
tance lines across images. 

To set preferences for these lines �

1111 Open the Configuration → Viewing dialog.

2222 Click the Image Annotations tab.

3333 Check the Tickmarks check box to show tick marks on the distance 
lines. 

4444 Set the minimal number of pixels between two ticks (experiment 
with this setting so the tick marks are at a usable distance on your 
monitors). 
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Working with hanging protocols

Hanging protocols allow RadWorks to manage the order and layout of view-
ports. They also allow the positioning the images from current and prior stud-
ies. You can use the hanging protocols on both single and multi-monitor 
systems.

RadWorks implements two types of hanging protocol: default and automated.

The basic difference between these is that the automated hanging protocols 
allow you to define selection criteria, whilst the default hanging protocols do 
not. 

Managing hanging protocols
Select Viewing → Hanging Protocols Manager from the Data Selector 
menu bar. The ‘Hanging Protocols Manager’ dialog box displays a list of all 
the available hanging protocols. With the buttons below the list you can cre-
ate, modify, copy, disable, delete, import or export hanging protocols. With 
the arrow buttons to the left of the list, you can set the priority of a specific 
protocol. You can select the group (default or automated hanging protocols) 
via the radio buttons. 

To add or modify a hanging protocol �
1111 To add a hanging protocol, click New.

2222 To modify an existing hanging protocol, select the protocol you want 
to modify and click Modify. 

3333 Adjust the settings in the Hanging Protocol Editor (click Help for 
detailed information on the options). 

4444 If you want to change the layout definition or select a specific hang-
ing protocol under certain conditions, click Wizard (see next sec-
tion). 

Using the wizard will generally be sufficient to create the hanging protocol 
selection you want to use. You can fine-tune the hanging protocol with the 
Fine tuning button in the Hanging Protocol Editor. This allows you to edit the 
VB script that defines the Hanging Protocol. Only change this if you are 
familiar with Visual Basic. 
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Wizard
There are three wizards that guide you through the main features of the proto-
col:

• Layout design wizard,

• Hang criteria wizard, 

• Selection criteria wizard. 

With the layout design and hang criteria wizards you define how the selected 
studies are presented. By using the wizard, you actually create or modify a 
two-part script. 

The first part of the script contains the layout (the positioning of series areas 
and image areas) and hang criteria (the placement of a scout image for exam-
ple). 

The second part of the script is a VB script. This part contains the selection 
criteria definitions. With the selection criteria, you can make rules to select 
specific study data to apply to the layout design and hang criteria.

If the set of studies you select for viewing match the selection criteria, the 
studies are presented in the way you defined the layout design and hang crite-
ria. If there are more hanging protocols with valid selection criteria, the one 
with the highest priority will be applied. The higher the position in the list 
with protocols in the Hanging Protocols Manager, the higher its priority.

Also, if there are multiple hanging protocols with one or more of the same 
selection criteria, you should place the protocol with the most selection crite-
ria at the top of the list.

Fine-tuning
You can make modifications to the ‘programming code’ that makes up a hang-
ing protocol using the Fine Tuning button.

When you are adding or modifying a default hanging protocol, you cannot 
edit the ‘Hanging Protocol Selection Criteria’ function area, because this 
function only applies to automated hanging protocols. The selection criteria 
script is displayed on a grayed background.

The ‘Hanging Protocol Fine Tuning’ dialog box displays two editable text 
boxes. Only the second box, containing the selection criteria definitions, will 
be parsed each time the user opens study data.
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The second box contains Hanging Protocol Selection Criteria. This code con-
sists of a function that validates the protocol based on the selected array of 
data (data_selection) as the input variable. The code loops through the supplied 
data selection. The code in the loop can set the function return variable to 
TRUE or FALSE if given conditions are met or not met. For example, if the 
modality of all data series is equal to ‘MR’ the function returns TRUE.

The text displayed in the gray areas above and under the second text box con-
tains information about the protocol itself and the editor.

Hanging protocol definition
The first editable area does not contain VB Script language but a structured 
language developed by GEMS IT Applicare, which can only be read by the 
RadWorks program. With this language, a custom layout can be defined by 
dividing the viewing area in series and image areas. You can also add hang 
criteria in this area like the pinning of a scout image and the positioning of an 
AP or LR image. The following layout functions can be used.

Comment text in the 
boxes is preceded by a 
single quote (‘). It is rec-

ommended to maximize the 
‘Hanging Protocol Fine Tuning’ 
dialog when you are editing one of 
the boxes.

Element Description

[L begin layout

[S begin series area

[V begin image area (also called viewport)

] End of L, S, V

LayoutName(“Name”) Function for setting the name for this layout function:

SplitNone Use the full area for just one view area

SplitHor X Divide the selected series into X rows; X is a number. 

SplitVer Y Divide the selected row of the selected series in Y number of 
rows.

PinProp AllCutlineSets Pin the image. Do not select a particular cutline set.

HangCriteria(0x80008,IS,”LOCAL-
IZER”)

Position image with DICOM tag ‘Image Type’ equals “Localizer”.

HangCriteria(0x185101,IsE-
qualTo,"AP" "PA")

Position AP / PA images.

HangCriteria(0x185101,IsE-
qualTo,"LR" "RL")

Position LR / RL images.

HangCriteria(0x80060,IsE-
qualTo,"MR")

Position to DICOM tag modality.

Possible layout functions
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Example: 
• The name of the layout is TechRef.

• There are 2 series in the viewport.

• There are 6 images in each series.

• The 6 images are configured with 3 rows with 2 columns.

• The first picture of the first series is the scout image.

• Position AP / PA images first.

Result code:
[L LayoutName("TechRef") SplitVer 2 LAYOUT ‘TechRef’ with 2 columns

[S No(0) SplitHor 3 divide FIRST SERIES in 3 rows

[ SplitVer 2 divide first row in 2 columns

[V No(0) PinProp AllCutlineSets pin the first image if the DICOM
tag

HangCriteria(0x185101,IsEqualTo,"AP" "PA")position AP,PA images
first

HangCriteria(0x80008,IsEqualTo,"LOCALIZER") Image Type
contains “LOCALIZER”

V] end scout image area

[V No(0) V]second image area

]end of first row

[ SplitVer 2 divide second row in 2 columns

[V No(0) V] first image area

[V No(0) V] second image area

] end of second row

[ SplitVer 2 divide third row in 2 columns

[V No(0) V] first image area

No(x) Sequential number of Series or image. This is currently not used 
by RadWorks, but can be in one of the future releases or Service 
Packs.

TimeOrder(MostRecent) Position to time order.

WindowProp(518,1549,Linear) Position with set windowing levels.

ZoomProp(Relative,1.000000) Position with set zoom factor.

AnnotationProp(None) Position with set level of annotation.

OrientationProp("L\F") Position with set orientation.

Element Description

Possible layout functions
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[V No(0) V] second image area

] end of third row

S] end of FIRST SERIES AREA

[S No(0) SplitHor 3 divide SECOND SERIES in 3 rows

HangCriteria(0x185101,IsEqualTo,"LR" "RL") position LR,RL
images secondly

[ SplitVer 2 divide second row in 2 columns

[V No(0) V] first image area

[V No(0) V] second image area

] end of first row

[ SplitVer 2 divide second row in 2 columns

[V No(0) V] first image area

[V No(0) V] second image area

] end of second row

[ SplitVer 2 divide third row in 2 columns

[V No(0) V] first image area

[V No(0) V] second image area

] end of third row

S] end of SECOND SERIES AREA

L]end of LAYOUT definition

Hanging protocol selection criteria
The second editable area contains VB Script language. As already stated, the 
best way to create the selection criteria is to use the Selection Criteria Wizard 
by clicking the Wizard button in the Hanging Protocol Manager. With this 
script, a custom selector can be defined by applying certain conditions in it. If, 
however, you desire very specific selections, you will need to use the scripting 
tool. The scripting statements shown below can be used. 

Regularly check the syn-
tax with the Check but-
ton next to the box you 

are editing. 

Statement Description

For study... Next With this statement the script loops through the selected studies. 

For series... Next With this statement the script loops through the series of the selected studies. 

Scripting statements
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Sample script
Apply this hanging protocol only for selected series containing CT modalities 
with a localizer image (also called scout or pilot image). This localizer image 
should not be the only image in the series.

Function CheckSelectionCriteria_TechRef(data_selection)

CheckSelectionCriteria_TechRef = false

For study = LBound(data_selection, 1) To UBound(data_selection, 1)

For series = LBound(data_selection, 2) To UBound(data_selection, 2)

ScoutPresent = false

ImagesPerSeries = 0

For tag... Next With this statement the script loops through the tags stored in tag_descr. 
These tags are a restricted set of tags. The tags are:
BodyPartExamined
ContrastBolusAgent
EchoTime
ImageOrientation
ImageType
Modality
PatientOrientation
PatientPosition
Protocol
RepetitionTime
SeriesDescription
SeriesInstanceUID
StudyDescription
StudyInstanceUID
ViewPosition
SeriesInStudy
ImagesInSeries
ImagesInStudy
StudiesInDataSelection
SeriesInDataSelection

Keep in mind that tag_descr is case sensitive. It is possible to expand the list 
of available DICOM tags by adding them as keys to the registry. 
HKEY_LOCAL_MACHINE\SOFTWARE\AMI\RadWorks\6.0\Modules\View-
ing\HangingProtocols\DICOMTags\Default.
Note: Do not create too many keys because it might decrease the perfor-
mance of your system. 

LBOUND (ARRAY 
[,DIM]) 

Returns the lower bounds for all dimensions of an array, or the lower bound 
for a specified dimension. ARRAY must be an array. DIM must be a scalar 
integer with a value in the range 1 to n, where n is the rank of ARRAY.
Results: The result type is default integer. 

UBOUND (ARRAY 
[,DIM]) 

Returns the upper bounds for all dimensions of an array, or the upper bound 
for a specified dimension. ARRAY must be an array. DIM must be a scalar 
integer with a value in the range 1 to n, where n is the rank of ARRAY.
Results: The result type is default integer. 

Statement Description

Scripting statements
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For tag = LBound(data_selection, 3) To UBound(data_selection, 3)

tag_descr = data_selection(study, series, tag, 0)

tag_value = data_selection(study, series, tag, 1)

tag_count = data_selection(study, series, tag, 2)

If tag_descr = "" Then

Exit For

End If

If tag_descr = "ImagesInSeries" Then

ImagesPerSeries = tag_value

End If

If tag_descr = "Modality" Then

If tag_value <> "CT" Then

Exit Function

End If

End If

If tag_descr = "ImageType" Then

If tag_value = "LOCALIZER" Then

ScoutPresent = TRUE

CheckSelectionCriteria_TechRef = TRUE

End If

End If

Next

If ScoutPresent = TRUE Then

If ImagesPerSeries = 1 Then

CheckSelectionCriteria_TechRef = FALSE

End If

End If

Next

Next

End Function

Explanation of the sample script
Declaration of the function. Return the result as Boolean. Take the array 
data_selection as input.

Function CheckSelectionCriteria_TechRef(data_selection)

Init the return value as FALSE from the function. Assume the selection is 
incorrect.

CheckSelectionCriteria_TechRef = FALSE

Next, loop through the studies in the selected data.

For study = LBound(data_selection, 1) To UBound(data_selection, 1)
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Now, loop through the series in the selected study.

For series = LBound(data_selection, 2) To UBound(data_selection,
2)

Declare and initialize the required local variables. Mark the scout image as not 
found and the number of images per series as 0.

ScoutPresent = false

ImagesPerSeries = 0

Loop through the tags in the selected series.

For tag = LBound(data_selection, 3) To UBound(data_selection,
3)

Next, retrieve tag information from the data selection array. Store them in 
local variables.

tag_descr = data_selection(study, series, tag, 0)

tag_value = data_selection(study, series, tag, 1)

tag_count = data_selection(study, series, tag, 2)

Stop the search ASAP. If out of tags then leave the series loop. Go to the next 
series.

If tag_descr = "" Then

Exit For

End If

Put number of images in this series in a local variable ImagePerSeries.

If tag_descr = "ImagesInSeries" Then

ImagesPerSeries = tag_value

End If

Next, specify your selection criteria.

Example: Check if modality is not MR.

First check if tag_descr equals “Modality”.

If tag_descr = "Modality" Then

Don’t select data other than with the CT modality. Check if tag_value does 
NOT equal “CT”.

If tag_value <> "CT" Then

Stop selecting by exiting the function. Hence the function return value stays 
FALSE.

Exit Function

Correctly end the IF .. THEN conditions with END IF statements

End If
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End If

Check if tag_descr equals “Imagetype”.

If tag_descr = "ImageType" Then

Check if tag_value of “ImageType” contains the string “LOCALIZER”.

If tag_value = "LOCALIZER" Then

Mark scout image by setting variable ScoutPresent as TRUE.

ScoutPresent = TRUE

Return function variable as TRUE.

CheckSelectionCriteria_TechRef = TRUE

End If

End If

Next

If, after looping all the tags, a localizer image is found.

If ScoutPresent = TRUE Then

Check if the number of images equals 1.

If ImagesPerSeries = 1 Then

If the number of images equals 1, return the function variable as FALSE.

CheckSelectionCriteria_TechRef = FALSE

End If

End If

Correctly end the FOR .. NEXT statements with NEXT.

Next

Next

Correctly end the declaration of the function.

End Function

Combined statements
Combined statements like the following example.

If tag_descr = "Modality" Then

If tag_value <> "MR" Then

CheckSelectionCriteria_TechRef_ = false

Exit Function

End If

End If

Can be replaced with:

If tag_descr = "Modality" And tag_value <> "MR" Then
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CheckSelectionCriteria_TechRef_ = false

Exit Function

End If

This often saves some code. It’s up to you what style of programming you 
apply. Choose your programming style preferably in such a way that the 
source code is easily readable.

You can also use the OR function on the tag selections. 

If tag_descr = "Modality" Then

If tag_value = "MR" or tag_value = "CT" Then

CheckSelectionCriteria_TechRef_ = false

Exit Function

End if

End If

In this example MR and CT modalities are not allowed. 

Or you can use the ElseIf statement on the tag selections in combination with 
And and Or. 

If tag_descr = "Modality" and tag_value <> "MR" Then

CheckSelectionCriteria_TechnicalReferenceManual = false

Exit Function

ElseIf tag_descr = "ImagesInSeries" and (tag_value < "2" or tag_value
>= "9") Then

CheckSelectionCriteria_TechnicalReferenceManual = false

Exit Function

End If

In this example MR modalities are not allowed. For all other modalities, only 
the series with 2 images or more, but no more than 9 images in it will return 
TRUE.

Most elegant would be the following use of the Select Case statement instead 
of separate If .. Then statements. To make the source better readable you better 
add the loop variable behind the Next statements. It also prevents errors by 
improper use of the For .. Next statement

Function CheckSelectionCriteria_TechRef(data_selection)

CheckSelectionCriteria_TechRef = false

For study = LBound(data_selection, 1) To UBound(data_selection, 1)

For series = LBound(data_selection, 2) To UBound(data_selection, 2)

ScoutPresent = false

ImagesPerSeries = 0
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For tag = LBound(data_selection, 3) To UBound(data_selection, 3)

tag_descr = data_selection(study, series, tag, 0)

tag_value = data_selection(study, series, tag, 1)

tag_count = data_selection(study, series, tag, 2)

Select Case tag_descr

Case "":

Exit For

Case "ImagesInSeries":

ImagesPerSeries = tag_value

Case "Modality":

If tag_value <> "CT" Then

Exit Function

End If

Case "ImageType":

If tag_value = "LOCALIZER" Then

ScoutPresent = TRUE

CheckSelectionCriteria_TechRef = TRUE

End If

End Select

Next tag

If ScoutPresent = TRUE And ImagesPerSeries = 1 Then

CheckSelectionCriteria_TechRef = FALSE

End If

Next series

Next study

End Function

Data selection array
Before RadWorks starts evaluating the first hanging protocol, it collects only a 
subset of DICOM tag contents in the active study selection. The data selection 
can consist of a single study or multiple studies selected by the user. This col-
lected data is stored in an array named data_selection.

Only the tags named in the registry key(s) ‘HangingProtocols\DICOMTags’ 
are aggregated. Tags occurring multiple times with the same value are stored 
just once for evaluation performance reasons. For each occurrence the 
tag_count is incremented.

Tags are collected per study and series separately, not per image. That is done 
for reasons of speed. There is no need for it to collect tags per image either.
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The following counter variables are filled before evaluation of selection rules 
starts:

• SeriesInStudy number of series in study'

• ImagesInSeries number of images in series'

• ImagesInStudy number of images in study'

• StudiesInDataSelection number of studies in data_selection

• SeriesInDataSelection number of series in data_selection

These counters are added as a tag in the data_selection array.

Aggregation of all DICOM tags in the currently selected studies, named in the 
registry key(s) of ‘HangingProtocols\DICOMTags’.

Declaration
dim data_selection(study_index, series_index, tag_index, 3), where:

• data_selection(study_index, series_index, tag_index)(0)= tag_descr

• data_selection(study_index, series_index, tag_index)(1)= tag_value

• data_selection(study_index, series_index, tag_index)(2)= tag_count

Improving performance
• Reduce the number of rules that need to be evaluated. Disable all 

unused protocols.

• Reduce the number of tags that are aggregated in the 
data_selection array. E.g. aggregate tags for certain modality 
types only. You might even want to remove some of the default 
DICOM Tags from the list if performance is an issue.

• Make VB Script exit from the function fast if the current study does 
not match the criteria. Make the detailed selection after making a 
rough selection first.

• Do not build infinite loops!

Multi-selectable hanging protocols
It is possible to perform actions on one or more hanging protocols (delete, 
copy, etc.).
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Import and Export Hanging Protocols
It is possible to import/export hanging protocols from/to an XML file.

When selecting more than one hanging protocol they will be exported into one 
XML file, which can be viewed with Microsoft Internet Explorer 5.0 or 
higher.

Orientation of image
The orientation of an image is based upon LR indications from DICOM 
header and can be used in a Hanging Protocol.

The hanging protocol editor is extended with an orientation section, which can 
be used to add the orientation property to either the series area or the viewport.

As with the markers in the viewports the orientation of the image is derived 
from either the image orientation or patient orientation values. In case of a 
mismatch the function is disabled.

Adding new DICOM tags as hang criteria
By default RadWorks comes with a limited number of hang criteria based on 
DICOM tags. You can add more in modality specific keys (CT,MR, CR of 
Default) by editing the following registry key:

HKLM\Software\AMI\RadWorks\6.0\Modules\Viewing\HangingProto-
cols\DICOMTags

The value name equals the description (no spaces allowed) and the 
REG_DWORD value equals the group plus element values of the DICOM tag 
(e.g. 00080008).

After restarting RadWorks the new DICOM tag will be added in the drop-
down list of the Hanging Protocol Manager and in the ‘help’ text in the Fine 
Tuning section

Hanging protocol for T1/T2
You do not have to declare T1Sag, ..., T1Ax. Also, you have to initialize them 
outside the study for-loop, so this protocol can also be used for sagittal and 
axial series divided over multiple studies. If you verify the tag-value, always 
use upper case! Verify the booleans T1Sag, .., T1Ax at the end (if all studies 
are checked).

CheckSelectionCriteria_Brain_Auto2series_vert = TRUE ' IMPORTANT: Do
not remove this line!

T1Sag = FALSE

Flair = FALSE

T2Ax = FALSE

RadWorks does not 
automatically add the 
extension .XML to the 

filename.
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T1Ax = FALSE

For study = LBound(data_selection, 1) To UBound(data_selection, 1)

For series = LBound(data_selection, 2) To UBound(data_selection, 2)

For tag = LBound(data_selection, 3) To UBound(data_selection, 3)

' Retrieve tag information:

tag_descr = data_selection(study, series, tag, 0)

tag_value = data_selection(study, series, tag, 1)

tag_count = data_selection(study, series, tag, 2)

' Stop search as soon as possible:

If tag_descr = "" Then

' Ready with this series, check next series

Exit For

End If

' Check If SeriesDescription tag equals "Brain T1 Sag", "Brain

Flair Axial", "Brain T2 Axial", or "Brain T1 Axial"

If tag_descr = "SeriesDescription" Then

If tag_value = "BRAIN T1 SAG" Then

T1Sag = TRUE

ElseIf tag_value = "BRAIN FLAIR AXIAL" Then

Flair = TRUE

ElseIf tag_value = "BRAIN T2 AXIAL" Then

T2Ax = TRUE

ElseIf tag_value = "BRAIN T1 AXIAL" Then

T1Ax = TRUE

End If

End If

' Check if the number of series in study is 2

If tag_descr = "SeriesInDataSelection" Then

If tag_value < 1 Then

CheckSelectionCriteria_Brain_Auto2series_vert =

FALSE

Exit Function

End If

End If

Next

Next

Next

CheckSelectionCriteria_Brain_Auto2series_vert = T1Sag And Flair And
T2Ax And T1Ax



C O N F I G U R I N G  T H E  V I E W I N G  S E C T I O N

RadWorks 6.0 installation and configuration guide

104 chapter 4

Hanging protocols and upgrading RadWorks
• The three groups of default hanging protocols will be joined into one 

large set.

• The hanging protocol name will be changed to <original name> + 
<previous group it belonged to>.

• Duplicated hanging protocols will be removed from the list.

Hanging Protocol Permissions (policy file) are also merged. The AMI.adm 
file is not automatically upgraded.
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Plug-ins

You can add plug-ins to add to RadWorks’s image manipulation functions. 
Once a plug-in is added, it can be accessed from the Layout Tooltab in the 
Viewing Section, and it can be made part of a Hanging Protocol. 

To add a Plug-in �

1111 Log in as an administrator.

2222 Select Configuration → Plug-in Definitions.

3333 Click Add. 

4444 Select the Category for the plug-in. 

5555 From the Select Component drop-down list, select the plug-in you 
want to add. 

6666 Click Modify to change the description for the plug-in. 

7777 Click Configure to change the settings for the plug-in. 

8888 Click OK. 

In the Hanging Protocol Editor, you can now select the available plug-ins in 
the Series and Image Properties area. 
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ost RadWorks systems will be used as part of a much wider and exten-
sive hospital system. It is hence vital that it can communicate with all 
kinds of other systems. To assist in this, RadWorks has an open inter-

face to external data sources:

• The information displayed in the Data Selector is not limited to a 
(filtered/sorted) view of the local database, but it can also present 
study or work item lists provided by external sources.

• Reports may be retrieved from and stored in external databases.

• Other applications (typically, RIS or HIS) can be notified of database 
changes and study status changes on the RadWorks station.

• RadWorks can commit certain actions depending on the acknowl-
edgement of an external application via transactions.

Implementations and functionality

The RadWorks modules that interface with external applications are called 
‘HIS/RIS Implementations’.

Each HIS/RIS implementation can interface with certain functionality in Rad-
Works by binding them to one of the four functionality connectors: worklist, 
report, notification, transaction. See the diagram below. 

Currently, the following implementations have been developed for RadWorks:

M

Functionality bindings

Implementations

Local mdb LDMWL

provider

RIS worklist

provider

RIS report

provider

RadWorks

Default RIS 'X' Mitra Other

DBS AE

r w w r

w = worklist

r = report



GEMS IT Applicare

109

The Default implementation interfaces with the local database and DICOM 
sources (C-FIND/C-MOVE SCPs and DICOM Modality Worklist providers).

The MitraPB implementation makes report retrieval (read-only) possible 
through a Mitra PACS Broker. The broker translates DICOM-like query 
requests from RadWorks to HL-7 (or other proprietary protocols supported by 
the Mitra), which the broker passes on to a HIS/RIS.

One generic implementation is supplied (CallExe) that can call an executable 
with a number of configurable command-line parameters. The called execut-
able will in turn communicate with the external source to retrieve or deliver 
the data.

In some cases, a specific implementation will have to be developed to inter-
face to a particular external application. Contact your distributor for further 
information.

General
When exchanging patient data with a HIS/RIS, you can configure when Rad-
Works considers patients to be the same. Select Configuration → Generic... 
from the menu bar in the Data Selector, and on the General tab of the Generic 
Properties dialog box, select a Compare Patients on radio button to compare 
Patient Names, Patient IDs, or both. 

Adding an implementation and binding to functionality �

1111 Open the HIS-RIS manager via Configuration → Generic → HIS-
RIS.

2222 Click Add to add a new implementation. 

Implementations come in the form of a DLL file. Make sure you 
have enabled ‘Show all files’ in the Windows Explorer, otherwise 
the browse option will not show the DLL files.

Name Short
name

Supplied with 
RadWorks

Included in 
default Setup

Default HIS/RIS Implementation Default Yes Yes

Mitra PACS Broker implementa-
tion

MitraPB Yes No

CallExe Implementation CallExe Yes No

Available HIS/RIS implementations
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3333 Configure the implementation (if applicable). 
Most implementations offer a configuration dialog, which is accessi-
ble by highlighting the implementation and clicking Configure. In 
most cases, the configuration dialog has a Help button that can give 
implementation-specific configuration details.

4444 To bind an implementation to a functionality, highlight the function-
ality and click Modify. Check the box for the implementation you 
want to bind.
You can select more than one implementation per functionality. 
However, it is not recommended (read: useless) to use more than one 
for the Report functionality, since you only want to retrieve and send 
reports to one system.

The following paragraphs list the functionalities. 

Reporting
After binding an implementation other than the default one, select Configura-
tion → Reporting to configure RadWorks to retrieve reports through the 
HIS-RIS implementation.

See the Reporting chapter for more details.

Worklists
RadWorks can act as a client for worklist providers.

Lists provided by external sources can be filtered and sorted with Worklist 
Views. You can define multiple views on the same source list. Views are 
stored per user and you can easily switch between the different views.

You can create a Worklist that has multiple sources. You can, for example, 
create a Worklist that lists studies from two archive systems, or you can create 
a Worklist that lists current studies in the local database, and their priors form 
both the local database and an archive. 

You can create Worklists that have a DICOM part 10 archive (CD-ROM) as a 
source. 

HIS/RIS implementations provide List Types. You can see the available list 
types when you configure the implementation, select Configuration → 
Generic, on the HIS/RIS tab, select the implementation and click Config. 

The List Types you add here, can be used to configure a worklist and they 
appear in the Database → View Properties menu, in the List drop-down list. 

Refer to the implementa-
tion’s online help for 
information on configur-

ing the various implementations.
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The number of list types defined by DICOM is limited. Currently, only a 
Patient Root Query List, Study Root Query List and DICOM Modality 
Worklist are defined. These are the List Types that will show up if you have 
only loaded the Default HIS/RIS implementation.

The purpose of the RadWorks Worklist tab in the Default HIS/RIS imple-
mentation is to provide worklist support based on the contents of the studies 
that are available locally. For example, in a situation where both new studies 
and old exams (priors) are sent to the same workstation, it can be used to gen-
erate worklists for reading and verifying. Thus, provided that a proper work-
flow is in place, it becomes possible to offer worklists.

By offering better worklist support it is easier for the users to automatically 
select the right studies for viewing, and improve their workflow and speed of 
reading.

For details on defining Worklist Views, see the RadWorks 6.0 User’s Guide. 

Notifications and transactions 
A Notification is a message that an event has happened in RadWorks (e.g. 
Study Arrived). No answer is expected from the external application.

A Transaction is a message that an event has happened in RadWorks that 
expects a response from the external application. RadWorks can act differ-
ently depending on the returned response. 

Information about the events that trigger notifications and transactions, and 
the content of the messages will be documented separately. Contact GEMS IT 
Applicare to receive the information.

Creating a worklist with a DICOM part 10 source �

1111 Select Configuration → Generic, and click the HIS-RIS proper-
ties tab.

2222 Select the Default HIS-RIS Implementation. 

3333 Click Config. 

4444 Click the Study → Patient tab, add the CD player as a DICOM Vol-
ume, and click Add. 

5555 In the Type list, select DICOM Volume. 

6666 Select the CD-ROM player as the source.

7777 Insert a DICOM CD, and click Test to test the connection to the vol-
ume.



I N T E G R A T I N G  W I T H  H I S - R I S  A N D  W O R K L I S T S

RadWorks 6.0 installation and configuration guide

112 chapter 5

8888 To view the CD’s contents, import the studies to the local database, 
or use ‘DirectView’. 
To enable the users to use DirectView, select Configuration → 
Viewing → General tab, then select the DirectView option.

9999 Create a new Worklist View for the CD.
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Tags indexed in the local database

The following DICOM and proprietary tags are used to display information in 
the Data Selector:

• You can query these fields in the local database.

• You can add these fields as a column in the Data Selector. 

To change or add to this list, please contact your distributor.

Tag Description

AMI Origin

AMI Folder

0010,0010 PatientName

0010,0020 PatientID

0010,0030 PatientBirthdate

0010,0040 PatientSex

0008,0020 StudyDate

0008,0030 StudyTime

0008,0060 Modality

0008,0050 Accesionnumber

0020,0010 StudyID

0008,0018 StudyInstanceUID

0008,0090 Referring Physician

0008,1030 Study Description

AMI Nr Of Series

AMI Nr Of Images

0028,0010 Rows

0028,0011 Columns

AMI ReceiveDateTime

0008,1060 Reading Physician

DICOM tags used in local database
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0008,1050 Performing Physician

0018,1030 Protocol Name

0018,0015 BodyPart Examined

0008,0080 Institution Name

0008,1010 Station Name

0008,1040 Institution Department Name

0032,1030 Reason For Study

0010,1000 Other Patient ID

DICOM tags used in local database
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Configuring CallExe

CallExe is a HIS/RIS interface that forwards part of the interface functions to 
a HIS/RIS executable. The following interface functions are forwarded to the 
HIS/RIS executable:

• Retrieve results and interpretations.

• Store results and interpretations.

• Sending notifications.

CallExe communicates with the HIS/RIS executable using command line 
parameters and text files. The actual communication with the HIS/RIS system 
is done by the HIS/RIS executable. The advantage of this approach is that the 
HIS/RIS executable can be developed and tested independently from Rad-
Works. 

How it works
CallExe implements the report interfaces methods:

• QueryResults.

• QueryInterpretations.

• RetrieveResult.

• StoreResult.

CallExe implements the Notification interface method:

• Notification.

When RadWorks broadcasts a notification (and CallExe is configured to ‘lis-
ten’ to this), CallExe will call the executable specified in the configuration 
with a set of DICOM tags specified at the command prompt. The CallExe 
configuration indicates which DICOM tags from the notifications are added to 
the command prompt. 

Sample configuration of CallExe for reporting
With the HIS-RIS tab of the Generic Properties window, CallExe can be 
added to the list of implementations. Subsequently, CallExe must be added to 
the Report and the Notification functionality. When CallExe is selected from 
the list of implementations and the Config button is clicked, the Properties 
window appears. The Properties window has three tabs that are explained in 
the following sections.
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Query Reports tab
The ‘Query’ Executable field is used to specify the HIS/RIS executable that 
handles the retrieval of a report text from the HIS/RIS system.

The Command line field specifies the parameters that are passed to the HIS/
RIS executable. Any DICOM value from patient level or study level can be 
passed by specifying the DICOM tag between ‘@’ characters. 

CallExe will append one extra parameter to the command line that specifies 
the text file where the report text must be stored. The Report output file com-
mand line option field can be used to prefix this parameter.

With the two separator fields, it is possible to define a file structure for the text 
file with the report text. In the following example, the report text of two 
results with two interpretations are passed from the HIS/RIS executable to 
CallExe:

Report text of Interpretation 1 of Result 1

%%

Report text of Interpretation 2 of Result 1

##

Report text of Interpretation 1 of Result 2

%%

Report text of Interpretation 2 of Result 2

##
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The Use Administrative data input file is used to pass additional patient / 
study data from RadWorks to the executable using a text file. The Use Admin-
istrative data output file is used to pass additional patient / study data from the 
executable to RadWorks using a text file. In both cases, CallExe will generate 
and append the name of the text file as an extra parameter to the command 
line. If required, the Command line option field can be used to prefix this 
parameter.

Store Reports tab

You use the ‘Store’ Executable field to specify the HIS/RIS executable that 
handles the storage of a report text to the HIS/RIS system.

The Command line field specifies the parameters that are passed to the HIS/
RIS executable. Any DICOM value can be passed by specifying the DICOM 
tag between ‘@’ characters. CallExe will append one last parameter to the 
command line that specifies the text file where the report text is stored. You 
can use the Report input file command line option field to prefix this parame-
ter.

With the two separator fields you can define a file structure for the text file 
with the report text. In the example below, the report text of two results with 
two interpretations are passed from CallExe to the HIS/RIS executable:

Report text of Interpretation 1 of Result 1
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%%

Report text of Interpretation 2 of Result 1

##

Report text of Interpretation 1 of Result 2

%%

Report text of Interpretation 2 of Result 2

##

The Use Administrative data input file is used to pass additional patient / 
study data from RadWorks to the executable using a text file. CallExe will 
generate and append the name of the text file as an extra parameter to the 
command line. If required, the Command line option field can be used to pre-
fix this parameter.

Miscellaneous tab

The Work directory field specifies the location of the files that are used for 
exchanging information between RadWorks and the executable. 

The ‘Notify’ Executable field is used to specify the HIS/RIS executable that 
handles the notifications sent by RadWorks. 
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The Command line field specifies the parameters that are passed to the HIS/
RIS executable. Any DICOM value can be passed by specifying the DICOM 
tag between ‘@’ characters. 

With the Keep temporary files check box enabled, temporary files are kept for 
debugging purposes. 

LF is used instead of CRLF to support the UNIX format (with just a single LF 
character to split the lines). 

The Time out field specifies the time out value in seconds for DICOM queries.

Example using VB Script
You can also use the Windows Scripting Host and a VB Script instead of an 
executable. This has the advantage that no compiler is needed to create the 
executable and that the scripts can be changed easily.

The Windows Scripting Host (cscript.exe) can be found in the 
C:\WINNT\System32 directory or can be downloaded from http://
msdn.microsoft.com/scripting/default.htm. The following sections describe 
the scripts that are used for the storage and retrieval of a report text and for the 
logging of notifications.

Querying Reports
The QueryReport.VBScript uses the Patient ID and the Accession NR to 
retrieve a report text from a text file in the Temp directory. If the text file does 
not exist, the report text is empty.

'Arguments: Patient ID, Accession NR, Report Option, Report Output

Const ForReading = 1

Const ForWriting = 2

Set objFSO = CreateObject("Scripting.FileSystemObject")

Set objArgs = WScript.Arguments

If objArgs.Count = 4 Then

strFileName = "C:\Temp\" + objArgs(0) + "_" + objArgs(1) + ".txt"

Set objReport = objFSO.OpenTextFile(objArgs(3), ForWriting, True)

If objFSO.FileExists(strFileName) = True Then

Set objFile = objFSO.OpenTextFile(strFileName, ForReading, False)

Do While objFile.AtEndOfStream <> True

objReport.WriteLine(objFile.ReadLine())

Loop

objFile.Close()

End If

objReport.Close()

End If
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Set objFSO = Nothing

Storing Reports
The StoreReport.VBS script uses the Patient ID and the Accession NR to store 
a report text in a text file in the Temp directory. If the report text is empty, the 
text file is deleted.

'Arguments: Patient ID, Accession NR, Report Option, Report Input

Const ForReading = 1

Const ForWriting = 2

Set objFSO = CreateObject("Scripting.FileSystemObject")

Set objArgs = WScript.Arguments

If objArgs.Count = 4 Then

strFileName = "C:\Temp\" + objArgs(0) + "_" + objArgs(1) + ".txt"

Set objReport = objFSO.OpenTextFile(objArgs(3), ForReading, False)

If objReport.AtEndOfStream = True And objFSO.FileExists(strFileName) =
True Then

' Delete the text file for an empty report

objFSO.DeleteFile(strFileName)

Else

Set objFile = objFSO.OpenTextFile(strFileName, ForWriting, True)

Do While objReport.AtEndOfStream <> True

objFile.WriteLine(objReport.ReadLine())

Loop

objFile.Close()

End If

objReport.Close()

End If

Set objFSO = Nothing

Notifying
The Notify.VBS script writes the arguments (including the notification, which 
is the first argument) to the file Notify.txt.

'Arguments: Notification, ...

Const ForAppending = 8

Set objFSO = CreateObject("Scripting.FileSystemObject")

Set objArgs = WScript.Arguments

If objArgs.Count > 1 Then

Set objFile = objFSO.OpenTextFile("C:\Temp\Notify.txt", ForAppending,
True)

objFile.Write(Date + Time)

For I = 0 To objArgs.Count 1

objFile.Write(", " + objArgs(I))



GEMS IT Applicare

121

Next

objFile.WriteLine("")

objFile.Close()

End If

Set objFSO = Nothing

Using SimCmdLn.exe with CallExe for reporting
The SimCmdLn executable is a sample application that simulates a RIS query 
according to an ID and, subsequently, places the result in an output file that is 
read by RadWorks in order to be displayed in the Viewing part's report area.

This application was written as a console application for Windows.

The code below is sparse and does not make use of MFC classes. Further-
more, it is mostly plain "C-style" code, with a couple of C++ dependencies, 
like comment style and local variable definition.

The code is purely meant as an example and provided as such. No claims can 
be made in case of possible malfunction.

Select Configuration → Generic... from the menu bar in the Data Selector 
and then click the HIS-RIS tab of the Generic Properties dialog box to add the 
CallExe.DLL (from the \bin directory) to the list of available implementa-
tions. Bind the Functionality to the Reports function (make sure it is the only 
Reports implementation!).

Select the CallExe line and click Config, in the Implementations box. Enter 
C:\AMI_60\samples\reports\SimCmdLn.exe, in the ‘Query Executable’ field 
on the first tab (Query Reports) - assuming RadWorks was installed in the 
default location.

Do the same on the second tab (Store Reports), in the ‘Store Executable’ field.

Make sure that the file SimCmdLn.exe is in your c:\AMI_60\samples\reports 
directory

Create a temporary directory called c:\AMI_60\temp.

In RadWorks, select Configuration → Reporting and set the following val-
ues:

• Uncheck report storage in local database.

• Double-click the default reporting profile entry.

• Select HIS/RIS interface as the type of remote reporting, and click 
Next >.
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• Set the Type of Multi line Edit Control to Plain text and set Location 
on the screen to Vertical split – Additional info at left.

Select Configuration → Generic from the menu bar in the Data Selector and 
then the HIS-RIS tab of the Generic Properties dialog box, and then configure 
the CallExe implementation as follows:

• On the first tab Query Reports, in the field Command line enter 
/DEF "xxx yyy" /PID "@00100020@" 
(including the quotes).

• On the second tab Store Reports, in the field Command line enter 
/DEF "xxx yyy" /PID "@00100020@" /RO 
C:\AMI_60\temp\rpt@00100020@.txt 
(including the quotes).

After editing and saving a report in RadWorks, the report is stored as a text 
file in the c:\AMI_60\temp directory.
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he reporting functionality in RadWorks is very flexible. It offers handles 
for implementing customized reporting, but some fine-tuning (writing 
templates and/or HTML files) may be necessary. Reports use the Struc-

tured Reporting part of the DICOM standard. 

The options in RadWorks 5.1 for editing reports were a Plain Text edit box, an 
MS-Word Template document or an HTML page. These remain with the cur-
rent versions, but the contents of the report are now stored in a DICOM Struc-
tured Report and can be queried, stored, retrieved etc. in standard DICOM 
fashion. Each Structured Report contains all study and patient information. 

Storage of these reports on third-party systems is possible if the third-party 
system that supports the DICOM Structured Report storage SCP. Optionally, 
RadWorks can convert the report to the format used in RadWorks 5.1 (where 
the information was stored in private tags), so the report can be stored on any 
system that supports image storage. Reports stored like this cannot use some 
of the new functionality available in RadWorks 6.0. 

Structured Reports are available in three levels of complexity: basic, enhanced 
and comprehensive. Basic reports are e.g. plain-text reports, while enhanced 
reports can contain pixel co-ordinates and hyperlinks for viewing. RadWorks 
can display all three report types, plus hyperlinks in enhanced reports. Cur-
rently, no interface is available to create links to pixel co-ordinates. 

A study can have multiple Structured Reports. These reports can be unrelated 
(second opinions, etc.) or versioned (several versions of the same report). 
When a report is versioned, you have the option to keep the older version or to 
overwrite it. 

By default, the most recent report is displayed with a study. You can select 
older reports: they are listed as separate studies in the data selector, and if you 
select ‘Show Reports’ for a study, the viewer opens with two panes, one for 
the most recent report, and one with a drop-down list that allows you to select 
all older reports. 

Once the study is declared Authorized, the report´s Verification data (verifier, 
date, time, verification status) and Completion Status are filled in and the 
report becomes Read-Only. If you have multiple reports, all reports except the 
most recent one are read-only. 

Templates are included with RadWorks for several report types. These offer 
the full reporting functionality. You can use these templates as the basis of 
your own templates. 

T
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Reporting options

There are a number of options for implementing reports. For example, reports 
can be created in XML, MS Word and HTML as well as plain text. Click Help 
for more explanation of the options in the Configuration → Reporting dia-
logs. 

The description of setting up plain text reports also contains information on 
how to setup the display of additional information next to the report. This is 
the same for all types of reports.
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Setting up reports in plain text

Requirements
None

Preparations
None

To configure reports �
1111 Select Configuration → Reporting... from the menu bar in the Data 

Selector.

2222 On the General Reporting Properties tab of the Reports Configura-
tion dialog box, select the DICOM tag that identifies which report 
you are currently looking at, when viewing multiple reports.

3333 Specify if a user can view the report in Reports in Viewing Section 
and/or the Reports in Data Selector. 

4444 Check the Report storage in local database checkbox, if the report 
is stored locally.

5555 On the Reporting Profiles tab, create profiles to use with a specific 
study status. A default profile is always available.

6666 Redefine the default profile: click Modify. 

7777 In the Type of Multi Line edit control edit box, select Plain Text.

The Additional Information settings are used if multiple reports 
exist: the Additional Info pane is used to display older reports. 
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8888 The Location on the screen controls where the additional reports 
are displayed (Top/Bottom, Left/Right).

9999 The Structured Reports HTML File is the template that will be 
used to display the additional reports. 

10101010 In the Structured Reports ID box, enter DICOM tags you want to 
display with the additional reports, so you can distinguish between 
the main report and the additional ones. 

11111111 Click Finish to save the settings for the selected profile.
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Setting up reporting for MS Word

Requirements
MS Word 8.0 or higher

Preparations
Install MS Word. 

The template must contain fields where RadWorks can place information. An 
example is provided in the \samples\reports directory. This sample contains 
macros. By default, Word warns you about macros in your document. You can 
set Word’s Macro security level to medium (only one warning when you open 
Word) or low (no warnings at all) to avoid seeing these warnings. But do this 
only if you are confident that no documents that macro viruses will ever be 
opened on the workstation. 

The template is only used to display the information. The information is 
stored in the database as plain text. This means you cannot use Word’s format-
ting options in the text (contents). You can apply formatting in the template. 

To configure RadWorks for MS Word �
1111 Select Configurations → Reporting.

2222 Click the Report Profiles tab, to create profiles to be used with a 
specific study status. 

3333 Redefine the default profile: click Modify. 

4444 In the Type of Multi Line edit control edit box, select Container 
with MS Word.
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5555 Click Next to go to the next dialog.

6666 Click Browse, and go to correct template in the “Template file” field.

7777 In the Report Field name(s) edit box, specify the name(s) of the 
field(s) in the Word document where the report text should be 
inserted.

In this edit box, every line represents one Word field. The first word 
on the line is the name of the field. The rest of the line is the name 
that will appear in the report (the field’s title). 

8888 In the Additional read-only fields edit box, specify optional 
DICOM tags. When you open a report, these tags are looked up in 
the database, and the information in them will be inserted in the 
Word file. For example, the Patient Name (00100010) helps identify 
the report quickly. These are read-only: if you edit this information 
in the report, the changes will NOT be put into the database. 

In this edit box, every line represents one Word field. The first word 
on the line is the DICOM tag of the database entry you want to put in 
the report field. The second word (optional) is the name of the data-
base field you want to put in the report field. 

9999 Click Finish to save the settings for the selected profile.

A field in an MS Word 
document can contain a 
maximum of 255 char-

acters. 
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Setting up for XML reports

Requirements
None

Preparations
None

To configure reports �
1111 Select the Configuration → Reporting menu.

2222 In the General Reporting Properties tab, select the DICOM tag 
that identifies which report you are currently looking at, when view-
ing multiple reports.

3333 Specify if a user can view the report in Reports in Viewing Section 
and/or the Reports in Data Selector. 

4444 Check the Report storage in local database checkbox, if the report 
is stored locally.

5555 In the Reporting Profiles tab, create profiles to use with a specific 
study status. A default profile is always available.

6666 Redefine the default profile: click Modify. 

7777 In the Type of Multi Line edit control edit box, select Container 
with XML.
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The Additional Information settings are used if multiple reports 
exist: the Additional Info pane is used to display older reports. 

8888 The Location on the screen controls where the additional reports 
are displayed (Top/Bottom, Left/Right).

9999 The Structured Reports HTML File is the template that will be 
used to display the additional reports. 

10101010 In the Structured Reports ID box, enter DICOM tags you want to 
display with the additional reports, so you can distinguish between 
the main report and the additional ones. 

11111111 Click Next >. 

12121212 In the HTML Script File, enter the HTML framework that will be 
used to display the report. 

13131313 In the XML Report Prototype File, enter the XML template that 
will be used when you create a new report. 

14141414 In the Is ready to leave edit box, enter a script to check if the user 
entered all the required parameters before exiting the report.

15151515 Click Finish to save the settings for the selected profile.
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Setting up externally stored reports – HIS/RIS

Requirements
Interface to HIS/RIS system

Preparations
Install the HIS/RIS in the Configuration → Generic → HIS/RIS tab and 
make sure that you selected Reporting to work with this interface.

To configure an externally stored report �
1111 Select Configuration → Reporting. 

2222 Uncheck the checkbox Report storage in local database in the 
General Reporting Properties tab. 
Instead of retrieving the report text from the local database, Rad-
Works now queries the RIS to see if a report is available and displays 
it with the chosen Multi Line edit control (see Setting up reports in 
plain text and Setting up reporting for MS Word).

3333 In the Report Profiles tab, create profiles to be used with a specific 
study status. Select the default entry and click Modify. 

4444 In the Type of remote reporting drop-down menu, select HIS-RIS 
interface. 

5555 Click Next >. 

6666 In the Type of Multi Line edit control edit box, select the file for-
mat for the report. 

7777 Select the Amendment behavior. 

8888 The Additional Information settings are used if multiple reports 
exist: these settings control the layout of all reports except the main 
(latest) one. The default values are a complete list of available tags. 

9999 Click Finish. 
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Setting up externally stored reports – Browser

Requirements
Interface to HIS/RIS system with an HTTP interface.

Preparations
The HIS/RIS does not have to be configured in the Configuration → Report-
ing → Generic tab. We will not use a HIS/RIS connection, but an HTTP con-
nection.

Configuration
1111 Select Configurations → Reporting.

2222 Uncheck the checkbox Report storage in local database in the 
General Reporting Properties tab. 

3333 In the Report Profiles tab, create profiles to be used with a specific 
study status. Select the default entry and click Modify. 

4444 In the Type of remote reporting drop-down menu, select Browser. 

5555 Click Next >. 

6666 In the URL (plus command line) or HTML file field, enter the 
URL plus the query parameters for the Browser interface. The query 
parameter can consist of DICOM tags.

An example: ”http://Server/Study.dll? GetRe-
port&UID=@00200010@”

7777 Use the Set tags script to specify which read-only fields should be 
passed on to the HTML file.

8888 In the ‘Save’ script edit box, enter a script that will notify the HIS/
RIS that a user has requested to save the report. 
If there is another way to save a report, you can leave this field 
empty. The same goes for the other scripts in this dialog. 

9999 In the Is ready to leave edit box, enter a script to check if the user 
entered all the required parameters before exiting the report.
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Study status mapping

RadWorks offers you the option to link a reporting profile to a study status. 
This allows you to, for instance, specify an MS Word template to create the 
report and a read-only HTML template for displaying the report, once the 
report has been authorized. 

To link a reporting profile to a study status �

1111 In RadWorks, select Configuration Configuration Configuration Configuration → Reporting Reporting Reporting Reporting.

2222 In the 'Reporting Study Status Mapping' tab, specify the link status 
should be linked to which profile. 

3333 Select a status and click Modify.

4444 Select the desired profile and click OK. The profile is now assigned 
to the study status.
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Reviewing reports from a Mitra PACS Broker

Requirements
Interface to Mitra PACS Broker (MitraPB) system with a text interface.

Preparations
To retrieve reports through the MitraPB�

1111 Add the MitraPB in the Configuration →    Generic → HIS-RIS →    
Implementations list.

2222 Bind the MitraPB implementation to the reporting functionality 
(next section in the same dialog).

3333 Select Configuration → Reporting → General Reporting Proper-
ties, and make sure that 'Report storage in local database' is 
unchecked. This makes RadWorks look for external reports.

Configuration
The aim of the MitraPB implementation DLL is to find a unique match of the 
currently selected study in RadWorks with a report entry in the Mitra PACS 
Broker.

Reports are requested from the MitraPB using the values of DICOM tags in 
the header of the current study.

1111 The first stage is that RadWorks requests all study entries matching 
the Patient level tag from the MitraPB. You specify this tag in the 
Patient Identification Tag box in Configuration → Generic → HIS-
RIS → MitraPB implementation → Configuration. Normally, the 
only usable tag for this is Patient ID (0010,0020). If no patient match 
is found, RadWorks will stop the report fetching procedure.

2222 From all entries the MitraPB returns, RadWorks checks if there are 
entries matching the Study Identification tag, beginning with the first 
tag that is listed.

You can specify multiple tags (use CTRL-Enter to insert more tags) for the 
study level, and these tags are matched in their listed order.

• If a unique match is found, that report will be retrieved.

• If there is no matching entry, RadWorks will check the next listed 
tag. If there are no further tags listed, the report window displays a 
blank report.
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• If multiple matches are found, RadWorks will continue with the next 
tag, to narrow down the matches to one unique match. If this does 
not result in a unique match, RadWorks will display 'The report 
could not be fetched' in the report window. Refer for more detailed 
information about the failure reason to the RadWorks.log (look for 
the [RF] and [RISx] messages).

Troubleshooting
Successful matches depend largely on the mapping of HL7 elements to 
'DICOM' elements by MitraPB. MitraPB has a set of configuration options to 
connect both.

You can apply several text conversions / processing functions on the data, 
concatenate values from multiple HL7 elements into one DICOM element, 
etc. This can help, but may result in unforeseen matching failures.

Uppercase/lowercase 
By default, RadWorks starts querying on the patient level (=Follow Server). 
This is configurable with the Query Level option on the MitraPB Implemen-
tation → Configuration dialog. (Query levels: Follow Server / Patient / 
Result / Study).

If you know beforehand that in general there is no matching possible on the 
Patient level, you can skip this step, and start querying at Study level. Note, 
that the same applies as for the Patient level query; if no unique match is 
found on the first tag, the report fetching procedure stops.

Matching on StudyUID only can be tricky, because the MitraPB has the capa-
bility to create StudyUIDs when the HIS-RIS does not supply the info. These 
automatically generated StudyUIDs will never match the one in the study on 
your local RadWorks database.

On the other hand, in an ideal world the HIS-RIS would know all StudyUIDs, 
beforehand. The matching process could be as simple as starting on Study 
level and just setting up the StudyUID as the matching tag (0020,000D).
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Compatibility with other systems

Previous RadWorks versions, and many other systems, do not support Struc-
tured Reports. If such a system receives an Structured Report, it may reject the 
whole study. If this happens, you can disable the sending of a Structured 
Report (in the Send dialog, or when configuring the Destination, see the chap-
ter on ‘Configuring teleradiology’ on page 53). You can also set RadWorks to 
send the study in the RadWorks 5.1 format. 
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ll RadWorks versions can print to Windows printers. The RadWorks 
Print Module also supports DICOM 3.0 compliant laser imagers (or 
print servers). Both monochrome and color printing is supported. The 

module allows for simultaneous connection to multiple printers. You can enter 
routine print jobs in the Data Selector with a few commands. In the Viewing 
Section, RadWorks 4.0 offers a versatile “virtual” film sheet to create sophisti-
cated print jobs on the fly.

Printing is a background process in RadWorks. You can continue viewing and 
reporting while RadWorks processes print jobs.

In addition, this module offers file export facilities in the TIFF (Tagged Image 
File Format) and BMP (Windows Bitmap) formats. This can be of interest to 
users who want to include high quality digital images in slide shows, teaching 
presentations, or reports.

Setting up a printer

The following sections will show you three basic printer configurations. 
Parameters not essential to the situation will be skipped. For more information 
on these, see the online Help.

The installation of the RadWorks Print Module is a prerequisite for these sce-
narios. This is done during RadWorks setup.

Setting up a DICOM printer
In this section, a Codonics printer will be used as an example. In general, the 
procedure can also be used for other DICOM printers. 

Requirements
• RadWorks Print Module.

• DICOM printer.

Preparation
The DICOM printer will be controlled via the network. Ask the system 
administrator for the host name, AE title and port number of the printer. The 
default AE title and port number of the printer can be found in the printer’s 
DICOM Conformance Statement. Various values that have to be entered when 
you connect the printer to RadWorks can also be found here. 

A

The ability to configure 
printers may be 
restricted to system 

administrators.
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Configuration
1111 Select Print → Destinations... from the Data Selector menu bar. A 

list of print destinations is displayed. 

2222 If the printer you are installing already exists there, you can simply 
select or copy it and modify the parameters. Otherwise, click Add. A 
wizard will guide you through the installation process.

3333 Select the type of printer in the Add Print Destination dialog box, in 
this case a DICOM printer. 

4444 Enter a name for the printer destination list in the Name field and a 
more detailed description of the printer in the Description field, and 
click Next >.

5555 Enter the printer’s AE title, host name and port number. For the 
Codonics printer, the AE title is “PRINT_SCP” and the port number 
is “104”. The host name can be an IP address. Select the type of pro-
cessing that will be done. The Codonics is a “PROCESSOR”.

6666 Select the type of supported magnification (“BILINEAR”) and the 
type of media (“PAPER”), and click Next >.

7777 Specify which media formats are supported. The Codonics can han-
dle 8 inch x 10 inch.
The Codonics is not completely DICOM compliant here. The way to 
specify the media size is “8X10IN” instead of the DICOM 
“8INX10IN”. This was fixed in a newer model, so please read the 
Conformance Statement carefully. Specify the correct format. 
Click Next >. 

8888 The header can only be used for Windows printers. It cannot be mod-
ified when defining a DICOM printer. Click Next >.
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9999 Select the supported layout. A “STANDARD\1,1” is always sup-
ported. Click Change to add other layouts from the Layout Pool. 
How to add layouts to this pool will be explained later on. The 
Codonics supports  “STANDARD\1,1”, “STANDARD\2,2”, 
“STANDARD\2,3” and  “STANDARD\3,3”. Click Next >.

10101010 Click the layouts from the pool to select them. The names of the 
selected layouts will be highlighted. Click OK to return to the wiz-
ard.

11111111 Check the Monochrome, Color or Both radio button, according to 
what the monitor supports. The Codonics 1600 series, for instance, 
supports color.

12121212 RadWorks is now ready to install the Codonics printer. Click Finish 
to add the Print Destination to the list.

13131313 Close the Print Destination list. 

14141414 Click the Print tab.

15151515 Select the new destination. 

16161616 Select a study. 

17171717 Select a layout (preferably STANDARD\1,1). Click Print, to check 
that the printer prints properly.

Setting up a Windows printer
In this section, a HP LaserJet 5 printer will be used as an example. In general, 
the procedure can also be used for other Windows printers. 

Requirements
• Windows printer

Color printing takes 
three times as long as 
monochrome printing. 

This is because of separate infor-
mation transmission for Red, 
Green and Blue.
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Preparation
Windows will have control over the Windows printer. RadWorks can only use 
the default printer. 

Configuration - Windows 2000
1111 In the Windows Start menu, select Start → Settings → Printers 

and double click the Add Printer icon in the Printers window. The 
Add Printer wizard starts. 

2222 Click Next >. 

3333 Depending on how your printer is connected, select ‘My Computer’ 
or ‘Network printer’.

4444 Find and select the printer you want to print with. 

5555 Select whether this will be the default printer. 

6666 Click Finish. 

Configuration - Windows NT 4
1111 In the Windows Start menu, select Start → Settings → Printers 

and double-click the Add Printer icon in the Printers window.

2222 Depending on how your printer is connected, select the My Com-
puter or Network printer server radio button, and click Next >.

3333 If you selected the My Computer radio button, select the port the 
printer is connected to.

4444 Select the correct manufacturer (“HP”) and printer type (“LaserJet 
5”). 

5555 Specify the name of the printer (“HP LaserJet 5”), select the Yes 
radio button to use this printer as the default printer, and click Next 
>.

6666 Set the sharing option.

7777 Windows is now ready to add the printer. Click Finish to add and 
print a test page.
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The Printers folder now looks like this:

Configuration - RadWorks
1111 Select Print → Destinations. A list of print destinations will be dis-

played. 

2222 If the printer you are installing already exists there, copy it and mod-
ify the parameters. Otherwise, click Add. A wizard starts which will 
guide you through the installation process.

3333 Select the type of printer you want to add a new print destination for, 
in the Add Print Destination dialog box, and click Next >.

4444 Enter the display name for the printer destination list and a more 
detailed description of the printer. 
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5555 Check or uncheck the Save All Image Data check box. If this is 
checked, the pixel data of all images is saved. If unchecked, only 
modified image pixel data (such as filtered images) will be saved for 
composed print jobs. Check the Merge Series check box, if you want 
RadWorks to continue printing new series on the same sheet as the 
previous one when printing multiple series. Check the Trim Lines 
check box, if you want trim boxes to be printed around the images. 
Click Next >.

6666 Enter the footer text. You may want to add predefined fields to your 
text. RadWorks supports the following specifiers for predefined 
fields:

%d = date

%s = sheet m of n

%t = time

%u= \\host\user. Click Next >.

7777 Enter the header text. The header text can consist of DICOM tags. 
For a complete list of DICOM tags, see the appendix on ‘Listings of 
DICOM Tags’ on page 389. Click Next >.

For unmodified images, 
RadWorks will use the 
data in the original study 

when printing the images. If, how-
ever, the study containing the 
images is deleted after submitting 
the job and before RadWorks has 
been able to actually print the 
images, it will not be possible to 
print them. To prevent this possi-
bility, you should check the Save 
All Image Data check box. Doing 
this will, however, slow down the 
submission of your print jobs 
since more information has to be 
saved
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8888 A Windows printer supports all possible layouts, so you don’t need 
to change the Layouts list. Click Next >.

9999 Select the color support for the printer. The LaserJet 5 is mono-
chrome. Click Next >.

10101010 RadWorks can now install the Windows printer. Click Finish to add 
the print destination to the list.

11111111 Close the Print Destination list. 

12121212 Click the Print tab. 

13131313 Select the new destination. 

14141414 Select a study. 

15151515 Select a layout. 

16161616 Click Print, to test if the printer will print.

Setting up a file printer
In this section, a TIFF ‘printer’ will be used as an example. In general, the 
procedure can also be used for other file printers. 

Requirements
• RadWorks Print Module.

Preparation
None.

Notes on the Windows printer wizard
The minimum bitmap size is the smallest size of the image sent to the printer. If an 
image in RadWorks is smaller than this, it will be enlarged to the minimum size 
before printing. Setting a high value will ensure that annotation is always easy to 
read even for very small images. The default bitmap size is 384 x 384 pixels. This 
offers good legibility for most purposes.

If the Use Original Size check box is checked, the minimum bitmap size is ignored 
and images will always be printed at a size which corresponds to their pixel dimen-
sions.

If color support is set to Monochrome, all images (including true-color ones) will 
be printed in monochrome tones. If it is set to Color, all images (including mono-
chrome) will be converted to true-color before printing. If Both is selected, the 
image type determines how it is printed.
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Configuration
1111 In RadWorks, select Print Destinations, to display a list of Print 

Destinations. 

2222 If the printer you are installing already exists there, select or copy it 
and modify the parameters. Otherwise, click Add button. A wizard 
will guide you through the installation process.

3333 Select the type of printer, in this case a TIFF file (there is no differ-
ence between the installation of a TIFF or a BMP file printer), and 
click Next >.

4444 Enter the display name for the Printer Destination list in the Name 
field, and a more detailed description of the printer in the Description 
field. Click Next >.

5555 Enter the output directory (“%ROOT%\OUTPUT” is default) and 
specify the output format, in the Directory field.

6666 Check the Create Separate Files check box to create a separate file 
for each image. By default, this option is selected. The files are 
stored in a directory structure like %ROOT%\OUTPUT\ 
sheet<nr>\image<rownr>_<columnnr>.
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7777 Uncheck the ‘Create Separate Files’ check box to create one file per 
sheet. The files are stored in a directory structure like 
%ROOT%\OUTPUT\sheet<no.>. Specifiers are:

%c, %C = column

%r, %R = row

%s, %S = sheet

%i, %I = image (of session)

%j, %J = image (of sheet)

8888 Capital letters generate numbers starting at 1. Lower case letters gen-
erate numbers starting at 0. Click Next >.

9999 The header is not used, so you don’t need to change anything in this 
panel. Click Next >.

10101010 A file supports all available layouts, so you don’t need to change 
anything in this panel.Click Next >.

11111111 Let the Print Service decide what type of color support to use. Select 
the Both radio button. 

12121212 RadWorks can now install the File printer. Click Finish to add the 
Print Destination to the list.

13131313 Close the Print Destination list. 

14141414 Click the Print tab. 

15151515 Select the new destination. 

16161616 Select an image. 

17171717 Select a layout. 

18181818 Click Print, to check if the image file has been created.
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Creating custom print layouts

RadWorks has a ‘layout pool’ which contains a wide range of pre-defined lay-
outs for printing images. You can select these layouts when defining a new 
printer (destination). This means that specific layout options can be provided 
for each particular printer.

If you want to print using a special layout not included in the layout pool, you 
should first add this to the layout pool and then make this layout available for 
the particular printer or printers.

To create a custom print layout � select Print → Layout Pool… from the menu 
bar in the Data Selector. In the Layout Pool, click Add… In the Add Layout 
dialog box, enter the desired rows and columns matrix and a name for your 
new layout. Click Preview >> to see the result of your configuration before 
you save it. Check the Advanced check box to directly enter the text in the 
configuration window. Click Help for details on how to set up the layout.

The Layout Pool displays all the layouts that have been pre-defined on your 
system. Use the scroll bar to view them. You cannot edit existing layouts, but 
you can delete as well as add them. To delete a layout, click Delete. 

Access to layout config-
uration may be restricted 
to administrators.

The Help also describes 
how to configure a 
DICOM printer to pro-

duce slides.

Do not delete layouts 
that are already being 
used by existing 

printer configurations, since they 
will also be deleted from the lay-
outs available for those printers.
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Configuring printers

Editing, copying and removing printers
Apart from adding new printers, you can also edit the configuration of exist-
ing printers.

To edit, copy or remove a printer � select Print → Destinations… from the menu 
bar in the Data Selector. In the Print Destinations dialog box, select a printer 
(click the printer’s name) and then click Modify, Copy or Delete.

If you click Modify, you will see a tabbed configuration box with all the 
options described above.

If you click Copy, you can copy an existing configuration to a new printer. 
Enter a new name and description in the Copy Print Destination dialog box, 
then modify the settings as appropriate.

Configuring how images are exported as bitmaps
How bitmap files are exported can be configured in a similar way as for print-
ers. When RadWorks is installed, destinations are provided to allow you to put 
all images to be exported into a single file or to save each image as a separate 
file. See the Help for examples of notation and an explanation on how to use 
script files.

To reconfigure printers, 
you may require system 
administrator rights to 

your system.

Double-click on a desti-
nation name to view 
detailed information on a 

particular printer/file export 
option.
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Connecting to a DICOM device

To connect DICOM devices �

1111 Make sure the printer is correctly installed, switched on and ready 
for input.

2222 Make sure you have a copy of the DICOM conformance statement of 
the printer.

3333 Make sure RadWorks is correctly installed and you have a Print 
license.

4444 Make sure the printer will accept associations from the RadWorks 
station.
Some printers force you to register all applications that will print to 
them. The printer manual will detail how to do this. Generally, you 
will need:
- the host name or IP address of the machine RadWorks runs on (con-
figured when the computer was put into the network), and
- its Application Entity title (can be set using the Configuration → 

Generic → DICOM dialog).

5555 Launch a command prompt.

6666 Try executing “ping <IP address of the printer>”. 
If this fails, there is a faulty network connection, the printer is not 
switched on, or generally, the printer cannot be found on the net-
work. Contact your system administrator.

7777 Try executing “ping <host name of the printer>”. 
If this fails, your DNS does not work correctly, the printer is not 
known to the DNS, or there is no DNS (Domain Name Server). If 
there is no DNS, add the IP address and host name of the printer to 
your \WinNT\System32\Drivers\Etc\Hosts file.

8888 Try executing “dcmecho2 <AE Title of the printer> <host name of 
the printer>:<port number of  the printer>”. 
You can find this utility in the Bin directory in your AMI root.

If the command fails, with the error ‘failed to request association’ the 
port number of the printer was not set correctly. You can find the port 
number of the printer in the DICOM conformance statement that 
came with the printer. Some printers allow you to change the port 
number. In that case, use the printer diagnostics to find out the new 
port number.

This works only if you 
use the TCP/IP protocol.

This command works 
only if the printer sup-
ports C-ECHO.
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If the command fails with the error ‘association rejected’ the AE title 
was not set correctly. You can find the AE title in the DICOM con-
formance statement of the printer. Some printers allow you to change 
the AE title. In that case, use the printer diagnostics to find the new 
AE title.

9999 Launch RadWorks.

10101010 Add a new DICOM printer destination. Change the name, descrip-
tion (optional), host name, port number and AE title. For most 
DICOM destinations, the other defaults will suffice. See also ‘Notes 
on specific printers’ on page 161.
Be sure to copy the information from the DICOM conformance 
statement.

11111111 Switch these options off: Print Job Event Reports, BFS Print Sup-
port, Trim Support, Use Presentation LUT and Compose Sheet (from 
the DICOM tab in the Print Destinations dialog). The Print Service 
will use a minimal set of features to print now.

12121212 Try to make a print. Do so by selecting a single 1-image study and 
printing to a one-up (STANDARD\1,1) layout. All print destinations 
(known to Applicare) support this layout.

If this doesn’t work, open the Print Queue dialog and view the Error Informa-
tion. This should provide information about the settings in the Print Destina-
tions Dialog to change.

BFB errors reflect wrong entries on the DICOM Film tab, whereas BFS errors 
represent errors in the DICOM tab.

To find out other capabilities of the printer, check its DICOM conformance 
statement and adjust the various settings in the Print Destinations Dialog (one 
at a time). In particular, when testing N-EVENT-REPORTs, the time-out 
should have a small value to prevent serious lock-up in case of printer failure.
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Inside DICOM Print configuration

This section explains the items in the dialog that opens when you select Print 
→    Destinations, and you modify a DICOM printer. The items marked DCS 
(DICOM Conformance Statement) are the DICOM tag names.

On the DICOM tab:

• AE Title 
(DCS: AE title)
The AE title of the printer, as set default (or changed using the 
printer setup).

• Host Name
The host name of the printer. The Domain Name Server (DNS) or the 
Hosts file provides this.

• Port Number 
(DCS:port number)
The printer port number, as set default (or changed in the printer 
setup).

• Destination 
(DCS:Basic Film Session -or- BFS, tag (2000,0040))
Defined terms are MAGAZINE and PROCESSOR. If the printer has 
a built-in processor, the setting should be PROCESSOR, otherwise, 
MAGAZINE.

• Print Priority 
(DCS:Basic Film Session -or- BFS, tag (2000,0020))
Defined terms are LOW, MED, HIGH. This defines the relative pri-
ority of jobs from different workstations (jobs from a single worksta-
tion are sent by the Print Service based on the priority set on the Print 
Tab in the Data Selector).

• Session Label 
(DCS:Basic Film Session -or- BFS, tag (2000,0050))
A label which identifies the Print Job during the print process. May 
or may not be printed on the film.

• Enable Print Job Event Reports 
(DCS:somewhere in the introduction)
The Print Job N-EVENT-REPORT mechanism is used to transmit 
status information from the printer to RadWorks in a asynchronous 
way. The status information can refer to the printer or the print job. 
RadWorks currently does not handle printer status information. It 
can, however handle print job status information. If you check this 
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box, RadWorks will halt subsequent job processing until it receives a 
READY signal from the printer. 
To avoid lock-up, a time-out can be specified (see below). DCS may 
or may not be accurate as to this information. In theory, checking this 
box for a printer that does not send N-EVENT-REPORTs on the print 
job will not harm, as the Print Module tries to determine the printer’s 
capability to send N-EVENT-REPORTs anyway. However, some 
printers wrongly signal that they will send N-EVENT-REPORTs, 
though they don’t. For such printers, turn this flag off. See ‘Notes on 
specific printers’ on page 161 for known cases.

• Time-out 
(not in DCS)
The N-EVENT-REPORT handling is error-prone in the sense that 
missing a single N-EVENT-REPORT might cause the Print Service/
Printer pair to enter an infinite wait situation. The Print Service will 
sit idling until the printer sends an N-EVENT-REPORT, while the 
printer will wait for the Print Service to drop the association (as the 
printer sent an N-EVENT-REPORT, which somehow never got 
across). The time-out is provided to end such a deadlock situation by 
silently proceeding as if the job printed well after the specified inter-
val.

• Compose Sheet 
(not in DCS)
Usually the Print Service lets the printer determine the placement of 
images, as dictated by the layout as supplied in the Layouts tab of the 
Print Destinations Dialog and subsequently selected from one of the 
print tabs. However, if you check this box, the Print Service will 
compose the filmsheet itself and send it as a large 1-up (STAN-
DARD\1,1 layout) to the printer. Some bitmaps may be so large that 
the printer cannot handle them. So its usually safe to keep this option 
turned off. However, if your DICOM printer does not handle a badly 
needed layout, you can check this box to handle it anyway. The Print 
Service handles any conceivable layout (which can be typed in the 
Add Layout dialog of the Layout Pool).

Note that checking the Compose Sheet box makes the ‘Use True 
Size’ box on the Image tab unavailable.

• BFS Print Support 
(either not in DCS or in introduction)
DICOM specifies two ways of printing filmsheets.
a. Issue a separate print command for every filmsheet (Basic Film 
Box BFB).
b. Issue a single print command for the complete job (Basic Film 
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Session BFS).
The DICOM standard requires DICOM printers to support both a 
and b. However, some printers fail to support b). This checkbox can 
be used to change the behavior of the Print Service from issuing a 
single print command for the BFS to issuing multiple print com-
mands, one for every BFB.

• Trim Support
Is ON by default. Switch OFF only if your printer does not support 
trim lines. 

• Use Presentation LUT
Is ON by default. Switch OFF to be able to specify a LUT other than 
the default one, e.g. for troubleshooting color matching issues. 

On the DICOM Film tab:
Items marked * will not be sent to the printer if they are left empty.

• Magnification 
(DCS:Basic Film Box, tag (2010,0060))
Defined terms are REPLICATE, BILINEAR, CUBIC or NONE. 
Some printers despite the standard do not support NONE. In the case 
of CUBIC, fill in Smoothing as well.

• Smoothing 
(DCS:Basic Film Box, tag (2010,0080)) *
If supported, and if Magnification is CUBIC, the smoothing type is a 
vendor-specific string which determines the actual type of CUBIC 
interpolation.

• Medium Type 
(DCS:Basic Film Session, tag (2000,0030))
Defined terms are PAPER, BLUE FILM and CLEAR FILM. Be sure 
to set the correct type, as this is a common cause of problems. See 
below for defaults.

• Config Info
(DCS:Basic Film Box, tag (2010,0150)) *
A vendor-specific string which can be used to specify things not in 
the DICOM standard. It may, e.g., be used for the definition of a 
lookup table to use. Consult DCS for more details.

• Densities/Border 
(DCS:Basic Film Box, tag (2010,0100))
Defined terms are BLACK, WHITE and an integer specifying the 
density in 1/100ths of optical density (OD). E.g., 150 specifies 1.5 
OD.



C O N F I G U R I N G  P R I N T I N G

RadWorks 6.0 installation and configuration guide

156 chapter 7

• Densities/Empty Image 
(DCS:Basic Film Box, tag (2010,0110)) *
As Densities/Border, but for image boxes that are not filled with an 
image (as, e.g. trailing images on the last sheet of a Data Selector 
job).

• Densities/Minimum and Densities Maximum 
(DCS:Basic Film Box, tags (2010,0120) and (2010,0130)) *
Minimum and maximum densities to use when determining printer 
range. If you use these settings, you usually need to make a couple of 
prints to determine the correct settings. The DCS may or may not 
give an interpretation of these fields. There appears to be some 
inconsistency across printers handling this attribute.

You can typically leave the Minimum and Maximum empty. Change these in 
cases of too light/too dark films only. Note that BLACK or WHITE is not a 
valid choice here.

• Basic Annotation Box Support 
The Print Service requests the DICOM Basic Annotation Box at the 
negotiation of the association. If this succeeds, it prints a text line in 
the box. The following tags are supported:
- Annotation Position (tag 2030.0010) (see Basic Annotation Box in 
Conformance Statement)
- Annotation Format (tag 2030.0020) (see Basic Annotation Box).
- Annotation Display ID (tag 2010.0030) (see Basic Film Box)

The Annotation Format is basically a text string possibly containing:
%u replaced by user name/computer

%t – time when the print job was submitted

%d – date when the print job was submitted

The default configuration is position = 1, display ID = 1, format = 
%d %t %u.

On the DICOM Media tab:

• DICOM Media
(DCS:Basic Film Box, tag (2010,0060) - FILM SIZE ID)
This is a single multi-line edit control which allows you to enter the 
supported media sizes. Little error checking is performed, so type the 
definitions carefully. The format is

<number>INX<number>IN

or
<number>CMX<number>CM

Some typical examples are 

The date and time for-
mats used are those set 
in the Control Panel 

applet Regional Settings.
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8INX10IN

14INX17IN

(typed as the definition above; a single film size on a single line).

If a device supports the ‘requested image size’ (DCS:Basic Gray-
scale/Color Image Box, tag (2020,0030)) attribute, it can be used for 
‘True Size’ printing.
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Configuring presentation sheets

IA daily routine in many hospitals is to have ‘morning rounds’ meetings to 
discuss clinical cases. During these presentations, only the most important 
images from a study are shown, summarizing the study for the participants.

Clinical presentations are also used for educational purposes.

RadWorks 6.0 facilitates presentation sheets, which allow you to place all rel-
evant images from multiple studies on one sheet for presentation purposes.

Performing diagnosis on this type of study can lead to interpretation mistakes, 
also because it is possible to combine images from different patients on the 
same sheet. To prevent the possibility of error, a descriptive message (Presen-
tation Sheet) will be displayed as a permanent annotation on the top-center of 
the viewport.

The implementation of presentation sheets in RadWorks allows the user 
responsible for preparing the ‘Morning Rounds presentation’ to ‘Print’ a com-
posed sheet to the Presentation Sheet printer. These virtual sheets will then be 
converted into a new study, which becomes available in the Data Selector. The 
user can select these and previous studies (when available on the local data-
base) for display.

Hanging protocol
To display the presentation sheets correctly, a specific hanging protocol is 
required. This hanging protocol has been copied to the AMI_60\Sam-
ples\HangingProtocols directory and must be imported via the Hanging Proto-
cols Manager.

New local worklist definition
For quick access to presentation sheets, create a new worklist definition. This 
worklist is user-specific. 

To create a worklist�

1111 Select Configuration → Generic... from the Data Selector menu 
bar. 

2222 Click the HIS-RIS tab and, in the Functionality area, make sure that 
the RadWorks Default Implementation is bound to the Worklist 
Functionality.

This feature offers the 
ability to create a ‘snap-
shot’ of a number of 

studies, both new and priors. 
Since no detailed, modality spe-
cific demographics are available 
in this snapshot. The study can be 
used for presentations only.

This feature is intended 
to create Presentation 
Sheets of the same 

patient. If a Presentation Sheet is 
created from different patients, 
when submitted to printer the 
print job will be saved as the Pre-
sentation Sheet study with the 
first patient in line.
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3333 In the Implementations area, select the Default HIS/RIS Implemen-
tation item.

4444 Click Config. Click on the RadWorks Worklist tab of the ‘Config-
ure RadWorks Default HIS/RIS Implementation’ dialog box.

5555 Click Add, and on the General tab of the RadWorks Worklist dialog 
box, give the worklist an appropriate description in the Description 
field.

6666 In the Type drop-down list, select Review.

7777 Go to the Active Studies tab and, in the Source area, click Add. 

8888 Add ‘Local RadWorks’ as a source. 

9999 In the Query area, click Add.

10101010 In the Field dialog box, click >>. 

11111111 From the list, select the StudyDescription DICOM tag. Double-click 
the tag to close the drop-down box. 

12121212 In the Query Value field enter: Presentation Sheet* 

13131313 Go to the Prior Studies tab. 

14141414 In the Source area, click Add. 

15151515 Add ‘Local RadWorks’ as a source.

16161616 Click the OK buttons to exit the configuration.

17171717 Restart RadWorks.

18181818 Create a new Worklist View and select ‘Presentation Sheet’ from the 
list in the Add View dialog.

19191919 Make the Presentation Sheet worklist view active. 

20202020 You can insert the DICOM tag ‘Prior’ (3109,100C) as a new column 
to view priors. 
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Creating a Presentation Sheet printer
The Presentation Sheet is a component of the Printer Service and requires a 
license for the DICOM Print Module.

Use the Add Printer wizard to create a printer destination based on this printer 
class. The first step in the wizard is the Printer Class: select Presentation 
Sheet. 

Use this new destination to create a print job for a Presentation Sheet in the 
Viewing Section.

Jobs you have printed to this destination will show up in the Presentation 
Sheet worklist. 

You can also print to the 
Presentation Sheet by 
selecting a study in the 

Data Selector, but then you would 
print the entire study instead of a 
selected number of key images.
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Notes on specific printers

Below are given some notes on specific popular DICOM printers you may 
have to configure.

Kodak MLP190
AE Title: KODAK_MLP190 (not configurable)

Port number: 5040 (configurable)

Software version 1.6.09 is known to correctly reject the Print Job SOP class 
(as requested when the Print Job Event Report flag is set). Older versions may 
not correctly do this, so its usually safer to keep the flag off for these versions.  
Older software versions may also fail to implement the print command on the 
BFS so uncheck the BFS Print Support check box if in doubt.

A way to check the software version is to turn on ALL logging for the Print 
Service (Configuration/Print Service/Logging, Logging Level=ALL) and 
reboot as stated. Then start an association with the minimal set (as described 
in chapter 0). After a successful association, check the Print log file (in the 
AMI\Print directory) and find the printer status report the software version is 
shown just after the line ‘Printer N-GET response received’.

Codonics 1600MD
(system software version 1.5.0, ImageWeb 1.0)

AE Title: PRINT_SCP (not configurable)

Port number: 104 (not configurable)

Contrary to what the DICOM standard says, this device does not support Print 
Job Event Reports. Uncheck the box. Medium Type should be PAPER for this 
device. This version of the software does not support requested image size.

A way to check the software version is to surf to http://<host name>. Click 
‘current version’ to see the software version. Click ‘printer status’ to see if a 
DICOM implementation is available.

It seems that the Codonics printer does not accept the TIFF’s that RW pro-
duces; use BMP’s instead. You can open a telnet session on the Codonics to 
follow the process. Log on as user “root”.

Kodak 8700 Print Server
(software versions 1.0 and 1.5)
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AE Title: PrtSCP

Port number: 1024

Software version 1.0 correctly implements N-EVENT-REPORTs. Version 1.5 
was only very basically tested with, but appears to support N-EVENT-
REPORTs as well. Both versions correctly implement the requested image 
size attribute.

Sterling Linx Print Server
(software version 2.7.1)

AE Title: IMS_PrintServer

Port number: 2000

Software version 2.7.1 should implement N-EVENT-REPORTs. Software 
capabilities depend on the attached camera. The DCS details which cameras 
support which layouts.

The requested image size attribute is (as yet) not supported.

Fuji MF Print Server
(software version 1.0) 

AE Title: unknown

Port number: unknown

Due to a bug, the Fuji software incorrectly drops the association after the first 
image is received. Another bug prevents AE Title using capitals from being 
authorized. Currently, the device cannot communicate correctly using 
DICOM. After Fuji’s software release B-03, this bug should be fixed. It has 
not been tested yet. The Basic Film Session is not supported.
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This chapter describes how to configure the Integration Module.

Inserting a tooltab...................................................166

Inserting a menu item.............................................168

Inserting a popup menu item..................................169

Inserting a command..............................................171

Starting an application with a command ................171

Opening a Web page with a command ..................172

Accessing a HIS-RIS function with a command.....173

Completing the Command Wizard .........................175
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he purpose of the Integration Module is to allow tooltabs and menu 
items to be added to RadWorks. These tooltabs and menu items can con-
tain web links and shortcuts to applications or HIS-RIS functions.

All changes made in the Integration Module are system-wide. This means all 
users will be able to use, edit and delete the new menus, menu items and 
tooltabs.

Configuring the Integration Module

The following information will guide you through the steps for adding 
tooltabs and menu items using the Integration Module.

To start configuring the Integration Module � select Configuration ���� Integra-
tion Module from the RadWorks menu bar.

The Tooltabs & Menus tab in the Integration and Module Configuration dia-
log box allows you to add the tooltabs, menu items and pop-ups. 

T
The information flows 
one way, for instance, 
there is usually no con-

firmation if the launched applica-
tion(s) or web page(s) display the 
requested information.
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The Commands tab allows you to add commands.

To add a command or a menu to a tooltab, you first create the command and 
then add it to the Tooltabs & Menus tab.

The easiest way to proceed is to first add all the commands you wish to use.

The following sections provide more specific information on how to insert 
and configure tooltabs, menus, pop-up items and commands.
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Inserting a tooltab

To insert a new tooltab � select Configuration ���� Integration Module from the 
RadWorks menu bar.

1111 Select the Tooltab Folder in the folder list on the Tooltabs & Menus 
tab of the Integration Module Configuration dialog box.

2222 Click Insert Tooltab. A new tooltab with the default name ‘New 
Tab’ is created.

3333 To name the tooltab, select the tooltab and click Rename, type the 
name you want and select the adjacent icon again.

4444 You can add a command or a group to the new tooltab for more 
information on inserting commands). A group contains several com-
mands in a titled box in the Data Selector of RadWorks. Notice the 
buttons under the Web sites and Applications section in the illustra-
tion below. The ‘www.applicare.com’ and ‘support@distribu-
tor.com’ buttons were created in a group called ‘Web sites’, whereas 
the ‘notepad’ button was created in a group called ‘Applications’. 
(See ‘Inserting a command’ on page 171 for more information on 
inserting commands.)

The captions and func-
tions of these buttons 
depend on the item you 

select in the list.
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These tooltabs appear as follows in the Integration Module Configu-
ration dialog box:

5555 By default, new tooltabs are displayed in all installed modules. How-
ever, you can determine in which modules they will be displayed by 
checking the check boxes in the list of modules in the bottom-right 
corner of the Integration Module Configuration dialog box.

6666 Click OK, to complete the configuration and restart RadWorks to 
view the changes.

7777 To remove a tooltab, select it and click Delete.
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Inserting a menu item

To insert a new menu item � select Configuration ���� Integration Module from 
the Data Selector menu bar.

1111 Select the Menu Folder in the folder list on the Tooltabs & Menus 
tab of the Integration Module Configuration dialog box.

2222 Click Insert Menu. A new tooltab with the default name ‘New 
Menu’ is created.

3333 To name the new menu select it, and click Rename, type the name 
you want and select the adjacent icon.

4444 On the new menu, you can insert a group or a command. A group 
appears as a submenu that can contain one or more commands. See 
the following illustration of a menu with submenus:

5555 By default, new menus are displayed in all installed modules. How-
ever, to determine in which modules they will be displayed check the 
check boxes in the list of modules in the bottom-right corner of the 
Integration Module Configuration dialog box.

6666 Click OK, to complete the configuration and restart RadWorks to 
view the changes.

7777 To remove a menu item select it, and click Delete.

The captions and func-
tions of these buttons 
depend on the item you 

select in the list.
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Inserting a popup menu item

You cannot add your own popup menus. You may, however, add popup groups 
and commands to the Worklist and Viewport menus.

To insert a new popup menu item � select Configuration ���� Integration Mod-
ule from the RadWorks menu bar.

1111 Select the Worklist or Viewport items below the Popup Folder in 
the folder list on the Tooltabs & Menus tab of the Integration Module 
Configuration dialog box.

2222 Select the item to which you want to add a Command or Group.

3333 Click Insert Group, to insert a group or Command to insert a com-
mand. A group is a submenu.

4444 To name a new group select it, and click Rename. Type the name 
you wish and reselect the adjacent icon.

Below is an example popup menu with submenus:
The captions and func-
tions of these buttons 
depend on the item you 

select in the list.
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5555 By default, new popup items are displayed in all installed modules. 
However, you can determine the modules in which they will be dis-
played by checking the check boxes in the list of modules in the bot-
tom-right corner of the Integration Module Configuration dialog 
box.

6666 Click OK, and restart RadWorks to view the changes.

7777 To remove a group or command, select it and click Delete.
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Inserting a command

A wizard offers three options to add new commands.

A command can either start an application (such as Microsoft Word), open a 
web page (such as an HTML-based report) or invoke a HIS-RIS function.

Starting an application with a command
To insert a command to start an application � 

1111 Select the Commands tab on the Integration Module Configuration 
tab (select Configuration ���� Integration Module from the Data 
Selector menu bar)
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2222 Check the Start an application radio button on the first page of the 
Add-A-Command Wizard. Click Next >.

1111 In the Command field of the Add a Command wizard, enter the 
application’s name and path, or click Browse to locate it. Then find 
the file in the dialog.:

2222 In the Work Directory field, you can define a different working 
directory for the application than for the executable. Enter the path or 
click Browse... to locate a directory.

3333 Another option is to select a DICOM tag from a selected Study, 
Series, Image or Result, if a RIS client is installed on the RadWorks 
system. If so, check the ‘use info of selected’ check box, select 
which data you want to see (Study, Series, Image or Result) and enter 
the DICOM tag in the Arguments edit box. Then click Tag to add a 
DICOM tag, and select the tag. 

4444 Check the ‘Allow more than one copy’ box to allow you to launch 
more than one copy of the program. Make sure that the program sup-
ports this. 

Opening a Web page with a command
To insert a command to open a Web page � 

1111 Select the Commands tab on the Integration Module Configuration 
dialog box (select Configuration ���� Integration Module from the 
Data Selector menu bar).
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2222 Check the Open a web page radio button on the first page of the 
Add-A-Command Wizard. Click Next >.

3333 Select the Type of URL you want to open from the Type drop-down 
list.

4444 Enter the Target (a path and file, or an e-mail address).

5555 You can forward information if the target allows this. Check the Use 
info of selected check box checkbox, and select the required infor-
mation to forward it.

Accessing a HIS-RIS function with a command
You can either send a Notification or a Transaction message to a HIS/RIS sys-
tem. The message has the contents of the selected subtype.

To insert a command to access a HIS-RIS function � 

1111 Select the Commands tab on the Integration Module Configuration 
tab (Configuration ���� Integration Module from the RadWorks 
menu bar). 

2222 Click a HIS / RIS function on the first page of the Add-A-Com-
mand Wizard. Click Next >.

If the system is con-
nected to e.g. a Mitra 
PACS Broker with a web 

interface you can specify the 
Patient ID tag as URL.
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3333 Select the type of information you want to use from the Use info of 
selected drop-down list.

4444 Select the type of message you want to send from the for each, send 
a drop-down list.

5555 Select the message subtype you want to send. The following sub-
types are available:

Type Message

Teleradiology submit started

Teleradiology send successful

Teleradiology send failed

Teleradiology study received

Storage commit successful

Storage commit failed

Print job submitted

Print job successful

Print job failed

Print job printing

Print job suspended

QC match successful

Overview of subtypes
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Completing the Command Wizard
To complete the wizard, add a description and a comment.

QC match failed

QC completed successful

QC failed

QC image changed

QC manual match successful

QC image deleted

QC image rotated

ROUTE_WORKLIST

Viewing started

Viewing cancelled

Viewing suspended

Viewing dictated

Viewing reviewed

Viewing verified

Key images modified / created

Study updated

Study Status changed

Make stat study

Make key study

Overview of subtypes
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The button on the Tooltab and a menu item display what you enter in the 
Description field.The list of available commands display what you enter in 
the Comment field.
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This chapter describes how to configure the RadWorks Quality Control Module. 

Preparations for configuring Quality Control ..........178

Setting up (auto) matching .....................................181

Sending Modality Performed Procedure Step 
messages...............................................................187
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he RadWorks Quality Control Module contains features intended to 
allow various quality control tasks to be undertaken at designated work-
stations (‘Quality Control Workstations’) within a hospital. These work-

stations are generally located between an acquisition device (such as a CT 
scanner) and the hospital’s network. They perform a ‘gatekeeper’ function by 
ensuring that acquired images and studies are correct and have the right 
patient information associated with them before they are made available at 
other locations on the network.

Preparations for configuring Quality Control

The Quality Control Module works closely with the Connection Service, 
especially when you set it up for auto matching or intend to configure the 
Auto Routing Protocol with Quality Control triggers.

This means that the workstations must be configured in various areas, before 
you can actually configure the Quality Control Module itself.

Configuring the HIS-RIS implementation
If the Quality Control Module is also to be connected to a HIS or RIS system 
RadWorks has to be configured in such a way that it can communicate with 
the HIS/RIS and be able to obtain worklists for matching purposes.

Typically this is done by selecting Configuration → Generic... from the 
Data Selector menu bar and then the HIS-RIS tab of the Generic Properties 
dialog box. See the HIS-RIS and Worklists Integration chapter in this guide 
for more information.

Configuring the Connection Service for auto matching
The Quality Control Module or the Connection Service perform auto match-
ing. You use the Quality Control Module to start auto matching. To do this, 
select a set of studies and then start the auto matching functionality. Alterna-
tively, you can configure the Connection Service to auto match all incoming 
studies. In both cases, matching is based on the origin of the study and a user-
defined rule.

T
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To configure the Connection Service to auto match incoming studies (trig-
gered by the study origin), select Configuration → Connection Service... 
from the Data Selector menu bar and then the Receive tab of the Connection 
Service Properties dialog box. Enter the dynamic link library QC.dll in the 
Post Process field as shown below. 

Restart the Connection Service after adding the Post Process file.

Adding destinations for auto transmission
It is possible to use specific Quality Control Module triggers, such as saving a 
study or matching a study, to send studies automatically to another worksta-
tion or archive.

To prepare the system for this, you will first have to add destinations and con-
figure the Auto Routing Protocol. See the Teleradiology chapter of this guide 
for details.

Adding origins
The Auto Routing Protocol and the auto matching function both use origins to 
trigger certain actions.
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To prepare the system for either of these, you will hence first have to add any 
origins that are required. See the Teleradiology chapter in this guide for 
details.

Adding special study statuses
During a QC session, the user will need to know whether a study has been 
successfully matched or not. The Quality Control Module has the capability to 
set the study status depending on the match result.

We recommend adding two QC-specific study statuses, Matched and 
Unmatched for example.

Adding worklist views
Creating DICOM modality worklist views is required when the user will what 
to use (Auto) matching.

See the on-line Help and the User’s Guide for further information on how to 
configure these.

Auto matching is a back-
ground process. It is, 
therefore, independent 

of Study Status Permission set-
tings. 
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Setting up (auto) matching

Merge mapping
By default, RadWorks will replace tags during matching (automatic or man-
ual).

As each worklist can have a different layout the Quality Control Module 
allows you to configure the merging / matching for each individual worklist.

During a QC session, the user can select the relevant worklist view and the 
entry to match the opened study with. Write options set in the Merge Mapping 
properties will then be applied.
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Origins and worklist views
After configuring origins and (DICOM) modality worklist views, you can 
configure the Quality Control Module to use a specific worklist for (auto) 
matching each origin.

Auto matching
When you set up a system for auto matching, you should make sure the cor-
rect dynamic link library has been configured in the Connection Service to 
automatically match an incoming study.

Then define which rule(s) to use during auto matching.

You can define more than one rule for each origin and move their priorities Up 
or Down. The first rule that produces a unique match will be used.

The administrator can 
set up a ‘default’ map-
ping, which is then used 

by default on all worklists. The 
default mapping is configured by 
selecting the item <default> from 
the Worklist drop-down list and 
then adding / modifying / deleting 
tags.
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Rules specify a worklist where to search for data and a query specific for that 
worklist.

An Administrator or a user with administrative rights must type the rules.

Syntax for a rule:

@<Worklist tag>@ == @<Study tag>@ AND …. AND
@<Worklist tag>@ == '<string>'

Logging auto matching
On the Quality Control tooltab, users can click Log in order to view the 
matching history of the studies added to the RadWorks system during auto-
matic matching.

Each entry in this dialog will have the status ‘Matched’ or ‘UnMatched’ (the 
exact name of statuses depends on the system configuration).

To display a second dialog with more detailed information, select an entry and 
click Open (or double click the entry) 

You are advised to test 
all rules before using the 
Auto Matching in prac-

tice.
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Typical log messages are:

Setting up RIS notifications

If the RadWorks system has been configured to connect to a HIS or RIS sys-
tem, you can configure RadWorks to send notifications each time a study has 
been changed. This will apply after for instance Study Status ID changes 
(either in the Data Selector or the Viewing Section), image manipulations 
(added window levels, flip/rotate actions, etc.) or any other type of action, 
which causes RadWorks to save the study.

Make sure the Notification functionality is linked to the appropriate HIS-RIS 
implementation. See the ‘HIS-RIS and Worklists Integration’ chapter of this 
guide for details.

No worklist item found None of the match rules could identify a unique match. Please 
verify if the information is available on a worklist or whether 
the match rule is valid.

Too many entries found: <number> None of the match rules returned a unique match. The <num-
ber> will tell the number of matches that were found while 
using the last match rule.

Successfully matched with rule: 
<number>

Informs you which rule was responsible for the successful 
match.

No merge list available No merge list was specified in the configuration.

Could not insert all worklist items into 
study

One of the worklist items could not be merged into the DICOM 
header. See the RadWorks.log file for more information.

Merging successful Worklist items are successfully merged into the study object.

Log messages and their meanings
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Editing demographics
DICOM tags can be edited with the Quality Control Module as long as it is 
part of a patient, study, series, or image object. (See the appendix of this guide 
for a list of all available DICOM tags.)

Below is described how to configure the Quality Control Module for editing 
the patient demographics.

In this dialog, an administrator can configure which tags are editable for 
which modality and at which level.

1111 To add a tag, click Add. 

2222 In the new dialog, enter the desired tag (by description of by group / 
element). Enter the field Type (Date box / Drop list / Edit box / ML 
edit box / Patient box / Time box). 

3333 In the Default Value field, enter an optional default value

4444 If you selected the “drop list” type, enter the possible entries the 
users can choose from.

5555 Click OK, so the user can edit the tag the next time the Quality Con-
trol Module is started.

The Connection and 
Database Services 
must be restarted for 

the changes to take effect.
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You can specify modality specific tags. For instance, the Transducer type 
(0017:6031) for Ultrasound. This tag cannot be edited if a CT study is open.

The Study Status ID (0032:000A) is another useful tag. This tag stores the 
Study Status ID the worklist uses.

In order to create a 
selection list of more 
than one item, press 

Enter to advance to the next line 
in the Selection List box.



GEMS IT Applicare

187

Sending Modality Performed Procedure Step 
messages

RadWorks is able to send MPPS messages using the HIS/RIS Dll called 
Mpps.dll in the AMI_60/bin directory. You can add this HIS/RIS Implementa-
tion with the Add button on the HIS-RIS tab of the Generic Properties page 
(select Configuration → Generic... from the Data Selector menu bar).

After adding the implementation, you should configure the Mpps.dll (using 
the Configure button, after you selected the line Modality Performed Proce-
dure Step [Mpps.dl]) and add it to the Transaction Functionality item in the 
lower list. (Select Transaction, click Modify, clear all checkboxes except for 
Internal and Modality Performed Procedure Step (Mpps.dll) and click OK).

The following new registry keys are created automatically when the Mpps.dll 
is installed (values are examples):

HKEY_LOCAL_MACHINE\SOFTWARE\AMI\AMIL\6.0\HIS_RIS\Implementation\Mpps

"FileName"="Mpps.dll"

"CalledAETitle"="MWLSERVER"

"CalledHost"="3.220.158.129"

"CalledPort"=dword:000008ca

"PerfProcStepIdFormat"=PPS@00080050@

After the application is restarted, the Quality Control module can send MPPS 
messages. You can see this when you click Save or Back. The Save Dialog 
will be extended with a Modality Performed Procedure Step combo box, ask-
ing users whether they wish to send the message or not. The combo box is 
only enabled if you matched the study related to a DICOM Modality Worklist 
item.

If ‘Declare the item completed’ is selected, the Quality Control module will 
send the MPPS message to the server until it succeeds. If this operation fails, 
the user can click Retry, (this may be helpful if the server was temporarily 
down) or Cancel, in which case the Save or Back operation cannot continue. 
The only way to save the study in this case is to select ‘Do not declare the item 
completed’. This implies the user will return to the study.

If you want to declare a worklist item invalid, select Discontinue from the 
right mouse button menu of the Modality Worklist control.
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MPPS data structure and sources
In the current QC implementation, the data from a study is completed (or cor-
rected) with the data from a worklist item. This procedure is called matching. 
For MPPS the worklist has a second use: reporting of work that has been per-
formed in order to trigger a workflow system. The MPPS IOD definition, 
therefore, contains both data from the study (that got its data partially from a 
match procedure) and from the worklist item itself (data that was necessary 
for the workflow process, but was not saved in the study). The following list 
displays the MPPS items and the data source.

MPPS Field VR DICOM Tag Source, additional comment

Patient's Name PN 0x00100010 Patient 

Patient ID LO 0x00100020 Patient

Patient's Birth Date DA 0x00100030 Patient

Patient's Sex CS 0x00100040 Patient

Referenced Patient Sequence SQ 0x00081120 Work list item

>Referenced SOP Class UID UI 0x00081150 Work list item

>Referenced SOP Instance UID UI 0x00081155 Work list item

Scheduled Step Attribute Sequence SQ 0x00400270 Newly created by RadWorks, containing  1 
item 

>Study Instance UID UI 0x0020000D Study, possibly from Worklist (configurable)

>Referenced Study Sequence SQ 0x00081110 Study, possibly from Worklist (configurable)

>>Referenced SOP Class UID UI 0x00081150 Study, possibly from Worklist (configurable)

>>Referenced SOP Instance UID UI 0x00081155 Study, possibly from Worklist (configurable)

>Accession Number SH 0x00080050 Study, possibly from Worklist (configurable)

>Placer Order Number/Imaging Service 
Request

SH 0x00402006 Worklist

>Filler Order Number/Imaging Service Request SH 0x00402007 Worklist

>Placer Order Number/Imaging Service 
Request

LO 0x00402016 Worklist

>Filler Order Number/ImagingService Request LO 0x00402017 Worklist

>Requested Procedure ID SH 0x00401001 Worklist

>Requested Procedure Description LO 0x00321060 Worklist
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>Placer Order Number/Procedure SH 0x00401006 Worklist

>Filler Order Number/Procedure SH 0x00401007 Worklist

>Scheduled Procedure Step ID SH 0x00400009 Worklist

>Scheduled Procedure Step Description LO 0x00400007 Worklist

>Scheduled Action Item Code Sequence SQ 0x00400008 Worklist

>>Code Value SH 0x00080100 Worklist

>>Coding Scheme designator SH 0x00080102 Worklist

>>Code Meaning LO 0x00080104 Worklist

Performed Station AE Title AE 0x00400241 Filled in by RadWorks, 

Performed Station Name SH 0x00400242 -

Performed Location SH 0x00400243 -

Performed Procedure Step Start Date DA 0x00400244 First Image of first Series: Acquisition Date

Performed Procedure Step Start Time TM 0x00400245 First image of first Series: Acquisition Time

Performed Procedure Step ID SH 0x00400253 RadWorks, generated from configurable 
tags

Performed Procedure Step End Date DA 0x00400250 RadWorks, system date

Performed Procedure Step End Time TM 0x00400251 RadWorks, system time

Performed Procedure Step Status CS 0x00400252 RadWorks

Performed Procedure Step Description LO 0x00400254 -

Comments on the Performed Procedure Step ST 0x00400280 -

Performed Procedure Type Description LO 0x00400255 -

Procedure Code Sequence SQ 0x00081032 Worklist

>Code Value SH 0x00080100 Worklist

>Coding Scheme Designator SH 0x00080102 Worklist

>Code Meaning LO 0x00080104 Worklist

Modality CS 0x00080060 Study

Study ID SH 0x00200010 Study
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Performed Action Item Sequence SQ 0x00400260 Worklist

>Code Value SH 0x00080100 Worklist

>Coding Scheme Designator SH 0x00080102 Worklist

>Code Meaning LO 0x00080104 Worklist

Performed Series Sequence SQ 0x00400340 Study, 1 item for every series in the study

>Performing Physician's Name PN 0x00081050 Series

>Operator's Name PN 0x00081070 Series

>Protocol Name LO 0x00181030 -

>Series Instance UID UI 0x0020000E Series

>Series Description LO 0x0008103E Series

>Retrieve AE Title AE 0x00080054 RadWorks, System AE-Title

>Referenced Image Sequence SQ 0x00081140 Series, 1 item for every image

>>Referenced SOP Class UID UI 0x00081150 Image

>>Referenced SOP Instance UID UI 0x00081155 Image

>Referenced Standalone SOP Instance 
Sequence

SQ 0x00400220 -

>>Referenced SOP Class UID UI 0x00081150 -

>>Referenced SOP Instance UID UI 0x00081155 -

Anatomic Structure Space or Region Sequence SQ 0x00082229 -

>Code Value SH 0x00080100 -

>Coding Scheme Designator SH 0x00080102 -

>Code Meaning LO 0x00080104 -

Total Time of Fluoroscopy US 0x00400300 First Image of first Series:

Total Number of Exposures US 0x00400301 First Image of first Series:

Distance Source to Detector SID DS 0x00181110 First image of first Series:

Distance Source to Entrance DS 0x00400306 First image of first Series:

Entrance Dose US 0x00400302 First image of first Series:

Exposed Area US 0x00400303 First image of first Series:
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Image Area Dose Product DS 0x0018115E First image of first Series:

Comments on Radiation Dose ST 0x00400310 First image of first Series:

Billing Procedure Step Sequence SQ 0x00400320 -

>Code Value SH 0x00080100 -

>Coding Scheme Designator SH 0x00080102 -

>Code Meaning LO 0x00080104 -

Film Consumption Sequence SQ 0x00400321 -

>Number of Films IS 0x21000170 -

>Medium Type CS 0x20000030 -

>Film Size ID CS 0x20100050 -

Billing Supplies and Devices Sequence SQ 0x00400324 -

>Billing Item Sequence SQ 0x00400296 -

>>Code Value SH 0x00080100 -

>>Coding Scheme Designator SH 0x00080102 -

>>Code Meaning LO 0x00080104 -

>Quantity Sequence SQ 0x00400293 -

>>Quantity DS 0x00400294 -

>>Measuring Units Sequence SQ 0x00400295 -

>>>Code Value SH 0x00080100 -

>>>Coding Scheme Designator SH 0x00080102 -

>>>Code Meaning LO 0x00080104 -
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Dynamics
The MPPS HIS/RIS Interface function Transaction() receives a dcmset con-
taining all necessary data to send both a MPPS N-CREATE and an N-SET. 
This set could contain a Referenced Study Component Sequence from the 
study involved, which is supposed to contain 0 or 1 sequence items containing 
the MPPS Instance UID (0008,1155). If this Referenced Study Component tag 
is present in the input set and contains one item, an N-GET is performed to 
query the SCP for the existence of the MPPS IOD. If it does not yet exist, a 
new UID is generated and used to issue an MPPS N-CREATE. In either case, 
the transaction is completed with an MPPS N-SET. The MPPS UID that was 
used for the MPPS operation is returned to the caller, in order to copy the UID 
to the study involved.

When sending a MPPS Discontinued message, no study is involved, so there 
is no place to retrieve a possible MPPS Instance UID from. Inherently, a dis-
continue message will always consist of a MPPS N-CREATE (‘IN 
PROGRESS’), immediately, followed by a MPPS N-SET Message, with the 
MPPS Status ID set to ‘DISCONTINUED’.

MPPS information sent to HIS/RIS system
There are two occasions when MPPS information is sent to the HIS/RIS sys-
tem:

Discontinued
When a study is selected from the Modality Worklist in the QC module and 
the Discontinue action is selected from the right mouse button menu, the cor-
responding MPPS information is sent to the HIS/RIS system (with the Per-
formed Procedure Step Status set to ‘DISCONTINUED’). The following 
DICOM values are passed with the MPPS information:

Field Tag Type

Patient's Name (0010,0010) PN

Patient ID (0010,0020) LO

Patient's Birth Date (0010,0030) DA

Patient's Sex (0010,0040) CS

Referenced Patient Sequence (0008,1120) SQ

>Referenced SOP Class UID (0008,1150) UI

>Referenced SOP Instance UID (0008,1155) UI

DICOM values sent with status set to ‘Discontinued’
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Scheduled Step Attribute Sequence (0040,0270) SQ

>Study Instance UID (0020,000D UI

>Referenced Study Sequence (0008,1110) SQ

>>Referenced SOP Class UID (0008,1150) UI

>>Referenced SOP Instance UID (0008,1155) UI

>Accession Number (0008,0050) SH

>Placer Order Number/Imaging Service Request (0040,2006) SH

>Filler Order Number/Imaging Service Request (0040,2007) SH

>Placer Order Number/Imaging Service Request (0040,2016) LO

>Filler Order Number/Imaging Service Request (0040,2017) LO

>Requested Procedure ID (0040,1001) SH

>Requested Procedure Description (0032,1060) LO

>Placer Order Number/Procedure (0040,1006) SH

>Filler Order Number/Procedure (0040,1007) SH

>Scheduled Procedure Step ID (0040,0009) SH

>Scheduled Procedure Step Description (0040,0007) LO

>Scheduled Action Item Code Sequence (0040,0008) SQ

>>Code Value (0008,0100) SH

>>Coding Scheme designator (0008,0102) SH

>>Code Meaning (0008,0104) LO

Performed Station AE Title (0040,0241) AE

Performed Station Name (0040,0242) SH

Performed Location (0040,0243) SH

Performed Procedure Step Start Date (0040,0244) DA

Performed Procedure Step Start Time (0040,0245) TM

Performed Procedure Step ID (0040,0253) SH

Performed Procedure Step End Date (0040,0250) DA

Performed Procedure Step End Time (0040,0251) TM

DICOM values sent with status set to ‘Discontinued’
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Performed Procedure Step Status (0040,0252) CS

Performed Procedure Step Description (0040,0254) LO

Comments on the Performed Procedure Step (0040,0280) ST

Performed Procedure Type Description (0040,0255) LO

Procedure Code Sequence (0008,1032) SQ

>Code Value (0008,0100) SH

>Coding Scheme Designator (0008,0102) SH

>Code Meaning (0008,0104) LO

Modality (0008,0060) CS

Study ID (0020,0010) SH

Study Identifier Performed Action Item Sequence (0040,0260) SQ

>Code Value (0008,0100) SH

>Coding Scheme Designator (0008,0102) SH

>Code Meaning (0008,0104) LO

Performed Series Sequence (0040,0340) SQ

>Performing Physician's Name (0008,1050) PN

>Operator's Name (0008,1070) PN

>Protocol Name (0018,1030) LO

>Series Instance UID (0020,000E UI

>Series Description (0008,103E LO

>Retrieve AE Title (0008,0054) AE

>Referenced Image Sequence (0008,1140) SQ

>>Referenced SOP Class UID (0008,1150) UI

>>Referenced SOP Instance UID (0008,1155) UI

>Referenced Standalone SOP Instance Sequence (0040,0220) SQ

>>Referenced SOP Class UID (0008,1150) UI

>>Referenced SOP Instance UID (0008,1155) UI

Anatomic Structure Space or Region Sequence (0008,2229) SQ

DICOM values sent with status set to ‘Discontinued’
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>Code Value (0008,0100) SH

>Coding Scheme Designator (0008,0102) SH

>Code Meaning (0008,0104) LO

Total Time of Fluoroscopy (0040,0300) US

Total Number of Exposures (0040,0301) US

Distance Source to Detector SID (0018,1110) DS

Distance Source to Entrance (0040,0306) DS

Entrance Dose (0040,0302) US

Exposed Area (0040,0303) US

Image Area Dose Product (0018,115E DS

Comments on Radiation Dose (0040,0310) ST

Billing Procedure Step Sequence (0040,0320) SQ

>Code Value (0008,0100) SH

>Coding Scheme Designator (0008,0102) SH

>Code Meaning (0008,0104) LO

Film Consumption Sequence (0040,0321) SQ

>Number of Films (2100,0170) IS

>Medium Type (2000,0030) CS

>Film Size ID (2010,0050) CS

Billing Supplies and Devices Sequence (0040,0324) SQ

>Billing Item Sequence (0040,0296) SQ

>>Code Value (0008,0100) SH

>>Coding Scheme Designator (0008,0102) SH

>>Code Meaning (0008,0104) LO

>Quantity Sequence (0040,0293) SQ

>>Quantity (0040,0294) DS

>>Measuring Units Sequence (0040,0295) SQ

>>>Code Value (0008,0100) SH

DICOM values sent with status set to ‘Discontinued’
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Completed
Each time, a match for a local study is done successfully from within the QC 
module (either manual or automatic), the dialog below will appear when the 
study is saved. When ‘Declare the item completed’ is selected, the corre-
sponding MPPS information is sent to the HIS/RIS system (with the Per-
formed Procedure Step Status set to ‘COMPLETED’).

The following DICOM values are passed with the MPPS information:

>>>Coding Scheme Designator (0008,0102) SH

>>>Code Meaning (0008,0104) LO

DICOM values sent with status set to ‘Discontinued’

No MPPS information is 
sent to the HIS/RIS sys-
tem when automatic 

matching is done outside of the 
QC module.

Field Tag Type

Patient's Name (0010,0010) PN

Patient ID (0010,0020) LO

Patient's Birth Date (0010,0030) DA

Patient's Sex (0010,0040) CS

Referenced Patient Sequence (0008,1120) SQ

>Referenced SOP Class UID (0008,1150) UI

>Referenced SOP Instance UID (0008,1155) UI

Scheduled Step Attribute Sequence (0040,0270) SQ

>Study Instance UID (0020,000D UI

>Referenced Study Sequence (0008,1110) SQ

>>Referenced SOP Class UID (0008,1150) UI

>>Referenced SOP Instance UID (0008,1155) UI

>Accession Number (0008,0050) SH

>Placer Order Number/Imaging Service Request (0040,2006) SH

>Filler Order Number/Imaging Service Request (0040,2007) SH

>Placer Order Number/Imaging Service Request (0040,2016) LO

>Filler Order Number/Imaging Service Request (0040,2017) LO

>Requested Procedure ID (0040,1001) SH

DICOM values sent with status set to ‘Completed’
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>Requested Procedure Description (0032,1060) LO

>Placer Order Number/Procedure (0040,1006) SH

>Filler Order Number/Procedure (0040,1007) SH

>Scheduled Procedure Step ID (0040,0009) SH

>Scheduled Procedure Step Description (0040,0007) LO

>Scheduled Action Item Code Sequence (0040,0008) SQ

>>Code Value (0008,0100) SH

>>Coding Scheme designator (0008,0102) SH

>>Code Meaning (0008,0104) LO

Performed Station AE Title (0040,0241) AE

Performed Station Name (0040,0242) SH

Performed Location (0040,0243) SH

Performed Procedure Step Start Date (0040,0244) DA

Performed Procedure Step Start Time (0040,0245) TM

Performed Procedure Step ID (0040,0253) SH

Performed Procedure Step End Date (0040,0250) DA

Performed Procedure Step End Time (0040,0251) TM

Performed Procedure Step Status (0040,0252) CS

Performed Procedure Step Description (0040,0254) LO

Comments on the Performed Procedure Step (0040,0280) ST

Performed Procedure Type Description (0040,0255) LO

Procedure Code Sequence (0008,1032) SQ

>Code Value (0008,0100) SH

>Coding Scheme Designator (0008,0102) SH

>Code Meaning (0008,0104) LO

Modality (0008,0060) CS

Study ID (0020,0010) SH

Study Identifier Performed Action Item Sequence (0040,0260) SQ

DICOM values sent with status set to ‘Completed’
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>Code Value (0008,0100) SH

>Coding Scheme Designator (0008,0102) SH

>Code Meaning (0008,0104) LO

Performed Series Sequence (0040,0340) SQ

>Performing Physician's Name (0008,1050) PN

>Operator's Name (0008,1070) PN

>Protocol Name (0018,1030) LO

>Series Instance UID (0020,000E UI

>Series Description (0008,103E LO

>Retrieve AE Title (0008,0054) AE

>Referenced Image Sequence (0008,1140) SQ

>>Referenced SOP Class UID (0008,1150) UI

>>Referenced SOP Instance UID (0008,1155) UI

>Referenced Standalone SOP Instance Sequence (0040,0220) SQ

>>Referenced SOP Class UID (0008,1150) UI

>>Referenced SOP Instance UID (0008,1155) UI

Anatomic Structure Space or Region Sequence (0008,2229) SQ

>Code Value (0008,0100) SH

>Coding Scheme Designator (0008,0102) SH

>Code Meaning (0008,0104) LO

Total Time of Fluoroscopy (0040,0300) US

Total Number of Exposures (0040,0301) US

Distance Source to Detector SID (0018,1110) DS

Distance Source to Entrance (0040,0306) DS

Entrance Dose (0040,0302) US

Exposed Area (0040,0303) US

Image Area Dose Product (0018,115E DS

Comments on Radiation Dose (0040,0310) ST

DICOM values sent with status set to ‘Completed’
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Billing Procedure Step Sequence (0040,0320) SQ

>Code Value (0008,0100) SH

>Coding Scheme Designator (0008,0102) SH

>Code Meaning (0008,0104) LO

Film Consumption Sequence (0040,0321) SQ

>Number of Films (2100,0170) IS

>Medium Type (2000,0030) CS

>Film Size ID (2010,0050) CS

Billing Supplies and Devices Sequence (0040,0324) SQ

>Billing Item Sequence (0040,0296) SQ

>>Code Value (0008,0100) SH

>>Coding Scheme Designator (0008,0102) SH

>>Code Meaning (0008,0104) LO

>Quantity Sequence (0040,0293) SQ

>>Quantity (0040,0294) DS

>>Measuring Units Sequence (0040,0295) SQ

>>>Code Value (0008,0100) SH

>>>Coding Scheme Designator (0008,0102) SH

>>>Code Meaning (0008,0104) LO

DICOM values sent with status set to ‘Completed’
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archives

This chapter describes the installation and configuration of the Single Media 
Archive functionality in RadWorks.

Setting up RadWorks to copy data to single media202

Setting up RadWorks to copy from a read-write 
medium ..................................................................204

Copying data from a read-write medium and viewing it 
in RadWorks...........................................................205
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ith RadWorks, users can store images in a single media archive. 
This means they can copy images from their local RadWorks data-
base to a read-write storage medium such as a zip disk or even a 

floppy disk. It also means they can copy images to a read-only storage 
medium such as a CD-R or DVD-R disk.

Setting up RadWorks to copy data to single media

The steps for settings up RadWorks to copy data to external media differ 
slightly depending on whether the media to be written to is read-write or read-
only. Both possibilities are covered below.

To configure single media archiving for use with a read-write medium �

1111 Select Configuration → Single Media Archive from the Data 
Selector menu bar. In the Configure Single Media Archiving dialog 
box, select Read-Writable from the Media Type drop-down list.

2222 Enter in the Device field, the drive of the device and the path to 
which you are copying data to or from, or click the Browse… button.

3333 Enter in the Total Size field, the storage limit of the medium you are 
using.

4444 Use the Block Size field, to define the size of the blocks you want for 
your read-write medium. The recommended setting is 4.

5555 Check the Store images JPEG Lossless compressed check box, if 
you want to store your images using JPEG Lossless format.

6666 Check the Copy files check box, to indicate that you want to copy 
additional items to your read-write medium. Then enter the path 
from where you want to copy those items (or use the Browse… but-
ton). An example of such an item might be the RadWorks CD 
Viewer. Note, that you copy the contents of entire folders, not indi-
vidual files.

7777 Check the Delete after archiving check box, if you want the study 
deleted after it has been copied, and then click OK.

W
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To configure single media archiving for use with a read-only medium �

1111 Select Configuration → Single Media Archive from the Data 
Selector menu bar. In the Configure Single Media Archiving dialog 
box select Read-Only from the Media Type drop-down list.

2222 Enter in the Device field, the drive of the device to which you are 
copying data to or from, or click the Browse… button.

3333 Specify in the Total Size field the storage limit of the medium you 
are using. For CD this is 650 or 720 MB; for DVD, 2.9 GB or 4.3 
GB, depending on the DVD and the device you are using.

4444 In the Block Size field, define the size of the blocks you want for 
your read-only medium. The recommended setting is 4.

5555 Click the Store images JPEG Lossless compressed check box, if 
you want to store your images using JPEG Lossless format.

6666 Check the Copy files check box, to indicate that you want to copy 
additional items to your read-only medium. Then enter the path from 
where you want to copy those items (or use the Browse… button). 
An example of such an item might be the RadWorks CD Viewer. 
Note that you copy the contents of entire folders, not individual files.

7777 In the Image directory field, type in the path and directory where 
you want your images to go on your CD or DVD, or use the 
Browse… button.

8888 Check the Verify burned contents check box, if you want a mes-
sage stating that your data has been has been copied to the CD.

9999 Check the Delete after archiving check box, if you want the study 
deleted after it has been copied, and then click OK.
Note that this option will only be performed after data from the local 
database is archived, not with archiving data you selected.
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Setting up RadWorks to copy from a read-write 
medium

Just as users can copy data from RadWorks to single media, they can also do 
the reverse. That is, they can copy from a read-write medium to RadWorks, 
provided the workstation is set up as detailed below.

The first step entails creating a worklist to which you can copy data.

To create a worklist to which you can export data �

1111 In the Data Selector, select Configuration → Generic from the 
menu bar.

2222 Click on the HIS-RIS tab in the Generic Properties dialog box. In 
the Implementations section, select Default HIS-RIS implementa-
tion (RadWorks Default). Then click Config…. 

3333 Select the Study/Patient list tab in the Configure RadWorks Default 
HIS/RIS Implementation dialog. Then click Add.

4444 In the Patient/Study List dialog, enter a name in the Description 
field for the study list you want to create and select from the Type list 
the kind of list you want to make; e.g., Study list or Patient list. Click 
Add again.

5555 Select DICOM Volume from the Type list in the Source dialog box. 
Next, type in the drive of the device containing the images you want 
to import into your RadWorks worklist.

6666 Click Test to see whether your connection will work. If a message 
appears stating that the connection has failed, go back and correct 
any mistakes you have made and check if the storage device you are 
connecting to contains data. Otherwise, click OK until you reach the 
Data Selector. Furthermore, make sure you have a read-write 
medium to copy data from.

7777 Exit RadWorks and restart it.
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Copying data from a read-write medium and viewing it 
in RadWorks

Once you have configured the worklist view, users can view it in RadWorks 
and export their data from the read-write medium back to RadWorks.

To view studies from a single medium archive in a worklist view �

1111 In the Data Selector, select Database → Add view from the menu 
bar.

2222 In the Add View dialog, specify the Description field by typing in a 
description for your new study list.

3333 From List, select the new worklist you created.

4444 Use the Copy settings from list to indicate the list whose settings 
should apply to the worklist you created.

5555 Click OK, and view the worklist by selecting it from the Worklist 
View drop-down list on the Data Selector tooltab.

6666 Double-click the study to view it. Note that you can only view the 
study if the Direct View checkbox on the General tab of the Viewing 
Properties dialog box is checked (select Configuration → Viewing 
from the Data Selector menu bar to view this). If you want to import 
the study, select it, right-click it and then left-click Import from the 
shortcut menu. RadWorks will return the file to the worklist view 
where it came from.
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ith RadWorks, it is possible to connect to a wide variety of input 
devices using the Data Acquisition Module. This chapter lists 
which devices are supported and explains how to install them. 

Supported devices

This version of RadWorks contains support for and is tested with the follow-
ing devices:

Digitizers
• Howtek 450

• Howtek 850 / 960

• Howtek Scanmaster DX

• Lumisys Lumiscan 75 (also tested with LS50, LS85)

• Vidar devices (e.g. VXR-12, Diagnostic Pro)

• TWAIN devices (e.g. document scanner, digital camera, etc.)

Frame grabbers
• Matrox Meteor I (only for Windows NT 4.0 systems)

• Matrox Meteor II

• Data Translation Mach DT3153

• Matrox Pulsar (only for Windows NT 4.0 systems)

• Foresight HI*DEF and I-60

Utilities
• Frame Grabber Emulator: for demonstration purposes.

• Frame Digitizer Emulator: for demonstration purposes.

• Graphic File & Clipboard Reader: for importing BMPs and non-
compressed TIFF files, importing from the clipboard.

The Setup program for RadWorks installs most device drivers automatically, 
but some need additional manual work.

W

The emulators can be 
used to test the behavior 
of the Frame Grabber 

and Digitizer software (or to dem-
onstrate both).
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Key features of supported digitizers
The key features of digitizers supported by RadWorks are shown in the table 
below.

Key features of supported frame grabber boards
Frame grabbers offer the ability to import images from modalities without 
DICOM or other digital image interfaces which have a video output signal 
(endoscopes, microscopes, etc.).

The Meteor and Mach boards are in the lower price range and support color.

The Pulsar and Foresight are more expensive, are monochrome, but support 
higher sampling rates and non-standard video signals.

Matrox Meteor I
This frame grabber is not supported on systems running Windows 2000.

• 4 composite color, Y/C or monochrome input channels,

• NTSC/PAL/SECAM, RS-170/CCIR, no support for non-standard 
signals,

• 8-bit digitalization,

• Max. sampling rate: standard (approx. 21MHz),

• PCI,

• No frame memory, uses DMA to Host memory,

• Optional RGB module, optional TV module,

Type OD DPI Rescan Feeder

Howtek Scanmaster-DX CCD .01-3.4 512 (8K) Yes No

Howtek 850 / 960 CCD .01-3.6 584 (8K) Yes Yes

Howtek 450 CCD .01-3.6 292 (4K) Yes Yes

Vidar VXR-12 CCD .01-3.0 300 Opt. No(t yet)

Vidar Diagnostic Pro CCD ? ? Yes Yes

Lumisys LS75 Laser .05-3.5 256 No Yes (6)

Lumisys LS85 Laser .03-4.1 512 No Yes (6)

Key features of supported digitizers. OD = Optical density, the degree of light that passes through a film 
(0 = White and ~3.5 = Black)
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• Programmable region of interest (ROI); only for non-RGB signals.

A typical application of this board is color or monochrome acquisition of stan-
dard video signals.

RGB should be used when available, since superior quality is obtained. Y/C 
is, however, lost.

Matrox Meteor II 
This frame grabber is supported on systems running Windows 2000.

• 4 composite color, Y/C or monochrome input channels

• NTSC/PAL/SECAM, RS-170/CCIR, no support for non-standard 
signals

• 8-bit digitalization

• Max. sampling rate: standard (approx. 21MHz)

• PCI

• No frame memory, uses DMA to Host memory

• Optional RGB module, optional TV module

• Programmable region of interest (ROI); only for non-RGB signals

Data Translation Mach DT3153
• 3 composite color, Y/C or monochrome input channels

• NTSC/PAL

• PCI

• No frame memory, uses DMA to Host memory

• Programmable region of interest for acquisition.

The board has the option of real-time (‘direct’) video overlay in video mem-
ory, but RadWorks does not use this feature.

Matrox Pulsar
• 4 monochrome analog input channels

• 10-bit digitalization, high frame-rates

• Max. sampling rate: 45MHz

• PCI

• Supports non-standard video signals

• 2Mb Frame memory, 2Mb overlay memory
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• Displaying capabilities on-board (max. 1600x1200x256 colors)

• Optional 16-bit Digital (TTL) interface. Typical application: grab 
from devices that produce non-interlaced video signals

• Line-scan cameras

• Old CT scanners

• PC monitors

Foresight HI*DEF Plus
• 4 monochrome analog input channels, 4 TTL level input channels

• 8-bit digitalization, high frame-rates

• Max. sampling rate (pixel rate): 140MHz

• Horizontal Frequency: Up to 78kHz

• ISA

• 2Mb Frame memory

• Supports non-standard video signals. Typical application: grab from 
devices that produce non-interlaced video signals

• Line-scan cameras

• Old CT scanners

• PC monitors

Foresight HI*DEF Accura
• 4 monochrome analog input channels, 4 TTL level input channels

• 8/10-bit digitalization, high frame rates

• Max. sampling rate (pixel rate): 150MHz

• Horizontal Frequency: Up to 105kHz

• PCI

• 4Mb Frame memory

• Supports non-standard video signals. Typical application: grab from 
devices that produce non-interlaced video signals

• Line-scan cameras

• Old CT scanners

• PC monitors

RadWorks supports 8-bit 
capturing only, and does 
not use overlay.



C O N F I G U R I N G  D A T A  A C Q U I S I T I O N

RadWorks 6.0 installation and configuration guide

212 chapter 11

RadWorks Acquisition Module Setup

Use the Add/Remove Programs control panel to install the devices described 
in the previous section.

Before installing, read the complete section with specifics concerning the 
device you want to install. Before installing the software, make sure you have 
installed the necessary hardware for the computer. 

For more information on installing the hardware, see the specifics in sections 
‘Installation and configuration of digitizers’ on page 225 and ‘Installation and 
configuration of frame grabbers’ on page 232.

The table below lists when RadWorks Setup (via Add/Remove Programs) will 
install the necessary device drivers and in which cases you need to install the 
hardware vendor’s software prior to running RadWorks Setup

Device Drivers

Matrox Meteor Installed by Setup

Matrox Pulsar Installed by Setup

Mach DT3153 Run Mach installation software

Foresight HI*DEF Plus Installed by Setup

Foresight HI*DEF Accura Installed by Setup (select HI*DEF Plus)

Howtek Scanmaster DX Install SCSI device
Run WNASPI software

Howtek MultiRad 850 Install SCSI device
Run WNASPI software

Howtek MultiRad 450 Install SCSI device
Run WNASPI software

Vidar VXR-12 Install SCSI device
Run WNASPI software

Lumisys Lumiscan Installed by Setup

Frame Grabber Emulator -

Digitizer Emulator -

Graphics File & Clipboard 
Reader 

-

TWAIN device driver Installed by Setup

Device driver installation
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For some devices you can find additional software in the 3RDPARTY folder 
on your RadWorks CD-ROM.

Software
The general part of the Acquisition Module is installed automatically if you 
install an Acquisition device.

To install the Acquisition Module and acquisition devices �

1111 Make sure you are logged on with administrative rights. Otherwise 
the Setup program will not install the device drivers.

2222 In the Add/Remove Programs control panel, select RadWorks and 
click Change.
The RadWorks installer starts. 

3333 In the Custom Setup dialog, select the device(s) you want to install.

4444 During the installation of the devices, additional dialogs may appear 
with device-specific options. Enter the required information (see the 
relevant sections later in this chapter).

5555 You are now ready to install the selected components. Click Finish 
to proceed. 

6666 The Setup Report informs you what has been installed, removed or 
not installed. Check the relevant lines of the Setup Report to see if 
the installation was successful.
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Configuring the Acquisition Module

The configuration parameters related to acquisition are distributed over three 
different locations:

1111 The General Acquisition properties dialog box (to access this, select 
Configuration → Acquisition... from the Data Selector menu bar).

2222 Hardware specific settings (Device Management): To access this, 
select Acquire → Devices… from the Data Selector menu bar.

3333 Acquire action settings. To access, click Image Types in the Acqui-
sition module.

1 and 2 contain parameters that only need to be configured once when you 
install a new device, and can only be performed with administrative rights. 3, 
however, contains parameters that the user may wish to change for each indi-
vidual acquire action.
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Configuring acquisition properties within RadWorks

To configure acquisition properties within RadWorks, select Configuration 
→ Acquisition... from the Data Selector menu bar.

Settings on the General tab:

Automatic Add of acquired images
If Yes is selected here (default), acquired images are added to the series.

Set Zoom to
If this checkbox is checked, a default zoom factor for new acquired images 
can be defined here. This can be useful when using a frame grabber in contin-
uous mode. If the zoom factor is set to 1:1, nothing extra is required to display 
the image, which speeds up the refresh rate for the screen. This option is 
unchecked by default.

Metrics
Select these to be displayed in centimeters or inches (default).

Save Study section:

Folder for acquired studies
Newly acquired studies are saved to this folder. One of the locally available 
folders can be chosen.
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Use ZLIB Compression
If enabled, a study is compressed before it is saved. The compression method 
used is ZLIB. When enabled, the size of the saved study is much less then 
uncompressed (up to 10 times), but save time is longer (up to twice compared 
to uncompressed).

Send study after save to
This option allows you to automatically transmit newly acquired studies to a 
pre-defined destination. In the drop-down list, you can select destinations that 
have been defined in the Connection menu ���� Destinations option of the 
Data Selector.

Return to Data Selector
If you use the Acquisition Module you will want to continue with a new 
acquisition after saving the previous one. Enabling this option will automati-
cally close the Acquisition Module after each save action.

Frame Grabbing section:
• Beeps on grab action

This is a useful option when using remote controls. If enabled, and 
the current acquisition device is a frame grabber, an acquisition 
action will be preceded and followed by a beep.

• On Start .. Hz, On Finish .. Hz, On Fail .. Hz
Frequency of start, finish and fail beep.

• Duration: .. msec
Length of a beep in milliseconds.

Disable error messages during grab
When grabbing an image with a frame grabber, errors may occur. A lot of data 
has to be transferred from the card to the main memory, especially, in continu-
ous mode. To prevent the continuous mode from breaking, you can switch off 
the error messages during a grab action. A good idea is to enable this option 
during the configuration of the system, and to disable it during normal use.

Minimal idle time between grab actions
You use this option to optimize system behavior during continuous mode. 
This time is the minimal idle time (in milliseconds) between two consecutive 
grab actions, which the system can use to perform other actions, like re-com-
puting the Pictorial Index.
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Settings on the Look-up tables tab

Devices
Lists the acquisition devices which have been installed on the system.

LUT area

Description
Name of the look-up table

Depth
Bit-depth of the images where this LUT may be applied to. Usually, 8 or 12 
bits.

Type
• User: a user-defined LUT will be used.

• Internal: (one of the) internal LUT(s) of the device will be used.

Photo interpretation
• Monochrome: 

the LUT will consist of one plane; so one plane needs to be defined 
under ‘Planes’.

• Color: 
the LUT will consist of 3 planes: R, G and B. Hence, three planes 
have to be defined under ‘Planes’. The color option can only be 
selected if the device supports it.

Planes
Here you enter the actual definition of a user-defined LUT.

A definition of a LUT exists of 1 or 3 lines, depending on the ‘Photo interpre-
tation’ setting above.

One-line definitions are for monochrome images, 3-line definitions for color 
RGB images, with 1 line for each plane.

Each line must contain 2 or more values, which must be within the pixel 
range. For an 8-bit depth image, this is from 0 to 255, for 12 bit images this is 
0 to 4095.

What are Look Up Tables (LUT), and what are they used for?
Look Up Tables are used to map an acquired pixel value from one value to 
another.
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The electronics used to scan an image, in most cases produce a non-linear out-
put. This means that compared to viewing the film on a lightbox, some gray 
value ranges may be darker (less contrast) and some gray value ranges may be 
lighter on the scanned image.

By applying a correction LUT on an acquired image, this “error” in particular 
pixel value ranges on the scanned film may be corrected.

Some digitizers (such as Vidar) have an internal correction LUT, which is cal-
ibrated for that specific model, which can be used by RadWorks.

When an image is acquired, the LUT will be applied to the acquired image 
data, before the image is displayed.

How does it work?
You enter a LUT definition by entering a series of values per plane.

The pixel range (determined by the bit-depth) for the image is divided in (# 
value + 1) sections. The first pixel value starts at 0 and ends at the first entered 
value. The following section starts at the first entered value, and ends at the 
next entered value, and so on. The last section ends at 255 (or 4096). Interme-
diate values are linear interpolated.

Example 1
Bit depth: 8 bits

‘Planes’ values: 10 100 150 200

RadWorks will add a 0 before the first value and the maximum value as last 
value.

Now the list looks like this: [0][10 100 150 200][255]

This means that the pixel range of 0..255 will be subdivided in 5 sections, 
each with length 51

LUT[0] = 0, LUT[51] = 10, LUT[102] = 100, LUT[153] = 150, LUT[204] = 
200, LUT[255] = 255.

The intermediate values of the LUT are linear interpolated.

Acquired:
[000..051]
[051..102]
[102..153]
[153..204]
[204..255]

Will be mapped to:
[000..010]
[010..100]
[100..150]
[150..200]
[200..255]

Look-up table mappings for example 1
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A pixel is acquired with value 51. This value is looked up in the LUT. 
LUT[51] = 10, thus, the pixel value 51 will be replaced by value 10

Example 2
We want to suppress the dark area of a B/W film completely and use the full 
available pixel range for the upper half of the acquired gray values. This way 
we can enhance the contrast in the light area.

Bit depth: 8 bits and ‘Planes’ values: 0 128

RadWorks will add a 0 before the first value and the maximum value as last 
value.

Now the list looks like this: [0][0 128][255]

This means that the pixel range of 0..255 will be subdivided in 3 sections, 
each with length 85.

8-bit dark LUT example

Acquired:
[000..085]
[085..170]
[170..255]

Will be mapped to:
[000..000]
[000..128]
[128..255]

Look-up table mappings for example 2

255

85 255

linear

dark
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Settings on the Patient Information tab 

Mandatory fields
If you check the ‘Mandatory fields:’ checkboxes, the user will have to com-
plete these fields before a study can be saved.

Enable
If checked, the Patient information dialog box in the acquisition screen has a 
section which can query a RIS system. 

The RadWorks system does not query the RIS system itself, but the user can 
specify another program that does the job. This program is started with two 
parameters: the input and the output file. RadWorks waits for the termination 
of this program, after which the output file is read, and the results are placed 
in the appropriate fields.

Input file
RIS input file name. This file is written by the Acquisition module, and con-
tains just one line: 

ID=xxx 

where xxx is the RIS identification number entered by the user.
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This does not need to be an ID, but can be any field that uniquely identifies a 
patient in the external RIS system.

Output file
RIS output file name.

Copy patient info from Database selector
If this option is enabled, patient information from the study currently selected 
in the Data Selector will be copied to the Patient Information dialog when the 
Acquisition Module is entered.

Remarks
• The ‘ID’ and ‘Status’ lines in the output file are mandatory. All other 

lines are optional. If lines are missing, the items in the Patient/Study 
details dialog in RadWorks will remain blank. RadWorks can be con-
figured to make some items ‘non-mandatory’. By default, all items 
are mandatory.

• When writing a line to the output file, start with the identifier, fol-
lowed by ‘=’, followed by a value. Everything following the ‘=’ is 
assumed to be part of the value, except the new-line characters (\r\n).

• Note of the following format specifications for the values:

Field Remarks

ID ID that was present in the input file

Status OK
RIS_ERROR
ERROR

PatientName 64 characters maximum

PatientID 16 characters maximum

BirthDate Format: dd-mm-yyyy

Sex M(ale) or F(emale) or O(ther) 

StudyDate Format: dd-mm-yyyy

StudyTime Format: hh:mm

ReqPhysician 64 characters maximum

StudyID 16 characters maximum

Description 64 characters maximum

Format specifications
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Bodypart 64 characters maximum

Executable Executable which queries the HIS/RIS system, and pro-
duces the Output file. 

Format specifications
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Hardware-specific settings (device management)

The hardware specific settings for each device can be modified in the Device 
Management dialog box. To access this, select Acquire ���� Devices… from 
the Data Selector menu bar 

The Device Management dialog box shows a list of acquisition devices that 
are currently installed and their status (ready/not loaded). 

The ‘Ready’ status line marked with ‘*’ is the active device. This is the device 
that acquisition will start up with.

The lower part of the dialog contains global settings for the device that is cur-
rently highlighted in the list area.

The ‘used channels’ setting: reducing this number to the number of channels 
actually in use prevents users from selecting an unused channel.

Remote control: select the serial port which the Remote Control for the 
selected channel is connected to.

Default modality: select the default modality you want to use.
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Acquire action settings (Image Types) 

Default modality

This dialog box consists of three sections: A common part, a section depen-
dent on the type of acquisition device: Frame grabber or Digitizer, and a 
device-specific part.

Description Name used to save image type
As soon as you type a new name, or modify an existing name, the ‘New’ 
button will be activated. Clicking the New button will save the current set 
of parameters as a new image type.

Height Height of the acquired image

Offset top Offset from top of the film or video signal

Width Width of the acquired image

Offset top Offset from the left of the film or video signal

Photometric Interpretation Select one of the possible (DICOM) photometric interpretations for this 
device
MONOCHROME1: zero value = white; max value=black
MONOCHROME2: zero value = black; max value=white
RGB

Bit Depth Select one of the possible bit depths for this device.

Lookup Table If in the general acquisition configuration LUTs are defined for this 
device, they can be selected here.

Auto update interval Time between the start of two grab actions.

Resolution Select one of the available resolutions.

Default rescan image type If a device supports rescanning, it is possible to define a rescan image 
type. This is an image type which must be already defined, and which is 
used to rescan a selection, e.g. at high resolution.
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Installation and configuration of digitizers

Setting up a Lumisys LS75 digitizer
Requirements

• Lumisys LS75 digitizer

• Lumisys LS75 interface (DCB–Data Control Board), that comes 
with the digitizer.

• Lumisys LS75 Control Interconnect Cable, that comes with the digi-
tizer.

• Free ISA slot in PC.

• RadWorks Distribution CD-ROM

To install the hardware �
1111 Take anti-static measures to protect the printed circuit board you are 

going to install.

2222 Check whether the 6 dip switches on the Lumisys interface board are 
set to their default setting (S1-S6:on-off-on-off-off-off = 
Mem:D0000-D7FFF; I/O:100h-11Fh).

3333 Check whether the jumper JP1 on the Lumisys interface board is set 
to its default setting IRQ5.

4444 Install the Lumisys interface board in a free ISA slot in the PC.

5555 Connect the Lumisys digitizer to the PC with the interconnection 
cable.

To install the software �
The driver for the Lumisys board is supplied on the RadWorks distribution 
CD-ROM and is installed automatically when running the RadWorks Setup.

1111 Make sure you are logged in with administrator rights. Otherwise, 
the Setup program will not install the device drivers or add the Reg-
istry keys.

2222 Install the ‘Lumiscan 75’ component of the RadWorks Acquisition 
Module: in the Modules dialog of the RadWorks setup, select 
‘Lumiscan 75’. The Lumisys driver should not yet be detected in the 
‘System Information’ report. In order to let Windows load the newly 
installed device driver, restart the PC.

Frame Grabber sizes are 
given in pixels, digitizer 
sizes in inches or centi-

meters, dependent on the global 
acquisition setting.

If the Lumisys interface 
board is removed, the 
driver has to be removed 

manually.
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3333 Copy CLUT.DAT into the WINNT\System32\Drivers directory.

The LSDT Windows NT device driver automatically loads this ‘Correction 
Look Up Table’ during the driver loading process.

If the CLUT.DAT file is not found the driver will default to a 1:1 correction 
LUT and a warning message will be logged to the System Event Log.

Under DOS, this file was named CLUTXXXX.DAT where XXXX is the 
serial number of the scanner system. This file is stored in C:\. You can use this 
CLUTXXXX.DAT that Lumisys supplies with the digitizer and rename it to 
CLUT.DAT, or create a new CLUT.DAT using the Lumisys tools. Only one 
CLUT.DAT file may be present on the system!
Refer to the Lumisys documentation for details.

Configuration
1111 Start RadWorks and select Acquire ���� Devices…. See ‘Device man-

agement’ on page 227 for an explanation of the Device Management 
dialog box.

2222 Highlight the ‘Lumiscan 75’ line, and make any necessary changes 
to the device settings in the bottom part.

3333 To load the ‘Lumiscan 75’ device, click Load.

4444 To activate one of the devices (default device), highlight the device 
and click Activate.

When you have finished...
To test your digitizer click the Acquisition tab, click Acquire Image(s), then 
click Scan to start digitizing. 

RadWorks Setup should have installed the items in the table below.

Hardware: LUMISYS ISA card

Device driver: LSDT.SYS

Name of device in control panel: Lsdt

Registry Keys: Imported from ACQ_LS75.TXT on the CD-
ROM.

Files: %ROOT%\BIN\LUMISYS.DLL
WINNT\System32\LSDTAPI.DLL
WINNT\System32\Drivers\LSDT.SYS
WINNT\System32\Drivers\CLUT.DAT

What is installed
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Device-specific configuration options

Device management
In the Device Management dialog box, the “Use Film Feeder” option can be 
enabled. When it is, and the user clicks Scan, a dialog box appears in which 
the number of films to be scanned can be entered.

Image types
‘Resolution mode’ may be set to ‘Fixed’ (a fixed number of dots per inch will 
be used) or Variable (2048 dots are used for the whole line, so the actual DPI 
will vary with the width of the film).

‘Pixel averaging mode’ may be selected. See the Lumisys documentation for 
more information.

Setting up Lumisys Lumiscan 85
When using the Lumisys LS85, two Registry keys need modification:

Key: Software\AMI\RadWorks\6.0\Modules\Acquire\Devices\Lumiscan75

Value: Desc=Lumiscan 85

Value: MaxDPL=4096

Setting up a Howtek Scanmaster DX
The Scanmaster DX supports rescanning of a selected area.

Requirements
• Howtek Scanmaster DX digitizer

• SCSI card

• SCSI cable

• RadWorks distribution CD-ROM

To install the hardware �
1111 Take anti-static measures to protect the printed circuit board you are 

going to install.

2222 Install the SCSI card in a free slot in the PC. 

3333 Install the SCSI software; see section ‘General note about SCSI 
devices’ on page 248.

4444 Connect the digitizer to the PC with the SCSI cable.
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To install the software �
The Scanmaster DX is a SCSI device and does not need an additional Win-
dows device driver.

1111 Make sure you are logged on with administrator rights. Otherwise, 
the Setup program will not add Registry keys.

2222 Install the ‘Howtek Scanmaster DX’ component of the RadWorks 
Acquisition Module: in the Modules dialog of the RadWorks setup, 
select ‘Howtek Scanmaster DX’.

To configure �
1111 Start RadWorks and select Acquire ���� Devices….

See the section about the Device Management screen.

2222 Highlight the ‘Howtek Scanmaster DX’ line, and make any neces-
sary changes to the device settings in the bottom part.

3333 To load the ‘Howtek Scanmaster DX’ device, click Load.

4444 To activate a device (default device), highlight the device and click 
Activate.

When you have finished...
To Test your digitizer, select the Acquisition tab, click Acquire Image(s), and 
click Scan to start digitizing. 

The Setup should have installed the following:

Additional software
The Scanmaster is supplied with software you can use to test the Scanmaster. 
Check the supplied disk for the ‘Programs’ directory. This directory contains a 
few test programs. If, for example “s_rescan.exe” produces an error message 
when run, RadWorks will not function properly either. So, if these tests fail, 
correct them before using RadWorks.

Additional software  Adaptec EZ-SCSI 4.0 or higher

Registry Keys Imported from SCNM_KEY.TXT on the CD-
ROM.

Files %ROOT%\Bin\HOWTEK.DLL
WINNT\System32\Drivers\CLUT.DAT

What has been installed
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Device-specific configuration options

Device Management
The Howtek Scanmaster DX has no global device parameters.

Image Types
“Logarithmic Data Acquisition” can be enabled or disabled. See Howtek doc-
umentation for more information.

Setting up a Vidar VXR-12 digitizer

Requirements
• Vidar VXR-12 DX digitizer

• SCSI card

• SCSI cable

• RadWorks distribution CD-ROM

To install the hardware �
1111 Take anti-static measures to protect the printed circuit board you are 

going to install.

2222 Install the SCSI card in a free slot in the PC. 

3333 Install the SCSI software; see section ‘General note about SCSI 
devices’ on page 248.

4444 Connect the digitizer to the PC with the SCSI cable.

To install the software �
The Vidar VXR-12 is a SCSI device and does not need an additional Windows 
device driver.

5555 Make sure you are logged on as an Administrator or as a user with 
administrative rights, otherwise, the setup program will not add Reg-
istry keys.

6666 Install the ‘Vidar VXR-12’ component of the RadWorks Acquisition 
Module: in the Modules dialog of the RadWorks setup, select ‘Vidar 
VXR-12’.

To configure �
1111 Start RadWorks and select Acquire ���� Devices….
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See section ‘Device management’ on page 227 for an explanation of the 
Device Management screen.

2222 Highlight the ‘Vidar VXR-12’ line, and make any necessary changes 
to the device settings in the bottom part.

3333 To load the ‘Vidar VXR-12’ device, click Load.

4444 To activate one of the devices (default device), highlight the device 
and click Activate.

Finished
• To Test your digitizer, select the Acquisition tab, click Acquire 

Image(s), and click Scan to start digitizing. 

Summary and where to look when installation was not successful
The Setup program should have installed the following:

Device-specific configuration options 

Device Management
• “Auto Eject Film”: when Auto Eject Film is enabled the digitized 

film is removed from the scanner after digitizing, otherwise it 
remains loaded. Disabling it makes easy re-scanning of areas of a 
film possible.

• “Calibrate” button: use when sliders on the digitizer were not in the 
widest position when the digitizer was turned on.

Image Types
•  “Exposure time” on larger exposure time, scans are slower, but 

noise reduction in dark areas may be achieved.

• “Dark Enhance” can be enabled or disabled. See the Vidar documen-
tation for more information.

Additional software Adaptec EZ-SCSI 4.0 or higher

Registry Keys Imported from the file VXR_KEY.TXT on the 
CD-ROM.

Files %ROOT%\Bin\VIDAR.DLL
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Look Up Tables (LUTs)
In the Configuration ���� Acquisition dialog, there is a tab page ‘Look Up 
tables’. The VXR has a few internally defined Look Up Tables, which can be 
used. To define one, select the VXR-12 from the device list. Now it is possible 
to select the “Internal” type. From the internal LUTs listed in the drop-down 
box, select the one you want to use. In the ‘Planes’ field, enter the values to 
use with the chosen lookup table. In the next table, the available LUTs are 
listed.

For instance, to define a Power based LUT, select “Power based” from the 
drop down list, and in the planes field enter the power value, e.g. 5. If you 
select the Histogram equalized table, two values must be entered in the Planes 
field, the minimum and maximum value, e.g. 30 and 100 (%).

Table Name Parameters: (Low / High limit)

Histogram equalized 0 / 100

Linear Histogram based 0 / 100

Linear Histogram independent 0 / 4095

Linear OD N/A

Logarithmic N/A

Power based 1 to 10

Square root
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Installation and configuration of frame grabbers

Performance of frame grabber workstations in continuous mode
If the continuous mode of a Frame Grabber is switched on, a lot of data is 
transported from the Frame Grabber card to the display. For example, one 
RGB image of 576 x 768 pixels results in 576 x 768 x 3 = 1.3 MB data which 
has to be transported from the Frame Grabber card to the display. This has 
great influence on the overall performance of the system.

There are several factors that are important to the performance of a Frame 
Grab workstation during continuous mode. 

First, there are two configuration options in Configuration ���� Acquisition ���� 
General: ‘Set Zoom to 1: 1’, and ‘Minimal idle time between two grab 
actions’ on the same page. 

When the Zoom factor is set to 1:1, no additional computing is required before 
a grabbed image is displayed. This can speed up the continuous mode consid-
erably.

The “Minimal idle time between two grab actions” sometimes has to be 
increased on slower machines.  Otherwise the system has no time to handle 
other processes, like mouse movements, keyboard input etc. On fast systems 
however, it is possible to set this time to 0 msec, without any performance 
problems. 

Furthermore, it is advisable not to grab the whole image, if not all image data 
is required. In the ‘Image Type’ dialog it is possible to define an ROI (offset 
from top and left, and horizontal and vertical size in pixels). If the installed 
board supports it, only the required region is grabbed. If not, a whole image is 
grabbed, but only the ROI is displayed, which can also be much faster.

In the ‘Configuration ���� Acquisition ���� General’ dialog, there is one more 
important option: “Disable error messages during grab”. During transfer of 
the data from the frame grabber card, errors may occur. If these occur during 
continuous mode, they would break the continuous mode. To prevent this, the 
display of error messages during a grab action can be suppressed. When 
switched off, the error messages will still be logged to the RadWorks log file, 
but not displayed to the user.

It is good practice to enable error messages during setup and maintenance, and 
to disable them during normal use.
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Setting up a Matrox Meteor frame grabber board
The paragraphs from “Requirements” to “Finished” describe the basic instal-
lation steps for a Matrox Meteor Frame Grabber board. Non-essential parame-
ters will be skipped. For more information about them, see the paragraphs 
following ‘Finished’. 

Requirements
• Matrox Meteor frame grabber board

• Matrox Meteor video input cable

• Latest Matrox Meteor drivers for Windows

• Free PCI slot in PC.

• RadWorks distribution CD-ROM

To install the hardware �
1111 Take anti-static measures to protect the printed circuit board you are 

going to install.

2222 Install the Matrox Meteor board in a free PCI slot in the PC.

To install the software �
1111 Make sure you are logged on as an Administrator or as a user with 

administrative rights, otherwise, the setup program is unable to 
install device drivers.

2222 Install the ‘Matrox Meteor’ component of the RadWorks Acquisition 
Module: in the Modules dialog of the RadWorks setup, select 
‘Matrox Meteor’.

• The Matrox Meteor driver should not yet be detected in the ‘System 
Information’ report.

• Accept the DMA memory buffer size of 1Mb when you are only 
acquiring monochrome or composite color images. Increase the 
buffer size to 3Mb when you are grabbing RGB images.

• Restart your computer, to allow the operating system to load the 
newly installed device driver.

See section ‘General notes about device drivers’ on page 250.

3333 After restarting, check whether the ‘Matrox Meteor’ device driver 
has loaded properly.
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To configure �
1111 Start RadWorks and select Acquire ���� Devices….

2222 Highlight the ‘Matrox Meteor’ line, and make any necessary 
changes to the device settings in the bottom part.

3333 To load the ‘Matrox Meteor’ device, click Load.

4444 To activate a device (default device), highlight the device and click 
Activate.

Matrox Meteor Signal Types

M_RS170 RS-170, 640x480 pixels, 12.5MHz, analog

M_RS-170_LOW RS-170, 512x480 pixels, 10.0MHz, analog

M_CCIR CCIR, 768x576 pixels, 14.8MHz, analog

M_NTSC NTSC, 640x480 pixels, 3x8 bits, 12.5MHz, composite

M_NTSC_RGB NTSC RGB, 640x480 pixels, 3x8 bits, 12.5MHz

M_NTSC_YC NTSC Y/C (S_VHS), 640x480 pixels, 3x8 bits, 12.5MHz

M_NTSC_LOW NTSC, 512x480 pixels, 3x8 bits, 10.0MHz, composite

M_NTSC_YC_LOW NTSC Y/C (S_VHS), 512x480 pixels, 3x8 bits, 10.0MHz

M_PAL PAL I, 768x576 pixels, 3x8 bits, 14.8MHz, composite

M_PAL_RGB PAL I RGB, 768x576 pixels, 3x8 bits, 12.5MHz

M_PAL_YC PAL Y/C (S_VHS), 768x576 pixels, 3x8 bits, 12.5MHz

M_SECAM SECAM, 768x576 pixels, 3x8 bits, 14.8MHz, composite

M_ SECAM _RGB SECAM RGB, 768x576 pixels, 3x8 bits, 12.5MHz

M_ SECAM _YC SECAM Y/C (S_VHS), 768x576 pixels, 3x8 bits, 12.5MHz
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Finished
1111 Connect your video source to the frame grabber using the video-

input cable.

2222 To test your Frame Grabber click the Acquisition tab, click Acquire 
Image(s), and click Grab to acquire an image.

Summary and where to look when installation was not successful
The Setup program should have installed the following:

Additional Software
The Meteor driver is installed during the Setup, but it can be installed directly 
using the MILDRV.EXE program that is on the RadWorks CD-ROM. Use this 
to view the error information when the driver installation fails. 

Device specific Configuration Options
During Setup the DMA memory buffer size is set to 3 MB by default. Some-
times, it may help to set this to a higher value when the RadWorks Acquisition 
software returns errors (depends on other devices using DMA memory). You 
set the size directly via the registry key:

Key: HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Man-
ager\Memory Management

Value: NonPagedPoolQuota

Value: NonPagedPoolSize

Give the same value to NonPagedPoolQuota and NonPagedPoolSize. The 
value is in bytes. Typical values are 3MB (0xFA000 hexadecimal) or 6MB 
(0x1F4000 hexadecimal). 

The Meteor/RGB version 
of the Meteor board has 
a Y/C connector, but it is 

disabled. Therefore, it is not pos-
sible to grab an image with the 
Meteor/RGB from a Y/C signal.

Device driver METEOR.SYS, MTXDMAx.SYS

Name of device in control panel: Matrox Meteor

Registry Keys: Imported from the file ACQ_MMET.TXT on the 
CD-ROM

Files %ROOT%\Bin\MATROX.DLL
WINNT\System32\Drivers\METEOR.SYS
WINNT\System32\MIL.DLL
WINNT\System32\MILMET.DLL
WINNT\System32\MILPUL.DLL
WINNT\System32\MILHOST.DLL
WINNT\System32\MILVHOOK.DLL
WINNT\System32\MILVGA.DLL
WINNT\System32\MILTIFF.DLL
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Device Management
“Signal Type”: The Signal Type specifies the video format of the signal that 
will be grabbed via this input channel. you can select the signal type from a 
pre-defined list.

You can only use one channel, if the input signal is ‘PAL_RGB’. The signal 
type of the first channel must be “M_PAL_RGB”, and the RGB input signal 
must be connected to channel 1, 2 and 3, and the synchronization on channel 
4.

“VCR/VTR”: When the input device is a VCR or a VTR (video cassette 
recorder), the VCR/VTR option should be enabled to improve the synchroni-
zation to the input signal.

The “DCF File” option is obsolete here (not applicable for Matrox Meteor).

Setting up a Matrox Pulsar frame grabber card
The paragraphs from “Requirements” to “Finished” describe the basic instal-
lation steps for a Matrox Pulsar frame grabber board. Non-essential parame-
ters will be skipped. For more information about them, see the paragraphs 
following ‘Finished’. 

Requirements
• Matrox Pulsar frame grabber board

• Matrox Pulsar video input cable

• Latest Matrox Pulsar drivers for Windows

• Video signal source with known specifications

• Free PCI slot in PC

• RadWorks distribution CD-ROM

Hardware Installation
1111 Take anti-static measures to protect the printed circuit board you are 

going to install.

Some models of the Matrox Pulsar board provide their own VGA output. 
Using the DIP-switches, the card can be configured such that it uses the pre-
installed VGA card (e.g. a Matrox Millennium).

2222 Check whether the 2 DIP-switch settings are set to ON in case the 
on-board VGA of the Pulsar is not used, but another VGA board is 
used instead, as described above.

3333 Install the Matrox Pulsar board in a free PCI slot in the PC.
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To install the software �
1111 Make sure you are logged on as an Administrator or as a user with 

administrative rights, otherwise, the setup program cannot install 
device drivers.

2222 Install the ‘Matrox Pulsar’ component of the RadWorks Acquisition 
Module: in the Modules dialog of the RadWorks setup, select 
‘Matrox Pulsar’.
The Matrox Pulsar driver should not yet be detected in the ‘System 
Information’ report.

3333 Select a DCF file. 
This DCF file depends on the video source that will be acquired 
from. Click Help, to display a list of DCFs that are available on the 
CD-ROM. Type the name of the file you want to use. 

If no appropriate DCF is available, you have to create a DCF your-
self. In that case, select a standard DCF file such as VCR_PAL.DCF 
from the list, and select the correct DCF later via the Device Man-
agement dialog.

4444 Restart the computer, to allow operating system to load the newly 
installed device driver.

See section ‘General notes about device drivers’ on page 250.

5555 After restarting, check whether the ‘Matrox Pulsar’ device driver has 
loaded properly.

Configuration
On the Device Management dialog it is possible to select a Digitizer Configu-
ration File (DCF). Select the one appropriate to the current signal type. It is 
possible to select a different DCF File for each channel.

1111 Start RadWorks and select Acquire ���� Devices….

See section ‘Device management’ on page 227 for an explanation of the 
Device Management screen.

2222 Highlight the ‘Matrox Pulsar’ line, and make any necessary changes 
to the device settings in the bottom part.

• Enter an appropriate DCF file name for this input channel.

3333 To load the ‘Matrox Pulsar’ device, click Load.

4444 To activate a device (default device), highlight the device and click 
Activate.
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Finished
1111 Connect your video source to the frame grabber using the video-

input cable.

Refer to the Pulsar installation manual for details on attaching a video source.

2222 To test your Frame Grabber click the Acquisition tab, click Acquire 
Image(s), and click Grab to acquire an image.

Summary and where to look when installation was not successful
The Setup program should have installed the following:

Additional Software
The Pulsar driver is installed during the Setup, but it can be installed directly 
using the MILDRV.EXE program that is on the RadWorks CD-ROM. Use this 
to view the error information when the driver installation fails. 

Device specific Configuration Options

Device Management
 “DCF File”: specify the DCF file to be used for this channel

Device specific troubleshooting
• If the device driver doesn’t start, and you have also installed a 

Matrox Millennium graphics card in your system, look in the Event 
Viewer for the reason. If one of the error messages is: “The informa-
tion from Pulsar, (): Resource conflict in memory ranges..”, there 
might be a problem with the Matrox Millennium driver. Install the 
latest mga64 drivers. They can be found on the Matrox web site, or 
on the Applicare support server.

Device driver PULSAR.SYS, MTXDMAx.SYS

Name of device in control panel Matrox Pulsar

Registry Keys Imported from the file ACQ_MPUL.TXT on 
the CD-ROM

Files: %ROOT%\Bin\PULSAR.DLL
WINNT\System32\Drivers\PULSAR.SYS
WINNT\System32\MIL.DLL
WINNT\System32\MILMET.DLL
WINNT\System32\MILPUL.DLL
WINNT\System32\MILHOST.DLL
WINNT\System32\MILVHOOK.DLL
WINNT\System32\MILVGA.DLL
WINNT\System32\MILTIFF.DLL
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• The Pulsar card fails on a motherboard that does not support the PCI 
bridge feature on the Pulsar. The system then returns the error mes-
sage: “The information from the Pulsar, (): Error occurred when get-
ting PCI configuration”. Select a system with a motherboard that 
supports PCI bridging.

Matrox Intellicam
If none of the supplied DCF-files are applicable, you have to create a DCF 
yourself. In that case, use the Matrox Intellicam Software (version 2.0) for 
DOS or Windows. Files created with earlier versions of Intellicam may not be 
compatible with ones created with version 2.0.

The Matrox Intellicam documentation provides excellent help for creating a 
video source definition file, and includes a Video Specification Form to help 
you identify and document the features of your video source and a good glos-
sary terms is included.

You will need a good specification of the video signal from the modality ven-
dor, without that, it will be very hard to create a good video signal source def-
inition.

Setting up a Data Translation Mach DT3153
The paragraphs from “Requirements” to “Finished” describe the basic instal-
lation steps for the HP DeskScan device. Non-essential parameters will be 
skipped. For more information about them, see the paragraphs following ‘Fin-
ished’. Requirements:

• DT3153 PCI frame grabber board

• DT3153 PCI video input cable

• Free PCI slot in PC.

• RadWorks distribution CD-ROM

To install hardware �
1111 Take anti-static measures to protect the printed circuit board you are 

going to install.

2222 Install the DT3153 PCI board in a free PCI slot in the PC.

On some Pentium Pro machines, problems could occur because of the used 
PCI chipset. The NATOMA 82440 is working fine, but from the Orion 82450 
chipset it is known that it causes problems.
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To install software �
1111 Make sure you are logged on as an Administrator or as a user with 

administrative rights, otherwise, the setup program will not install 
device drivers.

2222 Install the device driver. Install it from the Device driver disk that is 
supplied with the Frame Grabber card, or the one that can be found 
in the 3rdparty\DT3153 directory on the RadWorks CD-ROM. 

3333 In the Start menu, select Settings ���� Control Panel ���� MultiMedia 
icon.

4444 Select Add on the Device tab and select the first entry (unlisted or 
updated drivers).

5555 Click OK, and enter the location where the Mach software can be 
found (directory 3rdparty\DT3153\NT4_0\).

6666 When asked to enter a card name (or alias), enter “DT 3153” for 
instance. Use the same alias when configuring the Mach card from 
the RadWorks software.

7777 When the configuration menu comes up, configure the Mach card 
with at least 4MB and 50 or 60 Hz (often 50 for Europe, 60 for the 
US).

8888 In order to let NT load the newly installed device driver, the PC must 
be rebooted.

See section ‘General notes about device drivers’ on page 250.

9999 After restarting, check whether the ‘DT3153 Frame Grabber’ device 
driver has loaded properly.

10101010 Install the ‘Mach DT3153’ component of the RadWorks Acquisition 
Module: in the Modules dialog of the RadWorks setup, select ‘Mach 
DT3153’ in the ‘Component Selection I’ screen.

11111111 The Mach DT3153 driver should already be detected in the ‘System 
Information’ report.

12121212 Enter the alias you entered when installing the device driver (e.g. 
“DT 3153”).

13131313 Furthermore, you will get a message reminding you that you have to 
install the Mach driver, which you already did.
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To configure �
1111 Start RadWorks and open the Acquire ���� Devices… menu.

See section ‘Device management’ on page 227 for an explanation of the 
Device Management screen.

2222 Highlight the ‘Mach DT3153’ line, and make any necessary changes 
to the device settings in the bottom part.

3333 Select the appropriate Signal Type from the list.

4444 Click Load, to load the ‘Mach DT3153’ device’.

5555 Make one of the devices active (default device) by highlighting the 
device and click Activate.

Finished
1111 Connect your video source to the frame grabber using the video-

input cable.

2222 To test your Frame Grabber, select the Acquisition tab, click 
Acquire Image(s), and click Scan to start digitizing. 

Summary and where to look when installation was not successful
The Setup program should have installed the following: 

Additional Software
Not applicable.

Device specific Configuration Options

Device Management
“Driver Alias”: the alias assigned to the device driver during installation 
(applies to the board). See section Software installation above.

Device driver DT3153.SYS, DT3153.DRV

Name of device in control panel DT3153 Frame Grabber

Registry Keys Imported from the file ACQ_MACH.TXT on 
the CD-ROM

Files %ROOT%\Bin\MACH.DLL
WINNT\System32\Drivers\DT3153.SYS
WINNT\System32\Drivers\DT3153.DRV
WINNT\System32\OLFG32.DLL
WINNT\System32\OLIMG32.DLL
WINNT\System32\DTCOLORSDK.DLL
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“Signal Type”: you can select the signal type from a pre-defined list.

Device specific troubleshooting
• If the grabbed image looks distorted, possibly the card is configured 

at the wrong frequency (60 Hz instead of 50 Hz, or the other way 
around). You can change the settings via ‘Start menu | Settings | Con-
trol Panel | Multimedia | Devices | Other Multimedia devices | DT-
Open Layers DT3153 Mach Series Frame Grabber | Properties’.

Setting up an Foresight HI*DEF Plus or Accura frame grabber
The paragraphs “Requirements” until “Finished” will show you the basic 
steps for installing the Foresight HI*DEF Plus (ISA) or Accura (PCI) frame 
grabber. Parameters not essential to the situation will be skipped. You can find 
more about them in the paragraphs following “Finished”. 

Requirements
• Foresight HI*DEF Plus or Foresight Accura frame grabber board

• Foresight video-input cable

• video signal source with known specifications

• Free ISA slot in PC for HI*DEF Plus or PCI slot for HI*DEF 
Accura.

• RadWorks distribution CD-ROM

To install hardware �
1111 Take anti-static measures to protect the printed circuit board you are 

going to install.

2222 Check the jumper settings on the board.

• The default I/O address range is 2D0h-2DF.

3333 Install the Foresight HI*DEF board in a free ISA/PCI slot in the PC.

To install software �
1111 Make sure you are logged on as an Administrator or as a user with 

administrative rights, otherwise the setup program will not install 
device drivers.

2222 Install the ‘Foresight HI*DEF Plus’ component of the RadWorks 
Acquisition Module: in the Modules dialog of the RadWorks setup, 
select ‘Foresight HI*DEF Plus’ in the ‘Component Selection I’ 
screen.
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3333 The Foresight HI*DEF Plus driver should not be detected in the 
‘System Information’ report.

4444 The board requires a CHP file to configure the board for the given 
signal type.
Copy the appropriate CHP file to the %ROOT%\Bin directory.
A few samples are given in the directory 3rdparty\Foresight\Chp on 
the RadWorks CD-ROM. If none is suitable, you have to create a 
CHP file, using the HDP_AUTO.EXE or HDPSETUP utility. See 
the HI*DEF documentation, for more information.

5555 In order to let NT load the newly installed device driver, the PC must 
be rebooted.

See section ‘General notes about device drivers’ on page 250.

6666 After restarting, check whether the ‘hd4nt’ device driver has loaded 
properly.

Configuration
1111 Start RadWorks and select Acquire � � � � Devices….

See section ‘Device management’ on page 227 for an explanation of the 
Device Management screen.

2222 Highlight the ‘Foresight HI*DEF Plus’ line, and make any necessary 
changes to the device settings in the bottom part.

3333 Enter an appropriate CHP file name and path.

4444 Load the ‘Foresight HI*DEF Plus’ device by clicking ‘Load’.

5555 Make one of the devices active (default device) by highlighting the 
device and pressing ‘Activate’.

Finished
1111 Connect your video source to the frame grabber using the video-

input cable.

2222 Test your frame grabber by selecting the ‘Acquisition’ tab, press the 
‘Acquire Image(s)’ button, and press ‘Grab’ to acquire an image.

Summary & where to look when installation was not successful
The RadWorks Acquisition Setup program should have installed the follow-
ing: 
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Additional Software
HDPSETUP.EXE and HDP_AUTO.EXE are utilities delivered by Foresight 
for creating and editing CHP files (video signal specification files).

HDP_AUTO is Foresight’s Auto-SYNC utility, which automatically scans the 
video inputs of the Foresight HI*DEF Plus/Accura and tries to detect the type 
of signal that is connected to it. The result is stored in a CHP file. Auto-SYNC 
is only intended to give you a .CHP file that is pretty close to what you need; 
you will still need to adjust some of the parameters. Use HI*DEF Plus Setup 
(HDPSETUP) to do the final adjustments to your configuration file.

HDPSETUP is a CHP-file editor/testtool.

The tools require an expanded memory manager to be present, so you need to 
boot from a DOS floppy. Some environment variables need to be set before 
running the tools.

CHP files are ASCII text files and may be edited with a normal text editor as 
well.

Device specific Configuration Options

Device Management
“CHP File”: specify a CHP file to be used for this channel.

The board requires a CHP file to configure the channel for a given signal type. 
A few samples are given in the directory 3rdparty\Foresight\Chp on the Rad-
Works CD-ROM. If none is suitable, you have to create a CHP file, using the 
HDP_AUTO.EXE or HDPSETUP.EXE utility. See the HI*DEF documenta-
tion, for more information.

Device driver HD4NT.SYS

Name of device in control panel Hd4nt

Registry Keys Imported from the file ACQ_HDEF.TXT on the 
CD-ROM.

Files %ROOT%\Bin\FORESIGHT.DLL
WINNT\System32\DriversS\HD4NT.SYS
WINNT\System32\HDPW32NT.DLL
WINNT\System32\HD_TW32.DLL



GEMS IT Applicare

245

Installing and configuring TWAIN devices

This section describes the support for TWAIN devices. 

TWAIN defines a standard software protocol and Application Programming 
Interface (API) for communication between software applications and image 
acquisition devices.

(See http://www.visionshape.com/whitepaper.html to read more about the 
TWAIN standard).

Currently the RadWorks TWAIN interface has only been tested with the HP 
ScanJet Scanners (Source DeskScan II 2.5). No guarantees can be given for 
other TWAIN devices.

Therefore the installation and configuration will be explained for the HP 
DeskScan document scanner.

The HP DeskScan supports rescanning of a selected area.

The paragraphs “Requirements” until “Finished” will show you the basic 
steps for installing the HP DeskScan device. Parameters not essential to the 
situation will be skipped. You can find more about them in the paragraphs fol-
lowing “Finished”. 

Requirements
• HP DeskScan

• SCSI card

• SCSI cable

• RadWorks distribution CD-ROM

To install the hardware �
1111 Take anti-static measures to protect the printed circuit board you are 

going to install.

2222 Install the SCSI card in a free slot in the PC. 

3333 Install the (Adaptec or other) SCSI driver software. 

See ‘General note about SCSI devices’ on page 248. 

4444 Connect the document scanner to the PC with the SCSI cable.
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To install the software �
The HP DeskScan is a SCSI device that operates via TWAIN and does not 
need an additional Windows device driver.

1111 Make sure you are logged on as an Administrator or as a user with 
administrative rights; otherwise the setup program will not add Reg-
istry keys.

2222 Install the HP DeskScan software (version 2.3.1.a or higher). This 
can be obtained from the Hewlett Packard web site (http://
www.hp.com), or from the directory \3rdparty\DeskScan on the Rad-
Works CD-ROM. See the README.TXT in the directory \3rdparty 
for installation instructions.

3333 After installing the DeskScan software, the Start menu contains a 
group named HP DeskScan II. These programs can be used to test 
the connection to the scanner. If these work properly, it should also 
work properly from the RadWorks Acquisition Module.

4444 In order to let Windows load the newly installed TWAIN source and 
device drivers, allow the installation program to reboot the PC.

5555 After the PC has rebooted, test the ScanJet with the ScanJet applet in 
Control Panel.

6666 Install the ‘TWAIN Scanner’ component of the RadWorks Acquisi-
tion Module: in the Modules dialog of the RadWorks setup, select 
‘TWAIN Scanner’ in the ‘Component Selection III’ Screen.

To configure
1111 Start RadWorks and select Acquire ���� Devices….

See section ‘Device management’ on page 227 for an explanation of the 
Device Management screen.

2222 Highlight the ‘TWAIN Scanner’ line, and make any necessary 
changes to the device settings in the bottom part.

3333 Select a document scanner (DeskScan II) as Source.

4444 Load the ‘TWAIN Scanner’ device by pressing ‘Load’.

5555 Make one of the devices active (default device) by highlighting the 
device and pressing ‘Activate’.

Finished
Test your Document Scanner by selecting the ‘Acquisition’ tab, press the 
Acquire Image(s)’ button, and press ‘Scan’ to start digitizing. 
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Summary and where to look when installation was not successful
The Setup program should have installed the following:

Known problem:When the German Windows version is used, it is not possible 
to start the RadWorks Setup after an installation of the DeskScan 2.5 software. 
Suggested is to install RadWorks and the Acquisition module completely 
before doing a DeskScan setup.

Device specific Configuration Options

Device Management

“Source”: Before using the TWAIN digitizer, a source must be selected. Select a docu-
ment scanner here.
“Force Scan”: First action of user must be a scan with the TWAIN device, 
regardless of the currently active device. In some countries it is required to 
store a scan of a patient card together with the patients images.

“Enable Source UI”: If the option Enable Source UI is enabled, the user can-
not use the predefined Image Types. These buttons are removed from the 
Acquisition Tab. When the Digitize button is pressed, the User Interface of the 
selected TWAIN source is activated. After scanning an image, the image is 
inserted into RadWorks.

Additional software Adaptec EZ-SCSI 4.0 or higher
DeskScan 2.3.1.a or higher

Registry Keys Imported from the file TWAIN_KEY.TXT on the CD-
ROM.

Files %ROOT%\Bin\RWTWAIN.DLL
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Installing and configuring the acquisition utilities

The Graphics File and Clipboard Reader can be installed for inserting image 
data from graphic files and the Windows clipboard. The emulators can be 
installed to test or demonstrate the frame grabbing and digitizing functionality 
of RadWorks.

To install the hardware �
No additional hardware is required.

To install the software �
For the frame grabber emulator, the digitizer emulator and the graphics file & 
clipboard reader, run the Acquisition Setup program and select the appropriate 
devices.

1111 In the Modules dialog of the RadWorks setup, select the appropriate 
devices in the ‘Component Selection III’ Screen.

Summary

General note about SCSI devices
To access a SCSI device from the RadWorks Acquisition Module, the Adaptec 
EZ-SCSI 4.0 (or higher) software must be installed. It must be installed before 
the RadWorks Acquisition Module is installed. This is not freeware, so it is 
not on the RadWorks CD-ROM. Upgrades can be downloaded from the Inter-
net (http://www.adaptec.com).

When the Adaptec software is installed, there should be a program group 
labeled Adaptec EZ-SCSI 4.0. One of the programs in this group is the SCSI 
explorer. When started, all attached SCSI devices should be listed on the Inter-
rogator tab. If not shown here, check the following: 

• The PC was powered up before the SCSI device. Shut down, switch 
off the computer, switch on the SCSI device, and start the computer.

Registry Keys See the following files:
EDIG_KEY.TXT for the Digitizer Emulator
EFRG_KEY.TXT for the Frame Grabber Emulator
FDEV_KEY.TXT for the Graphic File and Clipboard 
reader.

Files %ROOT%\Bin\FILEDEV.DLL
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• Each SCSI device has a SCSI address, or also named a SCSI ID. 
Two SCSI devices cannot have the same SCSI address. If that is the 
case, shut down the computer and the devices, and change the SCSI 
address. Most devices have a SCSI address wheel, which can be 
adjusted with a small screwdriver. 

• The system crashes when starting the SCSI Explorer. Install the lat-
est WNASPI drivers. They can be found on the Adaptec Web site, or 
in the directory \3rdparty\Adaptec on the RadWorks CD-ROM.

• Maybe the SCSI card has not been mounted correctly into the sys-
tem, or the SCSI cables are not connected correctly. Shut down, and 
check.

 When two or more SCSI 
cards are installed, it is 
possible that those 

cards have the same ID in the list 
on the SCSI Explorer Interrogator 
tab. This should not cause any 
problems, because it is the ID as 
seen from the SCSI bus, not inter-
nal in the system.
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General notes about device drivers

Some devices require a device driver. The RadWorks Setup program installs 
them. After installation, the system has to be rebooted to allow Windows to 
load and start the newly installed device driver. If the device driver did not 
start correctly, the message “At least one driver failed to start” will be dis-
played at logon.

• To check the status of the device driver, select Settings ���� Control 
Panel ���� Devices from the Start menu. In the device list, search for 
the required device driver. The status should be “Started”.

• If the device is not started, select Programs ���� Administrative 
Tools ���� Event Viewer from the Start menu. If a device driver could 
not start, error messages are logged here. Errors are marked with a 
red Stop sign.

Another tip is to check whether the device is visible in the Windows Diagnos-
tics. Start this from the Start menu, select Programs ���� Administrative Tools 
���� Windows diagnostics.

To see which resources a device is using, click the Resources tab and then 
select Devices. The device should be listed here. Double clicking the device 
name to display more detailed information. Also, when you select ‘IRQ’ the 
device should be visible. If not, there might be an interrupt problem. Maybe, 
the acquisition device is claiming an interrupt or that an I/O port is used by 
another device. If so, refer to the acquisition device’s manual on how to 
change this.
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This chapter describes how to use RadWorks in a multi-user environment and 
security and auditing options. 

Windows configuration ...........................................252
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he aim of the multi-user capabilities of RadWorks is to allow multiple 
users to share a single RadWorks installation on a computer (sequen-
tially, in time) while seeing only the work and studies that they have to 

do, as well as being able to store their preferred settings. 

In addition, the users can log on to different computers to be able to do their 
job on those machines while maintaining their personal settings and configu-
rations. 

To achieve this, RadWorks uses a combination of mechanisms:

• With Windows’ roaming user profiles and policies, a user can log 
into any system on the network and use his own Windows settings 
and preferences. 

• With the RadWorks Settings Tool, a user’s settings in RadWorks can 
be copied to any RadWorks station on the network. 

When you copy the RadWorks settings, the hardware configuration of these 
machines need to be comparable (in terms of number of monitors, screen res-
olution, etc.) in order not to compromise the work.

Some of the subjects in this chapter are specific to your Windows version. For 
in-depth information on profiles and policies we refer you to Windows docu-
mentation, Microsoft TechNet and on-line documentation, such as “The Win-
dows NT FAQ” by John Saville (www.ntfaq.com) and “The Windows 2000 
FAQ” by John Saville (www.windows2000faq.com).

Windows configuration

You can use the following procedure for both Windows NT 4 and Windows 
2000 systems. 

You need the policy editor (poledit.exe) program for this procedure. If you use 
Windows 2000, copy the poledit program from a Windows NT 4 system or 
installation CD. Windows 2000 uses a new system for administering these 
policies, but the old policy editor can still be used. 

T
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Roaming (roving) profiles
Customers may want to maintain their RadWorks settings when they move 
around the hospital. Normally, all changes a user makes to his system are 
saved locally, in the \WINNT\Profile\<user name> directory. In order to allow 
the user to use those settings network-wide, the user profile has to be stored on 
a network share, so that it can be downloaded each time the user logs on. 
When the user logs off, the network profile is updated, and a copy of the pro-
file is saved locally.

Contact the system administrator of the site to set it up, or you can configure 
roaming profiles on a Windows NT 4.0 Server as follows:

First create a Default User:

1111 Log on to a workstation as a user without Administrator rights. Set 
up your desktop and change the settings that you want to change. 
Log off from the workstation. The profile is created at this point.

2222 Log back onto the workstation as a user who has Administrator 
rights to the local computer, as well as in the domain. In the System 
tool in Control Panel, click the User Profiles tab. Select the user's 
profile that you created in the previous step.

3333 Click Copy To, which will display a dialog box that allows you to 
specify where the profile is going to be copied, as well as being able 
to specify who is ‘Permitted to Use this profile’. To create the 
Default User Profile (base profile) you should permit the group 
‘Everyone’ to be able to use the profile. Next, in the ‘Copy To:’ field, 
type the server and the share name, as well as the profile name where 
you want to copy this profile to (click Browse, to locate the com-
puter and directory you want to copy the profile to).

It should be in this format:

\\Servername\Sharename\Profilename

Copy this profile to the Netlogon share and rename the profile 
Default User. This will enable Windows to create a new profile 
based on this profile for a user who does not already have a central or 
local profile.

4444 Now, when you log on to a computer, in the System Control Panel, 
on the User Profiles tab, the logon user profile type should be Roam-
ing.

To disable profiles stored locally to RadWorks �

1111 Start the registry editor (regedit.exe).

The profile name will 
actually be a directory 
name and the profile 

consists of the entire directory, 
and all subdirectories and files.

This Default User profile 
will be used to create 
new Roaming Profiles as 

well as new local profiles.
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2222 Open HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Win-
dows NT\CurrentVersion\Winlogon 

3333 Create a value called DeleteRoamingCache of type DWORD

4444 Set the value to 1

RadWorks settings 
Whenever a user logs off, the RadWorks settings are copied to the Server and 
becomes part of the roaming profile.

RadWorks only registers changes made by the current user to the default set-
tings and stores them in the HKCU\Software\AMI\RadWorks\6.0\ key. 

For example, when a user has added a new Automated Hanging Protocol on a 
single monitor RadWorks system, this will be available to him whenever that 
user logs on to a similar RadWorks system (one monitor). This will not be the 
case if the user logs on to a multi-monitor RadWorks system!

Windows security settings
The System Policy Editor is used to manage the permissions and settings for 
users in an environment with multiple workstations.

Feature overview
• Support multiple groups and multiple users (accounts).

• Use the normal log-on procedure of Windows 2000/NT.

• Support both domain controllers (roaming profiles) and local 
machines (local profiles) for storage of permissions, features, and 
user settings.

• Permissions can be set RadWorks wide or Module wide.

• Features/Simplification can be set per group, user or computer.

• Configuration can be set per group or user that override system 
(domain or local) settings.

Users
Several categories of users can be defined that use RadWorks for different 
purposes, e.g. radiologists, referring physicians, administrators, radiographers 
and nurses.

This tool is part of a Win-
dows NT 4.0 Server 
installation, or can be 

purchased as part of the NT 
resource toolkit.

The System Administra-
tor can also install a 
screen saver protected 

with a password with the default 
Windows profile.
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These groups should have different rights to do certain tasks, i.e. a radiologist 
is allowed to view a study while it has not yet been reported, whereas, a refer-
ring physician may only view a study when it has been verified. Likewise, 
support personnel may, for example, have the right to delete studies from the 
local system, whereas, this is not the case for referring physicians.

Also there is a permission that defines who can define the security on the sys-
tem. By default, this permission is held by (local) system administrators or 
domain administrators, but it could also be given to existing or new groups or 
individual users.

In addition, these users (whether of the same category or not) will want to 
change their settings or preferences, without changing the settings of other 
users.

Defining the security model
To allow a security model to function properly each user has a separate 
account for identification purposes when logging on to the computer . There-
fore, an account needs to be created for each user. This is done in the usual 
Windows 2000/NT fashion using the “User Manager” of the “Administrative 
Tools”. Create appropriate groups of (logically related) users, to simplify the 
definition and maintenance of the security model, so permissions can be 
granted or removed from groups of users at once rather than per user.

If a Windows domain server is available on the network and the local worksta-
tions are part of the domain you can define so-called domain accounts, so a 
user can automatically log on to any workstation on the network. 

Once these accounts have been defined, the security model can be created. 
The System Policy Editor (poledit.exe) should be used for this purpose. Poli-
cies (.pol files) are defined based on template files (.adm files) . These policies 
can contain settings for users, groups, and computers. They reside either on 
local workstations or on a network server.

A RadWorks template is supplied on the RadWorks CD ROM. Copy this file 
to the (hidden) INF directory in the Windows NT Server directory, which is 
the default directory for .ADM files.

For demonstration purposes, you may want to set up a policy file on a stand-
alone system, such as a laptop. 

To set up a policy file �

1111 Save the policy file in the \WINNT\Inf directory.

IYou can configure the 
domain server so a user 
can only log on to one or 

several workstations. How long a 
user may access the computer 
can also be configured. If a 2000/
NT server is not available, the 
accounts have to be (re)created 
on every computer the user wil 
log on to.
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2222 Open the following registry key: HKLM\System\CurrentCon-
trolSet\Control\Update and add the following value: Network-
Path REG_SZ \%systemroot%\Inf\<policy filename>

3333 Change the value of the key UpdateMode to 2

The System Policy Editor divides policies into two main groups, namely 
Users and Computers. You can add individual users or groups to a policy and 
,subsequently, define permissions and settings which differ from the default 
values. The following figure displays a sample policy in the System Policy 
Editor with the properties for one user shown. 

Performance
The multi-user capabilities are not expected to have an impact on existing per-
formance. Even when using roaming profiles (profiles stored on the server). 
These are cached locally upon logging on to the workstation, so there is no 
performance penalty once the user is logged in. However, it may take longer 
for users using roaming profiles to log on and off to the workstation.The rea-
son is that the roaming profile has to be downloaded from or uploaded to the 
Windows 2000/NT server.
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Reliability and safety issues
To a large extent the multi-user capabilities depend on Windows 2000/NT 
security. The administrator or system engineer must create the security model 
and should reflect the current workflow in which users do not have too many 
capabilities.

If a domain server is not available on the network, the security model can dif-
fer between machines.

Creating a RadWorks policy file
To set policies for RadWorks users, create a new policy file and add the Rad-
Works templates to it. 

Create and edit a policy file �

1111 Copy the RadWorks template from the Template directory on the 
RadWorks CD-ROM to the WINNT\INF directory.

2222 Start the Policy Editor.

3333 Select Options → Policy Template, to display the following dialog 
box. 

4444 By default, two templates are available. Click Add, browse to the 
WINNT\INF directory and select the RadWorks template.
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5555 Click OK.

6666 If you already have a policy file, open it. If not, create a new one.

Create new policy
When you select to create a new policy, two components will be available.

The Policy Editor works like the User Manager; you can add Computers, 
Groups and Users. The latter will automatically be added to the User 
(Domain) Manager, once the Policy has been saved.

To edit the policies, select the newly added Computer, Group or User. Then 
select Edit → Properties.
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Editing RadWorks permissions
Open the AMI tree and browse through the various permissions and features. 
Check or uncheck check marks to change permissions. 

Overview RadWorks Permissions
RadWorks distinguishes between two types of permissions:

RadWorks wide (permissions)
These permissions enable / disable features which are available throughout the 
RadWorks product line, independent of added modules.

Module wide (features)
These permissions enable / disable features which are available in a specific 
part of the RadWorks product line or which are dependent on added modules.

By default, all features are enabled during the installation of RadWorks and 
can only be disabled by using the Policy Editor on a Windows NT Server.

Contents of the RadWorks Permissions policy template (AMI.adm)
The purpose of this template is to either allow or deny a user or a group cer-
tain actions within RadWorks.

Contents of the RadWorks States policy template (AMIStat.adm)
The purpose of this template is to pre-set study statuses for a user or a group 
of users. 
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To display a list of the permitted statuses, click Show at the bottom of the dia-
log window.

If the list is empty, or if you wish to add to existing statuses, click Add.
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RadWorks Settings tool

With the RadWorks Settings tool, you can create a file that contains Rad-
Works’ settings, and copy these to another computer. See ‘Creating user pro-
files’ on page 48.
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RadWorks access control

RadWorks has functionality to control access to specific study data, to comply 
with HIPAA requirements. Access control is implemented as a HIS-RIS trans-
action. It is normally handled by the Default HIS/RIS Implementation, but it 
can be integrated with other external applications.

The internal HIS/RIS implementation has been extended to process this trans-
action and call a (configurable) script. This script is called before proceeding 
with the requested action. If the script returns false the access is denied. 

Use the internal HIS/RIS configuration dialog to control access to RadWorks �

1111 Select Configuration → Generic... from the Data Selector menu 
bar.

2222 Click the HIS-RIS tab of the Generic Properties dialog box and 
select the ‘Internal HIS/RIS Implementation’.

3333 Click Modify.

4444 Check the ‘Check Access Control’ check box.

5555 Click Script to change the script that does the actual checking. 

6666 Bind the ‘Transaction’ functionality to the ‘Internal HIS/RIS Imple-
mentation’.

This is a sample Access Control script:

This sends the User name, Access Level (i.e. type of access) and Workstation 
name, along with the Patient ID, Patient Name and Study ID for which access 
is requested. 
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Audit trail

RadWorks can log actions performed on study data in order to create an audit 
trail as required by HIPAA. This is implemented as a HIS-RIS notification. 

Normally, it is handled by the Default HIS/RIS Implementation, but it can be 
integrated with other external applications.

With the Default HIS/RIS Implementation, it offers basic logging to a plain 
text file. 

To enable logging �

1111 Select Configuration → Generic.... from the Data Selector menu 
bar.

2222 Click the HIS-RIS tab. 

3333 Select ‘Internal HIS/RIS Implementation’.

4444 Click Modify.

5555 Check the Log Audit Trail box. 

A log file (auditlog.log) will be created. A typical log line made by the inter-
nal implementation logs the user name, the system name, a description of the 
action, the patient name and id, and the study instance UID (if applicable).

The following actions are logged:

Action Audit Trail 
message RW DBS CS PS

Start RadWorks RadWorks started x

Stop RadWorks RadWorks stopped x

Access granted/
denied

Log all IsAccessAl-
lowed() calls

x x x x

Query database Query <param> x x

Remote Query data-
base

Query <param> x

Info dialog Info x

Move to folder Move to <to> x

Actions logged
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Compress folder (De)compress x

Send (data selector) Send x

Send (viewing) Send x

Auto-route Send x

Storage-Commit 
received

Storage Commit x

MPPS messages MPPS x

Report load (via 
HIS/RIS DLL)

Report load x

Report save (via 
HIS/RIS DLL)

Report save x

Print (data selector) Print x

Print (virtual film 
sheet)

Print x

Print (viewport) Print x

Delete study Delete x

Delete series Delete x

Delete image Delete x

Delete by mainte-
nance

Deleted by mainte-
nance

x

Delete after send Deleted after send x

(un)lock (un)lock x

set status StudyStatusId <old 
status> <new sta-
tus>

x

View image (stan-
dard)

View x

View image (with 
save)

View x

Open for QC QC Open x

Open copy for QC QC Copy x

MPR/MIP View x

Create new images 
(MPR/Acq)

Image created x

Actions logged



GEMS IT Applicare

265

Save study changes Save x

Archive (copy study 
to)

Archive store x

Import from Archive Archive import x

Study via input 
directory

Receive x

Receive study Receive from <ori-
gin>

x

Integration module 
(exe)

Run exe x

Integration module 
(HIS/RIS)

Run HIS/RIS x

Integration module 
(web)

Run web x

Actions logged
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This chapter describes how to maintain the RadWorks workstation. 
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nce you have your RadWorks workstation installed, it is important to 
keep it running optimally. RadWorks contains many features to help 
you maintain the system.

The Database Service is one of the underlying services of RadWorks. It is 
responsible for the file handling in the local database. It contains options to 
manage the data, e.g. to prevent too much data on the workstation’s harddisk. 

Automatically cleaning up data 

The hospital wants the system to check every morning at 9.00 AM and every 
evening at 6.00 PM for images received three days ago which are still on the 
disk. The hospital also wants the system to delete reviewed images that are in 
the ‘General’ folder, if less than 10% of the disk space is free.

Auto Delete
The Auto Delete function will allow you to automatically delete files from the 
database, to free more disk space. This will be done according to the SQL 
rules you specify. The Auto Delete function is activated during a Maintenance 
run of the Database Service.

Select Configuration → Database Service and click the Auto Delete tab, to 
display the following dialog box.

There are two auto deleting methods. Age deletion and disk space deletion.

O
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Age deletion
Age deletion will delete images, which have been on the system for a certain 
time. In this case, Time to Wait is 3 DAYS and Date Stamp to Use is CRE-
ATE. The SQL-rule should specify that this deletion rule only applies to the 
‘General’ folder, so the complete SQL-rule will be:

31091009 = ‘General’

(note the single quotes around the value of the field). If there is no SQL-rule 
defined, the Auto Delete will not work. You can separate statements with a 
return. They will be executed from top to bottom.

Date stamp to use
Type of data stamp to use in the checking of the age of the data. This can be:

• CREATE: time the data was created (= data added to local database).

• MODIFIED: time the data was saved last (e.g. saving window lev-
els)

Disk space deletion
Disk space deletion will delete images when the used disk space reaches a 
limit. In this case it is set to 90%. Specify on which drive the Disk Deletion 
should take place (“C:”), specify the allowed amount of used disk space after 
the deletion (“70%”), and specify the maximum allowed amount of used disk 
space (“90%”). Just as in the Age deletion, if there is no SQL-rule defined, the 
Auto Delete will not work. You can separate statements with a return. The 
system will check after each line if the required amount of free disk space is 
reached. If not, the next statement is executed.

Deletion is performed on a First In First Out basis (FIFO).

SQL rules
SQL rules exist of a number of Boolean expressions which can contain the 
words AND, OR and can contain brackets ‘()’ for ordering. The following 
variables are stored by the Data Selector and can be used in the SQL rules:

DICOM Tag Description

[dcm31091002] Status (Applicare’s proprietary statuses NEW and SEEN)

[dcm0032000A] Status1 (DICOM Study Status ID)

[dcm31091008] Origin

[dcm31091009] Folder

Variables stored by Data Selector
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Examples: 
To find all studies from a modality:

dcm00080061 like ‘%MR%’

The ‘like’ statement is used because the Modality tag can contain multiple 
values. Presentation states, for instance, are listed as modalities. 

To find all studies from referring physician ‘Jansen’, with modalities MR or 
CT:

dcm00080090 = ‘Jansen’ AND (dcm00080090 = ‘MR’ OR dcm00080090 = ‘CT’)

Maintenance Run
In the maintenance run, the Database Service checks the consistency of the 
database and executes the Auto Delete command(s) at the set Maintenance 
Times.

Consistency checks are, for example:

• Compare contents of local.mdb with data files in the RadWorks fold-
ers. If the data is not found in the local.mdb, but in a folder, it is 
added to the local.mdb

[dcm00100010] PatientName

[dcm00100020] PatientID

[dcm00100030] PatientBirthDate

[dcm00100040] PatientSex

[dcm00080020] StudyDate

[dcm00080030] StudyTime

[dcm00080050] AccessionNumber

[dcm00200010] StudyID

[dcm00080090] ReferringPhysician

[dcm00081030] StudyDescription

[dcm00080060] Modality

DICOM Tag Description

Variables stored by Data Selector
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• Select Configuration → Database Service, and click the Mainte-
nance tab to display the following dialog box.

When the service is started, a maintenance run is done after the Startup Delay 
has expired. This delay (in seconds) gives the Database Service enough time 
to start up completely. After the Service started correctly and the initial Main-
tenance Run is completed, the system will perform three regular Maintenance 
Runs at the specified Maintenance Times. You can modify these times or add 
new ones, according to the customer’s requirements. In our scenario, they 
should be set to 9.00 and 18.00.

If you want to increase or decrease the Thread Priority, you can set it from 
IDLE (least priority) to HIGH (most priority).
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RadWorks software patches

A Software Patch is used to distribute resolved (severe) deficiencies that have 
become evident after a release. A Software Patch is a single executable that is 
run on a system on which RadWorks has been installed. It updates existing 
executables and DLLs at the binary level. 

How to apply a software patch
Before applying a software patch it is best to read the accompanying release 
notes or any internal documentation supplied by your own company first.

When you have determined that a particular RadWorks systems needs to be 
patched, run the patch.

The patch program will automatically stop all the RadWorks Services, then 
unpack the compressed binaries and copy them to their appropriate directo-
ries. During this part of the patch, the program checks for the existence of a 
file, then checks the version of the file and, subsequently, overwrites the file 
with the new version.

When encountering problems
When encountering problems (for example, one of the Services was not 
stopped and the Software Patch was not able to change a file) some error mes-
sage will typically be displayed. Correct the problem and rerun the Software 
Patch. Note that there is no harm in running the Software Patch more than 
once because on subsequent runs the program will notice that the files already 
have been modified and, consequently, do nothing.

How to verify what software patch level a system has
There are two ways you can check which Software Patch level a RadWorks 
system has:

The ‘About’ box
Start RadWorks and select Help ���� About. 

The build number displayed in the ‘Version’ box is the build number of the 
RadWorks executable (RadWorks.exe), which may differ from the build num-
ber of the other binaries. When you click Details, the system lists in detail 
which version of each file is installed and which patches have been applied. 
When a patch is listed with “install date unknown”, that means the patch was 
part of the original installation (instead of being applied at a later date). For 
example, when all patches up to level 9 read “install date unknown”, that 
means your installation CD-ROM contains RadWorks 6.0 at patch level 9.
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Healthpage
The RadWorks Healthpage (\bin\Healthpage.exe, see ‘Getting system infor-
mation’ on page 283) gives status information on RadWorks. Click Version of 
Files to see which patch level the system has. 
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Upgrading

RadWorks 1.x to RadWorks 6.0
It is not possible to upgrade version 1.x to RadWorks 6.0. If you have a Rad-
Works 1.x system, you can install RadWorks 6.0 on the same system whilst 
keeping the 1.x version.

Remove RadWorks 1.x manually as described in the RadWorks 1.3 manual.

RadWorks 2.1, 4.0, 5.x to RadWorks 6.0
This subject is covered extensively in the Installation Chapter.

Known upgrade issues
This paragraph contains information on possible problems that might occur 
during an upgrade process.

If you encounter problems that are not discussed here, don’t hesitate to send 
an E-mail to support@applicare.com.

Windows
• The RadWorks 6.0 services use ODBC (MS-Access driver). This can 

lead to problems with other applications trying to install/delete 
ODBC drivers. Before installing such an application stop all Rad-
Works 6.0 services. 

• Do not run any previous version of RadWorks on the same machine 
(if you can not avoid this, use a different Windows NT boot for each 
installation).

• Use caution when installing beta and/or pre-release 3rd party soft-
ware on RadWorks 6.0 systems.

Dongles and license files
• When upgrading an existing RadWorks 2.1, 4.0 or 5.x system you 

will also need to obtain RadWorks 6.0-specific dongle upgrade 
codes. You can then upload these codes into the dongle (using 
Upgrade.exe, found in the \bin directory).

Viewing
• Although the minimum resolution in which RadWorks 6.0 is allowed 

to run is 800x600 (SVGA), you may experience some problems dis-
playing tooltabs with that resolution. We recommend you run Rad-
Works in at least 1024x768 (XVGA).

RadWorks 1.x is not 
Y2K compliant. Techni-
cal support s no longer 

provided for this version.

RadWorks 1.x was designed to 
run on Windows NT 3.51 systems. 
Upgrading such a system, usually, 
also means new hardware and a 
Windows 2000 license.

Dongles can not be 
downgraded.
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Connection Service
• When creating a new destination the port number is set to 104 by 

default. When adding a RadWorks 2.1 system as a destination using 
DICOM, change the port number to 3120, when adding a RadWorks 
4.0 or 5.x system as a destination using DICOM, change the port 
number to 3140.
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Workgroup Server

Users connected to server
In RadWorks Workgroup Clients, the Help menu contains a 'Users…' item. 
Click this item and a dialog box appears that will query the server for the 
active connected clients. Click Refresh to query the server again.

Monitoring the performance of the Database Service
In the Configuration → Database Service → General tab the 'Performance 
monitoring' checkbox is displayed. When this feature is enabled, a new log 
file (default name DBS_Performance.log) will be created that contains a line 
for each function called. These lines have the following syntax:

<time> [thread] <function>: <status>

<status> can have one of four values:

• BEGIN function is called,

• START functionality is started (START-BEGIN is wait time),

• FAILED functionality failed,

• END functionality successfully performed.

This feature is meant for measuring the usage/performance of a workgroup 
server. Only use it for diagnostic purposes and turn it off during normal opera-
tion.

The logging level is automatically set to ‘ALL’ and can only be changed in the 
registry:

HKLM/Software/AMI/Database/5.0/Performance/Logging

Valid levels are: NONE, LOW, NORMAL, HIGH and ALL.
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Making backups

Since RadWorks is highly configurable, it is recommended that you make 
backups of the following after the system is configured to your satisfaction 
and all settings are working correctly.

Copy the following RadWorks files to a safe location:

• %ROOT%\connect\connect.mdb

• %ROOT%\print\print.mdb

• %ROOT%\ait\ait.mdb 
(if the Single Media Archiving module is installed)

• %ROOT%\samples\reports\*.*
(if the user has created report templates and stored them in this direc-
tory)

Copy the following Windows files to a safe location:

• \winnt\profile\<user name>\ntuser.dat

where <user name> is the name of each user working with RadWorks. This 
file contains the complete HKEY_CURRENT_USER registry hive, which 
includes the personal settings of RadWorks. Create subdirectories per user on 
the safe location and copy the relevant ntuser.dat file to its appropriate direc-
tory.

Exporting Registry settings
The RadWorks Settings tool allows you to easily create backups of the Rad-
Works settings in the Registry. You can backup the system-wide settings (in 
the HKEY_LOCAL_MACHINE\Software\AMI hive) and user-specific settings (in the 
HKEY_CURRENT_USER\Software\AMI hive). 

To back up Registry settings �

1111 Start the RadWorks Settings tool. In the \bin directory, start Rad-
WorksSettingsTool.exe. 

2222 To back up the settings for the user that is currently logged in, click 
RadWorks User. 

3333 To back up the system-wide settings, click RadWorks System. 

4444 For both settings, you can specify a location. The settings are 
exported as an XML file. 

Make sure the 
exported file has the 
correct (user) name.
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5555 You can move user settings between computers. This way you can 
ensure a user has his own settings on each RadWorks station he uses. 
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Defragmentation

Hard disks can become heavily fragmented when a large number of files are 
stored and deleted at regular intervals. Fragmented image data files can be the 
result and will cause performance deterioration. Applicare therefore recom-
mends you defragment RadWorks systems regularly, or at least check the frag-
mentation percentage of the system.
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Moving local database to a different drive

To move the local database (and images directories) to a different drive than the Rad-
Works program files �

1111 Install RadWorks 6.0 on your local drive (for example, drive C).

2222 Stop the database service.

3333 Copy the folder C:\AMI_60\DATABASE to drive F, or another 
available drive. If you use another available drive, replace the drive 
letter “F” in the following text by the appropriate drive letter.

Type the following in regedit:

1111

[HKEY_LOCAL_MACHINE\SOFTWARE\AMI\Database\6.0\Databases]

[HKEY_LOCAL_MACHINE\SOFTWARE\AMI\Database\6.0\Data-
bases\Local]

“Description”=”Local Database”

“Directory”=”F:\\DATABASE\\LOCAL”

“DatabaseFile”=”F:\\DATABASE\\LOCAL\\LOCAL.MDB”

[HKEY_LOCAL_MACHINE\SOFTWARE\AMI\Database\6.0\Data-
bases\Local\General]

“Directory”=”F:\\DATABASE\\LOCAL\\GENERAL”

2222

[HKEY_LOCAL_MACHINE\SOFTWARE\ODBC.INI\DatabaseIndex]

“Driver”=”C:\\WINNT\\System32\\odbcjt32.dll”

“DBQ”=”F:\\DATABASE\\LOCAL\\LOCAL.MDB”

“DefaultDir”=”F:\\DATASE\\LOCAL”

Start the database service. 
Studies will be stored in the General Folder on drive F. 

• Note that processes between the ‘Input’ and ‘Work’ directory are still 
performed on your local drive C.

The database service 
(DATABASE.EXE) will 
still run from C:

Database\Input, Database\History 
and Database\Work will remain 
operational on C:

Archive buffers will still by default 
be created under the database 
root directory on C:
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• Note that newly created folders are also placed in the F:\DATA-
BASE\LOCAL directory.
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Starting and stopping the services

RadWorks Healthpage
You can use the RadWorks Healthpage (%ROOT%\bin\Healthpage.exe, see 
‘Getting system information’ on page 283) to start and stop the RadWorks ser-
vices. 

CtrlsrvW.exe
CtrlsrvW.exe is an utility that lists all RadWorks services and their status and 
allows you to start and stop them.
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Getting system information

The RadWorks Healthpage (\bin\Healthpage.exe) provides an overview of the 
system. It lists version numbers, free disk space, and some statistics on the 
services (these are mainly useful during troubleshooting). 

To export the status report to a file, click Make Status File. 

To view the information available in the local database, click Database Col-
umn Definitions. If a DICOM tag is listed here, you can view the information 
in the Data Selector by adding a column that displays this tag (right-click a 
column boundary, then select Insert Column). 
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ll RadWorks services use log files to output information, error mes-
sages and warnings. In case you encounter any problems look there 
first for possible causes.

RadWorks is supplied with several utilities, to enable troubleshooting using 
the console mode.

What to do if the system locks up

Initial steps to unlock the system �

1111 Open the Health Page, or the CtrlSrvw.exe (both can be found in 
the %ROOT%\bin directory). 

2222 Stop the services. 

3333 When the services have been stopped, restart them.

4444 Return to RadWorks.

System Overview

A

ODBC connections

local.mdb

DBS

connect.mdb print.mdb

CNS PRS

MS Access 2.0

databases

RadWorks

named pipes

User level

System level
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Tips on how to diagnose

Running a Service in Console Mode
It is possible to run a Service in “console mode”. In this mode, information 
that will be written to a log file is also displayed in a window.

To run a service in console mode �

1111 Start the system as usual, and then stop the service (use the Health 
Page or CtrlSrvW, both are in the %ROOT%\bin directory).

2222 Set logging level and logging type:
Open the Configuration → Connection service (or → Database 
service, or → Print service, as appropriate) menu. 

3333 Select the Logging tab. 

4444 Set the Logging Level to ALL. 

5555 Make sure the Logging Type CONSOLE check box is checked.

6666 Open a Command Prompt.

7777 Change directory to %ROOT%\BIN.

8888 Register the service so it can be run in console mode: 
Connection service: type connect /regserver

Database service: type database /regserver

Print service: type print /regserver

9999 In CtrlSrvW, the service will disappear from the list. 

10101010 Start the service:
Connection service: type connect
Database service: type database
Print service: type print

This will start the service as a foreground application (in a new Com-
mand Prompt window), so you can watch the logging in ‘real-time’

To increase the screen buffer size of the window, so you can scroll back �

1111 Right-click the title bar of the command prompt window. 

2222 From the menu, select Properties. 

3333 Open the Layout tab. 
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4444 Set the Screen Buffer Size - Height to 400 lines. 

To end console logging �

1111 Close the Command Prompt window that contains the logging infor-
mation. This will stop the service. 

2222 In a Command Prompt, register the service so it can be run as a ser-
vice: 
Connection service: type connect /service

Database service: type database /service

Print service: type print /service

3333 Start the service (use the Health Page or CtrlSrvW, both are in the 
%ROOT%\bin directory). 

Providing log files and other important information
If severe problems occur, technical support may ask you to make information 
available to them for troubleshooting.You can supply the log files, or a status 
file which contains registry information, logs and database information (the 
connection origins and destinations, print destinations and layouts, and the 
local database structure). 

The services, and RadWorks itself automatically create log files. The logging 
level is set to “NORMAL”, by default. If the log file does not supply you with 
enough information, you can increase the logging level.

To increase the logging level �

1111 Stop all the relevant services (use the Health Page or CtrlSrvW, 
both are in the %ROOT%\bin directory).

2222 Move the existing log files (%ROOT%\log) to a safe location.

3333 Set the logging levels for all the relevant services and RadWorks to 
'ALL'. Use the following table.

Component Log file How to set the level to 'ALL'

Connection Service %ROOT%\log\Connect.log Configuration → Connection Service, Log-
ging tab: Logging Level = ALL

Database Service %ROOT%\log\Database.log Configuration → Database Service, Log-
ging tab: Logging Level = ALL

Logging
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4444 Start the relevant services again.

To export the Status file�

1111 Open the Health Page (in the %ROOT%\bin directory).

2222 Click Make Status File. 

3333 Select a name and location for the file. 

Print Service %ROOT%\log\Print.log Configuration → Print Service, Logging 
tab: Logging Level = ALL

RadWorks main pro-
gram

%ROOT%\log\RadWorks.log Configuration → Generic, Logging tab: 
Logging Level = ALL

Logging
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Understanding the log files

The structure of a line in a log file is:

1999/05/16 10:06:20.362: <I> [DCM] Association instantiated success-
fully

Codes used in the log files

Thread codes
DBS= database service

CNS= connection service

PRS= print service

RW= RadWorks application

Code Occurrence Thread name Purpose

[A] CNS Association thread

[A-CONN] DBS ArchiveConnect thread

[C.P.x] RW,DBS,CNS,PRS ClientProtocol worker thread Listens to active pipe connection with other process

[CS] DBS, CNS, PRS ClientInterface Manager thread Waits for connections from other processes that want to 
communicate with this process

[I] DBS Input thread Scans the input directory for new files

[M] DBS, CNS, PRS Maintenance thread Performs scheduled maintenance runs.

[PI-dp] PRS DICOM Printing thread Handles DICOM print requests

[PI-ff] PRS FileFormat Printing thread Handles Print-to-File requests

[PI-wp] PRS Windows Printing thread Handles Windows print requests

[RISx] RW, DBS RIS connection thread

[R13] CNS Release 1.3 receive thread Waits for AMI protocol connections from 1.3 systems

[SCP] CNS DICOM SCP thread Listens on TCP port for incoming associations

[SCP-x] CNS DICOM worker thread Handles active association instance

[S.LC.x] DBS ServerProtocol worker thread AMI-DBS-LOCAL protocol

[S.P.x] DBS ServerProtocol worker thread
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SendEvent(<Event>) Event codes

[S.QR.x] DBS ServerProtocol worker thread AMI-DBS-QR protocol
Executes a.o. DICOM query requests

[ST] CNS Storage Commitment thread

[TC] RW TimerConnect thread

[TR] CNS Transmission thread Performs send jobs

[U] DBS UpdateQueue thread

Event Code Meaning

65537 (0x10001) SendQueue changed

65538 (0x10002) SendLog changed

65539 (0x10003) ReceiveLog changed

65540 (0x10004) OnGoing Transmission changed

65541 (0x10005) OnGoing Receive changed
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License files

MAC address detection in Windows 2000
When the system detects that there is no Active Network link, the network 
card drivers will not be bound to the NIC, and a 00-00-00-00-00-00 MAC 
address will be returned. For a windows 2000 system you can try the follow-
ing:

Summary
Windows 2000 contains the "Media Sensing" feature. You may use this fea-
ture on a Windows 2000-based computer using Transmission Control Proto-
col/Internet Protocol (TCP/IP) to detect whether or not your network media is 
in a "link state". A "link state" is defined as the physical media connecting or 
inserting itself on the network. For example, assuming a 10bt or 100bt physi-
cal media, Ethernet network adapters and hubs typically have a "link" light to 
indicate the current connection status. This is the same condition in which 
Windows 2000 can detect a link. Whenever Windows 2000 detects a "down" 
state on the media, it removes the bound protocols from that adapter until it is 
detected as "up" again. There may be situations where you may not want your 
network adapter to detect this state, and you can configure this by editing the 
registry.

More information
You can edit the registry to prevent media sensing. 

There are some side effects of disabling the "Media Sensing" feature. For 
example, if you have a machine with two network adapters, and you have the 
"Media Sensing" feature enabled, if one network adapter does not work, it is 
unbound, and associated routes are removed so that all traffic goes through the 
other network adapter (assuming a default gateway is there). Also, if you are a 
roaming (portable) user, the "Media Sensing" feature is what provides the 
ability to connect to any network and have everything work, without restart-
ing, release and renewing, and so on. After disabling Media Sense and restart-
ing, Windows 2000 still shows the "Network Disconnected" icon on the 
TaskBar and the 'ipconfig' command still shows a "Media State .....: Cable 
Disconnected" message when the cable is disconnected. However, the Net-
work Interface is bound to TCP/IP and you can verify this by looking at the 
route table --you can use the "route print" command-- which shows the inter-
face IP address (you are also able to ping the IP address assigned to the NIC).

10-Base2 or coaxial (RG-
58) Ethernet cable is not 
a connection-based 

media. Because of this, Windows 
2000 does not attempt to detect a 
"connect" state if this type of 
cabling is used.

NetBEUI and IPX do not recognize 
Media Sense.
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For information about how to edit the registry, view the "Changing Keys and 
Values" Help topic in Registry Editor (Regedit.exe) or the "Add and Delete 
Information in the Registry" and "Edit Registry Data" Help topics in 
Regedt32.exe. Note that you should back up the registry before you edit it. If 
you are running Windows NT or Windows 2000, you should also update your 
Emergency Repair Disk (ERD).

To prevent your network adapter from detecting the link state �

1111 Use Registry Editor (Regedt32.exe) to view the following key in the 
registry: 

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Tcpip\Parameters

2222 Add the following registry value: 

Value Name: DisableDHCPMediaSense

Data Type: REG_DWORD -Boolean

Value Data Range: 0, 1 (False, True) Default: 0 (False) 

Description: This parameter controls DHCP Media Sense behavior. 
If you set this value data to 1, DHCP, and even non-DHCP, clients 
ignore Media Sense events from the interface. By default, Media 
Sense events trigger the DHCP client to take an action, such as 
attempting to obtain a lease (when a connect event occurs), or invali-
dating the interface and routes (when a disconnect event occurs).

3333 Restart your computer.
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Data acquisition solutions

If you experience any trouble, check and try the following:

• Read the relevant section(s) in this documentation entirely and care-
fully.

• If the device is a SCSI device, read section ‘General note about SCSI 
devices’ on page 248.

• If the device uses a device driver, read section ‘General notes about 
device drivers’ on page 250.

• Check the Radworks.log file in the %ROOT%\Log directory for 
error messages.

• Get the latest version of the driver software for the hardware you are 
trying to install. The drivers on the RadWorks CD-ROM might be an 
older version.

• Do you have the appropriate license? If not, upgrade your license.

• Try the installation procedure on a ‘clean’ Windows system. 

• When acquiring large studies, the message “Your system is running 
low on virtual memory…” etc. may appear. If this is the case, enlarge 
the size of the Virtual Memory in Control Panel ���� System ���� 
Advanced ���� Performance Options. 
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Teleradiology solutions

RadWorks transmission problems

Transmissions that fail remain in the Send Queue. Select the Destination in the 
list and read the Details.

If the low detail level does not supply you with enough information select the 
high level option.

Display private tags in Remote View from RadWorks 4.0/5.x
In RadWorks 6.0 a bug was fixed, which showed wrong tags in a C-FIND 
response. This fix has consequences for older versions. Private tags may not 
be displayed correctly when performing a Remote View from a RadWorks 4.0 
or 5.0 system on a RadWorks 6.0 system.

This can be fixed by changing the DICOM dictionary registry
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HKEY_LOCAL_MACHINE\Software\AMI\AMIL\5.0\DicomDict\Elem<xxx>

Change tag value 0x310900xx into 0x310910xx.

Communication (error) messages
When sending or receiving association requests the connect.log file can con-
tain very specific (error) messages, informing you what happened during the 
communication.

The following errors are all RadWorks-related

Error message Possible cause and solution

Unknown error. Default error, when all other messages are not applicable.

Database error. The CS cannot connect to the DBS. This can be due to insufficient rights, 
or simply because the DBS is not running.

Study unknown error. The DBS cannot give the CS the study the CS is requesting for transmis-
sion. The study may have been deleted before the transmission actually 
started.

Study cannot be deleted. The DBS cannot delete the study that the CS has asked to be deleted. 
The CS asks for studies to be deleted if the 'Delete after Send' flag is 
enabled for a particular transmission job.

Memory allocation error. The CS cannot allocate a file copy buffer. It may be that the block size for 
file copies has been set unusually large (e.g. many megabytes). See sec-
tion 8.3.4.

Study load error. The CS cannot load a study. This indicates invalid data. Try viewing the 
study by selecting it from the data selector.

Study save error. The CS cannot save a temporary study. This is typically used for com-
pressed transfers, where data is first compressed, then saved, and then 
transmitted. It could be that there is not enough disk space available for 
the intermediate copy. It can also be that the work directory for the CS is 
not setup properly.

Identification error. The CS is not allowed to talk to the remote CS, because of identification 
problems.

Transmission details 
error.

The remote CS cannot accept the data that is about to be transmitted, 
since the parameters are incorrect.

Out of disk space. The remote CS refuses the transfer since not enough disk space is avail-
able on the remote system.

Transmission refused. The remote CS simply refuses the transfer (no reason given).

Transmission interrupted. The transmission was interrupted due to some error (e.g. line discon-
nect?)

Transmission cancelled. The user cancelled the transmission while it was active.

Communication-related errors
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Compression negotiation 
error.

The remote CS does not accept the compression parameters requested 
by the sending CS.

Compression error. The selected data cannot be compressed. This is likely due to particular 
properties in the selected data.

Study does not exist any-
more.

The study has been deleted while the transmission was active.

Study open error. The study file cannot be opened on the sending system.

Study read error. The study file cannot be read on the sending side.

Destination open error. A copy of the study file cannot be created on the receiving system. This is 
likely a security problem with the receive share on the remote system.

Destination write error. During the creation of the copy on the receiving system, something went 
wrong. The receiving system may be out of disk space, or may have 
crashed.

The following errors are all RAS-related

Error message Possible cause and solution

RAS: not enough mem-
ory.

The RAS functionality of NT does not work properly. This may be an 
inconsistent RAS installation. Please check RAS by making manual calls.

RAS: Line busy. The line is busy. No connection can be made.

RAS: No answer. The call is not answered. No connection can be made. Please check if the 
remote system is switched on and properly configured to answer calls.

RAS: No carrier. The call is answered but no modem carrier is detected. No connection 
can be made. Please check if the remote system is switched on and prop-
erly configured to answer calls.

RAS: No dial tone. A dial tone is not available. It is not possible to make a call. Is the modem 
plugged in to the telephone line? Do you need to dial an extension first to 
get an outside line?

RAS: No active ISDN line. There is not active ISDN line. It is not possible to make a call. Is the ISDN 
modem plugged in to the telephone line?

RAS: No ISDN channels 
available.

The ISDN line is in use by other devices. There are no free channels 
available.

RAS: Authentication fail-
ure.

The login failed due to authentication problems. Does the account dialing 
into the remote system (typically CN_Service) have dial-in permissions on 
the remote side? Are the passwords correct?

RAS: Other RAS error. Any other RAS error.

RAS: Unknown RAS 
error.

Unknown RAS error.

Communication-related errors
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Remote Access Service 
(RAS) could not be 
loaded.

RAS is not setup properly on the sending system. Please check your RAS 
configuration and try to do manual calls first to check RAS.

The following errors are all DICOM-related

Error message Possible cause and solution

DICOM: Parameter error. The sending system is not setup properly for DICOM transmission. Is the 
AE Title for the sending system specified? Does the sending system have 
a valid host name?

DICOM: Study load error. The CS cannot load a study. This indicates invalid data. Try viewing the 
study by selecting it from the data selector.

DICOM: Internal error. The CS detected an internal problem in the DICOM library.

DICOM: Association 
failed.

The CS could not establish a connection with the remote DICOM system. 
This is typically a configuration error. Check the host name, AE Title and 
port number for the remote system. This may also be due to configuration 
issues on the remote system.

DICOM: SOP class 
rejected.

The requested SOP class is not accepted by the remote system. The 
transfer cannot be carried out. This may be due to configuration issues on 
the remote system, like transferring data to RadWorks 5.1 without check-
ing the RadWorks 5.1 format checkbox. To correct this: In the Connection 
→ Destinations menu, select a destination, click Modify, then on the 
Transmission Parameters tab, check the RadWorks 5.1 format checkbox.

DICOM: Conversion 
error.

An error occurred while creating DICOM messages. This may indicate 
invalid data. Try viewing the study by selecting it from the data selector.

DICOM: Remote system 
out of resources.

The remote system indicates that it is out of resources. This can be a disk 
space or memory problem. Please check the remote system.

DICOM: Format error. The remote system could not read and/or understand the DICOM mes-
sage that was sent.

DICOM: Generic storage 
error.

The storage request failed on the remote system. There is no further 
specification.

DICOM: JPEG Compres-
sion Error.

The study cannot be compressed into DICOM JPEG format. This can be 
due to many reasons:
It is already compressed in some other compression format.
The study contains different bit-depths for the images. DICOM JPEG can-
not handle this.
The study contains signed pixel data. DICOM JPEG cannot handle this.

The following error is Wavelet-related

Error message Possible cause and solution

No wavelet compression 
license available.

Wavelet compression is requested but is not licensed. Please select a dif-
ferent compression format.

Communication-related errors



GEMS IT Applicare

299

Storage commitment messages 

The following messages can be displayed in the Send Queue or in the Send 
Details:

• Storage commitment: Not supported by SCP

The SCP does not support storage commitment. More precisely, it 
does not support the "Storage Commitment Push Model SOP Class" 
with class UID 1.2.840.10008.1.20.1.

• Storage commitment: Internal error constructing N-ACTION

Internal error that should never happen. The N-ACTION (= Storage 
Commitment Request) could not be constructed. 

• Storage commitment: Internal error unpacking N-EVENT-REPORT

The N-EVENT-REPORT (= Storage Commitment Result), received 
from the SCP, is unreadable.

• Storage commitment: Time out

An Storage Commitment Request has been sent, but a Storage Com-
mitment Result has never been sent back by the SCP.

• Storage commitment: N-ACTION sent, but SCP cannot process the 
request

An N-ACTION (= Storage Commitment Request) has been sent, but 
for some reason the SCP cannot sent back an N-EVENT-REPORT 
(=Storage Commitment Result). The most probable reason is that the 
SCU's DICOM parameters are not or not correctly known at the SCP 
site.

• Storage Commitment: Result received, but general failure

A Storage Commitment Result has been received, but with failure 
reason 0110H ("General Failure" according to the DICOM standard)

• Storage Commitment: Result received, but one or more images not 
stored

A Storage Commitment Result has been received, but with failure 
reason 0112H ("One or more images not stored" according to the 
DICOM standard)

• Storage Commitment: Result received, but referenced SOP class not 
supported
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A Storage Commitment Result has been received, but with failure 
reason 0122H ("Referenced SOP class not supported" according to 
the DICOM standard), i.e. the image modality is not supported by 
the SCP.

• Storage Commitment: Result received, but class/instance conflict

A Storage Commitment Result has been received, but with failure 
reason 0119H ("Class/instance conflict" according to the  DICOM 
standard). It means that the images with the requested UIDs are 
present but with another modality than specified in the Storage Com-
mitment Request.

• Storage Commitment: Result received, but duplicate transaction UID

A Storage Commitment Result has been received, but with failure 
reason 0131H ("Duplicate transaction UID" according to the 
DICOM standard). Each Storage Commitment Request contains a 
transaction UID, which should be unique. Apparently the SCP has 
received an earlier Storage Commitment Request with the same 
transaction UID as in the present Storage Commitment Request. 
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TCP/IP communication issues

The following information can also be found on the Microsoft TechNet CD 
ROM and in the knowledge base on Microsoft’s website, and has been 
included in this guide for your convenience.

Article number: Q169790

Article last modified on 10-03-1997

Copyright Microsoft Corporation 1997.

The information in this article applies to:

• Microsoft Windows NT Workstation version 4.0

• Microsoft Windows NT Server version 4.0

Summary
This article describes how to troubleshoot some common network communi-
cation problems you may experience when you use TCP/IP as your network 
protocol. These problems usually fall into one of the following two categories:

• You are unable to connect to a specific IP address.

• You are unable to connect to a specific host or NetBIOS name.

If you are unable to connect to a specific IP address, the problem is related to 
basic connectivity. If you are able to connect to a specific IP address, but you 
are not able to connect using the host or NetBIOS name for that IP address, 
the problem is related to name resolution.

More Information
To determine whether the problem is related to basic connectivity or name res-
olution, use the following procedure to determine whether you can connect to 
a specific IP address.

Connect to an IP Address
Try to connect to another computer on your network using its IP address and 
the TCP/IP program or utility of your choice. Web browsers, ftp, and Telnet 
are some programs and utilities commonly used to connect to other computers 
with TCP/IP.
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If you cannot connect to the other computer using its IP address, there is a 
basic connectivity problem. Use the information in the “Unable to Connect to 
a Specific IP Address” section below to resolve your issue. If you can connect 
to the other computer using its IP address, but you are not able to connect 
using the host or NetBIOS name of the other computer, there is probably a 
name resolution problem. Use the information in the “Unable to Connect to a 
Specific Host or NetBIOS Name” section below to resolve your issue.

Unable to connect to a specific IP address
Follow the procedures in each of the following sections in order. After you 
finish each procedure, check to see if you can connect to the other computer 
using its IP address.

Check Your TCP/IP configuration
When you use TCP/IP as your network protocol, an incorrect TCP/IP setting 
(such as an incorrect IP address or an incorrect subnet mask) can cause com-
munication problems. To determine whether Windows has recorded an error 
due to an incorrect TCP/IP setting, examine the Event Viewer system log and 
look for any entry with TCP/IP or DHCP as the source. To read an Event 
Viewer entry, double-click the entry.

If you receive TCP/IP errors in the Event Viewer system log, resolve each 
error received as indicated by the error message. For example, if you receive 
an error stating that the IP address parameter is incorrect, you should verify 
that your IP address is valid.

If there are no errors in the Event Viewer system log:

To make sure that the correct TCP/IP configuration information is being used �

1111 Use the IPCONFIG command to determine your computer’s basic 
TCP/IP settings. To do so, type “ipconfig” (without quotation marks) 
at a command prompt.

2222 Verify that the IP address and subnet mask displayed by the IPCON-
FIG command are the correct values for your computer. If you are 
not sure what the correct values are, contact your network adminis-
trator.

Ping the loopback address
Use the PING command to verify that TCP/IP is working properly. To do so, 
ping the loopback address (127.0.0.1) by typing the following command at a 
command prompt:

ping 127.0.0.1

You should receive a response similar to the following:

If you do not know the IP 
address for the Windows 
computer that you are 

attempting to connect to, run the 
IPCONFIG /ALL command at a 
command prompt on the other 
computer.

If Event Viewer records 
a DHCP error, report 
the error to your net-

work administrator.
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Pinging 127.0.0.1 with 32 bytes of data:

Reply from 127.0.0.1: bytes=32 time=<10ms TTL=128

Reply from 127.0.0.1: bytes=32 time=<10ms TTL=128

Reply from 127.0.0.1: bytes=32 time=<10ms TTL=128

Reply from 127.0.0.1: bytes=32 time=<10ms TTL=128

Ping your computer’s IP Address
If you can ping the loopback address successfully, attempt to ping your own 
IP address by typing “ping <IP address>” (without quotation marks) at a com-
mand prompt, where <IP address> is your computer’s IP address.

You should receive a response similar to the following:

Pinging <###.###.###.###> with 32 bytes of data:

Reply from <###.###.###.###>: bytes=32 time=77ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=80ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=78ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=79ms TTL=28

where <###.###.###.###> is your computer’s IP address.

If you receive an error message at this point, there may be a communication 
problem between Windows and your network adapter. To correct this prob-
lem:

Remove and reinstall your network adapter driver �

1111 In the Control Panel, double-click Network, and then click the 
Adapters tab.

2222 Click your network adapter driver to select it, click Remove, and 
then click Yes.

3333 Click Close, and then click Yes to restart your computer.

4444 Log on as a user with administrator rights.

5555 In the Control Panel, double-click Network, and then click the 
Adapters tab.

6666 Click Add, click your network adapter driver to select it, and then 
click OK.

7777 Use the dialog box(es) provided to configure your network adapter, 
and then click OK.

 You must be logged on 
as a user with Adminis-
trator rights to complete 

these steps.

 If you do not know your 
computer’s IP address, 
you can obtain that 

information by typing “ipconfig” 
(without quotation marks) at a 
command prompt.

 You must be logged on 
as a user with Adminis-
trator rights to complete 

these steps.
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8888 When prompted, type the path for the Windows source files, click 
Continue, and then click Close.

9999 When you are prompted for your TCP/IP configuration information, 
provide the appropriate values, and then click OK. If you are not 
sure what the appropriate values are, contact your network adminis-
trator.

10101010 Click No when you are prompted to restart your computer. If you 
have installed a Windows Service Pack, you need to reinstall the Ser-
vice Pack before you restart your computer.

11111111 Restart your computer.

If you are unable to ping your computer’s IP address after removing and rein-
stalling your network adapter driver, contact the manufacturer of your net-
work adapter to verify that you are using the appropriate Windows driver for 
your network adapter.

Clear the Address Resolution Protocol (ARP) cache
The address resolution protocol (ARP) cache is a list of recently resolved IP 
address to Media Access Control (MAC) address mappings. The MAC 
address is the unique physical address embedded in each network adapter.

If an entry in the ARP cache is incorrect, TCP/IP packets may be sent to the 
wrong computer. To display all mappings currently in the ARP cache, use the 
ARP command by typing “arp -a” (without quotation marks) at a command 
prompt. You should receive either a “No ARP Entries Found” message (if the 
ARP cache is empty) or a response similar to the following:

Interface: 10.1.1.3 on Interface 2

Internet Address Physical Address Type

10.1.1.7 08-00-02-06-ed-20 dynamic

10.1.1.254 08-00-02-0a-a3-10 dynamic

To remove any incorrect entries in the ARP cache, clear all entries using the 
following command:

arp -d <IP address>

where <IP address> is an Internet address stored in the ARP cache. Use this 
command for each entry in the ARP cache until all entries have been deleted.

For more information on the syntax, options, and usage of the ARP command, 
type “arp -?” (without quotation marks) at a command prompt.
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Verify the Default Gateway
Use the IPCONFIG command to determine the IP address that your computer 
uses to access your default gateway. To do so, type “ipconfig” (without quota-
tion marks) at a command prompt. Verify that the IP address displayed for 
your default gateway is correct. If you do not know the correct IP address for 
your default gateway, contact your network administrator.

When you have verified that you have the correct IP address for your default 
gateway, use the PING command to verify that you can ping your default 
gateway’s IP address. You should receive a response similar to the following:

Pinging <###.###.###.###> with 32 bytes of data:

Reply from <###.###.###.###>: bytes=32 time=77ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=80ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=78ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=79ms TTL=28

where <###.###.###.###> is the IP address of your default gateway.

If your default gateway is not connected to the network or not functioning 
properly, you may receive a response similar to the following:

Pinging <###.###.###.###> with 32 bytes of data:

Request timed out.

Request timed out.

Request timed out.

Request timed out.

If you cannot successfully ping your default gateway’s IP address, contact 
your network administrator to verify that your default gateway is connected to 
the network and functioning properly.

Ping the IP address of the other computer
Try to ping the IP address of the other computer. To do so, type “ping <IP 
address>” (without quotation marks) where <IP address> is the IP address of 
the other computer. You should receive a response similar to the following:

Pinging <###.###.###.###> with 32 bytes of data:

Reply from <###.###.###.###>: bytes=32 time=77ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=80ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=78ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=79ms TTL=28

where <###.###.###.###> is the IP address of the other computer.

If there is an improperly configured router between your computer and the 
other computer, or if there is a problem with the other computer, you may 
receive a response similar to the following:
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Pinging <###.###.###.###> with 32 bytes of data:

Request timed out.

Request timed out.

Request timed out.

Request timed out.

If your computer is on a different subnet than the other computer, try to ping 
the other computer from a computer that is on the same subnet as the other 
computer. If you cannot ping the other computer from a computer on the same 
subnet, ensure that the other computer is connected to the network and that 
you have the correct IP address for the other computer. If you can ping the 
other computer from a computer on the same subnet, contact your network 
administrator to resolve any routing problems that may exist on your network.

Verify persistent route table entries
Any computer using TCP/IP as a network protocol has a route table. The route 
a network packet takes from one computer using TCP/IP to another computer 
using TCP/IP is determined by the route table of the computer that sent the 
network packet.

Your computer’s route table is automatically rebuilt each time you restart your 
computer. You or your network administrator can add persistent (static) 
entries to your computer’s route table. Persistent entries are automatically 
reinserted in your route table each time your computer’s route table is rebuilt.

To view your computer’s route table, use the ROUTE command. To do so, 
type “route print” (without quotation marks) at a command prompt. You 
should receive a response similar to the following:

Active Routes:

Network Address Netmask Gateway Address Interface Metric

0.0.0.0 0.0.0.0 10.1.1.254 10.1.1.3 1

10.1.0.0 255.255.0.0 10.1.1.3 10.1.1.3 1

10.1.1.3 255.255.255.255 127.0.0.1 127.0.0.1 1

10.255.255.255 255.255.255.255 10.1.1.3 10.1.1.3 1

127.0.0.1 255.0.0.0 127.0.0.1 127.0.0.1 1

224.0.0.0 224.0.0.0 10.1.1.3 10.1.1.3 1

255.255.255.255 255.255.255.255 10.1.1.3 10.1.1.3 1

Verify with your network administrator that all persistent entries in your 
computer’s route table are valid.

For more information on routing, route tables, and the ROUTE command, see 
the following article in the Microsoft Knowledge Base:
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TCP/IP Routing Basics for Windows
Article number: Q140859

Use the TRACERT command
The TRACERT command reports each router or gateway crossed by a TCP/IP 
packet on its way to another host. To use the TRACERT command to trace the 
route between your computer and the other computer, type “tracert <IP 
address>” (without quotation marks) at a command prompt, where <IP 
address> is the IP address of the other computer. You should receive a 
response similar to the following:

Tracing route to <IP address> over a maximum of 30 hops:

1 <10 ms <10 ms <10 ms <###.###.###.###>

2 50 ms 50 ms 51 ms <###.###.###.###>

3 250 ms 80 ms 50 ms <###.###.###.###>

Trace complete.

where each <###.###.###.###> is the IP address of a different router.

If there is a problem with one of the routers that the network packet tries to 
cross, you may receive a response similar to the following: 

Tracing route to <IP address> over a maximum of 30 hops:

1 <10 ms <10 ms <10 ms <###.###.###.###>

2 * * * Request timed out.

3 * * * Request timed out.

4 * * * Request timed out.

If there is a configuration error on one of the routers between your computer 
and the other computer, you may receive a response similar to the following:

Tracing route to <IP address> over a maximum of 30 hops:

1 <10 ms <10 ms <10 ms <###.###.###.###>

2 50 ms 50 ms 51 ms <###.###.###.###>

3 <###.###.###.###> reports: Destination net unreachable.

You may also receive a response similar to the one above when there is a 
proxy or a firewall between your computer and the other computer.

If you are not able to obtain a successful response using the TRACERT com-
mand to trace the route between your computer and the other computer, con-
tact your network administrator to determine if there is a routing problem 
between your computer and the other computer.

For more information on the TRACERT command, see the following article 
in the Microsoft Knowledge Base:
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Using TRACERT to Ttroubleshoot TCP/IP problems in Windows
Article number: Q162326

Verify Server Services on the other computer
Verify that the appropriate server services are running on the other computer. 
For example, if you are attempting to use the Telnet tool to connect to the 
other computer, make sure that the other computer is configured as a Telnet 
server.

To verify that the appropriate server service is running on the other computer, 
attempt to connect to the other computer from another computer that is on the 
same subnet as the other computer. If you cannot connect to the other com-
puter from a computer on the same subnet, contact the network administrator 
to verify that the server service is configured and functioning properly on the 
other computer. If you can connect to the other computer from a computer on 
the same subnet, contact your network administrator to resolve any routing 
problems that may exist on your network.

Check IP Security on the server
Port settings for services on the other computer may be different than the port 
settings you are using to connect. The following chart lists some standard port 
settings for various protocols:

Port: Protocol:

---- ---------

80 HTTP

21 FTP

23 Telnet

70 Gopher

Use the Telnet tool to verify that the other computer is configured to permit 
connections on the same port you are using to connect. To do so, type the fol-
lowing line at a command prompt:

telnet <IP address> <port>

where <IP address> is the IP address of the other computer and <port> is the 
port you are attempting to make a connection on. For example, if you are 
attempting to make an ftp connection to the other computer on port 21, type 
“telnet <IP address> 21” (without quotation marks).

If you do not receive an error message, the other computer is configured to 
permit connections on that port. You should be able to make a connection 
using the appropriate service on that port.
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If you receive an error message, the other computer may not be configured to 
permit connections on that port. Contact the network administrator to obtain a 
valid port number for the service on the other computer.

Unable to connect to a specific host or netbios name
If you are able to connect to the other computer using its IP address, but you 
are not able to connect to the other computer using its host or NetBIOS name, 
there may be a name resolution problem. There are many methods that can be 
used to accomplish name resolution on a network including the following:

• HOSTS files

• Domain Name Service (DNS)

• LMHOSTS files

• Windows Internet Name Service (WINS)

If you are uncertain which methods are used to accomplish name resolution on 
your network, contact your network administrator. Follow the procedures in 
each of the following sections in order. After you finish each procedure, check 
to see if you can connect to the other computer using its host name or Net-
BIOS name.

Check the HOSTS File
The HOSTS file is a text file that you can edit with any text editor (such as 
Notepad). If your network uses HOSTS files for host name resolution and you 
cannot connect to the other computer using its host name, there may be an 
invalid entry in your HOSTS file. Search your HOSTS file for the host name 
of the other computer, verify that there is only one entry per host name, and 
then verify that the entry for the host name of the other computer is valid.

For more information on the HOSTS file, see the sample HOSTS file in the 
WINNT\System32\Drivers\Etc folder.

Check Your Domain Name Service (DNS) Configuration
A Domain Name Service (DNS) server provides host name resolution. If your 
network uses DNS for host name resolution and you cannot connect to the 
other computer using its host name, there may be a problem with your com-
puter’s DNS configuration or with the DNS server on your network.

To determine if there is a problem with your computer’s DNS configuration, 
follow these steps:
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1.Type “ipconfig /all” (without quotation marks) at a command prompt to dis-
play the IP address of your DNS server. If the IP address for your DNS server 
is not displayed, contact your network administrator to obtain the IP address 
for your DNS server.

2.Verify that you can communicate with your DNS server by pinging your 
DNS server’s IP address. You should see a reply similar to the following:

Pinging <###.###.###.###> with 32 bytes of data:

Reply from <###.###.###.###>: bytes=32 time=77ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=80ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=78ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=79ms TTL=28

where <###.###.###.###> is the IP address of the DNS server.

If you cannot ping the IP address of your DNS server successfully, contact 
your network administrator to verify that you have the correct IP address for 
your DNS server and that your DNS server is connected to the network and 
functioning properly.

If you can ping the IP address of your DNS server, but cannot resolve the host 
name of the other computer, your DNS server may not be resolving host 
names properly. If more than one DNS server is available on your network, 
configure your computer to use a different DNS server. If another DNS server 
resolves the host name of the other computer properly or if there is no other 
DNS server to use, contact your network administrator to correct the problem 
with the original DNS server.

When you have verified the correct IP address for your DNS server, update 
your computer’s TCP/IP settings. If you are using a dial-up connection to con-
nect to your network, you need to change only the TCP/IP settings in your 
Dial-Up Networking phone book entry with the correct IP address for your 
DNS server.

To change or add a valid IP address for your DNS server in your computer’s TCP/IP set-
tings �

1111 In the Control Panel, double-click Network, and then click the Pro-
tocols tab.

2222 Click TCP/IP Protocol to select it, click Properties, and then click 
the DNS tab.

3333 If you are adding a DNS server, click Add. If you are editing an 
existing server, click the IP address for the appropriate DNS server, 
and then click Edit.
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4444 Type the correct IP address for the DNS server, and then click OK.

5555 Click OK, and then click OK again. You may need to restart your 
computer after this step.

To change or add a valid IP address for your DNS server for a Dial-Up Networking 
phone book entry �

1111 In Dial-Up Networking, click the appropriate entry in the Phone 
book Entry To Dial box.

2222 Click More, and then click Edit Entry And Modem Properties.

3333 Click the Server tab, and then click the TCP/IP Settings button.

4444 Click Specify Name Server Addresses, and then type the correct IP 
address in the Primary DNS box.

Check the LMHOSTS file
The LMHOSTS file is a text file that you can edit with any text editor (such as 
Notepad). If your network uses LMHOSTS files for NetBIOS name resolution 
and you cannot connect to the other computer using its NetBIOS name, there 
may be an invalid entry in your LMHOSTS file. Search your LMHOSTS file 
for the NetBIOS name of the other computer, verify that there is only one 
entry per NetBIOS name, and then verify that the entry for the NetBIOS name 
of the other computer is correct.

If there are any #INCLUDE entries or any #BEGIN_ALTERNATE to 
#END_ALTERNATE blocks of lines in your LMHOSTS file, temporarily dis-
able all such lines or blocks of lines by placing the pound (#) character and 
one space at the beginning of each line to be disabled.

If disabling these lines or blocks of lines resolves the problem, re-enable the 
lines or blocks of lines one at a time until the problem reoccurs. When you 
have determined that a specific line or block of lines causes a problem, check 
the LMHOSTS files that the lines point to.

For more information on the LMHOSTS file, see the Lmhosts.sam sample file 
located in the WINNT\System32\Drivers\Etc folder.

Check your Windows Internet Name Service (WINS) configuration
A Windows Internet Name Service (WINS) server provides NetBIOS name 
resolution. If your network uses WINS for NetBIOS name resolution and you 
cannot connect to the other computer using its NetBIOS name, there may be a 
problem with your computer’s WINS configuration or with the WINS server 
on your network.
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To determine if there is a problem with your computer’s WINS configuration �

1111 Type “ipconfig /all” (without quotation marks) at a command prompt 
to display the IP address of your WINS server. If the IP address for 
your WINS server is not displayed, contact your network administra-
tor to obtain the IP address for your WINS server.

2222 Verify that you can communicate with your WINS server by pinging 
your WINS server’s IP address. You should see a reply similar to the 
following:

Pinging <###.###.###.###> with 32 bytes of data:

Reply from <###.###.###.###>: bytes=32 time=77ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=80ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=78ms TTL=28

Reply from <###.###.###.###>: bytes=32 time=79ms TTL=28

where <###.###.###.###> is the IP address of the WINS server.

If you cannot ping the IP address of your WINS server, contact your network 
administrator to verify that you have the correct IP address for your WINS 
server and that your WINS server is connected to the network and functioning 
properly.

If you can ping the IP address of your WINS server, but cannot resolve the 
NetBIOS name of the other computer, your WINS server may not be resolving 
NetBIOS names properly. If more than one WINS server is available on your 
network, configure your computer to use a different WINS server. If another 
WINS server resolves the NetBIOS name of the other computer properly or if 
there is no other WINS server to use, contact your network administrator to 
correct the problem with the original WINS server.

When you have verified the correct IP address for your WINS server, update 
your computer’s TCP/IP settings. If you are using a dial-up connection to con-
nect to your network, you need to change only the TCP/IP settings in your 
Dial-Up Networking phone book entry with the correct IP address for your 
WINS server.

To change or add a valid IP address for your WINS server in your computer’s TCP/IP 
settings �

1111 In Control Panel, double-click Network, and then click the Protocols 
tab.

2222 Click TCP/IP Protocol to select it, click Properties, and then click the 
WINS Address tab.
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3333 Type the correct WINS server IP address in the Primary WINS 
Server box, and then click OK.

4444 Click Close, and then click Yes to restart your computer.

To change or add a valid IP address for your WINS server for a Dial-Up Networking 
phone book entry �

1111 In Dial-Up Networking, click the appropriate entry in the Phone 
book Entry To Dial box.

2222 Click More, and then click Edit Entry And Modem Properties.

3333 Click the Server tab, and then click the TCP/IP Settings button.

4444 Click Specify Name Server Addresses, and then type the correct IP 
address in the Primary WINS box.
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Using the RadWorks utilities

The RadWorks utilities reside in the \bin sub-directory of the directory into 
which RadWorks has been installed (the default is \AMI_60). They can prove 
useful for a wide range of tasks.

Checkpal.exe
Checkpal is a Win32 application that attempts to create a palette with 256 gray 
values. If correct, the gray-scale ramp should not show any clear blocks, but 
show a seamless transition from black to white. The existence of blocks indi-
cates the use of a wrong video mode, or a limitation in the video driver or 
video card. Double-click to launch it. 

CtrlsrvW.exe
CtrlsrvW is a windows utility to change the execution status of a service or 
driver. It lists all RadWorks services and their status and allows you to start 
and stop them.

Dcmecho2.exe
Dcmecho2 is a command line utility to establish an association and issue a C-
ECHO command to a DICOM service on a RadWorks system or any other 
DICOM system that supports the Verification SOP class (C-ECHO SCP ser-
vice). This utility is typically used to test the most basic form of DICOM con-
nectivity. It can be regarded as the “ping” utility (frequently used for basic 
testing of TCP/IP networks) for DICOM.

Syntax: 
Dcmecho2 [-s port] [-t title] [-v] title host:service

[-s port] Port number for running in SCP (server) mode

[-h name] Host name for this machine

[-t title] Title for this (local) Application Entity

[-v] Verbose mode

title Title of called (remote) Application Entity

host Hostname of server

service Port number on server

Note that with the -s option the title, host, and service parameters may be 
omitted to accept any Application Entity.

Example: 
dcmecho2 AE_DIAG1 diag1:3140

1999/08/26 14:05:01.927: <A> Association requested successfully from AE
'AE_RadWorks' at address RadWorks:3140
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1999/08/26 14:05:02.258: <A> Successfully received C-ECHO response

DcmPing.exe
DcmPing is a utility to test the connection with a DICOM server or another 
RadWorks workstation (comparable to the Dcmecho2 command line utility). 
A successful response displays a number of standard SOP classes supported 
by the DICOM server.

If you do not know the host name, you can browse through the network neigh-
borhood by clicking the browse button.

You can choose to retrieve the DICOM port number and the AE Title automat-
ically (default setting) or enter the DICOM port number and AE Title manu-
ally. This option is not available on the Windows 2000 system.

When you click the Ping button an association request will be sent to the 
remote system.

If the remote system is not available or does not have an AE Title or port num-
ber, the program will inform you that the association failed. If it is successful, 
you will see information very much like shown in the figure below.



T R O U B L E S H O O T I N G

RadWorks 6.0 installation and configuration guide

316 chapter 14

Dcmsend2.exe
Dcmsend2 (a command line utility) can be used to test C-STORE SCP support 
on a DICOM system by sending a study to this system via the C-STORE SCU 
class. This utility is meant for basic testing, and will typically be run after the 
Dcmecho2 utility was found to run properly.

Syntax: 
DCMSend2 [-t title] [-v] [-d] [-p] title host:service data_file

[-t title] Title for this (local) Application Entity

[-v] Verbose mode

[-d] Data to send is in raw DICOM format

[-x] Data to send is in raw DICOM format with Explicit VR

[-p] Data to send is in DICOM Part 10 format

[-s] Use a single association per image

title Title of called (remote) Application Entity

host Hostname of server

service Port number on server

Without the [-d] option:

data_file Name of AMI dataset file without extension

(no .MET or .IMG)

With the [-d] option:

data_file Name of raw DICOM file (multiple files may be

gives separated by spaces)

Example: 
dcmsend2 AMI_DICOM20 machine:3120 c:\temp\study

(Application Entity title is AMI_DICOM20; host is machine; port
number is 3120).

Example: 
dcmsend2 -x -p AE_VIEWING40 machine:3140 c:\temp\dicomPart10study.tmp

License.exe
License is a command line utility to inspect the license codes present in a don-
gle. If a dongle is present on the parallel port, the contents of the dongle will 
be listed.

Syntax: 
license

Example:
C:\AMI_60\BIN>license

License expiry : 31-12-1999 (dd-mm-yyyy)

License type : Dongle



GEMS IT Applicare

317

Serial number : 19990512029

OEM : No OEM

Product type : RadWorks Diagnostic

License : Multi Monitor

License : Print

License : MPR/MIP

License : Data Acquisition

License : Single Medium Archive

License : Quality Control

License : Wavelet Compression

License : Workgroup Server: 2 concurrent users

RunLCfg.exe
RunLConfig is used from within RadWorks to display the license configura-
tion dialog available in the Configuration → Licensing… menu.

Tiffconv.exe
TIFF converter is a small windows utility to convert (a number of) TIFF files 
to the RadWorks native format.

To convert TIFF files to the RadWorks native format �

1111 Enter the Patient Data.

2222 Select the input files to be converted by clicking the Browse button 
next to the input file(s) box. You cannot change the input files or out-
put directory by entering a path.

3333 Select the output directory by clicking the Browse button next to the 
output directory box. 

4444 Click Convert to convert the files. A progress indicator will pop up 
to show the progress of the conversion process. After reading the 
TIFF files and writing the output, control returns to the dialog box 
and you can select a new set of input files. The settings for input and 
output directories are preserved.

Dcmscp.exe
This is a command line tool that will receive DICOM C-STORE commands 
and store the resulting files in temporary files on the hard disk.

Syntax:
dcmscp portnumber [transfersyntax]
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The program will wait for an SCU to connect and will then write the incoming 
DICOM data to disk. You can use the optional transfer syntax argument to 
force the acceptance of C-STORE commands using that particular transfer 
syntax only.

For some common transfer syntaxes the following symbolic names are avail-
able:

il = 1.2.840.10008.1.2 (Implicit Little Endian)

el = 1.2.840.10008.1.2.1 (Explicit Little Endian)

eb = 1.2.840.10008.1.2.2 (Explicit Big Endian)

jp8 = 1.2.840.10008.1.2.50 (JPEG 8 bit Default)

jp12 = 1.2.840.10008.1.2.51 (JPEG 12 bit Default)

jpll= 1.2.840.10008.1.2.70 (JPEG Lossless Default)

For instance, to capture input normally sent to the Connection Service (CS), 
stop the CS, and type:

dcmscp 104

The utility will store the captured input as .tmp files in the \bin directory.

Just typing dcmscp will display a brief overview of the command syntax.

DICOM repair utility
This utility is Origin-specific, it runs a script for every image in a study 
received by the Connection Service. The script can access any DICOM field 
in patient, study, series, or image objects and can change its value.

When installed and configured, the functionality works as follows:

1111 A study is received by the Connection Service.

2222 The origin is looked up.

3333 The script for the origin is loaded.

4444 The script is run for every image.

5555 If the script returns false for one or more images, it stops and does 
not apply repair actions to any of the images.

6666 When the script is run successfully for all images, the change infor-
mation is applied to all images.

7777 After the post-process step is completed, the study is saved and 
added to the database.



GEMS IT Applicare

319

You can only change DICOM fields that are stored in the AMI format, but you 
can’t change DICOM fields themselves.

The repair feature is implemented using a similar mechanism as QC auto-
matching. This mechanism is extended so it can run more than one post pro-
cess. The repair functionality itself is in a post process dll (repair.dll). The 
functionality in this dll will be called after receiving the images and before 
adding them to the database.

The repair functionality runs this script over all the images. If all scripts are 
run successfully, the collected changes are applied to the images. 

A script has two objects:

• dcmsetImage : Contains the image information. Via dcmsetIm-
age.GetValue() an unformatted DICOM value can be queried and 
used to make decisions etc in the script.

• dcmsetRepair : Contains all the changes that must be applied to the 
image. Via dcmsetRepair.SetValue() an unformatted DICOM value 
can be set. This will be used to overwrite the old value (or create a 
new one).

For configuration, use the RepairCfg application. With this application the 
repair functionality can be enabled/disabled, scripts can be added, modified 
and deleted. 

After creating the Origins in RadWorks you can select the appropriate origin 
and click Default. This will enter a default script into the dialog window. 

Click Test to parse the script to see if there are errors. Please note that this is a 
limited test.

Check the Enable check box to enable the script. 

When the Repair Script is enabled it will apply to the Origin you specified. 

In the Configuration → Connection Service menu, on the Receive tab, the 
‘Post Process’ field will be automatically updated with the ‘repair.dll’ entry. If 
the system has already been set up for automatic matching, then the new entry 
will be appended to the existing entry, ‘qc.dll’.

It will only apply 
changes when all 
images in a study can be 

correctly repaired.
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Remotely control a Windows system

Imagine the following situation: You have a Windows server that is physically 
inaccessible but reachable by TCP (it is at a remote site, for example). You 
have the Administrator account for the machine, but you cannot accomplish 
the task you need to perform using the standard NT management tools. In 
addition, the remote system doesn't have a remote control program installed. 
In this situation, you can install AT&T Laboratories Cambridge's Virtual Net-
work Computing (VNC), a freeware remote control tool, without physically 
accessing the machine.

To set up and use VNC on a remote system �

1111 Determine the Administrator password of the remote machine. 

2222 Download the VNC package (server and viewer) from: 
http://www.uk.research.att.com/vnc 

3333 Make sure you have the Regini, Shutdown and Netsvc tools (part of 
the Microsoft Windows 2000 Server Resource Kit and the Microsoft 
Windows NT Server 4.0 Resource Kit) .

4444 Extract the VNC files from the distribution package. The simplest 
way to accomplish this task is to install VNC on a test machine. The 
installation automatically creates the C:\program files\orl\vnc direc-
tory, which includes all but one of the files that you need to run 
VNC. The missing file is omnithread_ rt.dll, and you can find it in 
the \winnt\system32 directory. Copy the missing file to the C:\pro-
gram files\orl\vnc directory.

5555 Use the following commands to copy the VNC directory to the target 
machine:

NET USE \\<remote machine IP>\IPC$ /user:administrator password

MKDIR "\\<remote machine IP>\C$\program files\orl\vnc"

COPY "c:\program files\orl\vnc" "\\<remote machine IP>\C$\program
files\orl\vnc"

6666 For the VNC server to run, you'll also need to create registry entries 
on the target machine. To load the remote target machine's registry, 
use the following command:

REGINI -m \\<remote machine IP> vnc.regini

The Regini command registers the VNC server as an automatic star-
tup service on the remote machine. In addition, it sets the default 
VNC password as the remote machine's password. 
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7777 Start the VNC server on the remote server. You can use two methods 
to start VNC on the remote machine: You can use the ‘At’ command 
to schedule VNC to start, or you can use Shutdown (see the last step) 
to force a shutdown. The ‘At’ method is less disruptive but requires 
the Scheduler service to be running on the remote system. The 
Scheduler service isn't started by default, so you might need to use 
the following command to start it manually:

NETSVC \\<remote machine IP> schedule /start

8888 To use the ‘At’ method to schedule the VNC server to start, execute 
the following command to read the time on the remote server:

NET TIME \\<remote machine IP>

9999 Schedule an At command to run a couple of minutes after the time 
that the previous command returned, as the following example 
shows:

AT \\<remote machine IP> 00:00 "c:\program files\orl\vnc\win-
vnc.exe"

10101010 Wait a few minutes and launch vncviewer.exe to connect to the 
remote machine. 

11111111 If you’re not using the scheduler, remotely reboot the server:

SHUTDOWN \\<remote machine IP> /R /Y /C /T:0

After the reboot, the VNC server will be running as a service.
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This chapter describes how to use an SQL database with RadWorks. 

Installing SQL Server 7.0 .......................................324

Installing SQL Server 2000 ....................................326

Performance tuning................................................328
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t is possible to store RadWorks data in an SQL Server database, instead of 
storing it in MS Access database files. The feature is not meant to replace 
the use of MDB-files in general, but to offer an alternative path. The feature 

applies to the Database Service (local database and history database), to the 
Connection Service, to the Print Service.

Installing SQL Server 7.0

1111 Install SQLServer. It does not need to be installed on the same com-
puter as RadWorks.

2222 Apply SQL Server 7.0 SP1.

3333 Install the MDAC 2.01 upgrade.

4444 On the SQL Server machine, run the SQL Server enterprise manager 
and create a new database called RadWorks.

5555 From the SQL Server enterprise manager select this new RadWorks 
database and then open the Tools → Query Analyzer menu. 

6666 Open the file RadWorksLink.sql 
(this can be found in the directory \release\templates on the Rad-
Works 6.0 installation CD-ROM) and run it. The database will now 
be created.

7777 On the RadWorks computer, from the Control Panel → Adminis-
trative Tools folder, select the ODBC Data Sources applet. On the 
System DSN tab, check if the DSN RadWorksLink is already avail-
able. If it is, modify it; otherwise create it.

8888 To create the DSN, click Add. 

9999 In the Select a driver… wizard, select SQL Server.

10101010 In the Name edit box, enter RadWorksLink.

11111111 In the Description edit box, you can enter a description of the driver.

12121212 In the Server edit box, select the SQL Server machine: this could be 
(local) or the machine name.

13131313 Click Next: 

The feature explicitly 
does not apply to the 
Archive Index Tool.

I
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14141414 On the ‘How should SQL Server…’ page, select  With SQL Server 
authentication…

15151515 Select the checkbox Connect to SQL Server….

16161616 In the Login ID edit box, enter sa.

17171717 Leave the Password field empty.

18181818 Click Next >.

19191919 Select the checkbox Change the default database to. 

20202020 Select RadWorks as the default database. Leave all other fields as 
default.

21212121 Click Next >, then Finish.

22222222 In the dialog that appears click Test Data source and verify it suc-
ceeds.

23232323 Install RadWorks (all modules) on the RadWorks computer.

24242424 Find the file RadWorksLink.reg (in the directory \release\templates 
on the RadWorks installation CD-ROM) and double-click it (in Win-
dows 2000, click OK) It installs a number of registry values. 
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Installing SQL Server 2000

1111 Install Win2K (with Service Pack1), Internet Explorer 5.0 SP1, and 
then SQL Server. SQL Server does not need to be installed on the 
same computer as RadWorks. During installation: in ’authentication 
mode’ choose ’mixed mode’. For the ’sa’ login, check ’Blank Pass-
word’. Finish the set-up. SQL 2000 has a bug considering the pass-
word for the ’sa’ login, which actually isn’t empty. Follow this 
workaround:

2222 Run the SQL Server Enterprise Manager and connect to your system 
by double-clicking on it. 

3333 Scroll to //Security/Logins/ in where you’ll find the ’SQL Server 
Login Properties - sa’ dialog. 

4444 On the general tab you’ll notice that the edit box for Password isn’t 
empty. Empty it, then click OK. 

5555 The program will ask you to create a new Password. Leave it empty, 
then click OK. 

6666 Restart the program.

7777 Run the SQL Server Enterprise Manager and create a new database 
called RadWorks.

8888 From the SQL Server enterprise manager select this new RadWorks 
database and then open the Tools → Query Analyzer menu. 

9999 Open the file RadWorksLink.sql 
(this can be found in the directory \release\templates on the Rad-
Works 6.0 installation CD-ROM) and run it. The database will now 
be created.

10101010 Close the Query Analyzer and refresh the Service Enterprise Man-
ager (F5). Tables now can be found under RadWorks/Tables. 

11111111 On the RadWorks computer, from the Control Panel → Adminis-
trative Tools folder, select the ODBC Data Sources applet. On the 
System DSN tab, check if the DSN RadWorksLink is already avail-
able. If it is, modify it; otherwise create it.

12121212 To create the DSN, click Add. 

13131313 In the Select a driver… wizard, select SQL Server.
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14141414 In the Name edit box, enter RadWorksLink.

15151515 In the Description edit box, you can enter a description of the driver.

16161616 In the Server edit box, select the SQL Server machine: this could be 
(local) or the machine name.

17171717 Click Next: 

18181818 On the ‘How should SQL Server…’ page, select  With SQL Server 
authentication…

19191919 Select the checkbox Connect to SQL Server….

20202020 In the Login ID edit box, enter sa.

21212121 Leave the Password field empty.

22222222 Click Next >.

23232323 Select the checkbox Change the default database to. 

24242424 Select as the default database RadWorks. Leave all other fields 
default.

25252525 Click Next >, then Finish.

26262626 In the dialog box that appears click Test Data source and verify it 
succeeds.

27272727 Install RadWorks (all modules) on the RadWorks computer.

28282828 Find the file RadWorksLink.reg (in the directory \release\templates 
on the RadWorks 6.0 installation CD-ROM) and double-click it (in 
Windows 2000, click OK) It installs a number of registry values. 
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Performance tuning

If performance of the SQL server is insufficient, you may need to add indexes 
to fields in the TblDatabaseStudy database. See the SQL Server documenta-
tion for more information. Which fields to index is a trade-off: indexing 
makes finding studies faster, but slows down other operations (e.g. adding and 
deleting studies). 
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When you are using RadWorks there are various messages which may pop up. 
Some of these are error messages. These often relate to a problem with the 
way RadWorks was installed or configured, or how it interacts with other soft-
ware components. It may also be the result of attempting to perform an inap-
propriate action. Should a problem occur, RadWorks is designed to provide 
detailed information on what has happened in order to assist you or the system 
administrator resolve it as quickly and easily as possible.

When using RadWorks you will generally also see warning messages. These 
typically appear when you are attempting to perform some action which 
involves deleting information or changing the system in some irreversible 
way. They will also appear when you attempt to perform some action which is 
not allowed (attempting to remove a locked study for example).

This appendix lists all the messages you might encounter when using Rad-
Works, along with further explanation of what they mean and possible solu-
tions. 

The messages are listed according to the section of RadWorks in which they 
occur.



E R R O R ,  W A R N I N G  &  O T H E R  M E S S A G E S

RadWorks 6.0 installation and configuration guide

330 appendix A

General

Error message Cause of message

Cannot display on-line Help. The Help files may 
be missing or corrupt.

The required help files could not be found on your 
system. Setup may have failed. Consult your sys-
tem administrator.

The Online User Manual cannot be displayed. To 
view this, Acrobat Reader must be installed on 
your system. This is available on the RadWorks 
installation CD, or you can download the latest 
version from www. adobe.com.

Acrobat Reader was not available on your system 
to display the Online User Manual. If the problem 
persists after installing Acrobat Reader, or if you 
can view other Acrobat files on your system, the 
manual.pdf file may be missing or corrupt. Con-
tact your system administrator.

Cannot use empty filename For export functionality a filename must be speci-
fied.

No valid DICOM field entered! The DICOM field does not contain a valid DICOM 
field.

There is no valid Dongle attached to the system. 
Please check if the Dongle is connected properly

The dongle cannot be found. Make sure it is prop-
erly connected to your printer port.

The Dongle has expired on (dd/mm/yyyy) <date>. 
Please connect a valid Dongle to your system

Your dongle has expired. Contact your supplier 
for an update.

Cannot request a valid license from the license 
manager

The system cannot obtain a valid license from the 
license manager. Please contact your administra-
tor or supplier.

You cannot enter an empty time You must specify a time.

At least one field must be selected For export functionality at least one field must be 
selected.

Only one application can be started at a time You can run only one copy of RadWorks on a 
workstation at any one time.

Cannot use empty separator For export functionality a separator has to be 
specified.

No valid field The queried field does not contain a valid value.

Do you want to overwrite file <file>? You have specified an existing filename; proceed-
ing will overwrite the current file.

Field must be a valid DICOM field The specified value is not a valid DICOM field.

You must select a shortcut before clicking 
Remove

In the Select Shortcut box, select one of the 
assigned shortcuts before clicking Remove.

No value for DICOM field entered! The DICOM field has not been specified.

Field should not be empty A value for the field must be specified.
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The <number> is assumed to be the month. Pro-
ceed?

Warning message to inform the user of how the 
date is processed.

Not a valid date: <date>. Date must be formatted 
as: <date>

An incorrect date was entered. Correct the date 
according to the format.

Not a valid time: <time>. Time must be formatted 
as: <time>

An incorrect time was entered. Correct the time 
according to the format.

You must select a macro before clicking Create Before typing the shortcut key you have to specify 
the command (or macro).

No shortcut key has been defined You must add a shortcut key for this special com-
mand.

Description cannot be empty The description field must be specified.

Please specify a valid length During calibration a valid length must be speci-
fied.

No item selected You have not selected a item in the list.

Are you sure you want to change the ROOT 
directory?

Changing the ROOT directory can have many 
negative consequences. Check you configuration 
thoroughly after changing the ROOT directory.

Reset All will set all shortcuts back to their 
defaults. Any shortcuts you have created will be 
forgotten. Are you sure you want to do this?

Warning message that if you proceed all short-
cuts will be reset to the default values.

Are you sure you want to reset the positions of 
the toolbars?

All window positions of RadWorks will be reset. 
The default window positions will be restored. 
This cannot be undone.

The application must be restarted for the changes 
to take effect

If the user has changed some of the default hang-
ing protocols and wants to see the changes on 
the layout tooltab in the Data Selector, the appli-
cation will have to be restarted.

Invalid DICOM field The entered DICOM field is not a valid DICOM 
field.

An internal error occurred in the application. It 
must terminate immediately

An internal error occurred in the application. No 
recovery is possible. The application will be termi-
nated to ensure data integrity. Please contact 
your distributor.

You cannot enter an empty date Specify a valid date.

Empty query is not allowed! Empty queries are not allowed. Note that this is a 
setting of the view.

Invalid time <time> Specify a valid time.

Error message Cause of message
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<directory> is not relative to the ROOT directory 
<ROOT directory>. Do you want to set it anyway?

The specified directory is not relative to the 
ROOT directory and specifying this may cause 
problems later on.

No description entered. Please enter a descrip-
tion

To be able to refer to a Window Level you need to 
enter a description.

Please specify a description To store a new Window Level a description has to 
be provided.

The Description already exists. Please change While storing a new Window Level a description 
was used that already exists. Change it to make it 
unique.

Exit application? Click OK to exit the application, otherwise click 
Cancel.

Could not connect to local database The system was unable to connect to the Data-
base Service. Check that this is running.

The application must be restarted to obtain the 
default window positions

Restart the application in order to obtain the 
default window positions again.

Could not lock study after saving it An error occurred while locking the study.

One of the unused channels is still activated The number of used channels could not be set 
because a channel with a higher number was still 
activated.

If you select a different device now, you will not be 
able to cancel this dialog. Proceed?

When a different device is selected the settings 
for that device are saved before you can continue 
with entering data for the other device.

Delete image type <name>? This message is displayed to confirm if you really 
want to remove the image type.

External clients exist. If you quit the application, 
the clients may crash. Do you want the applica-
tion to suspend exiting until the last client has 
left?

Other applications have connected to RadWorks 
via the COM interface,. They may fail or crash 
when you force the application to exit. If you click 
Yes, the application will suspend until all other 
applications have left.

Check at least one modality, or select ‘Any modal-
ity’

When you have checked the ‘Modality’ radio but-
ton, you must check at least one of the modalities 
in the list.

Could not start import of data One of the studies could not be imported.

The save action is canceled, because the study 
status is not correct

If you are trying to save one study, the message 
states the current study status.
If you are trying to save multiple studies, the mes-
sage specifies for each study the patient name 
and the study status.

Error message Cause of message
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Data Selector

Error message Cause of message

<Action>: Can only be performed on studies in 
local database

The requested action can only be performed on 
studies in the local database. If you want to per-
form the action on the study, import it to the local 
database first.

No selection available General message when no selection has been 
made in the worklist view.

Do you want to delete the font? Warning that continuing will delete the font.

Do you want to delete the filter? Warning that continuing will delete the filter.

No field selected No field has been selected to be removed or 
added.

Description must be unique The description of a view must be unique.

Description may not be empty Each view must have a unique description.

Incorrect directory! Directory must be empty (for 
default) or a full path

The specified directory path is incorrect. A full 
path specification must be provided.

Locked study in selection. Can only delete data 
from unlocked studies

One or more studies in the selection is locked. 
Studies must be unlocked before they can be 
deleted.

No folder selected When clicking the Delete button for folders, a 
folder must be selected.

No selection available No selection was made before the selected com-
mand (delete or move for example).

Not all selected data could be moved General message when not all selected studies 
could be moved. This may be due to the fact that 
they are in use by other parts of the system (tel-
eradiology or printing for example) or because 
they are already present in the destination folder. 
Note that some studies in the selection may have 
been moved.

Empty description is not allowed When filling in the settings for a remote view, the 
Description field may not be empty.

No folder selected to edit When clicking the Edit button for folders a folder 
must be selected.

Folder name may not be empty When adding or editing a folder, the folder name 
cannot be empty.

Series in selection. Can only lock complete stud-
ies

Only complete studies can be locked. When one 
or more series are selected the lock command is 
not performed on any selected item.
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Remote View could not be deleted General error when the remove view could not be 
deleted.

Remote View could not be created General error when the remote view could not be 
created.

New folder name must be unique The folder already exists. All folders must have 
unique names.

No folder specified No folder was specified for the compression.

Can only compress studies in local database Only studies in the local database can be com-
pressed.

Not all studies could be compressed Not all selected studies could be compressed.

Selection of studies of same patient is only possi-
ble when only one study is selected.

Select just one study.

Data is in use by another part of the system or by 
another system

It may be that the study is currently being printed 
or send to another system, making it temporarily 
unavailable.

Not all selected data could be imported General message when not all selected studies 
could be imported. Note that some studies may 
have been imported after this message.

Can only move studies or patients in local data-
base

Only studies or patient in the local database can 
be moved. (You cannot move studies in worklists.)

Can only set status of studies in local database Only statuses of studies in the local database can 
be set.

Not all selected studies could be locked General message when not all selected studies 
could be locked.

Series in selection. Can only set status complete 
studies

Only the study statuses of complete studies can 
be changed. When one or more series are 
selected, the study status change command is not 
performed on the selected item.

Cannot delete Results or Interpretations The selection contains results and/or interpreta-
tions. These items cannot be deleted via the 
worklist control.

Status could not be set on all studies General message when not all studies statuses 
can be set.

Folder name could not be changed General error when the Database Service could 
not change the folder name.

Study status could not be set General message when the study status could not 
be set by the Database Service. This may be 
because the study is in use.

Error message Cause of message
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Field should not be empty During configuration of the Data Selector col-
umns, a particular field cannot be left empty.

Series in selection. Can only move complete stud-
ies

Only complete studies can be moved. When one 
or more series are selected the move command is 
not performed on any selected item.

Could not load all data General message when the study/series could 
not be loaded. This may occur when other parts of 
RadWorks are using this data (e.g. when the data 
is being transmitted to another site).

Folder name can only contain a-z, A-Z, 0-9 or 
spaces

The name of a folder can only contain a-z, A-Z, 0-
9 and spaces. Note that @#$%^ etc. are not 
allowed.

Incorrect parameters General error when the settings supplied in the 
dialog box are not correct.

Folder already exists It is not possible to add a folder with a name that 
already exists.

Can only edit folders of local database Only folders of the local database can be edited. 
Note that folders of remote RadWorks systems 
can be seen, but cannot be edited.

Image(s) in selection. Can only delete complete 
studies or series

The selection contains one or more images. Rad-
Works can only delete complete studies and/or 
series.

Default folder cannot be deleted The default folder cannot be deleted because it is 
needed for receiving new studies.

Folder could not be deleted. Folder contains one 
or more studies

Folders can only be deleted when empty. Check if 
the folder still contains studies.

Not all selected data could be deleted General message when not all selected data 
could be deleted. Note that locked studies cannot 
be deleted.

Folder could not be created General error when the Database Service could 
not create the folder.

Remote View could not be edited General error when the remote view could not be 
edited.

Can only delete folders from local database Folders can only be deleted from the local data-
base and not from remote databases.

Can only delete local data Studies can only be deleted from the local data-
base and not from remote databases.

No Remote View selected When adding or editing a remote view, a remote 
view must have been selected.

Error message Cause of message
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Could not connect with local database General message when RadWorks cannot con-
nect to the local database.

Can only add folders to local database Folders can only be added to the local database 
and not to remote databases.

Last view cannot be deleted The last view cannot be deleted. RadWorks 
needs at least one view to work properly.

No worklist active General error when no worklist control is active. 
Click on a worklist control to make it active.

Are you sure you want to delete this column? Confirm that you want to delete the column.

Error message Cause of message
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Integration module

Viewing

Error message Cause of message

Command validation failed. Check your Integra-
tion Module configuration. 

It was not possible to execute the command. The 
command may refer to a file no longer available. 

Command failed: Selections at this level are not 
supported by this type of worklist.

Command failed: Selection type is not allowed The type of selection required by the command is 
not available on the currently active worklist. This 
may occur when you a command taking patient 
level selections is invoked on a non-patient 
worklist. 

IntgModu: No license found for integration module You tried to start the integration module without a 
licence for it.

Command failed: No selection was found A command requiring a selection was invoked 
when the active worklist had no valid selection.

Command failed: Multiple selection not allowed 
as argument

You invoked a command on a selection with multi-
ple items for a command that can only take a sin-
gle selection as an argument. 

Command failed: The query selection returned an 
error.

The command you invoked tried to query the cur-
rent worklist. This produced a problem. 

The application must be restarted for changes in 
the selector desktop to take effect.

When you close the Integration module configura-
tion, all changes will take effect immediately 
except for the Data Selector. It will be updated 
when you restart RadWorks.

Error message Cause of message

User defined name is invalid. The edit field should 
not be empty and the name should not contain 
any white spaces. Please define a valid name for 
this special command

The user defined name is invalid because the edit 
field should not be empty and the name should 
not contain any white spaces.

OK to delete zooming preset? Click OK if you want to delete the zooming preset, 
otherwise click Cancel.
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User defined name already exists, please define 
another name

The name for the Special Command already 
exists and therefore you have to specify a different 
name.

Are you sure you want to abandon this job? Warning message to inform you that proceeding 
will abandon the active job.

A composition dialog box is already on-screen. 
Please close that dialog box first

Only one composition dialog box can be on-
screen at a time. Both the Compose Print Job and 
Compose Teleradiology Job dialog box are com-
position dialog boxes. This means that you cannot 
have a Compose Print Job dialog box and a Com-
pose Teleradiology Job dialog box on-screen at 
the same time.

Cannot save data. Do you want to exit without 
saving?

The system was unable to save a study correctly. 
This is probably due to a configuration problem 
(most likely the work directory setting).

You cannot change the patient while a composi-
tion dialog box is on-screen. Please close the dia-
log box first.

Close the composition dialog box before changing 
the current patient or study.

Unable to display image format An attempt was made to view data of which the 
image format is not supported by RadWorks.

This monitor is not calibrated correctly The monitor is not calibrated correctly. Recalibrate 
the monitor.

Your monitors are not calibrated, true size will 
become disabled in Viewing

Due to the fact that the monitors are not cali-
brated, true size viewing will not be available in 
the Viewing Section.

The name already exists. Please choose another 
name

When attempting to add settings for a new modal-
ity, the system detected that the modality is 
already in use. Either select this modality from the 
drop-down list or change the modality name to 
make it unique.

Cannot execute Special Command due to incor-
rect study status of the following studies: <List of 
Studies> Save Action Canceled.

System was unable to execute the Special Com-
mand because you are not allowed to change cur-
rent study status to desired study status.

No data to load There are no patients available to load.

No viewing desktop available There is no desktop for viewing available.

Failed to insert name Insertion of name failed. Contact your system 
administrator.

Could not load data The system was unable to load a study correctly. 
The study may not be a valid RadWorks data file.

No selection available You attempted to view data while no study was 
selected.

Error message Cause of message
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No data to paste No data was exported so there is nothing to paste 
to the clipboard.

You cannot leave Viewing while a composition 
dialog box is on-screen. Please close the dialog 
box first.

Please close the composition dialog box before 
leaving the Viewing Section.

Could not load data selection The system was unable to load a study correctly. 
The study may not be a valid RadWorks data file.

Export to clipboard failed The system was unable to export the data to the 
clipboard. Please check if the clipboard is empty 
and that you are not trying to export too much 
data.

Keep settings failed The system was unable to save the export set-
tings to the Registry.

Could not save all data The system was unable to save a study correctly. 
This is probably due to a configuration problem 
(most likely the work directory setting).

No data to export No data was exported so there is nothing to write 
to disk.

Cannot execute Special Command due to incor-
rect study status. (Current study status is <sta-
tus>.)

The system was unable execute the Special Com-
mand because of an inappropriate study status.

Cannot use empty separator For export functionality a separator has to be 
specified.

Unable to add to current study/studies The system was unable to add the selection to the 
currently loaded combination of studies and 
series. Select all data that you want to view and 
reload all data instead of adding to the current set.

Are you sure you want to remove <modality>? Ensure that you really do want to delete settings 
from the Registry.

Cannot delete registry key <key> Error message that the system failed to delete a 
Registry key.

Could not create cine link The system was not able to create the cine link.

Construction dialog failed The system was unable to create the dialog. The 
image is probably empty.

Save failed The system was unable to successfully complete 
a save operation. Please exit the study without 
saving data.

No permission to mark/unmark Key Images You do not have the permission to mark or unmark 
images as key images.

Error message Cause of message
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Mark/unmark Key Images in this modality has 
been disabled

The ability to mark and unmark key images has 
been turned off for that particular modality.

Selected items are from different patients Warning when going into Multi View mode that the 
selected items are from different patients.

The application must be restarted for the changes 
to take effect

The system (or RadWorks) must be restarted for 
the changes made during configuration to take 
effect.

Cannot change current study status to desired 
study status. (Desired study status is <status>.)

The system was unable to change the study sta-
tus to the desired study status. Check that you 
have the permission to set the study to the desired 
status.

Do you want to overwrite file <file>? Warning that you that you have specified an exist-
ing filename, and proceeding will overwrite the 
current file.

No next item available There is no next item available for viewing.

No previous item available There is no previous item available for viewing.

You have applied a non-linear window level. If you 
save this study it will be stored as a linear window 
level.

RadWorks can only store linear window levels 
with the images. If you decide to save this study, 
the window levels will be saved as linear window 
levels.

Name cannot be empty You must specify a name.

You have no permission to write to file <file> You do not have permission to write to the speci-
fied file. Specify a different file.

Change Viewport Areas is not yet supported for 
this monitor system (multiple rows)

Your monitor system configuration contains multi-
ple monitor rows. The ‘Change Viewport Areas’ 
functionality is not supported for this monitor con-
figuration.

The monitor IDs read from the registry are invalid: 
probably no monitor IDs or more than 2 monitor 
IDs.

One or both monitor IDs are not within the bound-
aries of the system monitor configuration. For 
example, if you have a multi-monitor system with 
four monitors next to each other, and no monitors 
on top of each other, then the monitor ID values 
have to be 1, 2, 3 or 4.

The first monitor ID you entered is larger than the 
second monitor ID value. This is not correct.- The 
monitor configuration of e.g. viewing must be 
specified within the boundaries of the system 
monitor configuration.

Reasons why the verification of the entered moni-
tor IDs or monitor configuration failed.

The specified monitor IDs must be less than or 
equal to the system monitor count.

Reasons why the verification of the entered moni-
tor IDs or monitor configuration failed.

Error message Cause of message
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You have applied a non-linear window level. If you 
save this study it will be stored as a linear window 
level

While viewing your patient you applied a non-lin-
ear window level. If you want to save this study 
the non-linear window level will be saved as a lin-
ear window level. The reason is that the non-lin-
ear function type and slope cannot be stored in 
DICOM.

No next/previous item is available You tried to go to the next/previous item in the list, 
but there is no next or previous item.

Select Annotation First Annotations and measurements can only be 
pasted when an annotation has been cut or cop-
ied first.

Font size (xx) must be between <min> and <max> 
points.

Enter a font size between the limits specified.

This command is irreversible. Do you want to pro-
ceed?

What you are about to do cannot be undone. Click 
Yes to proceed anyway with the irreversible 
action.

This image is not suitable for overlay purpose The image you selected cannot be used for over-
lay purposes.

Copying this annotation to clipboard failed, 
because there is no annotation to clip

You cannot copy non-existent annotation.

Pasting an annotation from clipboard failed, 
because clipboard is empty

There is no annotation on the clipboard, so you 
cannot paste it.

Are you sure you want to paste the xxx to all 
images in this series?

Please confirm that you want the shutter or anno-
tation to be copied to all images in the series.

An image is found that already contains a mask. 
Do you want to continue and skip this image?

A ‘Paste To All Images’ found an image that 
already contains a mask. An image can have only 
one mask. Answer Yes to leave the image alone 
and continue, or No to stop.

Insert the image next to this one? Inserting the image failed. You can click Yes to 
insert the next image.

There are no objects to paste Nothing is on the clipboard, so you cannot paste 
it.

Insert the image next to this one? Inserting the image failed. You can click Yes to 
insert the previous image.

The Window Level Set ‘xxx’ has become empty. 
The Set ‘yyy’ is now loaded

This is to inform you that the a more general win-
dow level set is loaded instead of a more specific 
one.

OK to delete zooming preset? If you click OK, the zoom preset will be deleted.

A new Window Level Set ‘<modality>, <body 
part>’ will be created. Do you want to copy the 
presets from the Window Level Set ‘<modality>’

If you click Yes here, the window level set for 
<modality> will be used as the basis for the newly 
formed body part-specific window level set.

Error message Cause of message
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Are you sure you want to remove the specified 
item? 

If you click Yes the current item will be removed; if 
you click No the item will remain in the list.

Only one Filter Set can be modified at the time You cannot modify multiple filter sets at the same 
time.

Are you sure you want to delete filter set? You should be sure that you want to delete the 
specified filter set.

No Filter Set selected You need to select one or more filter sets.

The last applied window level is a non-linear win-
dow level and cannot be saved as such

If you want to save the window level it will be 
saved as linear window level.

The filter set name you specified already exists. You should specify a different name.

Only one Filter Set can be copied You cannot copy multiple filter set items at the 
same time. Select a single filter.

No Filter selected You need to select a filter.

Cannot modify multiple filters. Please select one 
filter

It is not possible to modify multiple filter set items 
at the same time. Select one single filter.

The name you entered is already existing, please 
enter a unique filter name

The filter name you specified is already being 
used. Specify a different name.

It is not allowed to create a kernel filter without 
kernel values

You have not specified the kernel values for this 
kernel filter.

Please enter a unique filter name You must enter an unique filter name.

It is not allowed to enter a modality name with the 
prefix ‘Filter’

You prefixed the modality name with ‘Filter’. This 
is not allowed. Enter a different modality name.

Cannot delete system default You are trying to delete the default filter set. You 
cannot do this.

Please specify a valid Modality identifier The modality you have specified is invalid.

Error message Cause of message



GEMS IT Applicare

343

Reporting

Error message Cause of message

Could not show study report The report for this study may be present but could 
not be shown. Contact your system administrator.

No Default printer available You are attempting to print one or more reports 
that were shown in plain text. Probably the default 
printer has not been configured. Specify a default 
printer before attempting to print.

Failed to initialize printer You are attempting to print one or more reports 
that were shown in plain text. Probably the default 
printer is not correctly configured. Contact your 
system administrator.

The Profile Name <name> already exists. Please 
enter a unique name

Enter a unique profile name.

The Profile name should not be empty. Please 
enter a unique name

Enter a non-empty profile name.

No selection available You should first select at least one item, contain-
ing one or more studies, in order to show their 
report(s).

Could not save report <report> The report could not be saved for some reason. 
Contact your system administrator.

The report could not be printed / Report <report> 
could not be printed.)

Only the first <no.> reports were printed) / None 
of the reports were printed

A printing error occurred. Contact your system 
administrator.

Selection too large, You can show reports for 10 
studies at maximum

If you want to show the reports for multiple stud-
ies in the Data Selector, make sure that the selec-
tion comprises 10 studies as a maximum.

Could not load study Data could not be loaded. Data may be in use by 
another part of the RadWorks system / Data is 
locked by <user> on <computer> since <time>

An error occurred when trying to open a study for 
showing the report from the Data Selector. Con-
tact your system administrator.

No previous selection available You clicked the Previous button while there was 
no previous item available in the active worklist.

No next selection available You clicked the Next button while there was no 
next item available in the active worklist.
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No reports available for this selection No selec-
tion available

You should first select at least one item, contain-
ing one or more studies, in order to show their 
report(s).

Could not create reporting dialog The system was not able to show the report dia-
log box in the Data Selector. Contact your system 
administrator.

Could not add study report The system was not able to show one of the (mul-
tiple) reports in the Data Selector. Contact your 
system administrator.

Could not set study report The system was not able to show one of the 
reports in the Viewing Section. Contact your sys-
tem administrator.

Could not load report module The Report Module was not loaded correctly, so 
reports cannot be shown. Contact your system 
administrator.

The report text could not be displayed in the 
browser control

You used an alternative data entry mechanism for 
entering reports (MS Word, HTML) but the sys-
tem did not succeed in showing the report in the 
document. You will not be able to see the con-
tents of the report (if any) and the report will be 
read-only. Contact your system administrator.

Could not show all reports for this selection

Could not show the report(s) for this selection None of the reports for the selected studies could 
be shown. Contact your system administrator.

You reached the maximum content size of this 
report text, being 10240 characters. If you used a 
PASTE command, the inserted text may have 
been truncated.

The database field in which the report is stored 
has a maximum size of 10240 characters. If you 
type text into a plain text control, this message 
will appear when you reached that maximum. If 
you reached it by pasting text, the pasted text 
may have been truncated. In this case you are 
advised to check the end of your text.

Could not display study report In the Viewing Section, the report was not dis-
played properly. Please contact your system 
administrator.

The additional tags could not be displayed in the 
browser control

Additional tags can be displayed in both HTML 
and MS Word reporting. Not all of the field 
defined here were filled with the correct values. 
This is not generally a serious problem, but it 
should not occur. Contact your system adminis-
trator.

The report appears to be <number> characters 
long, while the maximum size is 10240 charac-
ters. Do you want to truncate it?

The report MS Word template document or HTML 
file allowed you to make a report which was too 
long. You must choose between truncation or re-
editing (i.e. shorten it manually). In the future your 
template should prohibit you from entering a 
report this size. Contact your system administra-
tor to arrange this.

Error message Cause of message
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Could not reload study for report ‘<report>’ After you saved or discarded the changed report, 
the report text was not restored properly. Contact 
your system administrator.

Error message Cause of message
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Hanging protocols

Error message Cause of message

Redraw layout failed Drawing of the hanging protocol failed.

Splitting this area into <number of rows> x <num-
ber of columns> series areas failed. <reason>

You have tried to split a series area into new 
series areas which are too small to display (see 
<reason>). Most of the time this is not a useful 
action. If you really want to perform this split, 
enlarge the Hanging Protocol Editor dialog box 
and try again.

Splitting this area into <number of rows> x <num-
ber of columns> viewport areas failed. <reason>

You have tried to split a viewport area into new 
viewport areas which are too small to display (see 
<reason>). Most of the time this is not a useful 
action. If you really want to perform this split, 
enlarge the Hanging Protocol Editor dialog box 
and try again.

Adding window property for this series area failed. 
<reason>

(Idem for zoom, annotation, cine, pin, criteria, 
time ordering). You have tried to add a window 
property for this series area. The reason why this 
fails is specified by <reason>. You have probably 
entered invalid window parameters.

Adding window property for this viewport area 
failed. <reason>

(Idem for zoom, annotation, cine, pin, criteria, 
time ordering) You have tried to add a window 
property for this series area. The reason why this 
fails is specified by <reason>. You have probably 
not set a pin or cine for this viewport or entered 
invalid window parameters.

No selection available General message when no selection is available 
in the Worklist Control.

No valid DICOM field entered! The DICOM field does not contain a valid DICOM 
field.

Script error <error number>: <error description> 
Ln <line number>, Col <column number>: ‘<error 
line>’

The selection criteria have a VB-script error in line 
<error line>.

Creating script-engine failed One of these four errors might occur if Internet 
Explorer is not (properly) installed. Test this by 
running Internet Explorer.

Setting host window failed

Adding top-level item failed

Setting script state to connected failed.

Empty layout name is not allowed You have to specify an unique name for this hang-
ing protocol.
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A name length of <length> is too long. Maximum 
number of characters allowed is <maximum 
length>.

You have to specify a name with length <maxi-
mum length>, because this name is also used in 
the VB-script as identifier.

Name <name> is already in use You have to specify an unique name for this hang-
ing protocol.

Name <name> is already in use (by <name with-
out special characters>)

You have to specify an unique name for this hang-
ing protocol. You have probably specified a new 
one with special characters (e.g. ‘&’) which is 
allowed. The name is only unique however if you 
can replace all the special characters by under-
scores (‘_’) and it is not the same as the name of 
another existing hanging protocol (with all its spe-
cial characters replaced by underscores (‘_’)).

Specify Hang Criteria for the pinned viewport You have pinned a viewport but you have no hang 
criteria specified for it. This means that the appli-
cation cannot find out which image has to be 
pinned in this viewport. Specify a DICOM criterion 
or Time Order criterion.

Specify Hang Criteria for the viewport containing 
a cine

You have added a cine to a viewport but you have 
no hang criteria specified for it. This means that 
the application cannot find out which images have 
to be displayed in cine mode. Specify a DICOM 
criterion or Time Order criterion.

Both layout definition and selection criteria are not 
correct. Do you want to leave anyway? If YES, the 
previous correct version will be applied

Both the layout definition and selection criteria are 
not correct. If you leave this dialog box, the layout 
definition and the selection criteria are set to the 
last correct version which is the version of the last 
correct ‘Check’ you performed. Try to solve the 
layout definition first and then solve the errors in 
the selection criteria.

The layout definition is not correct. Do you want to 
leave anyway? If YES, the previous correct ver-
sion will be applied.

The layout definition is not correct. If you leave 
this dialog box, the layout definition will be set to 
the last correct version, which is the version of the 
last correct ‘Check’ you performed. Otherwise 
click Check to check the layout definition to find 
out what is wrong.

The selection criteria is not correct. Do you want 
to leave anyway? If YES, the previous correct ver-
sion will be applied.

The selection criteria is not correct. If you leave 
this dialog box, the selection criteria will be set to 
the last correct version, which is the version of the 
last correct ‘Check’ you performed. Otherwise 
click Check to check the selection criteria to find 
out what is wrong.

No items available There are no hanging protocols in the list.

Layout definition is NOT correct. The layout definition is not correct. Possible rea-
sons are:

Empty Layout Definition The layout definition is empty.

Parse Error The layout syntax is not correct.

Error message Cause of message
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Invalid Layout Name The layout name has been changed. This is only 
allowed in the Hanging Protocol Editor dialog box.

Layout definition is correct This message informs you that the layout defini-
tion is correct.

Selection criteria is NOT correct. <Reason> The selection criterion is not correct. Possible rea-
sons are:

Empty Selection Criteria The selection criterion is empty.

Script error <error number>: <error description> Ln <line number>, Col <column number>: ‘<error 
line>’

 The selection criteria has a VB script error in line 
<error line>.

You specified an incorrect return value!

Use <return value> The function return value has been changed. The 
return values should always be equal to <return 
value>.

Creating script-engine failed Setting host window failed

Adding top level item failed Setting script state to connected failed.

One of these four errors might occur if Internet 
Explorer is not (properly) installed. Test this by 
running Internet Explorer.

Selection criteria is correct

This message informs you that the selection crite-
rion is correct.

Are you sure you want to delete this hanging pro-
tocol?

(To exclude this hanging protocol you can also 
disable the hanging protocol.)

This message appears to warn you that you are 
about to delete a hanging protocol and to inform 
you that another option is to disable the hanging 
protocol so you can always enable it again.

Are you sure you want to discard your changes? General message when clicking the Cancel but-
ton. You will lose your changes if you click Yes.

Please select one item In the hanging protocol manager, the action you 
selected can only be applied to a single selection.

The hanging protocol xxx was designed for a dif-
ferent monitor system configuration

You are trying to import a hanging protocol which 
does not match your monitor configuration. It will 
not be imported.

The hanging protocol xxx is an automated (so not 
a default) hanging protocol. Do you want to import 
this hanging protocol anyway?

The protocol you want to import belongs to the 
‘wrong’ class. If you click Yes, it will be imported 
anyway.

The syntax of hanging protocol xxx is not correct The hanging protocol has somehow become cor-
rupt (the file for import may have been corrupted). 
The hanging protocol will not be inserted. Try rec-
reating the file for import (by re-exporting a set of 
protocols for example).

Error message Cause of message
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Select one of the wizards first You need to select one of the Hanging Protocol 
Wizards before clicking OK.

Export to XML file failed The export of the hanging protocol failed. The 
disk may be full.

Import from XML file failed The import of the hanging protocol failed. The file 
may be corrupt.

The hanging protocol xxx was exported for mod-
ule yyy. Do you want to import this hanging proto-
col for module zzz anyway?

The hanging protocol in the file was exported for 
another module. If you click Yes this problem will 
be corrected for you.

There are no wizards installed in the xxx module No wizards are available for the Hanging Proto-
cols for module xxx.

Empty hanging protocol name is not allowed You cannot create give a hanging protocol an 
empty name.

A name length of is too long. Maximum number of 
characters allowed is 255

You cannot create or rename a hanging protocol 
with a name containing over 255 characters

Import succeeded The Hanging Protocols were successfully 
imported.

Export succeeded The hanging protocols were successfully 
exported.

First select a rule in the list You must first select the rule that you want to edit 
or remove

The Selection Criteria Wizard can only be used 
for automated hanging protocols

Only automated Hanging Protocols have selec-
tion criteria, so this wizard cannot be used for 
default Hanging Protocols.

Error message Cause of message
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MPR/MIP

Error message Cause of message

The selected image range is sparse (the slice 
thickness is smaller than twice the slice distance). 
This may lead to interpolation artifacts. Are you 
sure you want to continue?

If the images are spaced too far apart, data will be 
lacking and the rendering results may be unsatis-
factory. Some studies however, have incorrect 
information about slice thickness; they may still 
render useful images.

Cannot load study Loading the study failed.

Study not suitable for MPR/MIP. The selection 
was rejected because: <reason>

The study you selected does not contain any suit-
able series or image ranges which can be used 
for the stated algorithm. The <reason> details 
why.

The name must be unique and non-empty Pixel range defaults must have unique names. 
The one you typed already exists.

No selection available To start MPR or MIP you must first make a selec-
tion in the Local Database.

Save data failed. Leave module anyway? An error occurred when saving the data. If you 
click Yes now, your new images/series will be lost.

Failure while creating cine An error occurred during the creation of the cine. 
A cine will not be shown.

The selection had to be split up because: <rea-
son>

You made a selection, but as a whole it is not use-
ful for MPR or MIP. However, some sub-range of it 
can be used for MPR or MIP. You will see a dialog 
box which enables you to choose a range.

The running cine is not saved. Are you sure you 
want to leave the module?

You have a cine running and are attempting to 
leave MPR/MIP. If you click Yes the cine will not 
be added (and your changes will be lost).

Cannot create zero size cine The cine you requested has zero size (either zero 
degrees for a rotation cine or zero mm for a trans-
lation cine). It makes no sense to create a cine 
using these parameters.

Study is not local You tried to start MPR or MIP on a study that is 
not local (e.g., from a remote view). Make sure the 
study is in your local database by importing it.

Save failed Saving the new cine series failed.

The running cine is not saved. Are you sure you 
want to reset (and lose the cine)?

Clicking Reset will mean you will lose the cine. If 
you want to save your cine first, click No and then 
Save on the Cine Creation tooltab. You can safely 
reset after this.

Active viewport does not contain an image The active viewport is empty; the MPR/MIP mod-
ule is not able to find out which study you want to 
use for MPR or MIP.
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Must have a single selection You have multiple items selected. The MPR/MIP 
module expects a single selection. Select only the 
study you want to use for MPR or MIP.

No active list available None of the local or remote views is active. Acti-
vate a list by clicking its header.

No image available in viewport The active viewport doesn’t contain an image; the 
MPR/MIP module is not able to find out which 
study you want to use for MPR or MIP.

No active viewport No viewport is currently active; the MPR/MIP 
module is not able to find out which study you 
want to use for MPR or MIP.

<message concerning workgroup server> The study cannot be used for MPR because 
someone else on the same workgroup server is 
using it.

Error message Cause of message
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Teleradiology

General

Destination dialog box

Origin dialog box

Error message Cause of message

Connection Service currently not available The Connection Service is not running. Typically 
the system will have to be rebooted or the service 
may need to be (re-)started.

No item selected You are attempting to apply an operation to an 
item in a list box but no item is selected. Select an 
item in the list box.

No item(s) selected You are attempting to apply an operation to a 
range of items in a list box but no items are 
selected. Select at least one item in the list box.

You do not have a valid license to send a study The system cannot find a license that permits 
sending studies. Please verify your license. If you 
have a dongle license, check that the dongle is 
still connected to the parallel port of the computer.

Error message Cause of message

Name <name> already exists. Please use a 
unique name

You are attempting to add, copy or modify a desti-
nation with a name that is already in use. Please 
use a unique name for each destination.

Passwords are not identical The two passwords that were entered are not 
identical. Please make sure the password and the 
reconfirmed password are identical.

This field cannot be left empty The specified field must have a value. Specify 
one.

This field cannot contain just spaces The specified field must be filled with a real value 
that contains more than just spaces. Specify one.

Are you sure you want to delete destination 
‘<name>’?

You are about to delete the destination. If you do 
this you will lose the information for the destina-
tion.

Please specify valid compression parameters Invalid compression parameters were specified. 
Specify compression parameters that are valid for 
the current situation.
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Error message Cause of message

Name <name> already exists. Please use a 
unique name

You are attempting to add, copy or modify an ori-
gin with a name that is already in use. Use a 
unique name for each origin.

Cannot delete origin <name> The origin could not be deleted. Reboot the sys-
tem and try again.

Cannot modify origin <name> The system cannot modify its origin database. 
This may indicate an installation or configuration 
failure.

Are you sure you want to delete origin ‘<name>’? You are about to delete the origin. If you do this 
you will lose the information for the origin.
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Receive Log dialog box

Send Queue and Send Log dialog boxes

Send To dialog box

Error message Cause of message

Could not access key: <key> Part of the configuration information for export 
functionality cannot be accessed. This may indi-
cate an installation or configuration failure.

Cannot open file: <name> The export information cannot be saved to the 
specified file. Check that a valid file name has 
been specified. 

Error message Cause of message

Could not access key: <key> Part of the configuration information for export 
functionality cannot be accessed. This may indi-
cate an installation or configuration failure.

Cannot open file: <name> The export information cannot be saved to the 
specified file. Check that a valid file name has 
been specified. 

Error message Cause of message

You are not licensed to send a study The system cannot find a license that permits the 
sending studies. Verify your license. If you have a 
dongle license, check that the dongle is still con-
nected to the parallel port of the computer.

Can only send studies from local database It is not possible to submit a teleradiology job for 
items selected in remote views. Select studies in 
your local database view only.

Please select a destination You must select a destination if you want to sub-
mit a transmission job. Select a destination on the 
Teleradiology tooltab.

Could not send all selected items The system could not submit all selected studies 
for teleradiology. Examine your selection.

No destinations available Add a destination before trying to submit a telera-
diology job.
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Please specify valid compression parameters Invalid compression parameters were specified. 
Specify compression parameters that are valid for 
the current situation.

No selection available Select one or more studies before trying to submit 
a teleradiology job. 

Error message Cause of message
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Auto Transmit

Error message Cause of message

Cannot delete system default This auto transmit protocol is the system default 
and you cannot delete it. To disable this protocol, 
set its trigger type to <Disabled>.

Auto transmit protocol (system default) has been 
removed. Call your administrator.

Restart RadWorks. If the problem persists, call 
your system administrator.

Are you sure you want to delete protocol? Deleting an auto transmit protocol cannot be 
undone. Click OK to continue with deleting.

No protocol selected Select an auto transmission protocol first.

More than one protocol selected Select only one protocol and try again.

Rule cannot by modified with Add/Modify/Delete 
button.

You have already edited the script with the Edit 
button. Use it again if you want to modify the 
script. In the Edit Script dialog box, you can also 
delete the entire script. After closing the dialog 
box the Add/Modify/Delete buttons will be 
enabled again.

After editing script, the rule cannot be modified Rules cannot be changed once you have edited 
them. Click OK if you are confident of your JScript 
programming skills.

Script error <Code>: <Description>. In line <Line 
no.>, column <Column no.>: <Script line>.

The syntax of the JScript you entered is not cor-
rect. Modify the script at the cursor position.

Syntax error in: Check the syntax of the values you entered. 
Check that all values are between quotes, sepa-
rated by commas. For example: MR, CT.

Extra character(s) not expected Check the syntax of the values you entered. 
Check that all values are between quotes and 
separated by commas. For example: MR, CT

No value(s) entered Enter one or more values. Do not use quotes ().

No wildcard characters allowed for a value range. 
Remove it or enter a single value.

In a range, do not use wildcard characters such 
as *, or ?.

No wildcard characters allowed for a value range. 
Remove it.

In a range, do not use wildcard characters such 
as *, or ?.

No quotes needed here Enter the value without quotes ().

No valid field You have not entered a DICOM field, have not 
entered an existing DICOM field. Please enter the 
field.

No filter criterion selected Select a filter criterion first.
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<Name> is a reserved key word; please enter 
another name.

Enter another destination name.

Cannot get destination list The system could not retrieve a list of destina-
tions. Check that valid destinations have been 
entered for your system.

Cannot modify Auto Transmit parameters The system cannot modify its Auto Transmit 
parameters. This may indicate an installation or 
configuration failure.

Error message Cause of message



E R R O R ,  W A R N I N G  &  O T H E R  M E S S A G E S

RadWorks 6.0 installation and configuration guide

358 appendix A

Configuration

Compose Teleradiology Job dialog box

Export dialog box

Error message Cause of message

The system must be rebooted for the changes to 
take effect

This appears after configuration when the system 
settings have been changed. Reboot the system 
as recommended.

DICOM AE Title <AE Title> already exists for 
<Origin or Destination> <Name> OK to continue ?

Press Cancel and enter another AE Title. Alterna-
tively, press OK to enter the duplicate AE Title. 
We do not recommend entering duplicate AE 
titles since this is not in accordance with the 
DICOM standard.

Error message Cause of message

The selected image is already contained in the 
job

The specified image(s) could not be added 
because it was (they were) already selected for 
the teleradiology job.

<number> image(s) could not be added, because 
they were already selected

The specified image(s) could not be added 
because it was (they were) already selected for 
the teleradiology job.

A composition dialog box is already on-screen Only one instance of the Compose Teleradiology 
Job or Compose Print Job can be active at the 
same time.

No destinations available Add a destination before trying to invoke the 
Compose Teleradiology Job dialog box.

Please select a destination You must select a destination if you want invoke 
the Compose Teleradiology Job dialog box. 
Select a destination on the Teleradiology tooltab.

Please select at least one image At least one image should be available in the 
Compose Teleradiology Job dialog box before 
you submit it.

The image cannot be added. It is not an original 
image

An attempt was made to, for example, add a fil-
tered image to the Compose Teleradiology Job 
dialog box. It is only possible to add unmodified 
images.

<No.> image(s) could not be added, because it 
was/they were already selected

The series have already been added to the Tel-
eradiology job. 
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Error message Cause of message

At least one field must be selected For export functionality at least one field must be 
selected.

Cannot use empty filename For export functionality a filename has to be spec-
ified.

Cannot use empty separator For export functionality a separator has to be 
specified.

Do you want to overwrite file ‘<name>’? Check that you want to overwrite an existing file. 
This will happen if you proceed without specifying 
a different file name.
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Converter module

Error message Cause of message

The system must be rebooted for the changes to 
take effect

Restart your system.

Please fill in a valid directory name The input directory name you specified is not 
valid (you forgot to specify a drive letter for exam-
ple).

Are you sure you want to delete the selected con-
verter?

You are about to delete the selected converter. 
Proceed only if you really wish to do this.

Please select a converter to remove You did not specify a converter that should be 
removed.

The converter name cannot be the same as a 
Base Format name! Please use a unique name

Specify a unique name as the converter name.

Converter <converter> already exists! Please use 
a unique name

Specify a unique name for the converter.

Directory <dir> does not exist, do you want to cre-
ate it?

Click Yes to create the specified directory.

Directory <dir> is read-only. You need to have 
write access to use it

Select a directory to which you have write access.

Please restart the AMI Converter Service for the 
changes to take effect

You must restart your AMI Converter Service. You 
can do this using the Control Panel, or by using 
the CtrlSrvW.exe utility in the RadWorks Utils 
folder (directory).

Could not create directory. Generic Error Due to some error the converter service failed to 
create a new input directory. This message is dis-
played when no particular cause could be deter-
mined. 

Please fill in all fields One of the fields that should be completed is still 
empty. 

Acquisition

Invalid filename <filename> The operating system reported an error when 
accessing the RIS input file.

Delete lookup table <Name>? Confirm that you wish to delete this lookup table.

<Name> already in the list. Replace? You have used a name to identify an image type 
that is already being used.

Could not read Acquisition settings An error occurred during reading the acquisition 
configuration parameters. The acquisition keys in 
the NT registry might be damaged.
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Device not ready The Acquisition of a new image cannot be started 
because the acquisition device is not ready. Wait 
a few seconds or try to locate the source of the 
problem.

Only administrators are allowed to configure 
Acquisition

The Configuration | Acquisition dialog box can 
only be accessed if the current user has adminis-
trative rights.

Only administrators are allowed to configure 
Acquisition Devices

The Device Management dialog box can only be 
accessed if the current user has administrative 
rights.

Active channel must be one of the used channels You are attempting to select a channel which is 
not marked as a used channel in the Device Man-
agement dialog box. You must select a used 
channel.

Save data was not successful AN error occurred while saving the study data. 
The data has not been added to the Data Selec-
tor. There may be insufficient disk space.

Add data to folder <name> unsuccessful After saving the data it should be added to one of 
the data folders in RadWorks. Perhaps this no 
longer exists.

Close not possible. There will be no active device 
left

There must be at least one device active. Other-
wise the Acquisition Module cannot be started.

One of the unused channels is still activated You are attempting to decrease the number of 
used channels of a device, but one of the chan-
nels is indicated as the default active one.

Default acquisition device undefined One of the loaded devices must be indicated as 
the default active one.

No default device could not be activated. Repair 
or select another one first.

The default active device reported an error when 
it was started. Check its configuration or select 
another device as the default.

Error <number> on open file <filename> The file <filename> could not be opened due to 
error <number>. Refer to the OS documentation 
for further explanation of this error.

Error allocating conversion memory buffer The memory allocation needed to create a tempo-
rary conversion buffer failed. There may be insuf-
ficient memory available. Try to make more 
memory available.

Not a valid date: ‘<date>’. Date must be formatted 
as: ‘<today’s date>’

You entered the date in an invalid format. Enter 
the date as in the example.

Not all mandatory patient fields are filled in Before a study can be saved, all mandatory fields 
must have a non-empty value. Ensure that all 
fields are completed and try again.

Error message Cause of message
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Add data to folder <folder> unsuccessful When saving, the data could not be added to the 
specified folder. Check that the folder exists.

Do you want to save your data? Should acquired data be saved before the Acqui-
sition Module is left.

Only one acquisition desktop allowed at a time It is not possible to start the Acquisition module 
twice.

Selection does not contain image data It is not possible to add a selection to the Pictorial 
Index or to rescan it if it does not contain a mini-
mum of 2x2 pixels of image data. It is possibly 
located outside the image.

Device channels not defined The channels of a device are not defined.

Submitting of study to station <station> failed Auto send of an acquired study failed. See send 
log for details.

Match only possible at patient or study level Patient information data match can only be done 
if the selected item is a patient or study.

No patient selected. You attempted to match a patient from the 
worklist without a patient being selected. Select a 
patient first.

Error message Cause of message
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General acquisition device messages

Error message Cause of message

Acquisition settings not available No image type has been defined. Create one 
using the image type dialog box.

Bit depth not set The bit depth has not been se in the current 
image type.

Native output of device not set The output of the device, monochrome or color, 
has not been defined

Output of device not set. The output of the device, monochrome or color, 
has not been defined

Invalid photointerpretation. The photo-interpretation has not been defined for 
the current image.

Wrong LUT. ColorMode and LUT do not match. A color LUT has been selected for a monochrome 
image, or vice versa.

Wrong LUT. Bit depth doesn’t match with current 
setting. 

A 12-bit LUT has been selected for an 8-bit 
image, or vice versa.

Could not read image type. An error occurred during the read of an image 
type from the NT Registry.

Could not save image type. An error occurred during the save of an image 
type to the NT Registry.

Could not delete image type. An error occurred during the deletion of an image 
type from the NT Registry.

Resolution not valid. The resolution has not been set or has an invalid 
value

Could not lock study after saving it An error occurred while locking the study.

One of the unused channels is still activated The number of used channels could not be set 
because a channel with a higher number was still 
activated.

If you select a different device now, you will not be 
able to cancel this dialog. Proceed?

When a different device is selected the settings 
for that device are saved before you can continue 
with entering data for the other device.

Delete image type <name>? This message is displayed to confirm if you really 
want to remove the image type.

HIS/RIS

Please enter a RIS identification number Before the RIS program can be started, a RIS 
identification number must be given. Enter a num-
ber.

Could not open RIS executable <ris.exe> The RIS executable does not exist or is invalid.
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RIS Executable not defined The RIS program has not been defined. This 
should be done in Configuration | Acquisition | 
Patient Information.

RIS Input file not defined The RIS input file has not been defined. This 
should be done in Configuration | Acquisition | 
Patient Information.

RIS Output file not defined The RIS output file has not been defined. This 
should be done in Configuration | Acquisition | 
Patient Information.

RIS Output file <filename> does not exist The output file which should be created by the 
RIS executable could not be found.

Error message Cause of message
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LUT 

File devices

Error message Cause of message

Too few entries for definition of lookup table. A LUT must have at least 2 entries.

Invalid LUT: value greater than table size For an 8-bit LUT the largest value is 255, for a 12-
bit LUT it is 4095.

No planes defined in LUT The ‘Planes’ field in Configuration | Acquisition | 
Lookup Tables has not been completed.

A monochrome LUT must have one plane For a monochrome LUT only one plane is used.

A color LUT must have three planes A color LUT must have three planes: R, G and B.

Error message Cause of message

File type <filetype> not supported. Files of type <filetype> cannot be read.

Could not open file. The file could not be opened for reading.

Data in file has been changed. During acquisition the contents of the file have 
changed.

Can’t open clipboard - maybe it is in use by 
another application

Retry, check if another application is using the 
clipboard.

Error in data on clipboard. The clipboard contains invalid data.

Unsupported clipboard format: <format> The data format of the data currently on the clip-
board is not supported.

Compressed bitmaps not supported Compressed bitmaps are not (yet) supported. Try 
to decompress them with another software pack-
age.

Data on clipboard has been changed. During acquisition the contents of the clipboard 
changed.

<file> is not a valid bitmap file. <file> appears to be an invalid bitmap file.

TIFF data is corrupted TIFF file contains corrupted data.

Bitmaps with <number> colors not supported. Bitmaps which contain an image with <number> 
of colors are not supported.

Non-RGB and non-grayscale image Only RGB and grayscale images can be read.
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Response curves not supported The TIFF file contains response curves which are 
not supported.

Fax compression not supported The TIFF file is Fax compressed, which is not 
supported.

Multi-page file not supported. The TIFF file contains multiple pages, which is 
currently not supported.

LZW Compression not supported The TIFF file is LZW compressed, which is not 
supported

Color maps not supported The TIFF file contains color maps, which are not 
supported

Unsupported tag X, X, X The TIFF file contains a tag (indicated by X,X,X) 
which is not supported

Error message Cause of message
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ScanmasterDX

HI*DEF Plus

LS75

Error message Cause of message

HOWTEK: Scan open error: %d Error on opening device. Possibly incorrect SCSI 
card. Only SCSI-2 is supported.

Error message Cause of message

HI*DEF: Error %d. See file HPDERROR.DAT or 
manual for more information

See the Imagraph documentation for further infor-
mation about the error.

HI*DEF: MemBase or IOBase not specified The NT Registry keys are not defined. Invalid 
installation.

HI*DEF: Invalid board handle The NT Registry contains an invalid reference to 
a board.

HI*DEF: Unable to open board at IO address <X> Return Code = <X>

The HI*DEF Plus board could not be found at the 
address specified.

HI*DEF: CHP file not specified

The board configuration file must be specified in 
the Device Management dialog box

HI*DEF: Error <x> reading file <file>

Invalid format or file does not exist The specified configuration file (CHP) is invalid or 
could not be found.

HI*DEF: Width must be divisible by four The with of an image to be acquired must be 
divisible by four.

HI*DEF: Time Out occurred while waiting for com-
mand ready

Video signal possibly not present.

Error message Cause of message

LUMISCAN: Requested and real size do not 
match

Not all scanned data could be stored. 

The scanner reports that the scanned image is 
larger than the size as given in the image type. 
Adjust the size in the image type dialog box.

LUMISCAN: For variable resolution, dpi has to be 
in the range 256...<number>
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If variable resolution is chosen in the image type 
dialog box, the maximum resolution depends on 
the width of the film. Here the maximum dpi for 
the current film width is given.

LUMISCAN: For an image with width <width>,

the fixed resolution has to be in the range 55 - 
<number> dpi

If fixed resolution is chosen in the image type dia-
log box, the maximum resolution depends on the 
width of the film. Here the maximum dpi for the 
current film width is given

LUMISCAN: To scan an image with height 
<height>, dpi has to be at least <number>

If an image is scanned with variable resolution, 
the minimal dpi depends also on the height of the 
film.

LUMISCAN: Scanned dpi <number> differs from 
requested dpi <number>

Not all requested dpis are available. If not, the 
scanner adjust it to the nearest available.

Error message Cause of message



GEMS IT Applicare

369

Mach DT 3153

Meteor

Pulsar

TWAIN

Error message Cause of message

DT3153: Could not open device The device driver not installed or started

In the Device Management dialog box, an incor-
rect (or no) alias has been given for device.

DT3153: Could not allocate frame buffer Device driver not installed / started

Error message Cause of message

Could not allocate board E: The Meteor board could not be activated:- 
Maybe device driver not installed or started

Possible conflict of device driver with graphics 
card (other Matrox card)

Signal type not specified The Meteor signal type must be specified in the 
Device Management dialog box

Error message Cause of message

Pulsar configuration (DCF) file not specified The DCF must be specified in the Device Man-
agement dialog box for each channel used.

File <filename> does not exist The specified Pulsar DCF does not exist.

Error message Cause of message

TWAIN ERROR: %d Generic error message from the TWAIN device. 
See the TWAIN documentation.
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At least one scan with current device must be 
done

The Force Scan option is enabled in the Device 
Management dialog box and at least one scan 
should be done with the TWAIN device before 
another device can be selected.

TWAIN: Could not load TWAIN_32.DLL The TWAIN_32.DLL is not installed on the sys-
tem.

TWAIN: Invalid TWAIN_32.DLL The TWAIN_32.DLL is corrupted.

Could not open TWAIN Source manager An error occurred when opening the TWAIN 
source manager.

TWAIN Source not defined The TWAIN Source must be defined in the Device 
Management dialog box.

Exception on TWAIN command An exception occurred when a TWAIN command 
was executed by the TWAIN source.

Data source <Sourcename> not available The Source may be in use by another application. 
If not, you can try the following (experienced 
users only):- Start the Task Manager, Select the 
Processes tab and check whether the following 
processes are running: DeskScan.exe, 
TWUNK_16.exe. If you are sure that these two 
processes are not being used by other processes, 
kill them and retry.

Error in TWAIN Data Source or Data Source Man-
ager

An error occurred on the TWAIN side. Retry, 
restart RadWorks. If the problem persists, reboot.

Parameter out of range One of the supplied parameters to the TWAIN 
source is out of range.

Capability not supported by source The currently attached TWAIN source does not 
support the required capability

Error message Cause of message
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Vidar

Printing

Error message Cause of message

VXR-12: No SCSI found Error occurs on loading the VXR-12. The PC has 
no SCSI, or Adaptec EZ SCSI software not 
installed.

VXR-12: Error on opening SCSI toolkit Vidar SCSI Toolkit could not be opened.

VXR-12: Scanner not found No VXR-12 scanner attached to the PC or VXR-
12 scanner switched on after the PC.

VXR-12: Calibration failed. Maybe sliders are not 
in widest position

The calibration of the VXR failed. If sliders are in 
the widest position there is possibly a hardware 
problem.

Rescan initialization failed: Film is already ejected The rescan failed because the film was no longer 
available.

Invalid resolution selected (<resolution> dpi) The resolution could not be set because that 
value is not supported by the scanner.

Invalid exposure time selected (<exposure time> 
units)

The exposure time could not be set because that 
value is not supported by the scanner.

Scan initialization failed: Failed to load film An error occurred while loading the film into the 
scanner.

Exposure time changed since last scan. Recali-
brate?

When the exposure time has been changed,  
recalibration of the scanner is recommended.

Calibrate VXR digitizer now? This message is displayed to confirm if you want 
to calibrate the digitizer because calibrations 
could take several minutes.

Scan initialization failed: Invalid scan parameters An error occurred when initializing the scanner. 
Check that the scanner is installed correctly.

Error message Cause of message

Are you sure you want to delete the selected lay-
out(s)?

If you confirm the operation, the selected lay-
out(s) will be deleted from the layout pool (and 
hence no longer be available for Print Destina-
tions).
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Please select a layout first You must select a layout before you can start a 
Compose Print Job dialog box.

Discard changes in Layout Pool? If you confirm the Cancel action, all modifications 
made to the layout pool will be discarded.

Failed to initialize printer The print command could not be executed 
because the printer could not be initialized.

No Default printer available Specify a default printer before trying to print.

Please select a layout first You must select a layout before you open the 
Compose Print Job dialog box.

Study(s) could not be printed (Some of) the selected studies could not be 
printed.

No selection available Before you can print studies, you must select 
them in the local database.

Please supply a host name DICOM Print Destination needs a host name.

X Size should be at least 100 If you check the Advanced check box on this 
property page, you must fill in the maximum film 
size in the X and Y directions. Neither can be less 
than 100 pixels.

Y Size should be at least 100 If you check the Advanced check box on this 
property page, you must fill in the maximum film 
size in the X and Y directions. Neither can be less 
than 100 pixels.

Please supply a name Print Destinations must have a unique name.

Please supply an Application Entity title DICOM Print Destination needs an Application 
Entity title.

No default printer selected To be able to print to a Windows printer you must 
install one. Using the Start button on the NT 
desktop, select Settings/Printers and choose Add 
Printer to add a printer to your system.

Job too large - too many image boxes; cannot be 
printed

If there are too many image boxes, a Virtual Film 
Sheet job cannot be printed. Reduce the number 
of images in this job (divide it up) or use the Data 
Selector to print the study.

Job too large - too many sheets; cannot be 
printed

The composed job was too large and could hence 
not be printed. Delete some sheets or split the job 
up.

No default printer selected. Use Setup... to select 
a printer

To be able to print to a Windows printer you must 
install one. Using the Start button on the NT 
desktop, select Settings/Printers and choose Add 
Printer to add a printer to your system.

Error message Cause of message
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Print destination ‘<name>’ is currently busy. A 
busy destination cannot be deleted 

The destination you selected to delete is currently 
busy (handling a print job). You cannot delete a 
busy destination. Please retry when the print job 
has finished.

Print Service currently not available The Print Service is no longer available. Restart 
the service.

Are you sure you want to clear this sheet (all 
images will be cleared)?

If you confirm the action, all the images on the 
current (visible) sheet will be cleared.

Cannot use remote view You can only print studies from the local data-
base, but you have selected one from a remote 
view. You may need to make the local database 
active by clicking on its header.

Selection not available The selection in the Data Selector is not avail-
able.

Error saving while submitting print job There was an error while saving the Print Job. 
Your hard disk may be out of storage space.

Print Destination is currently busy. Changes will 
take effect only after the current job

The Print Destination you are about to modify is 
currently busy (handling a print job). The changes 
you make will take effect after you have confirmed 
the modifications and the current job has finished.

Cannot open file: <name> The export output file cannot be opened. Type a 
new file name to save the export results to.

Job could not be printed There was an error while printing the job.

Discard changes in Layout Pool? If you confirm the Cancel action, all modifications 
made to the layout pool will be discarded.

Print Destination not available The Print Destination is not (or no longer) avail-
able. The Print Service may have died. Restart 
the service.

No Print Destination or Layout selected. You must select a destination and layout before 
you can print a job.

Layout name already in use The (modified) layout name is already in use. 
Choose another one.

Please select a destination first First select a destination before opening a Com-
pose Print Job dialog box.

Incorrect layout You tried to create an invalid layout. Retry using a 
correct definition (see on-line Help for details).

Are you sure you want to delete this sheet (all 
images will be deleted)?

If you confirm the action, the current (visible) 
sheet will be deleted, as well as the images on it.

Error message Cause of message
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Cannot get work directory path There is an inconsistency in the registry settings. 
The requested action (e.g., submission of a Print 
Job) cannot be performed. Use the Print Service 
configuration to correctly set the work directory for 
the Print Service.

Are you sure you want to delete the selected lay-
out(s)?

If you confirm the operation, the selected lay-
out(s) will be deleted from the layout pool (and 
hence no longer be available for Print Destina-
tions).

The system must be rebooted for the changes to 
take effect

The changes made in the configuration dialog box 
will only come into effect after the computer is 
rebooted.

Please supply at least one medium size DICOM Print Destination needs at least one 
medium size.

Please choose a new name as this destination 
already exists

The name you typed for the new print destination 
already exists. Destination names must be 
unique. Choose a new name.

No item(s) selected You are attempting to delete or modify items but 
none have been selected.

No layout You did not type a layout definition prior to trying 
to add it.

Viewport cannot be printed Something went wrong when printing the view-
port.

Please select a printer first You need to select a printer (use the tooltabs to 
do so), before you can print the viewport. Print/
Image can be used to send the image to the Win-
dows Printer.

Do you really want to print xxx copies ? You have selected more than the configured max-
imum of copies. Press Yes to print them anyway. 
You can change this number in the Print Configu-
ration.

Error message Cause of message
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Archiving

Error message Cause of message

Incorrect Study Date The Study Date that was entered in the query dia-
log box is not a valid date. Use the correct sepa-
rator and syntax (e.g. DD/MM/YYYY, MM/YYYY 
or YYYY).

Incorrect Birth Date The Birth Date entered in the query dialog box is 
not a valid date. Use the correct separator and 
syntax (e.g. DD/MM/YYYY, MM/YYYY or YYYY).

Delete column? A warning that you are about to remove a column 
from the currently displayed list.

The system must be rebooted for the changes to 
take effect

The configuration for the Archive part of the Data-
base Service may have changed. You need to 
stop and start the Database Service and Rad-
Works to use the new configuration. If you reboot 
your system you will be certain that the new con-
figuration has been put into effect.

The volume name <name> is already used in the 
Archive Index. Please specify a different name.

You are trying to add a volume that already exists 
in the Archive Index. While it is not possible to do 
this directly, you can replace the old version by 
first deleting the old volume from the Archive 
Index and then adding the new version of the vol-
ume again.

This volume already exists in the Archive Index You are attempting to add a volume that already 
exists in the Archive Index, which you cannot do. 
It is, however, possible to replace the old version 
by first deleting the volume from the Archive 
Index and then adding the new version of the vol-
ume again.

Are you sure you want to remove Archive 
<Archive>?

You are about to remove an archive definition. 
Confirm that you really want to do this.

Could not read DICOMDIR file in specified direc-
tory

Either no DICOMDIR file is present in the speci-
fied directory or the DICOMDIR file could not be 
read.

Could not show studies The studies in the Archive Index could not be dis-
played. Restart the Archive Index Tool. If the 
problem persists, the Archive Index is probably 
corrupt.

Error during edit Volume Sheet An error occurred while editing a volume descrip-
tion. The volume list might not have been updated 
correctly. You can either requery the volume list or 
restart the Archive Index Tool.
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Could not get a flush lock from the Archive Man-
ager

During a flush operation the archive is locked. 
This means that the archive cannot be used for 
any operation in order not to disturb the flushing 
process. If by some chance another operation is 
running, the flush lock will not be obtained and the 
flushing cannot take place. Try the operation 
again a few seconds or minutes later. If this does 
not succeed, consult your system administrator.

It is not allowed to have the same Archive-ID for 
both the destination and the Verification Archive

When you use an archive buffer you could create 
a second archive for the target volume device in 
order to create a copy of your buffer to the target 
volume. The system offers you the possibility of 
checking whether the contents of your buffer and 
the volume managed by the second archive man-
ager completely match. Enter <none> if you don’t 
want to use the verification option or select a sec-
ond archive for verification.

Error during changing the Study State An error occurred while editing a study state. The 
study list might not be updated correctly. Either 
requery the study list or restart the Archive Index 
Tool.

It is not possible to flush the archive, because it 
doesn’t contain any studies

You tried to start the flush operation to copy the 
buffer to a target volume while the buffer was 
empty. This operation only make sense for buffers 
that are not empty.

Could not Get Study UIDs of selected studies A serious error occurred while trying to delete or 
move back a study from an archive (buffer). Con-
sult your system administrator.

Cannot delete registry key <name> A serious error occurred while trying to remove an 
archive definition from your registry. Please con-
sult your system administrator.

It is not possible to flush the Archive because its 
total size exceeds the predefined maximum

You tried to start the flush operation, but the 
actual size of the archive buffer exceeds the pre-
defined maximum for the target device. This could 
only happen if the maximum size of an existing 
non-empty archive buffer is set back to a lower 
value. As a solution, your system administrator 
could raise this maximum capacity, but this solu-
tion is probably not desirable. The other solution 
is to remove studies from your buffer (Move Back 
or Delete) until the total size of the buffer is less 
than the maximum capacity. You can check this 
using the Estimate Size command.

Move to buffer failed A serious error occurred while trying to move/
export a study to the archive (buffer). Consult 
your system administrator.

You are not licensed to perform Single Media 
Archive operations

The system detected that there was no license to 
perform archive operations. Check if your dongle 
is still connected or contact your system adminis-
trator.

Error message Cause of message
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Could not show volumes The volumes in the Archive Index could not be 
displayed. Restart the Archive Index Tool. If the 
problem persists, the Archive Index is probably 
corrupt.

Please select a Volume Type The volume type that is currently entered on the 
volume sheet is not correct. You should select or 
enter a valid volume type.

Delete selected volume(s)? You are about to delete the selected volumes 
from the Archive Index. Confirm that you really 
want to do this.

One or more of the volumes is not lent You are trying to return a volume that was not 
marked as lent, which you cannot do. Deselect 
this volume and try again.

No selection available You tried to start an archive operation (Move/ 
export/ delete/ Move back) without having 
selected any study.

Field should not be empty You are trying to edit or create a column without 
specifying a name. Enter a name.

Are you sure you want to cancel the <name> job? Confirm if you want to cancel the current opera-
tion.

Are you sure you want to move <studies> back 
from the archive?

Confirm if you want to move back the selected 
studies from the archive (buffer).

Are you sure you want to delete <studies> from 
the archive?

Confirm if you want to delete the selected studies 
from the archive (buffer).

Could not get information on archive contents 
(Archive ID <id>)

The archive’s general information could not be 
found. Please consult your system administrator

Could not run command to flush the buffer The file designated as the executable or batch file 
that performs the flush operation was not found. 
Consult your system administrator.

Could not create directory <path>, due to error nr 
<number>. Please create it manually or select an 
existing directory before you restart your system

When you click the New button on the Configura-
tion | Archiving |Archives Tab, the configuration 
tries to create a new directory to store your 
archive contents (buffer) even though you have 
not clicked the OK button. If the system cannot 
create this directory there is nothing really amiss. 
Perhaps the permission rights for creating this 
directory are not correct. However, the system 
now refers to a directory that does not exist. You 
can either click Cancel, remove the archive by 
clicking Remove, keep the archive and select an 
existing directory and click OK, or keep the 
archive and click OK and create the referenced 
directory manually. On restarting the database 
service, the system will look for the referenced 
directory and if it does not exist the archive will 
not be available.

Error message Cause of message
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Could not create directory <name>, due to error 
nr <number>. Please create it manually or select 
an existing directory before you restart your sys-
tem

When creating a new archive definition, Rad-
Works will create a new archive directory for you. 
If this creation process fails you could create it 
manually and assign it later in this archive defini-
tion. If this message occurs, just continue to con-
figure your archive. Before closing the dialog box 
and rebooting your system, check if the archive 
directory for this newly created archive definition 
actually exists. If it does not, create it manually 
e.g. using NT Explorer. Then close RadWorks 
and reboot the system. If the archive does not 
become enabled, check the database log for the 
reason.

Error during returning volumes A general error occurred while returning the 
selected volumes. Restart the Archive Index Tool 
and check for any inconsistencies.

Estimation of file sizes failed The estimation could not be performed. Possibly 
the archive was occupied by a maintenance pro-
cess. Also, the Database Service may not be 
responding or the archive might have been dis-
abled due to a consistency error. After a number 
of retries, ask your administrator to check the 
archive.

Export to buffer failed The Export to buffer job could not be started. Pos-
sibly the archive was occupied by a maintenance 
process. Also, the Database Service may not be 
responding or the archive might have been dis-
abled due to a consistency error. After a number 
of retries, ask your administrator to check the 
archive.

Error during lending volumes A general error occurred while lending the 
selected volumes. Restart the Archive Index Tool 
and check for any inconsistencies.

Incorrect Borrow Date The Borrow Date that was entered in the query 
dialog box is not a valid date. Use the correct sep-
arator and syntax (e.g. DD/MM/YYYY, MM/YYYY 
or YYYY).

Return selected volume(s)? You are about to return the selected volumes.

Move back from archive failed The move back job could not be started. Possibly 
the archive was occupied by a maintenance pro-
cess. Also, the Database Service may not be 
responding or the archive might have been dis-
abled due to a consistency error. After a number 
of retries, ask your administrator to check the 
archive.

Error message Cause of message
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Delete from archive failed The delete job could not be started. Possibly the 
archive was occupied by a maintenance process. 
Also, the Database Service may not be respond-
ing or the archive might have been disabled due 
to a consistency error. After a number of retries, 
ask your administrator to check the archive.

Export to archive failed The Export job could not be started. Possibly the 
Archive was occupied by a maintenance process. 
Also the database Service may not be responding 
or the Archive might have been disabled due to a 
consistency error. After some retries ask your 
administrator to check the Archive

Export to buffer failed The Export to buffer job could not be started. Pos-
sibly the Archive was occupied by a maintenance 
process. Also the database Service may not be 
responding or the Archive might have been dis-
abled due to a consistency error. After some 
retries ask your administrator to check the 
Archive.

Could not open Index Tool database The Archive Index Tool could not open the 
selected Index Tool database. The user should 
check the ODBC parameters of the Archive Index 
Tool in the configuration of the archive module. 
Also check whether the path and name of the 
Index Tool database are correct.

Please specify a Volume Name The volume name on the volume sheet dialog box 
is empty. The user should enter a unique volume 
name.

Incorrect Verification Date The Verification Date that was entered in the 
query dialog box is not a valid date. Please use 
the correct separator and syntax (e.g. DD/MM/
YYYY, MM/YYYY or YYYY).

Only studies from the local database can be 
moved/exported to the archive

You can only move studies from the local data-
base to the archive.

You selected one or more series. It’s not possible 
to work with archives on a series level

In order to move / export / delete / move back with 
regard to an archive, you should make a selection 
at study level.

Volume successfully added! This message appears to inform the user that the 
volume is successfully added to the Archive 
Index.

Are you sure you want to perform a verify opera-
tion?

Click Yes if you want to start the verification oper-
ation, in which the contents of the buffer and the 
target volume will be checked.

Error message Cause of message



E R R O R ,  W A R N I N G  &  O T H E R  M E S S A G E S

RadWorks 6.0 installation and configuration guide

380 appendix A

Could not get information on Remote View Before a delete or move back operation can be 
started it must be ensured that the remote view in 
which you selected some studies is a view on the 
active archive. As this could not be ensured, the 
operation has been cancelled. Consult your sys-
tem administrator.

One or more of the volumes is already lent or 
marked as lost

You are trying to borrow a volume that is not 
marked as present, which is not possible. Dese-
lect this volume and try again.

The verification operation was not performed cor-
rectly

The contents of the archive buffer and a volume 
may match, but this could not be checked 
because the verify job could not be started. The 
archive was possibly occupied by a maintenance 
process. Also, the Database Service may not be 
responding or the archive might have been dis-
abled due to a consistency error. After a number 
of retries, ask your administrator to check the 
archive.

Error during deleting volume An error occurred while deleting the selected vol-
umes. Restart the Archive Index Tool and check 
for any inconsistencies.

Currently a Job is Running. Please retry after this 
job has finished

This message should not appear. RadWorks is 
apparently not aware that an archive operation is 
still running. Please consult your system adminis-
trator.

Could not start Flush process The flush-tool executable or batch file cannot be 
properly started. You possibly exited RadWorks 
before the flush process was started. Check the 
flush tool field in the Configuration | Archiving | 
Module tab, restart RadWorks and try it again.

Volume(s) successfully deleted The selected volumes have been deleted from 
the Archive Index.

Only studies from a remote archive view can be 
moved back

Select the remote view on the active archive to 
select studies to move back or delete.

Only studies from a remote archive view can be 
deleted.

Only studies from the archive ‘<name>’ can be 
deleted

You clicked the Delete button but the active 
remote view did not show the contents of the 
active archive. Select the studies from an appro-
priate remote view.

Only studies from the archive ‘<name>’ can be 
moved back

You clicked the Move Back button but the active 
remote view did not show the contents of the 
active archive. Select the studies from an appro-
priate remote view.

Error message Cause of message
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Could not resume The Resume operation is essentially the same as 
starting a new move or export job. This job could 
not however be started. Possibly the archive was 
occupied by a maintenance process. Also, the 
Database Service may not be responding or the 
archive might have been disabled due to a con-
sistency error. 

Move to archive failed The move job could not be started. Possibly the 
archive was occupied by a maintenance process. 
Also, the Database Service may not be respond-
ing or the archive might have been disabled due 
to a consistency error. After a number of retries, 
ask your administrator to check the archive.

Export to archive failed The export job could not be started. Possibly the 
archive was occupied by a maintenance process. 
Also, the Database Service may not be respond-
ing or the archive might have been disabled due 
to a consistency error. After a number of retries, 
ask your administrator to check the archive.

Error message Cause of message
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Quality Control

Error message Cause of message

Data entered is not valid The date entered for this origin is not complete. 
Specify the origin name, destination name(s) and 
action.

Could not delete modality Could not delete the edit demographics settings 
for this modality type.

No study loaded No study to list the status history from is currently 
loaded.

It is not allowed to delete the Generic modality 
level

You cannot delete the default ‘Generic’ edit 
demographics configuration.

You cannot delete the last series of a study You are not allowed to delete the last series from 
a study.

Can only view local/worklist data Only studies from the local database of entries 
from the worklist can be processed.

Modality should not exceed two characters A modality cannot be specified with more than 
two characters.

Please select a single Worklist entry No multiple selection of worklist entries is allowed 
while working within Quality Control.

You cannot set the Patient Orientation of images 
that have a valid image orientation

When images have a valid image orientation, the 
patient orientation is derived from it. In this case, 
no patient orientation can be specified.

No valid data entered The data entered is not complete or is invalid.

No valid selection No valid selection available to open for Quality 
Control.

No series selection supported Series selections cannot be opened for Quality 
Control.

Please enter a valid orientation The patient orientation specified is not correct.

No active study to load The QCM module attempted and failed to load a 
study because there was no study active. 

Cannot modify field <number> of item. Other 
fields will be modified

It was attempted to edit a non-editable field in the 
QCM Configuration. The action will be ignored.

The match rule is not correctly specified You made a syntax error in the match rule you 
just specified. 

No Initial Worklist View selected In the QCM origin configuration, it is illegal to 
leave the Initial Worklist View blank. 
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Do you want to send the study to its destination 
immediately?

Please confirm the auto transmit action. You dia-
log can be bypassed by changing the configura-
tion.

Unable to display image format Loading the study has failed because the study 
contained an unsupported or corrupt image for-
mat. 

Can only match local study data You can only match studies available on your 
workstation’s local study list. 

Could not retrieve information from the Connec-
tion Service. To prevent accidental damage to 
your system settings, some property pages are 
unavailable

It is essential to collect the correct origin table 
from the connection service for some parts of the 
QC Module configuration to work correctly.

Cannot automatically match locked studies. 
Please unlock study first

The selection of studies that you tried to 
AutoMatch contained locked studies. Unlock 
them before attempting to automatch.

Cannot initialize because no Initial Worklist view 
is specified

Specify an Initial worklist view before attempting 
this part of the QCM Configuration. 

The application must be restarted for the changes 
to take effect

When you leave the QCM Configuration, you will 
need to restart RadWorks to ensure all settings 
changes take effect. 

The operation failed for at least one study: <error 
message>

The Automatic match process has failed automat-
ically match all studies. 

No selection available; Cannot insert multiple studies;

Cannot add selection(s) to active study; Cannot insert study as images because it con-
tains multiple series;

Cannot insert images because duplicates already 
exist;

When you try to insert images/series from other 
studies, you may get the error messages above if 
the selection can not correctly be inserted in the 
active study. 

Cannot insert images because the image type 
(SOP Class) differs from the images in the active 
series

If you want to insert images from a different study 
in an existing series, the modalities of the images 
must match that of the series. 

Could not load selection When you try to insert images/series from other 
studies, and the study you copy from fails to load, 
you get the above message. 

Could not insert worklist data into study; Series could not be inserted.;

Error message Cause of message
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Cannot write study data to disk (while preparing 
for AddData/ReplaceData);

The study could not be saved. This may be due to 
a full hard disk. If the errors persist, contact your 
service engineer or distributor. 

Cannot save study, internal error (UpdateData 
failed);

Cannot save study, internal error (AddData 
failed);

Cannot save study, internal error (ReplaceData 
failed);

Cannot save a non-linear VOI LUT Non-linear VOI LUT’s cannot be saved by the 
QCM Module. 

Cannot save rotation/flip actions to lossy com-
pressed or multiframe images

Flip and rotate actions can not be saved for all 
image types. 

Cannot connect to the local database The database service can not be reached. Shut-
down and reboot your system before continuing 
to use RadWorks. 

Cannot save: Study UID already in local database The study UID was already found in the local 
database. Most likely the UID has been inserted 
due to a erroneous match action. 

Cannot save: not all viewing contexts found An error occurred collecting the possible save 
status for this study

These errors can not be resolved by the user. If 
they persist, contact your service engineer or dis-
tributor. 

In order to assure data consistency the current 
study will be unloaded

A new and empty study will be created that con-
tains the worklist data. Do you want to proceed?

When a study is matched multiple times with mul-
tiple worklist entries, data consistency cannot be 
guaranteed. 

You cannot open a copy of a Worklist entry Opening a copy of a worklist entry is not allowed.

You cannot set the Patient Orientation due to Flip 
or Rotate actions you have performed.

You tried to set the patient orientation after you 
performed flip and rotate actions on images in the 
study. If you need to do both, set patient orienta-
tion first.

Do you want to send the study to its destination 
immediately?

Please confirm the auto transmit action. You dia-
log box can be bypassed by changing the config-
uration.

No active Worklist available No worklist available or active.

Match Failed: <reason> The reason indicates why the insertion of worklist 
information in the study failed.

Do you want to save the changes? (Changes are 
irreversible after saving) 

All changes are irreversible after saving. No undo 
is possible after the study has been saved.

Error message Cause of message
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Set the study status back from <status> to <sta-
tus>?

Confirm that the study status is to be set back 
from one status to another.

Are you sure you want to save all changes and 
close the patient demographics dialog?

Click OK to accept the changes you have made, 
Cancel to discard them.

Could not get access to origins and/or destina-
tions. Please verify if the Connection Service is 
running

No access to the Connection Service Origin and 
Destination table was possible. Verify that the ser-
vice is running properly.

Cannot load data Cannot load the data for Quality Control (Generic 
error message)

Save Error: <reason> The reason specifies why the study could not be 
saved.

Cannot add item because it is already in list You are trying to add an item that is already 
present in the list.

Your existing settings will be overwritten. Do you 
want to proceed?

The current Worklist to DICOM tag mapping con-
figuration will be overwritten when you proceed.

Please use characters L, P, H, R, A, or F only The specified characters are the only ones which 
can be used when setting the patient orientation.

Could not get access to user queries The queries you have specified on the Queries 
property sheet are not accessible. Do you have 
the initial worklist view set correctly?

The origin was not correctly specified The origin that was added was not described cor-
rectly.

No image selection supported No images can be opened for Quality Control 
(study selections only).

Please select a Worklist entry The match action failed because there was no 
worklist entry selected.

The system must be rebooted for the changes to 
take effect

This appears after configuration when the system 
settings have been changed. Reboot the system 
as recommended.

Multiple selections not allowed, only first one will 
be opened

Only single study selections are allowed. The first 
study in the selection will be used.

The edit item was not correctly specified The item is not correctly/completely specified. 

The query was not correctly specified The query is not correctly/completely specified.

No Patient level selection allowed No patient level selections allowed when opening 
study for Quality Control.

Only one QC Viewing desktop allowed at a time Only one quality control desktop (screen) is 
allowed at any one time.

You cannot delete the last image of a study A study must contain at least one image.

Error message Cause of message
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Configuration 

Monitor configuration

HIS/RIS configuration

Error message Cause of message

No selection available Select an item before performing the action.

Error message Cause of message

Enter value for Rows and value for Columns. You need to enter a valid value for Rows and for 
Columns.

Please enter the correct number of monitors You must specify the correct number of monitors 
as the number of rows followed by the number of 
columns (<rows> <columns>). 

DUAL PACS Viewers allow max. 2 monitors. A DUAL PACS Viewer has a maximum of 2 moni-
tors.

Invalid monitor configuration. Value of Rows and 
Columns should be greater than zero.

Monitor configurations need to have at least one 
row and one column.

Monitor Id not within boundaries of monitor con-
figuration.

The configured monitor Id needs to be within the 
bounds of the overall monitor configuration.

Monitor ID not within the boundaries of the sys-
tem monitor configuration

The configured monitor ID was not within the 
boundaries of the system monitor configuration.

First monitor ID should be less than or equal to 
last monitor ID.

The first monitor ID should have a number less 
than or equal to the last monitor ID.

Registry settings are invalid. The registry settings for the monitor configuration 
are invalid.

You specified an incorrect monitor row count and/
or monitor column count

The monitor configuration is not within the bound-
aries of the system monitor configuration.

Error message Cause of message

Removing this implementation will also remove 
the Local Studies and Local Patients lists. 
Remove the HIS/RIS implementation?

Click Yes to remove the DLL anyway, No to back 
out.



GEMS IT Applicare

387

License configuration

Remove implementation? Click Yes to remove the HIS/RIS implementation 
DLL, No not to do so.

Could not open HIS/RIS dll The HIS/RIS dll that was selected is not valid for 
the system. 

Error message Cause of message

Not a valid host name entered. File will not be 
created

A valid host name should be entered in the dialog 
box. A host name is the name of a computer 
within the same domain on the network. Host 
names can be listed by, for example, opening the 
‘Network Neighborhood’ folder in Windows.

Error creating file <file> During the generation of a license file it was not 
possible to create the file. The file could already 
exist and set to read-only or shared with another 
application.

The file <file> already exists. Overwrite? The file pointed to already exists. If you choose to 
overwrite the file, the contents of the existing file 
will be lost and overwritten by the contents of the 
file to be generated.

Could not locate directory (or no permission for 
any of the (sub)directories)

The license file (or directory) could not be located.

Please enter the full path name A full path name must be specified (e.g. 
C:\AMI_60\License).

Please enter a filename Enter a filename in the dialog edit box.

Error message Cause of message
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I
X Listings of DICOM Tags

This appendix provides two lists of DICOM tags. The first list places the tags in ascending, numerical order. The 
second gives the tag names in alphabetical order.

DICOM tags listed in numerical order

Group ElementVR Name Group ElementVR Name
0000 0002 UI Affected SOP Class UID. 
0000 0003 UI Requested SOP Class UID
0000 0100 US Command Field
0000 0110 US Message ID
0000 0120 US Message ID Being Responded To
0000 0600 AE Move Destination
0000 0700 US Priority
0000 0800 US Data Set Type
0000 0900 US Status
0000 0901 AT Offending Element
0000 0902 LO Error Comment
0000 0903 US Error ID
0000 1000 UI Affected SOP Instance UID
0000 1001 UI Requested SOP Instance UID
0000 1002 US Event Type ID
0000 1005 AT Attribute Identifier List
0000 1008 US Action Type ID
0000 1020 US Number of Remaining Sub-operations
0000 1021 US Number of Completed Sub-operations
0000 1022 US Number of Failed Sub-operations
0000 1023 US Number of Warning Sub-operations
0000 1030 AE Move Originator Application Entity Title
0000 1031 US Move Originator Message ID
0002 0001 OB File Meta Information Version
0002 0002 UI Media Storage SOP Class UID
0002 0003 UI Media Storage SOP Instance UID
0002 0010 UI Transfer Syntax UID
0002 0012 UI Implementation Class UID
0002 0013 SH Implementation Version Name
0002 0016 AE Source Application Entity Title

0002 0100 UI Private Information Creator UID
0002 0102 OB Private Information
0004 1130 CS File-set ID
0004 1141 CS File-set Descriptor File ID
0004 1142 CS Specific Character Set of File-set Descriptor File
0004 1200 UL Root Directory Entity’s First Directory Record Offset
0004 1202 UL Root Directory Entity Last Directory Record Offset
0004 1212 US File-set Consistency Flag
0004 1220 SQ Directory Record Sequence
0004 1400 UL Offset of the Next Directory Record
0004 1410 US Record In-use Flag
0004 1420 UL Offset of Referenced Lower-Level Directory Entity
0004 1430 CS Directory Record Type
0004 1432 UI Private Record UID
0004 1500 CS Referenced File ID
0004 1504 UL MRDR Directory Record Offset
0004 1510 UI Referenced SOP Class UID in File
0004 1511 UI Referenced SOP Instance UID in File
0004 1512 UI Referenced Transfer Syntax UID in File
0004 1600 UL Number of References
0008 0005 CS Specific Character Set
0008 0008 CS Image Type
0008 0012 DA Instance Creation Date
0008 0013 TM Instance Creation Time
0008 0014 UI Instance Creator UID
0008 0016 UI SOP Class UID
0008 0018 UI SOP Instance UID
0008 0020 DA Study Date
0008 0021 DA Series Date
0008 0022 DA Acquisition Date
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0008 0023 DA Content Date
0008 0024 DA Overlay Date
0008 0025 DA Curve Date
0008 002A DT Acquisition Datetime
0008 0030 TM Study Time
0008 0031 TM Series Time
0008 0032 TM Acquisition Time
0008 0033 TM Content Time
0008 0034 TM Overlay Time
0008 0035 TM Curve Time
0008 0042 CS Nuclear Medicine Series Type (RET)
0008 0050 SH Accession Number
0008 0052 CS Query/Retrieve Level
0008 0054 AE Retrieve AE Title
0008 0056 CS Instance Availability
0008 0058 UI Failed SOP Instance UID List
0008 0060 CS Modality
0008 0061 CS Modalities in Study
0008 0064 CS Conversion Type
0008 0068 CS Presentation Intent Type
0008 0070 LO Manufacturer
0008 0080 LO Institution Name
0008 0081 ST Institution Address
0008 0082 SQ Institution Code Sequence
0008 0090 PN Referring Physician's Name
0008 0092 ST Referring Physician's Address
0008 0094 SH Referring Physician's Telephone Numbers
0008 0100 SH Code Value
0008 0102 SH Coding Scheme Designator
0008 0103 SH Coding Scheme Version
0008 0104 LO Code Meaning
0008 0105 CS Mapping Resource
0008 0106 DT Context Group Version
0008 0107 DT Context Group Local Version
0008 010B CS Code Set Extension Flag
0008 010C UI Private Coding Scheme Creator UID
0008 010D UI Code Set Extension Creator UID
0008 010F CS Context Identifier
0008 0201 SH Timezone Offset From UTC
0008 1010 SH Station Name
0008 1030 LO Study Description
0008 1032 SQ Procedure Code Sequence
0008 103E LO Series Description
0008 1040 LO Institutional Department Name
0008 1048 PN Physician(s) of Record
0008 1050 PN Performing Physician's Name
0008 1060 PN Name of Physician(s) Reading Study
0008 1070 PN Operators' Name
0008 1080 LO Admitting Diagnoses Description
0008 1084 SQ Admitting Diagnosis Code Sequence
0008 1090 LO Manufacturer's Model Name
0008 1100 SQ Referenced Results Sequence
0008 1110 SQ Referenced Study Sequence
0008 1111 SQ Referenced Study Component Sequence
0008 1115 SQ Referenced Series Sequence
0008 1120 SQ Referenced Patient Sequence

0008 1125 SQ Referenced Visit Sequence
0008 1130 SQ Referenced Overlay Sequence
0008 1140 SQ Referenced Image Sequence
0008 1145 SQ Referenced Curve Sequence
0008 1150 UI Referenced SOP Class UID
0008 1155 UI Referenced SOP Instance UID
0008 115A UI SOP Classes Supported
0008 1160 IS Referenced Frame Number
0008 1195 UI Transaction UID
0008 1197 US Failure Reason
0008 1198 SQ Failed SOP Sequence
0008 1199 SQ Referenced SOP Sequence
0008 2110 CS Lossy Image Compression (RET)
0008 2111 ST Derivation Description
0008 2112 SQ Source Image Sequence
0008 2120 SH Stage Name
0008 2122 IS Stage Number
0008 2124 IS Number of Stages
0008 2128 IS View Number
0008 2129 IS Number of Event Timers
0008 212A IS Number of Views in Stage
0008 2130 DS Event Elapsed Time(s)
0008 2132 LO Event Timer Name(s)
0008 2142 IS Start Trim
0008 2143 IS Stop Trim
0008 2144 IS Recommended Display Frame Rate
0008 2200 CS Transducer Position (RET)
0008 2204 CS Transducer Orientation (RET)
0008 2208 CS Anatomic Structure (RET)
0008 2218 SQ Anatomic Region Sequence
0008 2220 SQ Anatomic Region Modifier Sequence
0008 2228 SQ Primary Anatomic Structure Sequence
0008 2229 SQ Anatomic Structure. Space or Region Sequence
0008 2230 SQ Primary Anatomic Structure Modifier Sequence
0008 2240 SQ Transducer Position Sequence
0008 2242 SQ Transducer Position Modifier Sequence
0008 2244 SQ Transducer Orientation Sequence
0008 2246 SQ Transducer Orientation Modifier Sequence
0009 0010 LO BlockID = "GEIIS"
0009 1010 SQ GE IIS Thumbnail Sequence
0010 0010 PN Patient's Name
0010 0020 LO Patient ID
0010 0021 LO Issuer of Patient ID
0010 0030 DA Patient's Birth Date
0010 0032 TM Patient's Birth Time
0010 0040 CS Patient's Sex
0010 0050 SQ Patient's Insurance Plan Code Sequence
0010 1000 LO Other Patient IDs
0010 1001 PN Other Patient Names
0010 1005 PN Patient's Birth Name
0010 1010 AS Patient's Age
0010 1020 DS Patient's Size
0010 1030 DS Patient's Weight
0010 1040 LO Patient's Address
0010 1060 PN Patient's Mother's Birth Name
0010 1080 LO Military Rank

Group ElementVR Name Group ElementVR Name
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0010 1081 LO Branch of Service
0010 1090 LO Medical Record Locator
0010 2000 LO Medical Alerts
0010 2110 LO Contrast Allergies
0010 2150 LO Country of Residence
0010 2152 LO Region of Residence
0010 2154 SH Patient's Telephone Numbers
0010 2160 SH Ethnic Group
0010 2180 SH Occupation
0010 21A0 CS Smoking Status
0010 21B0 LT Additional Patient History
0010 21C0 US Pregnancy Status
0010 21D0 DA Last Menstrual Date
0010 21F0 LO Patient's Religious Preference
0010 4000 LT Patient Comments
0018 0010 LO Contrast/Bolus Agent
0018 0012 SQ Contrast/Bolus Agent Sequence
0018 0014 SQ Contrast/Bolus Administration Route Sequence
0018 0015 CS Body Part Examined
0018 0020 CS Scanning Sequence
0018 0021 CS Sequence Variant
0018 0022 CS Scan Options
0018 0023 CS MR Acquisition Type
0018 0024 SH Sequence Name
0018 0025 CS Angio Flag
0018 0026 SQ Intervention Drug Information Sequence
0018 0027 TM Intervention Drug Stop Time
0018 0028 DS Intervention Drug Dose
0018 0029 SQ Intervention Drug Code Sequence
0018 002A SQ Additional Drug Sequence
0018 0030 LO Radionuclide (RET)
0018 0031 LO Radiopharmaceutical
0018 0032 DS Energy Window Centerline (RET)
0018 0033 DS Energy Window Total Width (RET)
0018 0034 LO Intervention Drug Name
0018 0035 TM Intervention Drug Start Time
0018 0036 SQ Interventional Therapy Sequence
0018 0037 CS Therapy Type
0018 0038 CS Interventional Status
0018 0039 CS Therapy Description
0018 0040 IS Cine Rate
0018 0050 DS Slice Thickness
0018 0060 DS KVP
0018 0070 IS Counts Accumulated
0018 0071 CS Acquisition Termination Condition
0018 0072 DS Effective Series Duration
0018 0073 CS Acquisition Start Condition
0018 0074 IS Acquisition Start Condition Data
0018 0075 IS Acquisition Termination Condition Data
0018 0080 DS Repetition Time
0018 0081 DS Echo Time
0018 0082 DS Inversion Time
0018 0083 DS Number of Averages
0018 0084 DS Imaging Frequency
0018 0085 SH Imaged Nucleus
0018 0086 IS Echo Number(s)

0018 0087 DS Magnetic Field Strength
0018 0088 DS Spacing Between Slices
0018 0089 IS Number of Phase Encoding Steps
0018 0090 DS Data Collection Diameter
0018 0091 IS Echo Train Length
0018 0093 DS Percent Sampling
0018 0094 DS Percent Phase Field of View
0018 0095 DS Pixel Bandwidth
0018 1000 LO Device Serial Number
0018 1004 LO Plate ID
0018 1010 LO Secondary Capture Device ID
0018 1011 LO Hardcopy Creation Device ID
0018 1012 DA Date of Secondary Capture
0018 1014 TM Time of Secondary Capture
0018 1016 LO Secondary Capture Device Manufacturer
0018 1017 LO Hardcopy Device Manufacturer
0018 1018 LO Secondary Capture Device Manufacturer's Model Name
0018 1019 LO Secondary Capture Device Software Version(s)
0018 101A LO Hardcopy Device Software Version
0018 101B LO Hardcopy Device Manfuacturer's Model Name
0018 1020 LO Software Version(s)
0018 1022 SH Video Image Format Acquired
0018 1023 LO Digital Image Format Acquired
0018 1030 LO Protocol Name
0018 1040 LO Contrast/Bolus Route
0018 1041 DS Contrast/Bolus Volume
0018 1042 TM Contrast/Bolus Start Time
0018 1043 TM Contrast/Bolus Stop Time
0018 1044 DS Contrast/Bolus Total Dose
0018 1045 IS Syringe Counts
0018 1046 DS Contrast Flow Rate(s)
0018 1047 DS Contrast Flow Duration(s)
0018 1048 CS Contrast/Bolus Ingredient
0018 1049 DS Contrast/Bolus Ingredient Concentration
0018 1050 DS Spatial Resolution
0018 1060 DS Trigger Time
0018 1061 LO Trigger Source or Type
0018 1062 IS Nominal Interval
0018 1063 DS Frame Time
0018 1064 LO Framing Type
0018 1065 DS Frame Time Vector
0018 1066 DS Frame Delay
0018 1067 DS Image Trigger Delay
0018 1068 DS Multiplex Group Time Offset
0018 1069 DS Trigger Time Offset
0018 106A CS Synchronization Trigger
0018 106C US Synchronization Channel
0018 106E UL Trigger Sample Position
0018 1070 LO Radiopharmaceutical Route
0018 1071 DS Radiopharmaceutical Volume
0018 1072 TM Radiopharmaceutical Start Time
0018 1073 TM Radiopharmaceutical Stop Time
0018 1074 DS Radionuclide Total Dose
0018 1075 DS Radionuclide Half Life
0018 1076 DS Radionuclide Positron Fraction
0018 1077 DS Radiopharmaceutical Specific Activity

Group ElementVR Name Group ElementVR Name
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0018 1080 CS Beat Rejection Flag
0018 1081 IS Low R-R Value
0018 1082 IS High R-R Value
0018 1083 IS Intervals Acquired
0018 1084 IS Intervals Rejected
0018 1085 LO PVC Rejection
0018 1086 IS Skip Beats
0018 1088 IS Heart Rate
0018 1090 IS Cardiac Number of Images
0018 1094 IS Trigger Window
0018 1100 DS Reconstruction Diameter
0018 1110 DS Distance Source to Detector
0018 1111 DS Distance Source to Patient
0018 1114 DS Estimated Radiographic Magnification Factor
0018 1120 DS Gantry/Detector Tilt
0018 1121 DS Gantry/Detector Slew
0018 1130 DS Table Height
0018 1131 DS Table Traverse
0018 1134 CS Table Motion
0018 1135 DS Table Vertical Increment
0018 1136 DS Table Lateral Increment
0018 1137 DS Table Longitudinal Increment
0018 1138 DS Table Angle
0018 113A CS Table Type
0018 1140 CS Rotation Direction
0018 1141 DS Angular Position
0018 1142 DS Radial Position
0018 1143 DS Scan Arc
0018 1144 DS Angular Step
0018 1145 DS Center of Rotation Offset
0018 1146 DS Rotation Offset (RET)
0018 1147 CS Field of View Shape
0018 1149 IS Field of View Dimension(s)
0018 1150 IS Exposure Time
0018 1151 IS X-ray Tube Current
0018 1152 IS Exposure
0018 1153 IS Exposure in uAs
0018 1154 DS Average Pulse Width
0018 1155 CS Radiation Setting
0018 1156 CS Rectification Type
0018 115A CS Radiation Mode
0018 115E DS Image Area Dose Product
0018 1160 SH Filter Type
0018 1161 LO Type of Filters
0018 1162 DS Intensifier Size
0018 1164 DS Imager Pixel Spacing
0018 1166 CS Grid
0018 1170 IS Generator Power
0018 1180 SH Collimator/grid Name
0018 1181 CS Collimator Type
0018 1182 IS Focal Distance
0018 1183 DS X Focus Center
0018 1184 DS Y Focus Center
0018 1190 DS Focal Spot(s)
0018 1191 CS Anode Target Material
0018 11A0 DS Body Part Thickness

0018 11A2 DS Compression Force
0018 1200 DA Date of Last Calibration
0018 1201 TM Time of Last Calibration
0018 1210 SH Convolution Kernel
0018 1242 IS Actual Frame Duration
0018 1243 IS Count Rate
0018 1244 US Preferred Playback Sequencing
0018 1250 SH Receiving Coil
0018 1251 SH Transmitting Coil
0018 1260 SH Plate Type
0018 1261 LO Phosphor Type
0018 1300 DS Scan Velocity
0018 1301 CS Whole Body Technique
0018 1302 IS Scan Length
0018 1310 US Acquisition Matrix
0018 1312 CS Phase Encoding Direction
0018 1314 DS Flip Angle
0018 1315 CS Variable Flip Angle Flag
0018 1316 DS SAR
0018 1318 DS dB/dt
0018 1400 LO Acquisition Device Processing Description
0018 1401 LO Acquisition Device Processing Code
0018 1402 CS Cassette Orientation
0018 1403 CS Cassette Size
0018 1404 US Exposures on Plate
0018 1405 IS Relative X-ray Exposure
0018 1450 CS Column Angulation
0018 1460 DS Tomo Layer Height
0018 1470 DS Tomo Angle
0018 1480 DS Tomo Time
0018 1490 CS Tomo Type
0018 1491 CS Tomo Class
0018 1495 IS Number of Tomosynthesis Source Images
0018 1500 CS Positioner Motion
0018 1508 CS Positioner Type
0018 1510 DS Positioner Primary Angle
0018 1511 DS Positioner Secondary Angle
0018 1520 DS Positioner Primary Angle Increment
0018 1521 DS Positioner Secondary Angle Increment
0018 1530 DS Detector Primary Angle
0018 1531 DS Detector Secondary Angle
0018 1600 CS Shutter Shape
0018 1602 IS Shutter Left Vertical Edge
0018 1604 IS Shutter Right Vertical Edge
0018 1606 IS Shutter Upper Horizontal Edge
0018 1608 IS Shutter Lower Horizontal Edge
0018 1610 IS Center of Circular Shutter
0018 1612 IS Radius of Circular Shutter
0018 1620 IS Vertices of the Polygonal Shutter
0018 1622 US Shutter Presentation Value
0018 1623 US Shutter Overlay Group
0018 1700 CS Collimator Shape
0018 1702 IS Collimator Left Vertical Edge
0018 1704 IS Collimator Right Vertical Edge
0018 1706 IS Collimator Upper Horizontal Edge
0018 1708 IS Collimator Lower Horizontal Edge

Group ElementVR Name Group ElementVR Name
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0018 1710 IS Center of Circular Collimator
0018 1712 IS Radius of Circular Collimator
0018 1720 IS Vertices of the Polygonal Collimator
0018 1800 CS Acquisition Time Synchronized
0018 1801 SH Time Source
0018 1802 CS Time Distribution Protocol
0018 2001 IS Page Number Vector
0018 2002 SH Frame Label Vector
0018 2003 DS Frame Primary Angle Vector
0018 2004 DS Frame Secondary Angle Vector
0018 2005 DS Slice Location Vector
0018 2006 SH Display Window Label Vector
0018 2010 DS Nominal Scanned Pixel Spacing
0018 2020 CS Digitizing Device Transport Direction
0018 2030 DS Rotation of Scanned Film
0018 5000 SH Output Power
0018 5010 LO Transducer Data
0018 5012 DS Focus Depth
0018 5020 LO Processing Function
0018 5021 LO Postprocessing Function
0018 5022 DS Mechanical Index
0018 5024 DS Thermal Index
0018 5026 DS Cranial Thermal Index
0018 5027 DS Soft Tissue Thermal Index
0018 5028 DS Soft Tissue-focus Thermal Index
0018 5029 DS Soft Tissue-surface Thermal Index
0018 5050 IS Depth of Scan Field
0018 5100 CS Patient Position
0018 5101 CS View Position
0018 5104 SQ Projection Eponymous Name Code Sequence
0018 5210 DS Image Transformation Matrix
0018 5212 DS Image Translation Vector
0018 6000 DS Sensitivity
0018 6011 SQ Sequence of Ultrasound Regions
0018 6012 US Region Spatial Format
0018 6014 US Region Data Type
0018 6016 UL Region Flags
0018 6018 UL Region Location Min X 0
0018 601A UL Region Location Min Y 0
0018 601C UL Region Location Max X 1
0018 601E UL Region Location Max Y 1
0018 6020 SL Reference Pixel X 0
0018 6022 SL Reference Pixel Y 0
0018 6024 US Physical Units X Direction
0018 6026 US Physical Units Y Direction
0018 6028 FD Reference Pixel Physical Value X
0018 602A FD Reference Pixel Physical Value Y
0018 602C FD Physical Delta X
0018 602E FD Physical Delta Y
0018 6030 UL Transducer Frequency
0018 6031 CS Transducer Type
0018 6032 UL Pulse Repetition Frequency
0018 6034 FD Doppler Correction Angle
0018 6036 FD Steering Angle
0018 6038 UL Doppler Sample Volume X Position
0018 603A UL Doppler Sample Volume Y Position

0018 603C UL TM-Line Position X 0
0018 603E UL TM-Line Position Y 0
0018 6040 UL TM-Line Position X 1
0018 6042 UL TM-Line Position Y 1
0018 6044 US Pixel Component Organization
0018 6046 UL Pixel Component Mask
0018 6048 UL Pixel Component Range Start
0018 604A UL Pixel Component Range Stop
0018 604C US Pixel Component Physical Units
0018 604E US Pixel Component Data Type
0018 6050 UL Number of Table Break Points
0018 6052 UL Table of X Break Points
0018 6054 FD Table of Y Break Points
0018 6056 UL Number of Table Entries
0018 6058 UL Table of Pixel Values
0018 605A FL Table of Parameter Values
0018 7000 CS Detector Conditions Nominal Flag
0018 7001 DS Detector Temperature
0018 7004 CS Detector Type
0018 7005 CS Detector Configuration
0018 7006 LT Detector Description
0018 7008 LT Detector Mode
0018 700A SH Detector ID
0018 700C DA Date of Last Detector Calibration
0018 700E TM Time of Last Detector Calibration
0018 7010 IS Exposures on Detector Since Last Calibration
0018 7011 IS Exposures on Detector Since Manufactured
0018 7012 DS Detector Time Since Last Exposure
0018 7014 DS Detector Active Time
0018 7016 DS Detector Activation Offset From Exposure
0018 701A DS Detector Binning
0018 7020 DS Detector Element Physical Size
0018 7022 DS Detector Element Spacing
0018 7024 CS Detector Active Shape
0018 7026 DS Detector Active Dimension(s)
0018 7028 DS Detector Active Origin
0018 7030 DS Field of View Origin
0018 7032 DS Field of View Rotation
0018 7034 CS Field of View Horizontal Flip
0018 7040 LT Grid Absorbing Material
0018 7041 LT Grid Spacing Material
0018 7042 DS Grid Thickness
0018 7044 DS Grid Pitch
0018 7046 IS Grid Aspect Ratio
0018 7048 DS Grid Period
0018 704C DS Grid Focal Distance
0018 7050 CS Filter Material
0018 7052 DS Filter Thickness Minimum
0018 7054 DS Filter Thickness Maximum
0018 7060 CS Exposure Control Mode
0018 7062 LT Exposure Control Mode Description
0018 7064 CS Exposure Status
0018 7065 DS Phototimer Setting
0018 8150 DS Exposure Time in mS
0018 8151 DS X-Ray Tube Current in mA
0020 000D UI Study Instance UID
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0020 000E UI Series Instance UID
0020 0010 SH Study ID
0020 0011 IS Series Number
0020 0012 IS Acquisition Number
0020 0013 IS Instance Number
0020 0014 IS Isotope Number (RET)
0020 0015 IS Phase Number (RET)
0020 0016 IS Interval Number (RET)
0020 0017 IS Time Slot Number (RET)
0020 0018 IS Angle Number (RET)
0020 0019 IS Item Number
0020 0020 CS Patient Orientation
0020 0022 IS Overlay Number
0020 0024 IS Curve Number
0020 0026 IS Lookup Table Number
0020 0032 DS Image Position (Patient)
0020 0037 DS Image Orientation (Patient)
0020 0052 UI Frame of Reference UID
0020 0060 CS Laterality
0020 0062 CS Image Laterality
0020 0100 IS Temporal Position Identifier
0020 0105 IS Number of Temporal Positions
0020 0110 DS Temporal Resolution
0020 0200 UI Synchronization Frame of Reference UID
0020 1000 IS Series in Study
0020 1002 IS Images in Acquisition
0020 1004 IS Acquisitions in Study
0020 1040 LO Position Reference Indicator
0020 1041 DS Slice Location
0020 1070 IS Other Study Numbers
0020 1200 IS Number of Patient Related Studies
0020 1202 IS Number of Patient Related Series
0020 1204 IS Number of Patient Related Instances
0020 1206 IS Number of Study Related Series
0020 1208 IS Number of Study Related Instances
0020 1209 IS Number of Series Related Instances
0020 4000 LT Image Comments
0028 0002 US Samples per Pixel
0028 0004 CS Photometric Interpretation
0028 0006 US Planar Configuration
0028 0008 IS Number of Frames
0028 0009 AT Frame Increment Pointer
0028 0010 US Rows
0028 0011 US Columns
0028 0012 US Planes
0028 0014 US Ultrasound Color Data Present
0028 0030 DS Pixel Spacing
0028 0031 DS Zoom Factor
0028 0032 DS Zoom Center
0028 0034 IS Pixel Aspect Ratio
0028 0051 CS Corrected Image
0028 0100 US Bits Allocated
0028 0101 US Bits Stored
0028 0102 US High Bit
0028 0103 US Pixel Representation
0028 0106 XS Smallest Image Pixel Value

0028 0107 XS Largest Image Pixel Value
0028 0108 XS Smallest Pixel Value in Series
0028 0109 XS Largest Pixel Value in Series
0028 0110 XS Smallest Image Pixel Value in Plane
0028 0111 XS Largest Image Pixel Value in Plane
0028 0120 XS Pixel Padding Value
0028 0300 CS Quality Control Image
0028 0301 CS Burned In Annotation
0028 1040 CS Pixel Intensity Relationship
0028 1041 SS Pixel Intensity Relationship Sign
0028 1050 DS Window Center
0028 1051 DS Window Width
0028 1052 DS Rescale Intercept
0028 1053 DS Rescale Slope
0028 1054 LO Rescale Type
0028 1055 LO Window Center & Width Explanation
0028 1090 CS Recommended Viewing Mode
0028 1101 XS Red Palette Color Lookup Table Descriptor
0028 1102 XS Green Palette Color Lookup Table Descriptor
0028 1103 XS Blue Palette Color Lookup Table Descriptor
0028 1199 UI Palette Color Lookup Table UID
0028 1201 US Red Palette Color Lookup Table Data
0028 1202 US Green Palette Color Lookup Table Data
0028 1203 US Blue Palette Color Lookup Table Data
0028 1221 OW Segmented Red Palette Color Lookup Table Data
0028 1222 OW Segmented Green Palette Color Lookup Table Data
0028 1223 OW Segmented Blue Palette Color Lookup Table Data
0028 1300 CS Implant Present
0028 1350 CS Partial View
0028 1351 ST Partial View Description
0028 2110 CS Lossy Image Compression
0028 2112 DS Lossy Image Compression Ratio
0028 3000 SQ Modality LUT Sequence
0028 3002 XS LUT Descriptor
0028 3003 LO LUT Explanation
0028 3004 LO Modality LUT Type
0028 3006 US LUT Data
0028 3010 SQ VOI LUT Sequence
0028 3110 SQ Softcopy VOI LUT Sequence
0028 5000 SQ Bi-Plane Acquisition Sequence
0028 6010 US Representative Frame Number
0028 6020 US Frame Numbers of Interest (FOI)
0028 6022 LO Frame(s) of Interest Description
0028 6030 US Mask Pointer(s)
0028 6040 US R Wave Pointer
0028 6100 SQ Mask Subtraction Sequence
0028 6101 CS Mask Operation
0028 6102 US Applicable Frame Range
0028 6110 US Mask Frame Numbers
0028 6112 US Contrast Frame Averaging
0028 6114 FL Mask Sub-pixel Shift
0028 6120 SS TID Offset
0028 6190 ST Mask Operation Explanation
0029 0060 LO RadWorksMarconi
0029 6024 US DCM_MARCONIKEYFRAMEINDICES
0032 000A CS Study Status ID
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0032 000C CS Study Priority ID
0032 0012 LO Study ID Issuer
0032 0032 DA Study Verified Date
0032 0033 TM Study Verified Time
0032 0034 DA Study Read Date
0032 0035 TM Study Read Time
0032 1000 DA Scheduled Study Start Date
0032 1001 TM Scheduled Study Start Time
0032 1010 DA Scheduled Study Stop Date
0032 1011 TM Scheduled Study Stop Time
0032 1020 LO Scheduled Study Location
0032 1021 AE Scheduled Study Location AE Title(s)
0032 1030 LO Reason for Study
0032 1032 PN Requesting Physician
0032 1033 LO Requesting Service
0032 1040 DA Study Arrival Date
0032 1041 TM Study Arrival Time
0032 1050 DA Study Completion Date
0032 1051 TM Study Completion Time
0032 1055 CS Study Component Status ID
0032 1060 LO Requested Procedure Description
0032 1064 SQ Requested Procedure Code Sequence
0032 1070 LO Requested Contrast Agent
0032 4000 LT Study Comments
0038 0004 SQ Referenced Patient Alias Sequence
0038 0008 CS Visit Status ID
0038 0010 LO Admission ID
0038 0011 LO Issuer of Admission ID
0038 0016 LO Route of Admissions
0038 001A DA Scheduled Admission Date
0038 001B TM Scheduled Admission Time
0038 001C DA Scheduled Discharge Date
0038 001D TM Scheduled Discharge Time
0038 001E LO Scheduled Patient Institution Residence
0038 0020 DA Admitting Date
0038 0021 TM Admitting Time
0038 0030 DA Discharge Date
0038 0032 TM Discharge Time
0038 0040 LO Discharge Diagnosis Description
0038 0044 SQ Discharge Diagnosis Code Sequence
0038 0050 LO Special Needs
0038 0300 LO Current Patient Location
0038 0400 LO Patient's Institution Residence
0038 0500 LO Patient State
0038 4000 LT Visit Comments
003A 0004 CS Waveform Originality
003A 0005 US Number of Waveform Channels
003A 0010 UL Number of Waveform Samples
003A 001A DS Sampling Frequency
003A 0020 SH Multiplex Group Label
003A 0200 SQ Channel Definition Sequence
003A 0202 IS Waveform Channel Number
003A 0203 SH Channel Label
003A 0205 CS Channel Status
003A 0208 SQ Channel Source Sequence
003A 0209 SQ Channel Source Modifiers Sequence

003A 020A SQ Source Waveform Sequence
003A 020C LO Channel Derivation Description
003A 0210 DS Channel Sensitivity
003A 0211 SQ Channel Sensitivity Units Sequence
003A 0212 DS Channel Sensitivity Correction Factor
003A 0213 DS Channel Baseline
003A 0214 DS Channel Time Skew
003A 0215 DS Channel Sample Skew
003A 0218 DS Channel Offset
003A 021A US Waveform Bits Stored
003A 0220 DS Filter Low Frequency
003A 0221 DS Filter High Frequency
003A 0222 DS Notch Filter Frequency
003A 0223 DS Notch Filter Bandwidth
0040 0001 AE Scheduled Station AE Title
0040 0002 DA Scheduled Procedure Step Start Date
0040 0003 TM Scheduled Procedure Step Start Time
0040 0004 DA Scheduled Procedure Step End Date
0040 0005 TM Scheduled Procedure Step End Time
0040 0006 PN Scheduled Performing Physician's Name
0040 0007 LO Scheduled Procedure Step Description
0040 0008 SQ Scheduled Action Item Code Sequence
0040 0009 SH Scheduled Procedure Step ID
0040 0010 SH Scheduled Station Name
0040 0011 SH Scheduled Procedure Step Location
0040 0012 LO Pre-Medication
0040 0020 CS Scheduled Procedure Step Status
0040 0100 SQ Scheduled Procedure Step Sequence
0040 0220 SQ Referenced Standalone SOP Instance Sequence
0040 0241 AE Performed Station AE Title
0040 0242 SH Performed Station Name
0040 0243 SH Performed Location
0040 0244 DA Performed Procedure Step Start Date
0040 0245 TM Performed Procedure Step Start Time
0040 0250 DA Performed Procedure Step End Date
0040 0251 TM Performed Procedure Step End Time
0040 0252 CS Performed Procedure Step Status
0040 0253 SH Performed Procedure Step ID
0040 0254 LO Performed Procedure Step Description
0040 0255 LO Performed Procedure Type Description
0040 0260 SQ Performed Action Item Sequence
0040 0270 SQ Scheduled Step Attributes Sequence
0040 0275 SQ Request Attributes Sequence
0040 0280 ST Comments on the Performed Procedure Steps
0040 0293 SQ Quantity Sequence
0040 0294 DS Quantity
0040 0295 SQ Measuring Units Sequence
0040 0296 SQ Billing Item Sequence
0040 0300 US Total Time of Fluoroscopy
0040 0301 US Total Number of Exposures
0040 0302 US Entrance Dose
0040 0303 US Exposed Area
0040 0306 DS Distance Source to Entrance
0040 0307 DS Distance Source to Support
0040 0310 ST Comments on Radiation Dose
0040 0312 DS X-Ray Output
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0040 0314 DS Half Value Layer
0040 0316 DS Organ Dose
0040 0318 CS Organ Exposed
0040 0320 SQ Billing Procedure Step Sequence
0040 0321 SQ Film Consumption Sequence
0040 0324 SQ Billing Supplies and Devices Sequence
0040 0330 SQ Referenced Procedure Step Sequence
0040 0340 SQ Performed Series Sequence
0040 0400 LT Comments on the Scheduled Procedure Step
0040 050A LO Specimen Accession Number
0040 0550 SQ Specimen Sequence
0040 0551 LO Specimen Identifier
0040 0555 SQ Acquisition Context Sequence
0040 0556 ST Acquisition Context Description
0040 059A SQ Specimen Type Code Sequence
0040 06FA LO Slide Identifier
0040 071A SQ Image Center Point Coordinates Sequence
0040 072A DS X offset in Slide Coordinate System
0040 073A DS Y offset in Slide Coordinate System
0040 074A DS Z offset in Slide Coordinate System
0040 08D8 SQ Pixel Spacing Sequence
0040 08DA SQ Coordinate System Axis Code Sequence
0040 08EA SQ Measurement Units Code Sequence
0040 1001 SH Requested Procedure ID
0040 1002 LO Reason for the Requested Procedure
0040 1003 SH Requested Procedure Priority
0040 1004 LO Patient Transport Arrangements
0040 1005 LO Requested Procedure Location
0040 1006 SH Placer Order Number / Procedure (RET)
0040 1007 SH Filler Order Number / Procedure (RET)
0040 1008 LO Confidentiality Code
0040 1009 SH Reporting Priority
0040 1010 PN Names of Intended Recipients of Results
0040 1400 LT Requested Procedure Comments
0040 2001 LO Reason for the Imaging Service Request
0040 2004 DA Issue Date of Imaging Service Request
0040 2005 TM Issue Time of Imaging Service Request
0040 2006 SH Placer Order Number / Imaging Service Request (RET)
0040 2007 SH Filler Order Number / Imaging Service Request (RET)
0040 2008 PN Order Entered By
0040 2009 SH Order Enterer's Location
0040 2010 SH Order Callback Phone Number
0040 2016 LO Placer Order Number / Imaging Service Request
0040 2017 LO Filler Order Number / Imaging Service Request
0040 2400 LT Imaging Service Request Comments
0040 3001 LO Confidentiality Constraint on Patient Data Description
0040 8302 DS Entrance Dose in mGy
0040 A010 CS Relationship Type
0040 A027 LO Verifying Organization
0040 A030 DT Verification DateTime
0040 A032 DT Observation DateTime
0040 A040 CS Value Type
0040 A043 SQ Concept-name Code Sequence
0040 A050 CS Continuity Of Content
0040 A073 SQ Verifying Observer Sequence
0040 A075 PN Verifying Observer Name

0040 A088 SQ Verifying Observer Identification Code Sequence
0040 A0B0 US Referenced Waveform Channels
0040 A120 DT DateTime
0040 A121 DA Date
0040 A122 TM Time
0040 A123 PN Person Name
0040 A124 UI UID
0040 A130 CS Temporal Range Type
0040 A132 UL Referenced Sample Positions
0040 A136 US Referenced Frame Numbers
0040 A138 DS Referenced Time Offsets
0040 A13A DT Referenced Datetime
0040 A160 UT Text Value
0040 A168 SQ Concept Code Sequence
0040 A180 US Annotation Group Number
0040 A195 SQ Modifier Code Sequence
0040 A300 SQ Measured Value Sequence
0040 A30A DS Numeric Value
0040 A360 SQ Predecessor Documents Sequence
0040 A370 SQ Referenced Request Sequence
0040 A372 SQ Performed Procedure Code Sequence
0040 A375 SQ Current Requested Procedure Evidence Sequence
0040 A385 SQ Pertinent Other Evidence Sequence
0040 A491 CS Completion Flag
0040 A492 LO Completion Flag Description
0040 A493 CS Verification Flag
0040 A504 SQ Content Template Sequence
0040 A525 SQ Identical Documents Sequence
0040 A730 SQ Content Sequence
0040 B020 SQ Annotation Sequence
0040 DB00 CS Template Identifier
0040 DB06 DT Template Version
0040 DB07 DT Template Local Version
0040 DB0B CS Template Extension Flag
0040 DB0C UI Template Extension Organization UID
0040 DB0D UI Template Extension Creator UID
0040 DB73 UL Referenced Content Item Identifier
0045 0010 LO BlockID = "GE LUT Asymmetry Parameter"
0045 1067 DS LUT Assymetry
0050 0004 CS Calibration Image
0050 0010 SQ Device Sequence
0050 0014 DS Device Length
0050 0016 DS Device Diameter
0050 0017 CS Device Diameter Units
0050 0018 DS Device Volume
0050 0019 DS Inter-marker Distance
0050 0020 LO Device Description
0054 0010 US Energy Window Vector
0054 0011 US Number of Energy Windows
0054 0012 SQ Energy Window Information Sequence
0054 0013 SQ Energy Window Range Sequence
0054 0014 DS Energy Window Lower Limit
0054 0015 DS Energy Window Upper Limit
0054 0016 SQ Radiopharmaceutical Information Sequence
0054 0017 IS Residual Syringe Counts
0054 0018 SH Energy Window Name
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0054 0020 US Detector Vector
0054 0021 US Number of Detectors
0054 0022 SQ Detector Information Sequence
0054 0030 US Phase Vector
0054 0031 US Number of Phases
0054 0032 SQ Phase Information Sequence
0054 0033 US Number of Frames in Phase
0054 0036 IS Phase Delay
0054 0038 IS Pause Between Frames
0054 0050 US Rotation Vector
0054 0051 US Number of Rotations
0054 0052 SQ Rotation Information Sequence
0054 0053 US Number of Frames in Rotation
0054 0060 US R-R Interval Vector
0054 0061 US Number of R-R Intervals
0054 0062 SQ Gated Information Sequence
0054 0063 SQ Data Information Sequence
0054 0070 US Time Slot Vector
0054 0071 US Number of Time Slots
0054 0072 SQ Time Slot Information Sequence
0054 0073 DS Time Slot Time
0054 0080 US Slice Vector
0054 0081 US Number of Slices
0054 0090 US Angular View Vector
0054 0100 US Time Slice Vector
0054 0101 US Number of Time Slices
0054 0200 DS Start Angle
0054 0202 CS Type of Detector Motion
0054 0210 IS Trigger Vector
0054 0211 US Number of Triggers in Phase
0054 0220 SQ View Code Sequence
0054 0222 SQ View Modifier Code Sequence
0054 0300 SQ Radionuclide Code Sequence
0054 0302 SQ Administration Route Code Sequence
0054 0304 SQ Radiopharmaceutical Code Sequence
0054 0306 SQ Calibration Data Sequence
0054 0308 US Energy Window Number
0054 0400 SH Image ID
0054 0410 SQ Patient Orientation Code Sequence
0054 0412 SQ Patient Orientation Modifier Code Sequence
0054 0414 SQ Patient Gantry Relationship Code Sequence
0054 1000 CS Series Type
0054 1001 CS Units
0054 1002 CS Counts Source
0054 1004 CS Reprojection Method
0054 1100 CS Randoms Correction Method
0054 1101 LO Attenuation Correction Method
0054 1102 CS Decay Correction
0054 1103 LO Reconstruction Method
0054 1104 LO Detector Lines of Response Used
0054 1105 LO Scatter Correction Method
0054 1200 DS Axial Acceptance
0054 1201 IS Axial Mash
0054 1202 IS Transverse Mash
0054 1203 DS Detector Element Size
0054 1210 DS Coincidence Window Width

0054 1220 CS Secondary Counts Type
0054 1300 DS Frame Reference Time
0054 1310 IS Primary (Prompts) Counts Accumulated
0054 1311 IS Secondary Counts Accumulated
0054 1320 DS Slice Sensitivity Factor
0054 1321 DS Decay Factor
0054 1322 DS Dose Calibration Factor
0054 1323 DS Scatter Fraction Factor
0054 1324 DS Dead Time Factor
0054 1330 US Image Index
0054 1400 CS Counts Included
0054 1401 CS Dead Time Correction Flag
0060 3000 SQ Histogram Sequence
0060 3002 US Histogram Number of Bins
0060 3004 XS Histogram First Bin Value
0060 3006 XS Histogram Last Bin Value
0060 3008 US Histogram Bin Width
0060 3010 LO Histogram Explanation
0060 3020 UL Histogram Data
0070 0001 SQ Graphic Annotation Sequence
0070 0002 CS Graphic Layer
0070 0003 CS Bounding Box Annotation Units
0070 0004 CS Anchor Point Annotation Units
0070 0005 CS Graphic Annotation Units
0070 0006 ST Unformatted Text Value
0070 0008 SQ Text Object Sequence
0070 0009 SQ Graphic Object Sequence
0070 0010 FL Bounding Box Top Left Hand Corner
0070 0011 FL Bounding Box Bottom Right Hand Corner
0070 0012 CS Bounding Box Text Horizontal Justification
0070 0014 FL Anchor Point
0070 0015 CS Anchor Point Visibility
0070 0020 US Graphic Dimensions
0070 0021 US Number of Graphic Points
0070 0022 FL Graphic Data
0070 0023 CS Graphic Type
0070 0024 CS Graphic Filled
0070 0041 CS Image Horizontal Flip
0070 0042 US Image Rotation
0070 0052 SL Displayed Area Top Left Hand Corner
0070 0053 SL Displayed Area Bottom Right Hand Corner
0070 005A SQ Displayed Area Selection Sequence
0070 0060 SQ Graphic Layer Sequence
0070 0062 IS Graphic Layer Order
0070 0066 US Graphic Layer Recommended Display Grayscale Value
0070 0067 US Graphic Layer Recommended Display RGB Value
0070 0068 LO Graphic Layer Description
0070 0080 CS Presentation Label
0070 0081 LO Presentation Description
0070 0082 DA Presentation Creation Date
0070 0083 TM Presentation Creation Time
0070 0084 PN Presentation Creator's Name
0070 0100 CS Presentation Size Mode
0070 0101 DS Presentation Pixel Spacing
0070 0102 IS Presentation Pixel Aspect Ratio
0070 0103 FL Presentation Pixel Magnification Ratio
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0088 0130 SH Storage Media File-set ID
0088 0140 UI Storage Media File-set UID
0088 0200 SQ Icon Image Sequence
0088 0904 LO Topic Title
0088 0906 ST Topic Subject
0088 0910 LO Topic Author
0088 0912 LO Topic Key Words
0100 0410 CS SOP Instance Status
0100 0420 DT SOP Authorization Date and Time
0100 0424 LT SOP Authorization Comment
0100 0426 LO Authorization Equipment Certification Number
2000 0010 IS Number of Copies
2000 001E SQ Printer Configuration Sequence
2000 0020 CS Print Priority
2000 0030 CS Medium Type
2000 0040 CS Film Destination
2000 0050 LO Film Session Label
2000 0060 IS Memory Allocation
2000 0061 IS Maximum Memory Allocation
2000 0062 CS Color Image Printing Flag
2000 0063 CS Collation Flag
2000 0065 CS Annotation Flag
2000 0067 CS Image Overlay Flag
2000 0069 CS Presentation LUT Flag
2000 006A CS Image Box Presentation LUT Flag
2000 00A0 US Memory Bit Depth
2000 00A1 US Printing Bit Depth
2000 00A2 SQ Media Installed Sequence
2000 00A4 SQ Other Media Available Sequence
2000 00A8 SQ Supported Image Display Formats Sequence
2000 0500 SQ Referenced Film Box Sequence
2000 0510 SQ Referenced Stored Print Sequence
2010 0010 ST Image Display Format
2010 0030 CS Annotation Display Format ID
2010 0040 CS Film Orientation
2010 0050 CS Film Size ID
2010 0052 CS Printer Resolution ID
2010 0054 CS Default Printer Resolution ID
2010 0060 CS Magnification Type
2010 0080 CS Smoothing Type
2010 00A6 CS Default Magnification Type
2010 00A7 CS Other Magnification Types Available
2010 00A8 CS Default Smoothing Type
2010 00A9 CS Other Smoothing Types Available
2010 0100 CS Border Density
2010 0110 CS Empty Image Density
2010 0120 US Min Density
2010 0130 US Max Density
2010 0140 CS Trim
2010 0150 ST Configuration Information
2010 0152 LT Configuration Information Description
2010 0154 IS Maximum Collated Films
2010 015E US Illumination
2010 0160 US Reflected Ambient Light
2010 0376 DS Printer Pixel Spacing
2010 0500 SQ Referenced Film Session Sequence

2010 0510 SQ Referenced Image Box Sequence
2010 0520 SQ Referenced Basic Annotation Box Sequence
2020 0010 US Image Position
2020 0020 CS Polarity
2020 0030 DS Requested Image Size
2020 0040 CS Requested Decimate/Crop Behavior
2020 0050 CS Requested Resolution ID
2020 00A0 CS Requested Image Size Flag
2020 00A2 CS Decimate/Crop Result
2020 0110 SQ Basic Grayscale Image Sequence
2020 0111 SQ Basic Color Image Sequence
2020 0130 SQ Referenced Image Overlay Box Sequence (RET)
2020 0140 SQ Referenced VOI LUT Box Sequence (RET)
2030 0010 US Annotation Position
2030 0020 LO Text String
2040 0010 SQ Referenced Overlay Plane Sequence
2040 0011 US Referenced Overlay Plane Groups
2040 0020 SQ Overlay Pixel Data Sequence
2040 0060 CS Overlay Magnification Type
2040 0070 CS Overlay Smoothing Type
2040 0072 CS Overlay or Image Magnification
2040 0074 US Magnify to Number of Columns
2040 0080 CS Overlay Foreground Density
2040 0082 CS Overlay Background Density
2040 0090 CS Overlay Mode (RET)
2040 0100 CS Threshold Density (RET)
2040 0500 SQ Referenced Image Box Sequence (RET)
2050 0010 SQ Presentation LUT Sequence
2050 0020 CS Presentation LUT Shape
2050 0500 SQ Referenced Presentation LUT Sequence
2100 0010 SH Print Job ID
2100 0020 CS Execution Status
2100 0030 CS Execution Status Info
2100 0040 DA Creation Date
2100 0050 TM Creation Time
2100 0070 AE Originator
2100 0140 AE Destination AE
2100 0160 SH Owner ID
2100 0170 IS Number of Films
2100 0500 SQ Referenced Print Job Sequence
2110 0010 CS Printer Status
2110 0020 CS Printer Status Info
2110 0030 LO Printer Name
2110 0099 SH Print Queue ID
2120 0010 CS Queue Status
2120 0050 SQ Print Job Description Sequence
2120 0070 SQ Referenced Print Job Sequence
2130 0010 SQ Print Management Capabilities Sequence
2130 0015 SQ Printer Characteristics Sequence
2130 0030 SQ Film Box Content Sequence
2130 0040 SQ Image Box Content Sequence
2130 0050 SQ Annotation Content Sequence
2130 0060 SQ Image Overlay Box Content Sequence
2130 0080 SQ Presentation LUT Content Sequence
2130 00A0 SQ Proposed Study Sequence
2130 00C0 SQ Original Image Sequence
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3002 0002 SH RT Image Label
3002 0003 LO RT Image Name
3002 0004 ST RT Image Description
3002 000A CS Reported Values Origin
3002 000C CS RT Image Plane
3002 000D DS X-Ray Image Receptor Translation
3002 000E DS X-Ray Image Receptor Angle
3002 0010 DS RT Image Orientation
3002 0011 DS Image Plane Pixel Spacing
3002 0012 DS RT Image Position
3002 0020 SH Radiation Machine Name
3002 0022 DS Radiation Machine SAD
3002 0024 DS Radiation Machine SSD
3002 0026 DS RT Image SID
3002 0028 DS Source to Reference Object Distance
3002 0029 IS Fraction Number
3002 0030 SQ Exposure Sequence
3002 0032 DS Meterset Exposure
3004 0001 CS DVH Type
3004 0002 CS Dose Units
3004 0004 CS Dose Type
3004 0006 LO Dose Comment
3004 0008 DS Normalization Point
3004 000A CS Dose Summation Type
3004 000C DS Grid Frame Offset Vector
3004 000E DS Dose Grid Scaling
3004 0010 SQ RT Dose ROI Sequence
3004 0012 DS Dose Value
3004 0040 DS DVH Normalization Point
3004 0042 DS DVH Normalization Dose Value
3004 0050 SQ DVH Sequence
3004 0052 DS DVH Dose Scaling
3004 0054 CS DVH Volume Units
3004 0056 IS DVH Number of Bins
3004 0058 DS DVH Data
3004 0060 SQ DVH Referenced ROI Sequence
3004 0062 CS DVH ROI Contribution Type
3004 0070 DS DVH Minimum Dose
3004 0072 DS DVH Maximum Dose
3004 0074 DS DVH Mean Dose
3006 0002 SH Structure Set Label
3006 0004 LO Structure Set Name
3006 0006 ST Structure Set Description
3006 0008 DA Structure Set Date
3006 0009 TM Structure Set Time
3006 0010 SQ Referenced Frame of Reference Sequence
3006 0012 SQ RT Referenced Study Sequence
3006 0014 SQ RT Referenced Series Sequence
3006 0016 SQ Contour Image Sequence
3006 0020 SQ Structure Set ROI Sequence
3006 0022 IS ROI Number
3006 0024 UI Referenced Frame of Reference UID
3006 0026 LO ROI Name
3006 0028 ST ROI Description
3006 002A IS ROI Display Color
3006 002C DS ROI Volume

3006 0030 SQ RT Related ROI Sequence
3006 0033 CS RT ROI Relationship
3006 0036 CS ROI Generation Algorithm
3006 0038 LO ROI Generation Description
3006 0039 SQ ROI Contour Sequence
3006 0040 SQ Contour Sequence
3006 0042 CS Contour Geometric Type
3006 0044 DS Contour Slab Thickness
3006 0045 DS Contour Offset Vector
3006 0046 IS Number of Contour Points
3006 0048 IS Contour Number
3006 0049 IS Attached Contours
3006 0050 DS Contour Data
3006 0080 SQ RT ROI Observations Sequence
3006 0082 IS Observation Number
3006 0084 IS Referenced ROI Number
3006 0085 SH ROI Observation Label
3006 0086 SQ RT ROI Identification Code Sequence
3006 0088 ST ROI Observation Description
3006 00A0 SQ Related RT ROI Observations Sequence
3006 00A4 CS RT ROI Interpreted Type
3006 00A6 PN ROI Interpreter
3006 00B0 SQ ROI Physical Properties Sequence
3006 00B2 CS ROI Physical Property
3006 00B4 DS ROI Physical Property Value
3006 00C0 SQ Frame of Reference Relationship Sequence
3006 00C2 UI Related Frame of Reference UID
3006 00C4 CS Frame of Reference Transformation Type
3006 00C6 DS Frame of Reference Transformation Matrix
3006 00C8 LO Frame of Reference Transformation Comment
3008 0010 SQ Measured Dose Reference Sequence
3008 0012 ST Measured Dose Description
3008 0014 CS Measured Dose Type
3008 0016 DS Measured Dose Value
3008 0020 SQ Treatment Session Beam Sequence
3008 0022 IS Current Fraction Number
3008 0024 DA Treatment Control Point Date
3008 0025 TM Treatment Control Point Time
3008 002A CS Treatment Termination Status
3008 002B SH Treatment Termination Code
3008 002C CS Treatment Verification Status
3008 0030 SQ Referenced Treatment Record Sequence
3008 0032 DS Specified Primary Meterset
3008 0033 DS Specified Secondary Meterset
3008 0036 DS Delivered Primary Meterset
3008 0037 DS Delivered Secondary Meterset
3008 003A DS Specified Treatment Time
3008 003B DS Delivered Treatment Time
3008 0040 SQ Control Point Delivery Sequence
3008 0042 DS Specified Meterset
3008 0044 DS Delivered Meterset
3008 0048 DS Dose Rate Delivered
3008 0050 SQ Treatment Summary Calculated Dose Reference seq. 
3008 0052 DS Cumulative Dose to Dose Reference
3008 0054 DA First Treatment Date
3008 0056 DA Most Recent Treatment Date
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3008 005A IS Number of Fractions Delivered
3008 0060 SQ Override Sequence
3008 0062 AT Override Parameter Pointer
3008 0064 IS Measured Dose Reference Number
3008 0066 ST Override Reason
3008 0070 SQ Calculated Dose Reference Sequence
3008 0072 IS Calculated Dose Reference Number
3008 0074 ST Calculated Dose Reference Description
3008 0076 DS Calculated Dose Reference Dose Value
3008 0078 DS Start Meterset
3008 007A DS End Meterset
3008 0080 SQ Referenced Measured Dose Reference Sequence
3008 0082 IS Referenced Measured Dose Reference Number
3008 0090 SQ Referenced Calculated Dose Reference Sequence
3008 0092 IS Referenced Calculated Dose Reference Number
3008 00A0 SQ Beam Limiting Device Leaf Pairs Sequence
3008 00B0 SQ Recorded Wedge Sequence
3008 00C0 SQ Recorded Compensator Sequence
3008 00D0 SQ Recorded Block Sequence
3008 00E0 SQ Treatment Summary Measured Dose Reference Sequence
3008 0100 SQ Recorded Source Sequence
3008 0105 LO Source Serial Number
3008 0110 SQ Treatment Session Application Setup Sequence
3008 0116 CS Application Setup Check
3008 0120 SQ Recorded Brachy Accessory Device Sequence
3008 0122 IS Referenced Brachy Accessory Device Number
3008 0130 SQ Recorded Channel Sequence
3008 0132 DS Specified Channel Total Time
3008 0134 DS Delivered Channel Total Time
3008 0136 IS Specified Number of Pulses
3008 0138 IS Delivered Number of Pulses
3008 013A DS Specified Pulse Repetition Interval
3008 013C DS Delivered Pulse Repetition Interval
3008 0140 SQ Recorded Source Applicator Sequence
3008 0142 IS Referenced Source Applicator Number
3008 0150 SQ Recorded Channel Shield Sequence
3008 0152 IS Referenced Channel Shield Number
3008 0160 SQ Brachy Control Point Delivered Sequence
3008 0162 DA Safe Position Exit Date
3008 0164 TM Safe Position Exit Time
3008 0166 DA Safe Position Return Date
3008 0168 TM Safe Position Return Time
3008 0200 CS Current Treatment Status
3008 0202 ST Treatment Status Comment
3008 0220 SQ Fraction Group Summary Sequence
3008 0223 IS Referenced Fraction Number
3008 0224 CS Fraction Group Type
3008 0230 CS Beam Stopper Position
3008 0240 SQ Fraction Status Summary Sequence
3008 0250 DA Treatment Date
3008 0251 TM Treatment Time
300A 0002 SH RT Plan Label
300A 0003 LO RT Plan Name
300A 0004 ST RT Plan Description
300A 0006 DA RT Plan Date
300A 0007 TM RT Plan Time

300A 0009 LO Treatment Protocols
300A 000A CS Treatment Intent
300A 000B LO Treatment Sites
300A 000C CS RT Plan Geometry
300A 000E ST Prescription Description
300A 0010 SQ Dose Reference Sequence
300A 0012 IS Dose Reference Number
300A 0014 CS Dose Reference Structure Type
300A 0015 CS Nominal Beam Energy Unit
300A 0016 LO Dose Reference Description
300A 0018 DS Dose Reference Point Coordinates
300A 001A DS Nominal Prior Dose
300A 0020 CS Dose Reference Type
300A 0021 DS Constraint Weight
300A 0022 DS Delivery Warning Dose
300A 0023 DS Delivery Maximum Dose
300A 0025 DS Target Minimum Dose
300A 0026 DS Target Prescription Dose
300A 0027 DS Target Maximum Dose
300A 0028 DS Target Underdose Volume Fraction
300A 002A DS Organ at Risk Full-volume Dose
300A 002B DS Organ at Risk Limit Dose
300A 002C DS Organ at Risk Maximum Dose
300A 002D DS Organ at Risk Overdose Volume Fraction
300A 0040 SQ Tolerance Table Sequence
300A 0042 IS Tolerance Table Number
300A 0043 SH Tolerance Table Label
300A 0044 DS Gantry Angle Tolerance
300A 0046 DS Beam Limiting Device Angle Tolerance
300A 0048 SQ Beam Limiting Device Tolerance Sequence
300A 004A DS Beam Limiting Device Position Tolerance
300A 004C DS Patient Support Angle Tolerance
300A 004E DS Table Top Eccentric Angle Tolerance
300A 0051 DS Table Top Vertical Position Tolerance
300A 0052 DS Table Top Longitudinal Position Tolerance
300A 0053 DS Table Top Lateral Position Tolerance
300A 0055 CS RT Plan Relationship
300A 0070 SQ Fraction Group Sequence
300A 0071 IS Fraction Group Number
300A 0078 IS Number of Fractions Planned
300A 0079 IS Number of Fractions Per Day
300A 007A IS Repeat Fraction Cycle Length
300A 007B LT Fraction Pattern
300A 0080 IS Number of Beams
300A 0082 DS Beam Dose Specification Point
300A 0084 DS Beam Dose
300A 0086 DS Beam Meterset
300A 00A0 IS Number of Brachy Application Setups
300A 00A2 DS Brachy Application Setup Dose Specification Point
300A 00A4 DS Brachy Application Setup Dose
300A 00B0 SQ Beam Sequence
300A 00B2 SH Treatment Machine Name
300A 00B3 CS Primary Dosimeter Unit
300A 00B4 DS Source-Axis Distance
300A 00B6 SQ Beam Limiting Device Sequence
300A 00B8 CS RT Beam Limiting Device Type
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300A 00BA DS Source to Beam Limiting Device Distance
300A 00BC IS Number of Leaf/Jaw Pairs
300A 00BE DS Leaf Position Boundaries
300A 00C0 IS Beam Number
300A 00C2 LO Beam Name
300A 00C3 ST Beam Description
300A 00C4 CS Beam Type
300A 00C6 CS Radiation Type
300A 00C8 IS Reference Image Number
300A 00CA SQ Planned Verification Image Sequence
300A 00CC LO Imaging Device-Specific Acquisition Parameters
300A 00CE CS Treatment Delivery Type
300A 00D0 IS Number of Wedges
300A 00D1 SQ Wedge Sequence
300A 00D2 IS Wedge Number
300A 00D3 CS Wedge Type
300A 00D4 SH Wedge ID
300A 00D5 IS Wedge Angle
300A 00D6 DS Wedge Factor
300A 00D8 DS Wedge Orientation
300A 00DA DS Source to Wedge Tray Distance
300A 00E0 IS Number of Compensators
300A 00E1 SH Material ID
300A 00E2 DS Total Compensator Tray Factor
300A 00E3 SQ Compensator Sequence
300A 00E4 IS Compensator Number
300A 00E5 SH Compensator ID
300A 00E6 DS Source to Compensator Tray Distance
300A 00E7 IS Compensator Rows
300A 00E8 IS Compensator Columns
300A 00E9 DS Compensator Pixel Spacing
300A 00EA DS Compensator Position
300A 00EB DS Compensator Transmission Data
300A 00EC DS Compensator Thickness Data
300A 00ED IS Number of Boli
300A 00EE CS Compensator Type
300A 00F0 IS Number of Blocks
300A 00F2 DS Total Block Tray Factor
300A 00F4 SQ Block Sequence
300A 00F5 SH Block Tray ID
300A 00F6 DS Source to Block Tray Distance
300A 00F8 CS Block Type
300A 00FA CS Block Divergence
300A 00FC IS Block Number
300A 00FE LO Block Name
300A 0100 DS Block Thickness
300A 0102 DS Block Transmission
300A 0104 IS Block Number of Points
300A 0106 DS Block Data
300A 0107 SQ Applicator Sequence
300A 0108 SH Applicator ID
300A 0109 CS Applicator Type
300A 010A LO Applicator Description
300A 010C DS Cumulative Dose Reference Coefficient
300A 010E DS Final Cumulative Meterset Weight
300A 0110 IS Number of Control Points

300A 0111 SQ Control Point Sequence
300A 0112 IS Control Point Index
300A 0114 DS Nominal Beam Energy
300A 0115 DS Dose Rate Set
300A 0116 SQ Wedge Position Sequence
300A 0118 CS Wedge Position
300A 011A SQ Beam Limiting Device Position Sequence
300A 011C DS Leaf/Jaw Positions
300A 011E DS Gantry Angle
300A 011F CS Gantry Rotation Direction
300A 0120 DS Beam Limiting Device Angle
300A 0121 CS Beam Limiting Device Rotation Direction
300A 0122 DS Patient Support Angle
300A 0123 CS Patient Support Rotation Direction
300A 0124 DS Table Top Eccentric Axis Distance
300A 0125 DS Table Top Eccentric Angle
300A 0126 CS Table Top Eccentric Rotation Direction
300A 0128 DS Table Top Vertical Position
300A 0129 DS Table Top Longitudinal Position
300A 012A DS Table Top Lateral Position
300A 012C DS Isocenter Position
300A 012E DS Surface Entry Point
300A 0130 DS Source to Surface Distance
300A 0134 DS Cumulative Meterset Weight
300A 0180 SQ Patient Setup Sequence
300A 0182 IS Patient Setup Number
300A 0184 LO Patient Additional Position
300A 0190 SQ Fixation Device Sequence
300A 0192 CS Fixation Device Type
300A 0194 SH Fixation Device Label
300A 0196 ST Fixation Devi ce Description
300A 0198 SH Fixation Device Position
300A 01A0 SQ Shielding Device Sequence
300A 01A2 CS Shielding Device Type
300A 01A4 SH Shielding Device Label
300A 01A6 ST Shielding Device Description
300A 01A8 SH Shielding Device Position
300A 01B0 CS Setup Technique
300A 01B2 ST Setup Technique Description
300A 01B4 SQ Setup Device Sequence
300A 01B6 CS Setup Device Type
300A 01B8 SH Setup Device Label
300A 01BA ST Setup Device Description
300A 01BC DS Setup Device Parameter
300A 01D0 ST Setup Reference Description
300A 01D2 DS Table Top Vertical Setup Displacement
300A 01D4 DS Table Top Longitudinal Setup Displacement
300A 01D6 DS Table Top Lateral Setup Displacement
300A 0200 CS Brachy Treatment Technique
300A 0202 CS Brachy Treatment Type
300A 0206 SQ Treatment Machine Sequence
300A 0210 SQ Source Sequence
300A 0212 IS Source Number
300A 0214 CS Source Type
300A 0216 LO Source Manufacturer
300A 0218 DS Active Source Diameter
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300A 021A DS Active Source Length
300A 0222 DS Source Encapsulation Nominal Thickness
300A 0224 DS Source Encapsulation Nominal Transmission
300A 0226 LO Source Isotope Name
300A 0228 DS Source Isotope Half Life
300A 022A DS Reference Air Kerma Rate
300A 022C DA Air Kerma Rate Reference Date
300A 022E TM Air Kerma Rate Reference Time
300A 0230 SQ Application Setup Sequence
300A 0232 CS Application Setup Type
300A 0234 IS Application Setup Number
300A 0236 LO Application Setup Name
300A 0238 LO Application Setup Manufacturer
300A 0240 IS Template Number
300A 0242 SH Template Type
300A 0244 LO Template Name
300A 0250 DS Total Reference Air Kerma
300A 0260 SQ Brachy Accessory Device Sequence
300A 0262 IS Brachy Accessory Device Number
300A 0263 SH Brachy Accessory Device ID
300A 0264 CS Brachy Accessory Device Type
300A 0266 LO Brachy Accessory Device Name
300A 026A DS Brachy Accessory Device Nominal Thickness
300A 026C DS Brachy Accessory Device Nominal Transmission
300A 0280 SQ Channel Sequence
300A 0282 IS Channel Number
300A 0284 DS Channel Length
300A 0286 DS Channel Total Time
300A 0288 CS Source Movement Type
300A 028A IS Number of Pulses
300A 028C DS Pulse Repetition Interval
300A 0290 IS Source Applicator Number
300A 0291 SH Source Applicator ID
300A 0292 CS Source Applicator Type
300A 0294 LO Source Applicator Name
300A 0296 DS Source Applicator Length
300A 0298 LO Source Applicator Manufacturer
300A 029C DS Source Applicator Wall Nominal Thickness
300A 029E DS Source Applicator Wall Nominal Transmission
300A 02A0 DS Source Applicator Step Size
300A 02A2 IS Transfer Tube Number
300A 02A4 DS Transfer Tube Length
300A 02B0 SQ Channel Shield Sequence
300A 02B2 IS Channel Shield Number
300A 02B3 SH Channel Shield ID
300A 02B4 LO Channel Shield Name
300A 02B8 DS Channel Shield Nominal Thickness
300A 02BA DS Channel Shield Nominal Transmission
300A 02C8 DS Final Cumulative Time Weight
300A 02D0 SQ Brachy Control Point Sequence
300A 02D2 DS Control Point Relative Position
300A 02D4 DS Control Point 3D Position
300A 02D6 DS Cumulative Time Weight
300C 0002 SQ Referenced RT Plan Sequence
300C 0004 SQ Referenced Beam Sequence
300C 0006 IS Referenced Beam Number

300C 0007 IS Referenced Reference Image Number
300C 0008 DS Start Cumulative Meterset Weight
300C 0009 DS End Cumulative Meterset Weight
300C 000A SQ Referenced Brachy Application Setup Sequence
300C 000C IS Referenced Brachy Application Setup Number
300C 000E IS Referenced Source Number
300C 0020 SQ Referenced Fraction Group Sequence
300C 0022 IS Referenced Fraction Group Number
300C 0040 SQ Referenced Verification Image Sequence
300C 0042 SQ Referenced Reference Image Sequence
300C 0050 SQ Referenced Dose Reference Sequence
300C 0051 IS Referenced Dose Reference Number
300C 0055 SQ Brachy Referenced Dose Reference Sequence
300C 0060 SQ Referenced Structure Set Sequence
300C 006A IS Referenced Patient Setup Number
300C 0080 SQ Referenced Dose Sequence
300C 00A0 IS Referenced Tolerance Table Number
300C 00B0 SQ Referenced Bolus Sequence
300C 00C0 IS Referenced Wedge Number
300C 00D0 IS Referenced Compensator Number
300C 00E0 IS Referenced Block Number
300C 00F0 IS Referenced Control Point Index
300E 0002 CS Approval Status
300E 0004 DA Review Date
300E 0005 TM Review Time
300E 0008 PN Reviewer Name
3101 0010 LO BlockID = "AMI Annotations_02"
3101 0011 LO BlockID = "AMI Annotations_01"
3101 1020 SQ AMI Annotation Sequence (RET)
3101 1110 SQ AMI Annotation Sequence (RET)
3103 0010 LO BlockID = "AMI Sequence Annotations_02"
3103 0011 LO BlockID = "AMI Sequence Annotations_01"
3103 1010 CS AMI Annotation Sequence (RET)
3103 1020 UI AMI Annotation UID (RET)
3103 1030 US AMI Annotation Color (RET)
3103 1050 CS AMI Annotation Line Style (RET)
3103 1060 SQ AMI Annotation Elements (RET)
3103 1070 SH AMI Annotation Label (RET)
3103 1080 PN AMI Annotation Creator (RET)
3103 1090 PN AMI Annotation Modifiers (RET)
3103 10A0 DA AMI Annotation Creation Date (RET)
3103 10B0 TM AMI Annotation Creation Time (RET)
3103 10C0 DA AMI Annotation Modification Dates (RET)
3103 10D0 TM AMI Annotation Modification Times (RET)
3103 10E0 US AMI Annotation Frame Number (RET)
3103 1110 CS AMI Annotation Sequence (RET)
3103 1120 UI AMI Annotation UID (RET)
3103 1130 US AMI Annotation Color (RET)
3103 1150 CS AMI Annotation Line Style (RET)
3103 1160 SQ AMI Annotation Elements (RET)
3103 1170 SH AMI Annotation Label (RET)
3103 1180 PN AMI Annotation Creator (RET)
3103 1190 PN AMI Annotation Modifiers (RET)
3103 11A0 DA  AMI Annotation Creation Date (RET)
3103 11B0 TM AMI Annotation Creation Time (RET)
3103 11C0 DA  AMI Annotation Modification Dates (RET)
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3103 11D0 TM AMI Annotation Mofification Times (RET)
3103 11E0 US AMI Annotation Frame Number (RET)
3105 0010 LO BlockID = "AMI Sequence AnnotElements_01"
3105 1010 DS AMI Annotation Element Position
3105 1020 LT AMI Annotation Element Text
3107 0010 LO BlockID = "AMI ImageTransform_01"
3107 0011 LO BlockID = "AMI ImageContextExt_01"
3107 1010 DS AMI Transformation Matrix (RET)
3107 1020 DS AMI Center Offset (RET)
3107 1030 DS AMI Magnification (RET)
3107 1040 CS AMI Magnification Type (RET)
3107 1050 DS AMI Displayed Area (RET)
3107 1060 DS AMI Calibration Factor (RET)
3107 11A0 CS AMI Window Function (RET)
3107 11B0 DS AMI Window Slope (RET)
3109 0010 LO BlockID = "Applicare/RadWorks/Version 5.0"
3109 0011 LO BlockID = "AMI ImageContext_01"
3109 0012 LO BlockID = "Applicare/RadWorks/Version 6.0/Summary"
3109 1001 ST DCM_WORKLISTFILENAME <internal>
3109 1002 SH DCM_AMI_STATUS: NEW/SEEN Status
3109 1003 CS Delete Lock:  Flag indicating study is locked.
3109 1004 CS DCM_AMI_STATUS2: <internal>
3109 1005 CS DCM_AMI_STATUS3: <internal>
3109 1006 CS DCM_AMI_STATUS4: <internal>
3109 1007 UL DCM_AMI_STATUSBITS: <internal>
3109 1008 LO DCM_AMI_ORIGIN: Receive Origin
3109 1009 LO Folder
3109 100A DA Receive Date
3109 100B TM Receive Time
3109 100C CS Prior
3109 100D CS STAT Study:  Flag indicating study is STAT. '
3109 100E CS <internal>.  Flag indicating study/image is KEY. 
3109 1010 CS DCM_AMI_LOCALSTUDY: <internal>
3109 1011 LO DCM_AMI_RESULT_MSG: <internal>
3109 1012 LO DCM_AMI_CURRENT_USER: <internal>
3109 1013 DA DCM_AMI_SYSTEM_DATE: <internal>
3109 1014 TM DCM_AMI_SYSTEM_TIME: <internal>
3109 1020 UI <internal>.  Refers to the UID of the Worklist item.
3109 1021 CS DCM_AMI_HOSTNAME: <internal>
3109 1022 AE DCM_AMI_DICOM_AE_TITLE: <internal>
3109 1023 US DCM_AMI_DICOM_PORT_NUMBER: <internal>
3109 1024 LO DCM_AMI_DESTINATION_NAME: <internal>
3109 1025 LO  <internal>.  AMI origin name
3109 1026 UI <internal>.  Study instance uid generated by modality
3109 1027 SQ <internal>.  Sequence (AE Host Port Stor. Comm.)
3109 102A LO Send Flag
3109 102B LO Print Flag
3109 102C LO Archive Flag
3109 1030 LO  <internal>.  Requesting Facility Name
3109 1031 CS <internal>. Requesting Procedure Name
3109 1032 CS <internal>.  Requesting Procedure Code
3109 1033 CS Request Storage Commitment. 
3109 1034 CS Requested Compression. 
3109 1035 SQ  <internal>.  Study seq. for replies to PATIENT queries
3109 1036 LO  <internal>.  Origin of update (used by Local Worklist)
3109 1036 LO Origin of update

3109 1037 UI  <internal>.  Study UID that is being replaced
3109 1038 SH  ACR code for teaching "folder" worklists
3109 1039 SH  <internal>.  Special Interest Code (for teaching worklist)
3109 1040 IS <internal>.  Number of Study Related Images
3109 1041 CS <internal>.  Study locked
3109 1042 CS <internal>. Contains workstation name
3109 1110 CS AMI Window Invert (RET)
3109 1120 IS AMI Window Center (RET)
3109 1130 IS AMI Window Widith (RET)
3109 1140 CS AMI Pixel Aspect Ratio Swap (RET)
3109 1150 CS AMI Enable Averaging (RET)
3109 1160 CS AMI Quality (RET)
3109 1170 CS AMI Viewport Annotation Level (RET)
3109 1180 CS AMI Show Image Annotation (RET)
3109 1190 CS AMI Show Image Overlay (RET)
3109 1201 SH DCM_AMI_STATUS
3109 1211 ST DCM_AMI_ORIGIN
3109 1212 ST Receive Origin Description
3109 1215 DA DCM_AMI_RECEIVEDATE
3109 1216 TM  DCM_AMI_RECEIVETIME
3111 0010 LO BlockID = "AMI StudyExtensions_01"
3111 0011 LO BlockID = "RadWorksTBR"
3111 1001 UL AMI Last Released Annot Label (RET)
3111 1102 CS AMI Compression Type (RET)
3111 11FF SQ DCM_AMI_QUERY_RESULT: <internal>
3113 0010 LO BlockID = "Applicare/RadStore/Version 1.0"
3113 0020 LO BlockID = "Applicare/Workflow/Version 1.0"
3113 1001 SL OBSOLETE
3113 1002 SL Id1
3113 1003 SL Id2
3113 1004 SL Id3
3113 1011 LO OBSOLETE
3113 1012 CS State:  image archiving state
3113 1013 DA DateLastModified
3113 1014 DA DateLastAccessed
3113 1015 CS OBSOLETE
3113 1016 FD ByteSize
3113 1017 LO LibraryId
3113 1018 LO Pathnames
3113 1019 LO CachePathnames
3113 101A LO Source
3113 101B LO Destination
3113 101C SL MediumId
3113 101D LO ArchiveId
3113 101E LO Origin
3113 1031 IS OBSOLETE
3113 1032 IS OBSOLETE
3113 1033 IS OBSOLETE
3113 1035 LO ImageMediumLocation
3113 1036 LO ImageMediumLabel
3113 1037 CS ImageMediumState
3113 1038 LO SeriesMediumLocation
3113 1039 LO SeriesMediumLabel
3113 103a CS SeriesMediumState
3113 103b LO StudyMediumLocation
3113 103c LO StudyMediumLabel
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3113 103d CS StudyMediumState
3113 1052 CS StudyState:  binary composition of image states
3113 1053 CS SeriesState:  binary composition of image states
3113 1055 CS ImageStateText:  textual description of image state
3113 1056 CS SeriesStateText:  textual description combined series state
3113 1057 CS StudyStateText:  textual description combined study state
3113 1060 DT Expiration:  determines lifetime of internal worklist items 
3113 1068 SQ DeltaSets
3113 2001 CS OrderControl: <internal>
3113 2010 SH ScheduledActionItemCodeValue: <internal>
3113 2011 SH Sch.ActionItemCodingSchemeDesignator: <internal>
3113 2012 LO ScheduledActionItemCodeMeaning: <internal>
3113 2015 SH RequestedActionItemCodeValue: <internal>
3113 2016 SH Req.ActionItemCodingSchemeDesignator: <internal>
3113 2017 LO RequestedActionItemCodeMeaning: <internal>
3113 2020 SH PerformedActionItemCodeValue: <internal>
3113 2021 SH Perf.ActionItemCodingSchemeDesignator: <internal>
3113 2022 LO PerformedActionItemCodeMeaning: <internal>
3113 2025 SH PerformedProcedureCodeValue: <internal>
3113 2026 SH Perf.ProcedureCodingSchemeDesignator: <internal>
3113 2027 LO PerformedProcedureCodeMeaning: <internal>
3113 2030 UI ReferencedImageSOPClassUID: <internal>
3113 2031 UI ReferencedImageSOPInstanceUID: <internal>
3113 20E0 CS LockedByHostname: <internal>
3113 20E1 CS LockedByUser: <internal>
3113 20E2 CS KfEditLockUser: <internal>.
4008 0040 SH Results ID
4008 0042 LO Results ID Issuer
4008 0050 SQ Referenced Interpretation Sequence
4008 0100 DA Interpretation Recorded Date
4008 0101 TM Interpretation Recorded Time
4008 0102 PN Interpretation Recorder
4008 0103 LO Reference to Recorded Sound
4008 0108 DA Interpretation Transcription Date
4008 0109 TM Interpretation Transcription Time
4008 010A PN Interpretation Transcriber
4008 010B ST Interpretation Text
4008 010C PN Interpretation Author
4008 0111 SQ Interpretation Approver Sequence
4008 0112 DA Interpretation Approval Date
4008 0113 TM Interpretation Approval Time
4008 0114 PN Physician Approving Interpretation
4008 0115 LT Interpretation Diagnosis Description
4008 0117 SQ Interpretation Diagnosis Code Sequence
4008 0118 SQ Results Distribution List Sequence
4008 0119 PN Distribution Name
4008 011A LO Distribution Address
4008 0200 SH Interpretation ID
4008 0202 LO Interpretation ID Issuer
4008 0210 CS Interpretation Type ID
4008 0212 CS Interpretation Status ID
4008 0300 ST Impressions
4008 4000 ST Results Comments
4101 0010 LO BlockID = "Applicare/Print/Version 5.1"
4101 1001 UL DCM_PRINT_MASKSTATE: <internal>
4101 1002 SQ DCM_PRINT_ANNOTS: <internal>

4101 1003 LO DCM_PRINT_FONT: <internal>
4101 1004 UL DCM_PRINT_FONTSIZE: <internal>
4101 1005 FD DCM_PRINT_FONTRELSIZE: <internal>
4101 1006 US DCM_PRINT_OVERLAY: <internal>
4101 1007 US DCM_PRINT_PIXELREP: <internal>
4105 0010 LO BlockID = "Applicare/RadWorks/Version 6.0"
4105 1001 CS Annotation Type
4105 1002 DS Annotation Value
4105 1003 UI Cutline Image UID
4105 1004 UI Cutline Group UID
4105 1005 US Annotation Color
4105 1006 CS Annotation Line Style
4105 1007 SH Annotation Label
4105 1008 PN Annotation Creator
4105 1009 DA Annotation Creation Date
4105 100A TM Annotation Creation Time
4105 100B SQ Annotation Modification Sequence
4105 100C PN Annotation Modifier
4105 100D DA Annotation Modification Date
4105 100E TM Annotation Modification Time
4105 100F LO Palette Color LUT Name
4105 1010 US Annotation Number
4107 0010 LO BlockID = "Applicare/RadWorks/Version 6.0"
4107 1001 SQ Requested Palette Color LUT
5000 0005 US Curve Dimensions
5000 0010 US Number of Points
5000 0020 CS Type of Data
5000 0022 LO Curve Description
5000 0030 SH Axis Units
5000 0040 SH Axis Labels
5000 0103 US Data Value Representation
5000 0104 US Minimum Coordinate Value
5000 0105 US Maximum Coordinate Value
5000 0106 SH Curve Range
5000 0110 US Curve Data Descriptor
5000 0112 US Coordinate Start Value
5000 0114 US Coordinate Step Value
5000 1001 CS Curve Activation Layer
5000 2000 US Audio Type
5000 2002 US Audio Sample Format
5000 2004 US Number of Channels
5000 2006 UL Number of Samples
5000 2008 UL Sample Rate
5000 200A UL Total Time
5000 200C OW Audio Sample Data
5000 200E LT Audio Comments
5000 2500 LO Curve Label
5000 2600 SQ Referenced Overlay Sequence
5000 2610 US Referenced Overlay Group
5000 3000 OW Curve Data
5400 0100 SQ Waveform Sequence
5400 0110 OW Channel Minimum Value
5400 0112 OW Channel Maximum Value
5400 1004 US Waveform Bits Allocated
5400 1006 CS Waveform Sample Interpretation
5400 100A OW Waveform Padding Value
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5400 1010 OW Waveform Data
6000 0010 US Overlay Rows
6000 0011 US Overlay Columns
6000 0012 US Overlay Planes
6000 0015 IS Number of Frames in Overlay
6000 0022 LO Overlay Description
6000 0040 CS Overlay Type
6000 0045 LO Overlay Subtype
6000 0050 SS Overlay Origin
6000 0051 US Image Frame Origin
6000 0052 US Overlay Plane Origin
6000 0060 CS Compression Code (RET)
6000 0100 US Overlay Bits Allocated
6000 0102 US Overlay Bit Position
6000 1001 CS Overlay Activation Layer
6000 1100 US Overlay Descriptor - Gray (RET)
6000 1101 US Overlay Descriptor - Red (RET)
6000 1102 US Overlay Descriptor - Green (RET)
6000 1103 US Overlay Descriptor - Blue (RET)
6000 1200 US Overlays - Gray (RET)
6000 1201 US Overlays - Red (RET)
6000 1202 US Overlays - Green (RET)
6000 1203 US Overlays - Blue (RET)
6000 1301 IS ROI Area
6000 1302 DS ROI Mean
6000 1303 DS ROI Standard Deviation
6000 1500 LO Overlay Label
6000 3000 OW Overlay Data
6000 4000 LO Comments (RET)
7FD1 0010 LO BlockID = "GEIIS"
7FD1 1010 UL GE IIS Compression ID
7FD1 1020 UL GE IIS Multiframe Offsets
7FE0 0010 OW Pixel Data
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DICOM tags listed alphabetically

Name Group ElementVR Name Group Element VR
Affected SOP Class UID. 0000 0002 UI
Requested SOP Class UID 0000 0003 UI
Command Field 0000 0100 US
Message ID 0000 0110 US
Message ID Being Responded To 0000 0120 US
Move Destination 0000 0600 AE
Priority 0000 0700 US
Data Set Type 0000 0800 US
Status 0000 0900 US
Offending Element 0000 0901 AT
Error Comment 0000 0902 LO
Error ID 0000 0903 US
Affected SOP Instance UID 0000 1000 UI
Requested SOP Instance UID 0000 1001 UI
Event Type ID 0000 1002 US
Attribute Identifier List 0000 1005 AT
Action Type ID 0000 1008 US
Number of Remaining Sub-operations 0000 1020 US
Number of Completed Sub-operations 0000 1021 US
Number of Failed Sub-operations 0000 1022 US
Number of Warning Sub-operations 0000 1023 US
Move Originator Application Entity Title 0000 1030 AE
Move Originator Message ID 0000 1031 US
File Meta Information Version 0002 0001 OB
Media Storage SOP Class UID 0002 0002 UI
Media Storage SOP Instance UID 0002 0003 UI
Transfer Syntax UID 0002 0010 UI
Implementation Class UID 0002 0012 UI
Implementation Version Name 0002 0013 SH
Source Application Entity Title 0002 0016 AE
Private Information Creator UID 0002 0100 UI
Private Information 0002 0102 OB
File-set ID 0004 1130 CS
File-set Descriptor File ID 0004 1141 CS
Specific Character Set of File-set Descriptor File 0004 1142 CS
Root Directory Entity’s First Directory Record Offset 0004 1200 UL
Root Directory Entity Last Directory Record Offset 0004 1202 UL
File-set Consistency Flag 0004 1212 US
Directory Record Sequence 0004 1220 SQ
Offset of the Next Directory Record 0004 1400 UL
Record In-use Flag 0004 1410 US
Offset of Referenced Lower-Level Directory Entity 0004 1420 UL
Directory Record Type 0004 1430 CS
Private Record UID 0004 1432 UI
Referenced File ID 0004 1500 CS
MRDR Directory Record Offset 0004 1504 UL
Referenced SOP Class UID in File 0004 1510 UI
Referenced SOP Instance UID in File 0004 1511 UI
Referenced Transfer Syntax UID in File 0004 1512 UI
Number of References 0004 1600 UL
Specific Character Set 0008 0005 CS

Image Type 0008 0008 CS
Instance Creation Date 0008 0012 DA
Instance Creation Time 0008 0013 TM
Instance Creator UID 0008 0014 UI
SOP Class UID 0008 0016 UI
SOP Instance UID 0008 0018 UI
Study Date 0008 0020 DA
Series Date 0008 0021 DA
Acquisition Date 0008 0022 DA
Content Date 0008 0023 DA
Overlay Date 0008 0024 DA
Curve Date 0008 0025 DA
Acquisition Datetime 0008 002A DT
Study Time 0008 0030 TM
Series Time 0008 0031 TM
Acquisition Time 0008 0032 TM
Content Time 0008 0033 TM
Overlay Time 0008 0034 TM
Curve Time 0008 0035 TM
Nuclear Medicine Series Type (RET) 0008 0042 CS
Accession Number 0008 0050 SH
Query/Retrieve Level 0008 0052 CS
Retrieve AE Title 0008 0054 AE
Instance Availability 0008 0056 CS
Failed SOP Instance UID List 0008 0058 UI
Modality 0008 0060 CS
Modalities in Study 0008 0061 CS
Conversion Type 0008 0064 CS
Presentation Intent Type 0008 0068 CS
Manufacturer 0008 0070 LO
Institution Name 0008 0080 LO
Institution Address 0008 0081 ST
Institution Code Sequence 0008 0082 SQ
Referring Physician's Name 0008 0090 PN
Referring Physician's Address 0008 0092 ST
Referring Physician's Telephone Numbers 0008 0094 SH
Code Value 0008 0100 SH
Coding Scheme Designator 0008 0102 SH
Coding Scheme Version 0008 0103 SH
Code Meaning 0008 0104 LO
Mapping Resource 0008 0105 CS
Context Group Version 0008 0106 DT
Context Group Local Version 0008 0107 DT
Code Set Extension Flag 0008 010B CS
Private Coding Scheme Creator UID 0008 010C UI
Code Set Extension Creator UID 0008 010D UI
Context Identifier 0008 010F CS
Timezone Offset From UTC 0008 0201 SH
Station Name 0008 1010 SH
Study Description 0008 1030 LO
Procedure Code Sequence 0008 1032 SQ
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Series Description 0008 103E LO
Institutional Department Name 0008 1040 LO
Physician(s) of Record 0008 1048 PN
Performing Physician's Name 0008 1050 PN
Name of Physician(s) Reading Study 0008 1060 PN
Operators' Name 0008 1070 PN
Admitting Diagnoses Description 0008 1080 LO
Admitting Diagnosis Code Sequence 0008 1084 SQ
Manufacturer's Model Name 0008 1090 LO
Referenced Results Sequence 0008 1100 SQ
Referenced Study Sequence 0008 1110 SQ
Referenced Study Component Sequence 0008 1111 SQ
Referenced Series Sequence 0008 1115 SQ
Referenced Patient Sequence 0008 1120 SQ
Referenced Visit Sequence 0008 1125 SQ
Referenced Overlay Sequence 0008 1130 SQ
Referenced Image Sequence 0008 1140 SQ
Referenced Curve Sequence 0008 1145 SQ
Referenced SOP Class UID 0008 1150 UI
Referenced SOP Instance UID 0008 1155 UI
SOP Classes Supported 0008 115A UI
Referenced Frame Number 0008 1160 IS
Transaction UID 0008 1195 UI
Failure Reason 0008 1197 US
Failed SOP Sequence 0008 1198 SQ
Referenced SOP Sequence 0008 1199 SQ
Lossy Image Compression (RET) 0008 2110 CS
Derivation Description 0008 2111 ST
Source Image Sequence 0008 2112 SQ
Stage Name 0008 2120 SH
Stage Number 0008 2122 IS
Number of Stages 0008 2124 IS
View Number 0008 2128 IS
Number of Event Timers 0008 2129 IS
Number of Views in Stage 0008 212A IS
Event Elapsed Time(s) 0008 2130 DS
Event Timer Name(s) 0008 2132 LO
Start Trim 0008 2142 IS
Stop Trim 0008 2143 IS
Recommended Display Frame Rate 0008 2144 IS
Transducer Position (RET) 0008 2200 CS
Transducer Orientation (RET) 0008 2204 CS
Anatomic Structure (RET) 0008 2208 CS
Anatomic Region Sequence 0008 2218 SQ
Anatomic Region Modifier Sequence 0008 2220 SQ
Primary Anatomic Structure Sequence 0008 2228 SQ
Anatomic Structure. Space or Region Sequence 0008 2229 SQ
Primary Anatomic Structure Modifier Sequence 0008 2230 SQ
Transducer Position Sequence 0008 2240 SQ
Transducer Position Modifier Sequence 0008 2242 SQ
Transducer Orientation Sequence 0008 2244 SQ
Transducer Orientation Modifier Sequence 0008 2246 SQ
BlockID = "GEIIS "0009 0010 LO
GE IIS Thumbnail Sequence 0009 1010 SQ
Patient's Name 0010 0010 PN
Patient ID 0010 0020 LO

Issuer of Patient ID 0010 0021 LO
Patient's Birth Date 0010 0030 DA
Patient's Birth Time 0010 0032 TM
Patient's Sex 0010 0040 CS
Patient's Insurance Plan Code Sequence 0010 0050 SQ
Other Patient IDs 0010 1000 LO
Other Patient Names 0010 1001 PN
Patient's Birth Name 0010 1005 PN
Patient's Age 0010 1010 AS
Patient's Size 0010 1020 DS
Patient's Weight 0010 1030 DS
Patient's Address 0010 1040 LO
Patient's Mother's Birth Name 0010 1060 PN
Military Rank 0010 1080 LO
Branch of Service 0010 1081 LO
Medical Record Locator 0010 1090 LO
Medical Alerts 0010 2000 LO
Contrast Allergies 0010 2110 LO
Country of Residence 0010 2150 LO
Region of Residence 0010 2152 LO
Patient's Telephone Numbers 0010 2154 SH
Ethnic Group 0010 2160 SH
Occupation 0010 2180 SH
Smoking Status 0010 21A0 CS
Additional Patient History 0010 21B0 LT
Pregnancy Status 0010 21C0 US
Last Menstrual Date 0010 21D0 DA
Patient's Religious Preference 0010 21F0 LO
Patient Comments 0010 4000 LT
Contrast/Bolus Agent 0018 0010 LO
Contrast/Bolus Agent Sequence 0018 0012 SQ
Contrast/Bolus Administration Route Sequence 0018 0014 SQ
Body Part Examined 0018 0015 CS
Scanning Sequence 0018 0020 CS
Sequence Variant 0018 0021 CS
Scan Options 0018 0022 CS
MR Acquisition Type 0018 0023 CS
Sequence Name 0018 0024 SH
Angio Flag 0018 0025 CS
Intervention Drug Information Sequence 0018 0026 SQ
Intervention Drug Stop Time 0018 0027 TM
Intervention Drug Dose 0018 0028 DS
Intervention Drug Code Sequence 0018 0029 SQ
Additional Drug Sequence 0018 002A SQ
Radionuclide (RET) 0018 0030 LO
Radiopharmaceutical 0018 0031 LO
Energy Window Centerline (RET) 0018 0032 DS
Energy Window Total Width (RET) 0018 0033 DS
Intervention Drug Name 0018 0034 LO
Intervention Drug Start Time 0018 0035 TM
Interventional Therapy Sequence 0018 0036 SQ
Therapy Type 0018 0037 CS
Interventional Status 0018 0038 CS
Therapy Description 0018 0039 CS
Cine Rate 0018 0040 IS
Slice Thickness 0018 0050 DS
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KVP 0018 0060 DS
Counts Accumulated 0018 0070 IS
Acquisition Termination Condition 0018 0071 CS
Effective Series Duration 0018 0072 DS
Acquisition Start Condition 0018 0073 CS
Acquisition Start Condition Data 0018 0074 IS
Acquisition Termination Condition Data 0018 0075 IS
Repetition Time 0018 0080 DS
Echo Time 0018 0081 DS
Inversion Time 0018 0082 DS
Number of Averages 0018 0083 DS
Imaging Frequency 0018 0084 DS
Imaged Nucleus 0018 0085 SH
Echo Number(s) 0018 0086 IS
Magnetic Field Strength 0018 0087 DS
Spacing Between Slices 0018 0088 DS
Number of Phase Encoding Steps 0018 0089 IS
Data Collection Diameter 0018 0090 DS
Echo Train Length 0018 0091 IS
Percent Sampling 0018 0093 DS
Percent Phase Field of View 0018 0094 DS
Pixel Bandwidth 0018 0095 DS
Device Serial Number 0018 1000 LO
Plate ID 0018 1004 LO
Secondary Capture Device ID 0018 1010 LO
Hardcopy Creation Device ID 0018 1011 LO
Date of Secondary Capture 0018 1012 DA
Time of Secondary Capture 0018 1014 TM
Secondary Capture Device Manufacturer 0018 1016 LO
Hardcopy Device Manufacturer 0018 1017 LO
Secondary Capture Device Manufacturer's Model Name 0018 1018 LO
Secondary Capture Device Software Version(s) 0018 1019 LO
Hardcopy Device Software Version 0018 101A LO
Hardcopy Device Manfuacturer's Model Name 0018 101B LO
Software Version(s) 0018 1020 LO
Video Image Format Acquired 0018 1022 SH
Digital Image Format Acquired 0018 1023 LO
Protocol Name 0018 1030 LO
Contrast/Bolus Route 0018 1040 LO
Contrast/Bolus Volume 0018 1041 DS
Contrast/Bolus Start Time 0018 1042 TM
Contrast/Bolus Stop Time 0018 1043 TM
Contrast/Bolus Total Dose 0018 1044 DS
Syringe Counts 0018 1045 IS
Contrast Flow Rate(s) 0018 1046 DS
Contrast Flow Duration(s) 0018 1047 DS
Contrast/Bolus Ingredient 0018 1048 CS
Contrast/Bolus Ingredient Concentration 0018 1049 DS
Spatial Resolution 0018 1050 DS
Trigger Time 0018 1060 DS
Trigger Source or Type 0018 1061 LO
Nominal Interval 0018 1062 IS
Frame Time 0018 1063 DS
Framing Type 0018 1064 LO
Frame Time Vector 0018 1065 DS
Frame Delay 0018 1066 DS

Image Trigger Delay 0018 1067 DS
Multiplex Group Time Offset 0018 1068 DS
Trigger Time Offset 0018 1069 DS
Synchronization Trigger 0018 106A CS
Synchronization Channel 0018 106C US
Trigger Sample Position 0018 106E UL
Radiopharmaceutical Route 0018 1070 LO
Radiopharmaceutical Volume 0018 1071 DS
Radiopharmaceutical Start Time 0018 1072 TM
Radiopharmaceutical Stop Time 0018 1073 TM
Radionuclide Total Dose 0018 1074 DS
Radionuclide Half Life 0018 1075 DS
Radionuclide Positron Fraction 0018 1076 DS
Radiopharmaceutical Specific Activity 0018 1077 DS
Beat Rejection Flag 0018 1080 CS
Low R-R Value 0018 1081 IS
High R-R Value 0018 1082 IS
Intervals Acquired 0018 1083 IS
Intervals Rejected 0018 1084 IS
PVC Rejection 0018 1085 LO
Skip Beats 0018 1086 IS
Heart Rate 0018 1088 IS
Cardiac Number of Images 0018 1090 IS
Trigger Window 0018 1094 IS
Reconstruction Diameter 0018 1100 DS
Distance Source to Detector 0018 1110 DS
Distance Source to Patient 0018 1111 DS
Estimated Radiographic Magnification Factor 0018 1114 DS
Gantry/Detector Tilt 0018 1120 DS
Gantry/Detector Slew 0018 1121 DS
Table Height 0018 1130 DS
Table Traverse 0018 1131 DS
Table Motion 0018 1134 CS
Table Vertical Increment 0018 1135 DS
Table Lateral Increment 0018 1136 DS
Table Longitudinal Increment 0018 1137 DS
Table Angle 0018 1138 DS
Table Type 0018 113A CS
Rotation Direction 0018 1140 CS
Angular Position 0018 1141 DS
Radial Position 0018 1142 DS
Scan Arc 0018 1143 DS
Angular Step 0018 1144 DS
Center of Rotation Offset 0018 1145 DS
Rotation Offset (RET) 0018 1146 DS
Field of View Shape 0018 1147 CS
Field of View Dimension(s) 0018 1149 IS
Exposure Time 0018 1150 IS
X-ray Tube Current 0018 1151 IS
Exposure 0018 1152 IS
Exposure in uAs 0018 1153 IS
Average Pulse Width 0018 1154 DS
Radiation Setting 0018 1155 CS
Rectification Type 0018 1156 CS
Radiation Mode 0018 115A CS
Image Area Dose Product 0018 115E DS
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Filter Type 0018 1160 SH
Type of Filters 0018 1161 LO
Intensifier Size 0018 1162 DS
Imager Pixel Spacing 0018 1164 DS
Grid 0018 1166 CS
Generator Power 0018 1170 IS
Collimator/grid Name 0018 1180 SH
Collimator Type 0018 1181 CS
Focal Distance 0018 1182 IS
X Focus Center 0018 1183 DS
Y Focus Center 0018 1184 DS
Focal Spot(s) 0018 1190 DS
Anode Target Material 0018 1191 CS
Body Part Thickness 0018 11A0 DS
Compression Force 0018 11A2 DS
Date of Last Calibration 0018 1200 DA
Time of Last Calibration 0018 1201 TM
Convolution Kernel 0018 1210 SH
Actual Frame Duration 0018 1242 IS
Count Rate 0018 1243 IS
Preferred Playback Sequencing 0018 1244 US
Receiving Coil 0018 1250 SH
Transmitting Coil 0018 1251 SH
Plate Type 0018 1260 SH
Phosphor Type 0018 1261 LO
Scan Velocity 0018 1300 DS
Whole Body Technique 0018 1301 CS
Scan Length 0018 1302 IS
Acquisition Matrix 0018 1310 US
Phase Encoding Direction 0018 1312 CS
Flip Angle 0018 1314 DS
Variable Flip Angle Flag 0018 1315 CS
SAR 0018 1316 DS
dB/dt 0018 1318 DS
Acquisition Device Processing Description 0018 1400 LO
Acquisition Device Processing Code 0018 1401 LO
Cassette Orientation 0018 1402 CS
Cassette Size 0018 1403 CS
Exposures on Plate 0018 1404 US
Relative X-ray Exposure 0018 1405 IS
Column Angulation 0018 1450 CS
Tomo Layer Height 0018 1460 DS
Tomo Angle 0018 1470 DS
Tomo Time 0018 1480 DS
Tomo Type 0018 1490 CS
Tomo Class 0018 1491 CS
Number of Tomosynthesis Source Images 0018 1495 IS
Positioner Motion 0018 1500 CS
Positioner Type 0018 1508 CS
Positioner Primary Angle 0018 1510 DS
Positioner Secondary Angle 0018 1511 DS
Positioner Primary Angle Increment 0018 1520 DS
Positioner Secondary Angle Increment 0018 1521 DS
Detector Primary Angle 0018 1530 DS
Detector Secondary Angle 0018 1531 DS
Shutter Shape 0018 1600 CS

Shutter Left Vertical Edge 0018 1602 IS
Shutter Right Vertical Edge 0018 1604 IS
Shutter Upper Horizontal Edge 0018 1606 IS
Shutter Lower Horizontal Edge 0018 1608 IS
Center of Circular Shutter 0018 1610 IS
Radius of Circular Shutter 0018 1612 IS
Vertices of the Polygonal Shutter 0018 1620 IS
Shutter Presentation Value 0018 1622 US
Shutter Overlay Group 0018 1623 US
Collimator Shape 0018 1700 CS
Collimator Left Vertical Edge 0018 1702 IS
Collimator Right Vertical Edge 0018 1704 IS
Collimator Upper Horizontal Edge 0018 1706 IS
Collimator Lower Horizontal Edge 0018 1708 IS
Center of Circular Collimator 0018 1710 IS
Radius of Circular Collimator 0018 1712 IS
Vertices of the Polygonal Collimator 0018 1720 IS
Acquisition Time Synchronized 0018 1800 CS
Time Source 0018 1801 SH
Time Distribution Protocol 0018 1802 CS
Page Number Vector 0018 2001 IS
Frame Label Vector 0018 2002 SH
Frame Primary Angle Vector 0018 2003 DS
Frame Secondary Angle Vector 0018 2004 DS
Slice Location Vector 0018 2005 DS
Display Window Label Vector 0018 2006 SH
Nominal Scanned Pixel Spacing 0018 2010 DS
Digitizing Device Transport Direction 0018 2020 CS
Rotation of Scanned Film 0018 2030 DS
Output Power 0018 5000 SH
Transducer Data 0018 5010 LO
Focus Depth 0018 5012 DS
Processing Function 0018 5020 LO
Postprocessing Function 0018 5021 LO
Mechanical Index 0018 5022 DS
Thermal Index 0018 5024 DS
Cranial Thermal Index 0018 5026 DS
Soft Tissue Thermal Index 0018 5027 DS
Soft Tissue-focus Thermal Index 0018 5028 DS
Soft Tissue-surface Thermal Index 0018 5029 DS
Depth of Scan Field 0018 5050 IS
Patient Position 0018 5100 CS
View Position 0018 5101 CS
Projection Eponymous Name Code Sequence 0018 5104 SQ
Image Transformation Matrix 0018 5210 DS
Image Translation Vector 0018 5212 DS
Sensitivity 0018 6000 DS
Sequence of Ultrasound Regions 0018 6011 SQ
Region Spatial Format 0018 6012 US
Region Data Type 0018 6014 US
Region Flags 0018 6016 UL
Region Location Min X 0 0018 6018 UL
Region Location Min Y 0 0018 601A UL
Region Location Max X 1 0018 601C UL
Region Location Max Y 1 0018 601E UL
Reference Pixel X 0 0018 6020 SL
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Reference Pixel Y 0 0018 6022 SL
Physical Units X Direction 0018 6024 US
Physical Units Y Direction 0018 6026 US
Reference Pixel Physical Value X 0018 6028 FD
Reference Pixel Physical Value Y 0018 602A FD
Physical Delta X 0018 602C FD
Physical Delta Y 0018 602E FD
Transducer Frequency 0018 6030 UL
Transducer Type 0018 6031 CS
Pulse Repetition Frequency 0018 6032 UL
Doppler Correction Angle 0018 6034 FD
Steering Angle 0018 6036 FD
Doppler Sample Volume X Position 0018 6038 UL
Doppler Sample Volume Y Position 0018 603A UL
TM-Line Position X 0 0018 603C UL
TM-Line Position Y 0 0018 603E UL
TM-Line Position X 1 0018 6040 UL
TM-Line Position Y 1 0018 6042 UL
Pixel Component Organization 0018 6044 US
Pixel Component Mask 0018 6046 UL
Pixel Component Range Start 0018 6048 UL
Pixel Component Range Stop 0018 604A UL
Pixel Component Physical Units 0018 604C US
Pixel Component Data Type 0018 604E US
Number of Table Break Points 0018 6050 UL
Table of X Break Points 0018 6052 UL
Table of Y Break Points 0018 6054 FD
Number of Table Entries 0018 6056 UL
Table of Pixel Values 0018 6058 UL
Table of Parameter Values 0018 605A FL
Detector Conditions Nominal Flag 0018 7000 CS
Detector Temperature 0018 7001 DS
Detector Type 0018 7004 CS
Detector Configuration 0018 7005 CS
Detector Description 0018 7006 LT
Detector Mode 0018 7008 LT
Detector ID 0018 700A SH
Date of Last Detector Calibration 0018 700C DA
Time of Last Detector Calibration 0018 700E TM
Exposures on Detector Since Last Calibration 0018 7010 IS
Exposures on Detector Since Manufactured 0018 7011 IS
Detector Time Since Last Exposure 0018 7012 DS
Detector Active Time 0018 7014 DS
Detector Activation Offset From Exposure 0018 7016 DS
Detector Binning 0018 701A DS
Detector Element Physical Size 0018 7020 DS
Detector Element Spacing 0018 7022 DS
Detector Active Shape 0018 7024 CS
Detector Active Dimension(s) 0018 7026 DS
Detector Active Origin 0018 7028 DS
Field of View Origin 0018 7030 DS
Field of View Rotation 0018 7032 DS
Field of View Horizontal Flip 0018 7034 CS
Grid Absorbing Material 0018 7040 LT
Grid Spacing Material 0018 7041 LT
Grid Thickness 0018 7042 DS

Grid Pitch 0018 7044 DS
Grid Aspect Ratio 0018 7046 IS
Grid Period 0018 7048 DS
Grid Focal Distance 0018 704C DS
Filter Material 0018 7050 CS
Filter Thickness Minimum 0018 7052 DS
Filter Thickness Maximum 0018 7054 DS
Exposure Control Mode 0018 7060 CS
Exposure Control Mode Description 0018 7062 LT
Exposure Status 0018 7064 CS
Phototimer Setting 0018 7065 DS
Exposure Time in mS 0018 8150 DS
X-Ray Tube Current in mA 0018 8151 DS
Study Instance UID 0020 000D UI
Series Instance UID 0020 000E UI
Study ID 0020 0010 SH
Series Number 0020 0011 IS
Acquisition Number 0020 0012 IS
Instance Number 0020 0013 IS
Isotope Number (RET) 0020 0014 IS
Phase Number (RET) 0020 0015 IS
Interval Number (RET) 0020 0016 IS
Time Slot Number (RET) 0020 0017 IS
Angle Number (RET) 0020 0018 IS
Item Number 0020 0019 IS
Patient Orientation 0020 0020 CS
Overlay Number 0020 0022 IS
Curve Number 0020 0024 IS
Lookup Table Number 0020 0026 IS
Image Position (Patient) 0020 0032 DS
Image Orientation (Patient) 0020 0037 DS
Frame of Reference UID 0020 0052 UI
Laterality 0020 0060 CS
Image Laterality 0020 0062 CS
Temporal Position Identifier 0020 0100 IS
Number of Temporal Positions 0020 0105 IS
Temporal Resolution 0020 0110 DS
Synchronization Frame of Reference UID 0020 0200 UI
Series in Study 0020 1000 IS
Images in Acquisition 0020 1002 IS
Acquisitions in Study 0020 1004 IS
Position Reference Indicator 0020 1040 LO
Slice Location 0020 1041 DS
Other Study Numbers 0020 1070 IS
Number of Patient Related Studies 0020 1200 IS
Number of Patient Related Series 0020 1202 IS
Number of Patient Related Instances 0020 1204 IS
Number of Study Related Series 0020 1206 IS
Number of Study Related Instances 0020 1208 IS
Number of Series Related Instances 0020 1209 IS
Image Comments 0020 4000 LT
Samples per Pixel 0028 0002 US
Photometric Interpretation 0028 0004 CS
Planar Configuration 0028 0006 US
Number of Frames 0028 0008 IS
Frame Increment Pointer 0028 0009 AT
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Rows 0028 0010 US
Columns 0028 0011 US
Planes 0028 0012 US
Ultrasound Color Data Present 0028 0014 US
Pixel Spacing 0028 0030 DS
Zoom Factor 0028 0031 DS
Zoom Center 0028 0032 DS
Pixel Aspect Ratio 0028 0034 IS
Corrected Image 0028 0051 CS
Bits Allocated 0028 0100 US
Bits Stored 0028 0101 US
High Bit 0028 0102 US
Pixel Representation 0028 0103 US
Smallest Image Pixel Value 0028 0106 XS
Largest Image Pixel Value 0028 0107 XS
Smallest Pixel Value in Series 0028 0108 XS
Largest Pixel Value in Series 0028 0109 XS
Smallest Image Pixel Value in Plane 0028 0110 XS
Largest Image Pixel Value in Plane 0028 0111 XS
Pixel Padding Value 0028 0120 XS
Quality Control Image 0028 0300 CS
Burned In Annotation 0028 0301 CS
Pixel Intensity Relationship 0028 1040 CS
Pixel Intensity Relationship Sign 0028 1041 SS
Window Center 0028 1050 DS
Window Width 0028 1051 DS
Rescale Intercept 0028 1052 DS
Rescale Slope 0028 1053 DS
Rescale Type 0028 1054 LO
Window Center & Width Explanation 0028 1055 LO
Recommended Viewing Mode 0028 1090 CS
Red Palette Color Lookup Table Descriptor 0028 1101 XS
Green Palette Color Lookup Table Descriptor 0028 1102 XS
Blue Palette Color Lookup Table Descriptor 0028 1103 XS
Palette Color Lookup Table UID 0028 1199 UI
Red Palette Color Lookup Table Data 0028 1201 US
Green Palette Color Lookup Table Data 0028 1202 US
Blue Palette Color Lookup Table Data 0028 1203 US
Segmented Red Palette Color Lookup Table Data 0028 1221 OW
Segmented Green Palette Color Lookup Table Data 0028 1222 OW
Segmented Blue Palette Color Lookup Table Data 0028 1223 OW
Implant Present 0028 1300 CS
Partial View 0028 1350 CS
Partial View Description 0028 1351 ST
Lossy Image Compression 0028 2110 CS
Lossy Image Compression Ratio 0028 2112 DS
Modality LUT Sequence 0028 3000 SQ
LUT Descriptor 0028 3002 XS
LUT Explanation 0028 3003 LO
Modality LUT Type 0028 3004 LO
LUT Data 0028 3006 US
VOI LUT Sequence 0028 3010 SQ
Softcopy VOI LUT Sequence 0028 3110 SQ
Bi-Plane Acquisition Sequence 0028 5000 SQ
Representative Frame Number 0028 6010 US
Frame Numbers of Interest (FOI) 0028 6020 US

Frame(s) of Interest Description 0028 6022 LO
Mask Pointer(s) 0028 6030 US
R Wave Pointer 0028 6040 US
Mask Subtraction Sequence 0028 6100 SQ
Mask Operation 0028 6101 CS
Applicable Frame Range 0028 6102 US
Mask Frame Numbers 0028 6110 US
Contrast Frame Averaging 0028 6112 US
Mask Sub-pixel Shift 0028 6114 FL
TID Offset 0028 6120 SS
Mask Operation Explanation 0028 6190 ST
RadWorksMarconi 0029 0060 LO
DCM_MARCONIKEYFRAMEINDICES 0029 6024 US
Study Status ID 0032 000A CS
Study Priority ID 0032 000C CS
Study ID Issuer 0032 0012 LO
Study Verified Date 0032 0032 DA
Study Verified Time 0032 0033 TM
Study Read Date 0032 0034 DA
Study Read Time 0032 0035 TM
Scheduled Study Start Date 0032 1000 DA
Scheduled Study Start Time 0032 1001 TM
Scheduled Study Stop Date 0032 1010 DA
Scheduled Study Stop Time 0032 1011 TM
Scheduled Study Location 0032 1020 LO
Scheduled Study Location AE Title(s) 0032 1021 AE
Reason for Study 0032 1030 LO
Requesting Physician 0032 1032 PN
Requesting Service 0032 1033 LO
Study Arrival Date 0032 1040 DA
Study Arrival Time 0032 1041 TM
Study Completion Date 0032 1050 DA
Study Completion Time 0032 1051 TM
Study Component Status ID 0032 1055 CS
Requested Procedure Description 0032 1060 LO
Requested Procedure Code Sequence 0032 1064 SQ
Requested Contrast Agent 0032 1070 LO
Study Comments 0032 4000 LT
Referenced Patient Alias Sequence 0038 0004 SQ
Visit Status ID 0038 0008 CS
Admission ID 0038 0010 LO
Issuer of Admission ID 0038 0011 LO
Route of Admissions 0038 0016 LO
Scheduled Admission Date 0038 001A DA
Scheduled Admission Time 0038 001B TM
Scheduled Discharge Date 0038 001C DA
Scheduled Discharge Time 0038 001D TM
Scheduled Patient Institution Residence 0038 001E LO
Admitting Date 0038 0020 DA
Admitting Time 0038 0021 TM
Discharge Date 0038 0030 DA
Discharge Time 0038 0032 TM
Discharge Diagnosis Description 0038 0040 LO
Discharge Diagnosis Code Sequence 0038 0044 SQ
Special Needs 0038 0050 LO
Current Patient Location 0038 0300 LO
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Patient's Institution Residence 0038 0400 LO
Patient State 0038 0500 LO
Visit Comments 0038 4000 LT
Waveform Originality 003A 0004 CS
Number of Waveform Channels 003A 0005 US
Number of Waveform Samples 003A 0010 UL
Sampling Frequency 003A 001A DS
Multiplex Group Label 003A 0020 SH
Channel Definition Sequence 003A 0200 SQ
Waveform Channel Number 003A 0202 IS
Channel Label 003A 0203 SH
Channel Status 003A 0205 CS
Channel Source Sequence 003A 0208 SQ
Channel Source Modifiers Sequence 003A 0209 SQ
Source Waveform Sequence 003A 020A SQ
Channel Derivation Description 003A 020C LO
Channel Sensitivity 003A 0210 DS
Channel Sensitivity Units Sequence 003A 0211 SQ
Channel Sensitivity Correction Factor 003A 0212 DS
Channel Baseline 003A 0213 DS
Channel Time Skew 003A 0214 DS
Channel Sample Skew 003A 0215 DS
Channel Offset 003A 0218 DS
Waveform Bits Stored 003A 021A US
Filter Low Frequency 003A 0220 DS
Filter High Frequency 003A 0221 DS
Notch Filter Frequency 003A 0222 DS
Notch Filter Bandwidth 003A 0223 DS
Scheduled Station AE Title 0040 0001 AE
Scheduled Procedure Step Start Date 0040 0002 DA
Scheduled Procedure Step Start Time 0040 0003 TM
Scheduled Procedure Step End Date 0040 0004 DA
Scheduled Procedure Step End Time 0040 0005 TM
Scheduled Performing Physician's Name 0040 0006 PN
Scheduled Procedure Step Description 0040 0007 LO
Scheduled Action Item Code Sequence 0040 0008 SQ
Scheduled Procedure Step ID 0040 0009 SH
Scheduled Station Name 0040 0010 SH
Scheduled Procedure Step Location 0040 0011 SH
Pre-Medication 0040 0012 LO
Scheduled Procedure Step Status 0040 0020 CS
Scheduled Procedure Step Sequence 0040 0100 SQ
Referenced Standalone SOP Instance Sequence 0040 0220 SQ
Performed Station AE Title 0040 0241 AE
Performed Station Name 0040 0242 SH
Performed Location 0040 0243 SH
Performed Procedure Step Start Date 0040 0244 DA
Performed Procedure Step Start Time 0040 0245 TM
Performed Procedure Step End Date 0040 0250 DA
Performed Procedure Step End Time 0040 0251 TM
Performed Procedure Step Status 0040 0252 CS
Performed Procedure Step ID 0040 0253 SH
Performed Procedure Step Description 0040 0254 LO
Performed Procedure Type Description 0040 0255 LO
Performed Action Item Sequence 0040 0260 SQ
Scheduled Step Attributes Sequence 0040 0270 SQ

Request Attributes Sequence 0040 0275 SQ
Comments on the Performed Procedure Steps 0040 0280 ST
Quantity Sequence 0040 0293 SQ
Quantity 0040 0294 DS
Measuring Units Sequence 0040 0295 SQ
Billing Item Sequence 0040 0296 SQ
Total Time of Fluoroscopy 0040 0300 US
Total Number of Exposures 0040 0301 US
Entrance Dose 0040 0302 US
Exposed Area 0040 0303 US
Distance Source to Entrance 0040 0306 DS
Distance Source to Support 0040 0307 DS
Comments on Radiation Dose 0040 0310 ST
X-Ray Output 0040 0312 DS
Half Value Layer 0040 0314 DS
Organ Dose 0040 0316 DS
Organ Exposed 0040 0318 CS
Billing Procedure Step Sequence 0040 0320 SQ
Film Consumption Sequence 0040 0321 SQ
Billing Supplies and Devices Sequence 0040 0324 SQ
Referenced Procedure Step Sequence 0040 0330 SQ
Performed Series Sequence 0040 0340 SQ
Comments on the Scheduled Procedure Step 0040 0400 LT
Specimen Accession Number 0040 050A LO
Specimen Sequence 0040 0550 SQ
Specimen Identifier 0040 0551 LO
Acquisition Context Sequence 0040 0555 SQ
Acquisition Context Description 0040 0556 ST
Specimen Type Code Sequence 0040 059A SQ
Slide Identifier 0040 06FA LO
Image Center Point Coordinates Sequence 0040 071A SQ
X offset in Slide Coordinate System 0040 072A DS
Y offset in Slide Coordinate System 0040 073A DS
Z offset in Slide Coordinate System 0040 074A DS
Pixel Spacing Sequence 0040 08D8 SQ
Coordinate System Axis Code Sequence 0040 08DA SQ
Measurement Units Code Sequence 0040 08EA SQ
Requested Procedure ID 0040 1001 SH
Reason for the Requested Procedure 0040 1002 LO
Requested Procedure Priority 0040 1003 SH
Patient Transport Arrangements 0040 1004 LO
Requested Procedure Location 0040 1005 LO
Placer Order Number / Procedure (RET) 0040 1006 SH
Filler Order Number / Procedure (RET) 0040 1007 SH
Confidentiality Code 0040 1008 LO
Reporting Priority 0040 1009 SH
Names of Intended Recipients of Results 0040 1010 PN
Requested Procedure Comments 0040 1400 LT
Reason for the Imaging Service Request 0040 2001 LO
Issue Date of Imaging Service Request 0040 2004 DA
Issue Time of Imaging Service Request 0040 2005 TM
Placer Order Number / Imaging Service Request (RET) 0040 2006 SH
Filler Order Number / Imaging Service Request (RET) 0040 2007 SH
Order Entered By 0040 2008 PN
Order Enterer's Location 0040 2009 SH
Order Callback Phone Number 0040 2010 SH
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Placer Order Number / Imaging Service Request 0040 2016 LO
Filler Order Number / Imaging Service Request 0040 2017 LO
Imaging Service Request Comments 0040 2400 LT
Confidentiality Constraint on Patient Data Description 0040 3001 LO
Entrance Dose in mGy 0040 8302 DS
Relationship Type 0040 A010 CS
Verifying Organization 0040 A027 LO
Verification DateTime 0040 A030 DT
Observation DateTime 0040 A032 DT
Value Type 0040 A040 CS
Concept-name Code Sequence 0040 A043 SQ
Continuity Of Content 0040 A050 CS
Verifying Observer Sequence 0040 A073 SQ
Verifying Observer Name 0040 A075 PN
Verifying Observer Identification Code Sequence 0040 A088 SQ
Referenced Waveform Channels 0040 A0B0 US
DateTime 0040 A120 DT
Date 0040 A121 DA
Time 0040 A122 TM
Person Name 0040 A123 PN
UID 0040 A124 UI
Temporal Range Type 0040 A130 CS
Referenced Sample Positions 0040 A132 UL
Referenced Frame Numbers 0040 A136 US
Referenced Time Offsets 0040 A138 DS
Referenced Datetime 0040 A13A DT
Text Value 0040 A160 UT
Concept Code Sequence 0040 A168 SQ
Annotation Group Number 0040 A180 US
Modifier Code Sequence 0040 A195 SQ
Measured Value Sequence 0040 A300 SQ
Numeric Value 0040 A30A DS
Predecessor Documents Sequence 0040 A360 SQ
Referenced Request Sequence 0040 A370 SQ
Performed Procedure Code Sequence 0040 A372 SQ
Current Requested Procedure Evidence Sequence 0040 A375 SQ
Pertinent Other Evidence Sequence 0040 A385 SQ
Completion Flag 0040 A491 CS
Completion Flag Description 0040 A492 LO
Verification Flag 0040 A493 CS
Content Template Sequence 0040 A504 SQ
Identical Documents Sequence 0040 A525 SQ
Content Sequence 0040 A730 SQ
Annotation Sequence 0040 B020 SQ
Template Identifier 0040 DB00 CS
Template Version 0040 DB06 DT
Template Local Version 0040 DB07 DT
Template Extension Flag 0040 DB0B CS
Template Extension Organization UID 0040 DB0C UI
Template Extension Creator UID 0040 DB0D UI
Referenced Content Item Identifier 0040 DB73 UL
BlockID = "GE LUT Asymmetry Parameter "0045 0010 LO
LUT Assymetry 0045 1067 DS
Calibration Image 0050 0004 CS
Device Sequence 0050 0010 SQ
Device Length 0050 0014 DS

Device Diameter 0050 0016 DS
Device Diameter Units 0050 0017 CS
Device Volume 0050 0018 DS
Inter-marker Distance 0050 0019 DS
Device Description 0050 0020 LO
Energy Window Vector 0054 0010 US
Number of Energy Windows 0054 0011 US
Energy Window Information Sequence 0054 0012 SQ
Energy Window Range Sequence 0054 0013 SQ
Energy Window Lower Limit 0054 0014 DS
Energy Window Upper Limit 0054 0015 DS
Radiopharmaceutical Information Sequence 0054 0016 SQ
Residual Syringe Counts 0054 0017 IS
Energy Window Name 0054 0018 SH
Detector Vector 0054 0020 US
Number of Detectors 0054 0021 US
Detector Information Sequence 0054 0022 SQ
Phase Vector 0054 0030 US
Number of Phases 0054 0031 US
Phase Information Sequence 0054 0032 SQ
Number of Frames in Phase 0054 0033 US
Phase Delay 0054 0036 IS
Pause Between Frames 0054 0038 IS
Rotation Vector 0054 0050 US
Number of Rotations 0054 0051 US
Rotation Information Sequence 0054 0052 SQ
Number of Frames in Rotation 0054 0053 US
R-R Interval Vector 0054 0060 US
Number of R-R Intervals 0054 0061 US
Gated Information Sequence 0054 0062 SQ
Data Information Sequence 0054 0063 SQ
Time Slot Vector 0054 0070 US
Number of Time Slots 0054 0071 US
Time Slot Information Sequence 0054 0072 SQ
Time Slot Time 0054 0073 DS
Slice Vector 0054 0080 US
Number of Slices 0054 0081 US
Angular View Vector 0054 0090 US
Time Slice Vector 0054 0100 US
Number of Time Slices 0054 0101 US
Start Angle 0054 0200 DS
Type of Detector Motion 0054 0202 CS
Trigger Vector 0054 0210 IS
Number of Triggers in Phase 0054 0211 US
View Code Sequence 0054 0220 SQ
View Modifier Code Sequence 0054 0222 SQ
Radionuclide Code Sequence 0054 0300 SQ
Administration Route Code Sequence 0054 0302 SQ
Radiopharmaceutical Code Sequence 0054 0304 SQ
Calibration Data Sequence 0054 0306 SQ
Energy Window Number 0054 0308 US
Image ID 0054 0400 SH
Patient Orientation Code Sequence 0054 0410 SQ
Patient Orientation Modifier Code Sequence 0054 0412 SQ
Patient Gantry Relationship Code Sequence 0054 0414 SQ
Series Type 0054 1000 CS
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Units 0054 1001 CS
Counts Source 0054 1002 CS
Reprojection Method 0054 1004 CS
Randoms Correction Method 0054 1100 CS
Attenuation Correction Method 0054 1101 LO
Decay Correction 0054 1102 CS
Reconstruction Method 0054 1103 LO
Detector Lines of Response Used 0054 1104 LO
Scatter Correction Method 0054 1105 LO
Axial Acceptance 0054 1200 DS
Axial Mash 0054 1201 IS
Transverse Mash 0054 1202 IS
Detector Element Size 0054 1203 DS
Coincidence Window Width 0054 1210 DS
Secondary Counts Type 0054 1220 CS
Frame Reference Time 0054 1300 DS
Primary (Prompts) Counts Accumulated 0054 1310 IS
Secondary Counts Accumulated 0054 1311 IS
Slice Sensitivity Factor 0054 1320 DS
Decay Factor 0054 1321 DS
Dose Calibration Factor 0054 1322 DS
Scatter Fraction Factor 0054 1323 DS
Dead Time Factor 0054 1324 DS
Image Index 0054 1330 US
Counts Included 0054 1400 CS
Dead Time Correction Flag 0054 1401 CS
Histogram Sequence 0060 3000 SQ
Histogram Number of Bins 0060 3002 US
Histogram First Bin Value 0060 3004 XS
Histogram Last Bin Value 0060 3006 XS
Histogram Bin Width 0060 3008 US
Histogram Explanation 0060 3010 LO
Histogram Data 0060 3020 UL
Graphic Annotation Sequence 0070 0001 SQ
Graphic Layer 0070 0002 CS
Bounding Box Annotation Units 0070 0003 CS
Anchor Point Annotation Units 0070 0004 CS
Graphic Annotation Units 0070 0005 CS
Unformatted Text Value 0070 0006 ST
Text Object Sequence 0070 0008 SQ
Graphic Object Sequence 0070 0009 SQ
Bounding Box Top Left Hand Corner 0070 0010 FL
Bounding Box Bottom Right Hand Corner 0070 0011 FL
Bounding Box Text Horizontal Justification 0070 0012 CS
Anchor Point 0070 0014 FL
Anchor Point Visibility 0070 0015 CS
Graphic Dimensions 0070 0020 US
Number of Graphic Points 0070 0021 US
Graphic Data 0070 0022 FL
Graphic Type 0070 0023 CS
Graphic Filled 0070 0024 CS
Image Horizontal Flip 0070 0041 CS
Image Rotation 0070 0042 US
Displayed Area Top Left Hand Corner 0070 0052 SL
Displayed Area Bottom Right Hand Corner 0070 0053 SL
Displayed Area Selection Sequence 0070 005A SQ

Graphic Layer Sequence 0070 0060 SQ
Graphic Layer Order 0070 0062 IS
Graphic Layer Recommended Display Grayscale Value 0070 0066 US
Graphic Layer Recommended Display RGB Value 0070 0067 US
Graphic Layer Description 0070 0068 LO
Presentation Label 0070 0080 CS
Presentation Description 0070 0081 LO
Presentation Creation Date 0070 0082 DA
Presentation Creation Time 0070 0083 TM
Presentation Creator's Name 0070 0084 PN
Presentation Size Mode 0070 0100 CS
Presentation Pixel Spacing 0070 0101 DS
Presentation Pixel Aspect Ratio 0070 0102 IS
Presentation Pixel Magnification Ratio 0070 0103 FL
Storage Media File-set ID 0088 0130 SH
Storage Media File-set UID 0088 0140 UI
Icon Image Sequence 0088 0200 SQ
Topic Title 0088 0904 LO
Topic Subject 0088 0906 ST
Topic Author 0088 0910 LO
Topic Key Words 0088 0912 LO
SOP Instance Status 0100 0410 CS
SOP Authorization Date and Time 0100 0420 DT
SOP Authorization Comment 0100 0424 LT
Authorization Equipment Certification Number 0100 0426 LO
Number of Copies 2000 0010 IS
Printer Configuration Sequence 2000 001E SQ
Print Priority 2000 0020 CS
Medium Type 2000 0030 CS
Film Destination 2000 0040 CS
Film Session Label 2000 0050 LO
Memory Allocation 2000 0060 IS
Maximum Memory Allocation 2000 0061 IS
Color Image Printing Flag 2000 0062 CS
Collation Flag 2000 0063 CS
Annotation Flag 2000 0065 CS
Image Overlay Flag 2000 0067 CS
Presentation LUT Flag 2000 0069 CS
Image Box Presentation LUT Flag 2000 006A CS
Memory Bit Depth 2000 00A0 US
Printing Bit Depth 2000 00A1 US
Media Installed Sequence 2000 00A2 SQ
Other Media Available Sequence 2000 00A4 SQ
Supported Image Display Formats Sequence 2000 00A8 SQ
Referenced Film Box Sequence 2000 0500 SQ
Referenced Stored Print Sequence 2000 0510 SQ
Image Display Format 2010 0010 ST
Annotation Display Format ID 2010 0030 CS
Film Orientation 2010 0040 CS
Film Size ID 2010 0050 CS
Printer Resolution ID 2010 0052 CS
Default Printer Resolution ID 2010 0054 CS
Magnification Type 2010 0060 CS
Smoothing Type 2010 0080 CS
Default Magnification Type 2010 00A6 CS
Other Magnification Types Available 2010 00A7 CS
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Default Smoothing Type 2010 00A8 CS
Other Smoothing Types Available 2010 00A9 CS
Border Density 2010 0100 CS
Empty Image Density 2010 0110 CS
Min Density 2010 0120 US
Max Density 2010 0130 US
Trim 2010 0140 CS
Configuration Information 2010 0150 ST
Configuration Information Description 2010 0152 LT
Maximum Collated Films 2010 0154 IS
Illumination 2010 015E US
Reflected Ambient Light 2010 0160 US
Printer Pixel Spacing 2010 0376 DS
Referenced Film Session Sequence 2010 0500 SQ
Referenced Image Box Sequence 2010 0510 SQ
Referenced Basic Annotation Box Sequence 2010 0520 SQ
Image Position 2020 0010 US
Polarity 2020 0020 CS
Requested Image Size 2020 0030 DS
Requested Decimate/Crop Behavior 2020 0040 CS
Requested Resolution ID 2020 0050 CS
Requested Image Size Flag 2020 00A0 CS
Decimate/Crop Result 2020 00A2 CS
Basic Grayscale Image Sequence 2020 0110 SQ
Basic Color Image Sequence 2020 0111 SQ
Referenced Image Overlay Box Sequence (RET) 2020 0130 SQ
Referenced VOI LUT Box Sequence (RET) 2020 0140 SQ
Annotation Position 2030 0010 US
Text String 2030 0020 LO
Referenced Overlay Plane Sequence 2040 0010 SQ
Referenced Overlay Plane Groups 2040 0011 US
Overlay Pixel Data Sequence 2040 0020 SQ
Overlay Magnification Type 2040 0060 CS
Overlay Smoothing Type 2040 0070 CS
Overlay or Image Magnification 2040 0072 CS
Magnify to Number of Columns 2040 0074 US
Overlay Foreground Density 2040 0080 CS
Overlay Background Density 2040 0082 CS
Overlay Mode (RET) 2040 0090 CS
Threshold Density (RET) 2040 0100 CS
Referenced Image Box Sequence (RET) 2040 0500 SQ
Presentation LUT Sequence 2050 0010 SQ
Presentation LUT Shape 2050 0020 CS
Referenced Presentation LUT Sequence 2050 0500 SQ
Print Job ID 2100 0010 SH
Execution Status 2100 0020 CS
Execution Status Info 2100 0030 CS
Creation Date 2100 0040 DA
Creation Time 2100 0050 TM
Originator 2100 0070 AE
Destination AE 2100 0140 AE
Owner ID 2100 0160 SH
Number of Films 2100 0170 IS
Referenced Print Job Sequence 2100 0500 SQ
Printer Status 2110 0010 CS
Printer Status Info 2110 0020 CS

Printer Name 2110 0030 LO
Print Queue ID 2110 0099 SH
Queue Status 2120 0010 CS
Print Job Description Sequence 2120 0050 SQ
Referenced Print Job Sequence 2120 0070 SQ
Print Management Capabilities Sequence 2130 0010 SQ
Printer Characteristics Sequence 2130 0015 SQ
Film Box Content Sequence 2130 0030 SQ
Image Box Content Sequence 2130 0040 SQ
Annotation Content Sequence 2130 0050 SQ
Image Overlay Box Content Sequence 2130 0060 SQ
Presentation LUT Content Sequence 2130 0080 SQ
Proposed Study Sequence 2130 00A0 SQ
Original Image Sequence 2130 00C0 SQ
RT Image Label 3002 0002 SH
RT Image Name 3002 0003 LO
RT Image Description 3002 0004 ST
Reported Values Origin 3002 000A CS
RT Image Plane 3002 000C CS
X-Ray Image Receptor Translation 3002 000D DS
X-Ray Image Receptor Angle 3002 000E DS
RT Image Orientation 3002 0010 DS
Image Plane Pixel Spacing 3002 0011 DS
RT Image Position 3002 0012 DS
Radiation Machine Name 3002 0020 SH
Radiation Machine SAD 3002 0022 DS
Radiation Machine SSD 3002 0024 DS
RT Image SID 3002 0026 DS
Source to Reference Object Distance 3002 0028 DS
Fraction Number 3002 0029 IS
Exposure Sequence 3002 0030 SQ
Meterset Exposure 3002 0032 DS
DVH Type 3004 0001 CS
Dose Units 3004 0002 CS
Dose Type 3004 0004 CS
Dose Comment 3004 0006 LO
Normalization Point 3004 0008 DS
Dose Summation Type 3004 000A CS
Grid Frame Offset Vector 3004 000C DS
Dose Grid Scaling 3004 000E DS
RT Dose ROI Sequence 3004 0010 SQ
Dose Value 3004 0012 DS
DVH Normalization Point 3004 0040 DS
DVH Normalization Dose Value 3004 0042 DS
DVH Sequence 3004 0050 SQ
DVH Dose Scaling 3004 0052 DS
DVH Volume Units 3004 0054 CS
DVH Number of Bins 3004 0056 IS
DVH Data 3004 0058 DS
DVH Referenced ROI Sequence 3004 0060 SQ
DVH ROI Contribution Type 3004 0062 CS
DVH Minimum Dose 3004 0070 DS
DVH Maximum Dose 3004 0072 DS
DVH Mean Dose 3004 0074 DS
Structure Set Label 3006 0002 SH
Structure Set Name 3006 0004 LO
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Structure Set Description 3006 0006 ST
Structure Set Date 3006 0008 DA
Structure Set Time 3006 0009 TM
Referenced Frame of Reference Sequence 3006 0010 SQ
RT Referenced Study Sequence 3006 0012 SQ
RT Referenced Series Sequence 3006 0014 SQ
Contour Image Sequence 3006 0016 SQ
Structure Set ROI Sequence 3006 0020 SQ
ROI Number 3006 0022 IS
Referenced Frame of Reference UID 3006 0024 UI
ROI Name 3006 0026 LO
ROI Description 3006 0028 ST
ROI Display Color 3006 002A IS
ROI Volume 3006 002C DS
RT Related ROI Sequence 3006 0030 SQ
RT ROI Relationship 3006 0033 CS
ROI Generation Algorithm 3006 0036 CS
ROI Generation Description 3006 0038 LO
ROI Contour Sequence 3006 0039 SQ
Contour Sequence 3006 0040 SQ
Contour Geometric Type 3006 0042 CS
Contour Slab Thickness 3006 0044 DS
Contour Offset Vector 3006 0045 DS
Number of Contour Points 3006 0046 IS
Contour Number 3006 0048 IS
Attached Contours 3006 0049 IS
Contour Data 3006 0050 DS
RT ROI Observations Sequence 3006 0080 SQ
Observation Number 3006 0082 IS
Referenced ROI Number 3006 0084 IS
ROI Observation Label 3006 0085 SH
RT ROI Identification Code Sequence 3006 0086 SQ
ROI Observation Description 3006 0088 ST
Related RT ROI Observations Sequence 3006 00A0 SQ
RT ROI Interpreted Type 3006 00A4 CS
ROI Interpreter 3006 00A6 PN
ROI Physical Properties Sequence 3006 00B0 SQ
ROI Physical Property 3006 00B2 CS
ROI Physical Property Value 3006 00B4 DS
Frame of Reference Relationship Sequence 3006 00C0 SQ
Related Frame of Reference UID 3006 00C2 UI
Frame of Reference Transformation Type 3006 00C4 CS
Frame of Reference Transformation Matrix 3006 00C6 DS
Frame of Reference Transformation Comment 3006 00C8 LO
Measured Dose Reference Sequence 3008 0010 SQ
Measured Dose Description 3008 0012 ST
Measured Dose Type 3008 0014 CS
Measured Dose Value 3008 0016 DS
Treatment Session Beam Sequence 3008 0020 SQ
Current Fraction Number 3008 0022 IS
Treatment Control Point Date 3008 0024 DA
Treatment Control Point Time 3008 0025 TM
Treatment Termination Status 3008 002A CS
Treatment Termination Code 3008 002B SH
Treatment Verification Status 3008 002C CS
Referenced Treatment Record Sequence 3008 0030 SQ

Specified Primary Meterset 3008 0032 DS
Specified Secondary Meterset 3008 0033 DS
Delivered Primary Meterset 3008 0036 DS
Delivered Secondary Meterset 3008 0037 DS
Specified Treatment Time 3008 003A DS
Delivered Treatment Time 3008 003B DS
Control Point Delivery Sequence 3008 0040 SQ
Specified Meterset 3008 0042 DS
Delivered Meterset 3008 0044 DS
Dose Rate Delivered 3008 0048 DS
Treatment Summary Calculated Dose Reference seq. 3008 0050 SQ
Cumulative Dose to Dose Reference 3008 0052 DS
First Treatment Date 3008 0054 DA
Most Recent Treatment Date 3008 0056 DA
Number of Fractions Delivered 3008 005A IS
Override Sequence 3008 0060 SQ
Override Parameter Pointer 3008 0062 AT
Measured Dose Reference Number 3008 0064 IS
Override Reason 3008 0066 ST
Calculated Dose Reference Sequence 3008 0070 SQ
Calculated Dose Reference Number 3008 0072 IS
Calculated Dose Reference Description 3008 0074 ST
Calculated Dose Reference Dose Value 3008 0076 DS
Start Meterset 3008 0078 DS
End Meterset 3008 007A DS
Referenced Measured Dose Reference Sequence 3008 0080 SQ
Referenced Measured Dose Reference Number 3008 0082 IS
Referenced Calculated Dose Reference Sequence 3008 0090 SQ
Referenced Calculated Dose Reference Number 3008 0092 IS
Beam Limiting Device Leaf Pairs Sequence 3008 00A0 SQ
Recorded Wedge Sequence 3008 00B0 SQ
Recorded Compensator Sequence 3008 00C0 SQ
Recorded Block Sequence 3008 00D0 SQ
Treatment Summary Measured Dose Reference Sequence3008 00E0 SQ
Recorded Source Sequence 3008 0100 SQ
Source Serial Number 3008 0105 LO
Treatment Session Application Setup Sequence 3008 0110 SQ
Application Setup Check 3008 0116 CS
Recorded Brachy Accessory Device Sequence 3008 0120 SQ
Referenced Brachy Accessory Device Number 3008 0122 IS
Recorded Channel Sequence 3008 0130 SQ
Specified Channel Total Time 3008 0132 DS
Delivered Channel Total Time 3008 0134 DS
Specified Number of Pulses 3008 0136 IS
Delivered Number of Pulses 3008 0138 IS
Specified Pulse Repetition Interval 3008 013A DS
Delivered Pulse Repetition Interval 3008 013C DS
Recorded Source Applicator Sequence 3008 0140 SQ
Referenced Source Applicator Number 3008 0142 IS
Recorded Channel Shield Sequence 3008 0150 SQ
Referenced Channel Shield Number 3008 0152 IS
Brachy Control Point Delivered Sequence 3008 0160 SQ
Safe Position Exit Date 3008 0162 DA
Safe Position Exit Time 3008 0164 TM
Safe Position Return Date 3008 0166 DA
Safe Position Return Time 3008 0168 TM
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Current Treatment Status 3008 0200 CS
Treatment Status Comment 3008 0202 ST
Fraction Group Summary Sequence 3008 0220 SQ
Referenced Fraction Number 3008 0223 IS
Fraction Group Type 3008 0224 CS
Beam Stopper Position 3008 0230 CS
Fraction Status Summary Sequence 3008 0240 SQ
Treatment Date 3008 0250 DA
Treatment Time 3008 0251 TM
RT Plan Label 300A 0002 SH
RT Plan Name 300A 0003 LO
RT Plan Description 300A 0004 ST
RT Plan Date 300A 0006 DA
RT Plan Time 300A 0007 TM
Treatment Protocols 300A 0009 LO
Treatment Intent 300A 000A CS
Treatment Sites 300A 000B LO
RT Plan Geometry 300A 000C CS
Prescription Description 300A 000E ST
Dose Reference Sequence 300A 0010 SQ
Dose Reference Number 300A 0012 IS
Dose Reference Structure Type 300A 0014 CS
Nominal Beam Energy Unit 300A 0015 CS
Dose Reference Description 300A 0016 LO
Dose Reference Point Coordinates 300A 0018 DS
Nominal Prior Dose 300A 001A DS
Dose Reference Type 300A 0020 CS
Constraint Weight 300A 0021 DS
Delivery Warning Dose 300A 0022 DS
Delivery Maximum Dose 300A 0023 DS
Target Minimum Dose 300A 0025 DS
Target Prescription Dose 300A 0026 DS
Target Maximum Dose 300A 0027 DS
Target Underdose Volume Fraction 300A 0028 DS
Organ at Risk Full-volume Dose 300A 002A DS
Organ at Risk Limit Dose 300A 002B DS
Organ at Risk Maximum Dose 300A 002C DS
Organ at Risk Overdose Volume Fraction 300A 002D DS
Tolerance Table Sequence 300A 0040 SQ
Tolerance Table Number 300A 0042 IS
Tolerance Table Label 300A 0043 SH
Gantry Angle Tolerance 300A 0044 DS
Beam Limiting Device Angle Tolerance 300A 0046 DS
Beam Limiting Device Tolerance Sequence 300A 0048 SQ
Beam Limiting Device Position Tolerance 300A 004A DS
Patient Support Angle Tolerance 300A 004C DS
Table Top Eccentric Angle Tolerance 300A 004E DS
Table Top Vertical Position Tolerance 300A 0051 DS
Table Top Longitudinal Position Tolerance 300A 0052 DS
Table Top Lateral Position Tolerance 300A 0053 DS
RT Plan Relationship 300A 0055 CS
Fraction Group Sequence 300A 0070 SQ
Fraction Group Number 300A 0071 IS
Number of Fractions Planned 300A 0078 IS
Number of Fractions Per Day 300A 0079 IS
Repeat Fraction Cycle Length 300A 007A IS

Fraction Pattern 300A 007B LT
Number of Beams 300A 0080 IS
Beam Dose Specification Point 300A 0082 DS
Beam Dose 300A 0084 DS
Beam Meterset 300A 0086 DS
Number of Brachy Application Setups 300A 00A0 IS
Brachy Application Setup Dose Specification Point 300A 00A2 DS
Brachy Application Setup Dose 300A 00A4 DS
Beam Sequence 300A 00B0 SQ
Treatment Machine Name 300A 00B2 SH
Primary Dosimeter Unit 300A 00B3 CS
Source-Axis Distance 300A 00B4 DS
Beam Limiting Device Sequence 300A 00B6 SQ
RT Beam Limiting Device Type 300A 00B8 CS
Source to Beam Limiting Device Distance 300A 00BA DS
Number of Leaf/Jaw Pairs 300A 00BC IS
Leaf Position Boundaries 300A 00BE DS
Beam Number 300A 00C0 IS
Beam Name 300A 00C2 LO
Beam Description 300A 00C3 ST
Beam Type 300A 00C4 CS
Radiation Type 300A 00C6 CS
Reference Image Number 300A 00C8 IS
Planned Verification Image Sequence 300A 00CA SQ
Imaging Device-Specific Acquisition Parameters 300A 00CC LO
Treatment Delivery Type 300A 00CE CS
Number of Wedges 300A 00D0 IS
Wedge Sequence 300A 00D1 SQ
Wedge Number 300A 00D2 IS
Wedge Type 300A 00D3 CS
Wedge ID 300A 00D4 SH
Wedge Angle 300A 00D5 IS
Wedge Factor 300A 00D6 DS
Wedge Orientation 300A 00D8 DS
Source to Wedge Tray Distance 300A 00DA DS
Number of Compensators 300A 00E0 IS
Material ID 300A 00E1 SH
Total Compensator Tray Factor 300A 00E2 DS
Compensator Sequence 300A 00E3 SQ
Compensator Number 300A 00E4 IS
Compensator ID 300A 00E5 SH
Source to Compensator Tray Distance 300A 00E6 DS
Compensator Rows 300A 00E7 IS
Compensator Columns 300A 00E8 IS
Compensator Pixel Spacing 300A 00E9 DS
Compensator Position 300A 00EA DS
Compensator Transmission Data 300A 00EB DS
Compensator Thickness Data 300A 00EC DS
Number of Boli 300A 00ED IS
Compensator Type 300A 00EE CS
Number of Blocks 300A 00F0 IS
Total Block Tray Factor 300A 00F2 DS
Block Sequence 300A 00F4 SQ
Block Tray ID 300A 00F5 SH
Source to Block Tray Distance 300A 00F6 DS
Block Type 300A 00F8 CS
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Block Divergence 300A 00FA CS
Block Number 300A 00FC IS
Block Name 300A 00FE LO
Block Thickness 300A 0100 DS
Block Transmission 300A 0102 DS
Block Number of Points 300A 0104 IS
Block Data 300A 0106 DS
Applicator Sequence 300A 0107 SQ
Applicator ID 300A 0108 SH
Applicator Type 300A 0109 CS
Applicator Description 300A 010A LO
Cumulative Dose Reference Coefficient 300A 010C DS
Final Cumulative Meterset Weight 300A 010E DS
Number of Control Points 300A 0110 IS
Control Point Sequence 300A 0111 SQ
Control Point Index 300A 0112 IS
Nominal Beam Energy 300A 0114 DS
Dose Rate Set 300A 0115 DS
Wedge Position Sequence 300A 0116 SQ
Wedge Position 300A 0118 CS
Beam Limiting Device Position Sequence 300A 011A SQ
Leaf/Jaw Positions 300A 011C DS
Gantry Angle 300A 011E DS
Gantry Rotation Direction 300A 011F CS
Beam Limiting Device Angle 300A 0120 DS
Beam Limiting Device Rotation Direction 300A 0121 CS
Patient Support Angle 300A 0122 DS
Patient Support Rotation Direction 300A 0123 CS
Table Top Eccentric Axis Distance 300A 0124 DS
Table Top Eccentric Angle 300A 0125 DS
Table Top Eccentric Rotation Direction 300A 0126 CS
Table Top Vertical Position 300A 0128 DS
Table Top Longitudinal Position 300A 0129 DS
Table Top Lateral Position 300A 012A DS
Isocenter Position 300A 012C DS
Surface Entry Point 300A 012E DS
Source to Surface Distance 300A 0130 DS
Cumulative Meterset Weight 300A 0134 DS
Patient Setup Sequence 300A 0180 SQ
Patient Setup Number 300A 0182 IS
Patient Additional Position 300A 0184 LO
Fixation Device Sequence 300A 0190 SQ
Fixation Device Type 300A 0192 CS
Fixation Device Label 300A 0194 SH
Fixation Devi ce Description 300A 0196 ST
Fixation Device Position 300A 0198 SH
Shielding Device Sequence 300A 01A0 SQ
Shielding Device Type 300A 01A2 CS
Shielding Device Label 300A 01A4 SH
Shielding Device Description 300A 01A6 ST
Shielding Device Position 300A 01A8 SH
Setup Technique 300A 01B0 CS
Setup Technique Description 300A 01B2 ST
Setup Device Sequence 300A 01B4 SQ
Setup Device Type 300A 01B6 CS
Setup Device Label 300A 01B8 SH

Setup Device Description 300A 01BA ST
Setup Device Parameter 300A 01BC DS
Setup Reference Description 300A 01D0 ST
Table Top Vertical Setup Displacement 300A 01D2 DS
Table Top Longitudinal Setup Displacement 300A 01D4 DS
Table Top Lateral Setup Displacement 300A 01D6 DS
Brachy Treatment Technique 300A 0200 CS
Brachy Treatment Type 300A 0202 CS
Treatment Machine Sequence 300A 0206 SQ
Source Sequence 300A 0210 SQ
Source Number 300A 0212 IS
Source Type 300A 0214 CS
Source Manufacturer 300A 0216 LO
Active Source Diameter 300A 0218 DS
Active Source Length 300A 021A DS
Source Encapsulation Nominal Thickness 300A 0222 DS
Source Encapsulation Nominal Transmission 300A 0224 DS
Source Isotope Name 300A 0226 LO
Source Isotope Half Life 300A 0228 DS
Reference Air Kerma Rate 300A 022A DS
Air Kerma Rate Reference Date 300A 022C DA
Air Kerma Rate Reference Time 300A 022E TM
Application Setup Sequence 300A 0230 SQ
Application Setup Type 300A 0232 CS
Application Setup Number 300A 0234 IS
Application Setup Name 300A 0236 LO
Application Setup Manufacturer 300A 0238 LO
Template Number 300A 0240 IS
Template Type 300A 0242 SH
Template Name 300A 0244 LO
Total Reference Air Kerma 300A 0250 DS
Brachy Accessory Device Sequence 300A 0260 SQ
Brachy Accessory Device Number 300A 0262 IS
Brachy Accessory Device ID 300A 0263 SH
Brachy Accessory Device Type 300A 0264 CS
Brachy Accessory Device Name 300A 0266 LO
Brachy Accessory Device Nominal Thickness 300A 026A DS
Brachy Accessory Device Nominal Transmission 300A 026C DS
Channel Sequence 300A 0280 SQ
Channel Number 300A 0282 IS
Channel Length 300A 0284 DS
Channel Total Time 300A 0286 DS
Source Movement Type 300A 0288 CS
Number of Pulses 300A 028A IS
Pulse Repetition Interval 300A 028C DS
Source Applicator Number 300A 0290 IS
Source Applicator ID 300A 0291 SH
Source Applicator Type 300A 0292 CS
Source Applicator Name 300A 0294 LO
Source Applicator Length 300A 0296 DS
Source Applicator Manufacturer 300A 0298 LO
Source Applicator Wall Nominal Thickness 300A 029C DS
Source Applicator Wall Nominal Transmission 300A 029E DS
Source Applicator Step Size 300A 02A0 DS
Transfer Tube Number 300A 02A2 IS
Transfer Tube Length 300A 02A4 DS
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Channel Shield Sequence 300A 02B0 SQ
Channel Shield Number 300A 02B2 IS
Channel Shield ID 300A 02B3 SH
Channel Shield Name 300A 02B4 LO
Channel Shield Nominal Thickness 300A 02B8 DS
Channel Shield Nominal Transmission 300A 02BA DS
Final Cumulative Time Weight 300A 02C8 DS
Brachy Control Point Sequence 300A 02D0 SQ
Control Point Relative Position 300A 02D2 DS
Control Point 3D Position 300A 02D4 DS
Cumulative Time Weight 300A 02D6 DS
Referenced RT Plan Sequence 300C 0002 SQ
Referenced Beam Sequence 300C 0004 SQ
Referenced Beam Number 300C 0006 IS
Referenced Reference Image Number 300C 0007 IS
Start Cumulative Meterset Weight 300C 0008 DS
End Cumulative Meterset Weight 300C 0009 DS
Referenced Brachy Application Setup Sequence 300C 000A SQ
Referenced Brachy Application Setup Number 300C 000C IS
Referenced Source Number 300C 000E IS
Referenced Fraction Group Sequence 300C 0020 SQ
Referenced Fraction Group Number 300C 0022 IS
Referenced Verification Image Sequence 300C 0040 SQ
Referenced Reference Image Sequence 300C 0042 SQ
Referenced Dose Reference Sequence 300C 0050 SQ
Referenced Dose Reference Number 300C 0051 IS
Brachy Referenced Dose Reference Sequence 300C 0055 SQ
Referenced Structure Set Sequence 300C 0060 SQ
Referenced Patient Setup Number 300C 006A IS
Referenced Dose Sequence 300C 0080 SQ
Referenced Tolerance Table Number 300C 00A0 IS
Referenced Bolus Sequence 300C 00B0 SQ
Referenced Wedge Number 300C 00C0 IS
Referenced Compensator Number 300C 00D0 IS
Referenced Block Number 300C 00E0 IS
Referenced Control Point Index 300C 00F0 IS
Approval Status 300E 0002 CS
Review Date 300E 0004 DA
Review Time 300E 0005 TM
Reviewer Name 300E 0008 PN
BlockID = "AMI Annotations_02" 3101 0010 LO
BlockID = "AMI Annotations_01" 3101 0011 LO
AMI Annotation Sequence (RET) 3101 1020 SQ
AMI Annotation Sequence (RET) 3101 1110 SQ
BlockID = "AMI Sequence Annotations_02" 3103 0010 LO
BlockID = "AMI Sequence Annotations_01" 3103 0011 LO
AMI Annotation Sequence (RET) 3103 1010 CS
AMI Annotation UID (RET) 3103 1020 UI
AMI Annotation Color (RET) 3103 1030 US
AMI Annotation Line Style (RET) 3103 1050 CS
AMI Annotation Elements (RET) 3103 1060 SQ
AMI Annotation Label (RET) 3103 1070 SH
AMI Annotation Creator (RET) 3103 1080 PN
AMI Annotation Modifiers (RET) 3103 1090 PN
AMI Annotation Creation Date (RET) 3103 10A0 DA
AMI Annotation Creation Time (RET) 3103 10B0 TM

AMI Annotation Modification Dates (RET) 3103 10C0 DA
AMI Annotation Modification Times (RET) 3103 10D0 TM
AMI Annotation Frame Number (RET) 3103 10E0 US
AMI Annotation Sequence (RET) 3103 1110 CS
AMI Annotation UID (RET) 3103 1120 UI
AMI Annotation Color (RET) 3103 1130 US
AMI Annotation Line Style (RET) 3103 1150 CS
AMI Annotation Elements (RET) 3103 1160 SQ
AMI Annotation Label (RET) 3103 1170 SH
AMI Annotation Creator (RET) 3103 1180 PN
AMI Annotation Modifiers (RET) 3103 1190 PN
 AMI Annotation Creation Date (RET) 3103 11A0 DA
AMI Annotation Creation Time (RET) 3103 11B0 TM
 AMI Annotation Modification Dates (RET) 3103 11C0 DA
AMI Annotation Mofification Times (RET) 3103 11D0 TM
AMI Annotation Frame Number (RET) 3103 11E0 US
BlockID = "AMI Sequence AnnotElements_01 3105 0010 LO
AMI Annotation Element Position 3105 1010 DS
AMI Annotation Element Text 3105 1020 LT
BlockID = "AMI ImageTransform_01 3107 0010 LO
BlockID = "AMI ImageContextExt_01 3107 0011 LO
AMI Transformation Matrix (RET) 3107 1010 DS
AMI Center Offset (RET) 3107 1020 DS
AMI Magnification (RET) 3107 1030 DS
AMI Magnification Type (RET) 3107 1040 CS
AMI Displayed Area (RET) 3107 1050 DS
AMI Calibration Factor (RET) 3107 1060 DS
AMI Window Function (RET) 3107 11A0 CS
AMI Window Slope (RET) 3107 11B0 DS
BlockID = "Applicare/RadWorks/Version 5.0" 3109 0010 LO
BlockID = "AMI ImageContext_01" 3109 0011 LO
BlockID = "Applicare/RadWorks/Version 6.0/Summary”3109 0012 LO
DCM_WORKLISTFILENAME <internal> 3109 1001 ST
DCM_AMI_STATUS: NEW/SEEN Status 3109 1002 SH
Delete Lock:  Flag indicating study is locked. 3109 1003 CS
DCM_AMI_STATUS2: <internal> 3109 1004 CS
DCM_AMI_STATUS3: <internal> 3109 1005 CS
DCM_AMI_STATUS4: <internal> 3109 1006 CS
DCM_AMI_STATUSBITS: <internal> 3109 1007 UL
DCM_AMI_ORIGIN: Receive Origin 3109 1008 LO
Folder 3109 1009 LO
Receive Date 3109 100A DA
Receive Time 3109 100B TM
Prior 3109 100C CS
STAT Study:  Flag indicating study is STAT. 3109 100D CS
<internal>.  Flag indicating study/image is KEY. 3109 100E CS
DCM_AMI_LOCALSTUDY: <internal> 3109 1010 CS
DCM_AMI_RESULT_MSG: <internal> 3109 1011 LO
DCM_AMI_CURRENT_USER: <internal> 3109 1012 LO
DCM_AMI_SYSTEM_DATE: <internal> 3109 1013 DA
DCM_AMI_SYSTEM_TIME: <internal> 3109 1014 TM
<internal>.  Refers to the UID of the Worklist item. 3109 1020 UI
DCM_AMI_HOSTNAME: <internal> 3109 1021 CS
DCM_AMI_DICOM_AE_TITLE: <internal> 3109 1022 AE
DCM_AMI_DICOM_PORT_NUMBER: <internal> 3109 1023 US
DCM_AMI_DESTINATION_NAME: <internal> 3109 1024 LO
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 <internal>.  AMI origin name 3109 1025 LO
<internal>.  Study instance uid generated by modality 3109 1026 UI
<internal>.  Sequence (AE Host Port Stor. Comm.) 3109 1027 SQ
Send Flag 3109 102A LO
Print Flag 3109 102B LO
Archive Flag 3109 102C LO
 <internal>.  Requesting Facility Name 3109 1030 LO
<internal>. Requesting Procedure Name 3109 1031 CS
<internal>.  Requesting Procedure Code 3109 1032 CS
Request Storage Commitment. 3109 1033 CS
Requested Compression. 3109 1034 CS
 <internal>.  Study seq. for replies to PATIENT queries 3109 1035 SQ
 <internal>.  Origin of update (used by Local Worklist) 3109 1036 LO
Origin of update 3109 1036 LO
 <internal>.  Study UID that is being replaced 3109 1037 UI
 ACR code for teaching "folder" worklists 3109 1038 SH
 <internal>.  Special Interest Code (for teaching worklist)3109 1039 SH
<internal>.  Number of Study Related Images 3109 1040 IS
<internal>.  Study locked 3109 1041 CS
<internal>. Contains workstation name 3109 1042 CS
AMI Window Invert (RET) 3109 1110 CS
AMI Window Center (RET) 3109 1120 IS
AMI Window Widith (RET) 3109 1130 IS
AMI Pixel Aspect Ratio Swap (RET) 3109 1140 CS
AMI Enable Averaging (RET) 3109 1150 CS
AMI Quality (RET) 3109 1160 CS
AMI Viewport Annotation Level (RET) 3109 1170 CS
AMI Show Image Annotation (RET) 3109 1180 CS
AMI Show Image Overlay (RET) 3109 1190 CS
DCM_AMI_STATUS 3109 1201 SH
DCM_AMI_ORIGIN 3109 1211 ST
Receive Origin Description 3109 1212 ST
DCM_AMI_RECEIVEDATE 3109 1215 DA
 DCM_AMI_RECEIVETIME 3109 1216 TM
BlockID = "AMI StudyExtensions_01" 3111 0010 LO
BlockID = "RadWorksTBR" 3111 0011 LO
AMI Last Released Annot Label (RET) 3111 1001 UL
AMI Compression Type (RET) 3111 1102 CS
DCM_AMI_QUERY_RESULT: <internal> 3111 11FF SQ
BlockID = "Applicare/RadStore/Version 1.0" 3113 0010 LO
BlockID = "Applicare/Workflow/Version 1.0" 3113 0020 LO
OBSOLETE 3113 1001 SL
Id1 3113 1002 SL
Id2 3113 1003 SL
Id3 3113 1004 SL
OBSOLETE 3113 1011 LO
State:  image archiving state 3113 1012 CS
DateLastModified 3113 1013 DA
DateLastAccessed 3113 1014 DA
OBSOLETE 3113 1015 CS
ByteSize 3113 1016 FD
LibraryId 3113 1017 LO
Pathnames 3113 1018 LO
CachePathnames 3113 1019 LO
Source 3113 101A LO
Destination 3113 101B LO

MediumId 3113 101C SL
ArchiveId 3113 101D LO
Origin 3113 101E LO
OBSOLETE 3113 1031 IS
OBSOLETE 3113 1032 IS
OBSOLETE 3113 1033 IS
ImageMediumLocation 3113 1035 LO
ImageMediumLabel 3113 1036 LO
ImageMediumState 3113 1037 CS
SeriesMediumLocation 3113 1038 LO
SeriesMediumLabel 3113 1039 LO
SeriesMediumState 3113 103a CS
StudyMediumLocation 3113 103b LO
StudyMediumLabel 3113 103c LO
StudyMediumState 3113 103d CS
StudyState:  binary composition of image states 3113 1052 CS
SeriesState:  binary composition of image states 3113 1053 CS
ImageStateText:  textual description of image state 3113 1055 CS
SeriesStateText:  textual description combined series state3113 1056 CS
StudyStateText:  textual description combined study state3113 1057 CS
Expiration:  determines lifetime of internal worklist items 3113 1060 DT
DeltaSets 3113 1068 SQ
OrderControl: <internal> 3113 2001 CS
ScheduledActionItemCodeValue: <internal> 3113 2010 SH
Sch.ActionItemCodingSchemeDesignator: <internal> 3113 2011 SH
ScheduledActionItemCodeMeaning: <internal> 3113 2012 LO
RequestedActionItemCodeValue: <internal> 3113 2015 SH
Req.ActionItemCodingSchemeDesignator: <internal> 3113 2016 SH
RequestedActionItemCodeMeaning: <internal> 3113 2017 LO
PerformedActionItemCodeValue: <internal> 3113 2020 SH
Perf.ActionItemCodingSchemeDesignator: <internal> 3113 2021 SH
PerformedActionItemCodeMeaning: <internal> 3113 2022 LO
PerformedProcedureCodeValue: <internal> 3113 2025 SH
Perf.ProcedureCodingSchemeDesignator: <internal> 3113 2026 SH
PerformedProcedureCodeMeaning: <internal> 3113 2027 LO
ReferencedImageSOPClassUID: <internal> 3113 2030 UI
ReferencedImageSOPInstanceUID: <internal> 3113 2031 UI
LockedByHostname: <internal> 3113 20E0 CS
LockedByUser: <internal> 3113 20E1 CS
KfEditLockUser: <internal>. 3113 20E2 CS
Results ID 4008 0040 SH
Results ID Issuer 4008 0042 LO
Referenced Interpretation Sequence 4008 0050 SQ
Interpretation Recorded Date 4008 0100 DA
Interpretation Recorded Time 4008 0101 TM
Interpretation Recorder 4008 0102 PN
Reference to Recorded Sound 4008 0103 LO
Interpretation Transcription Date 4008 0108 DA
Interpretation Transcription Time 4008 0109 TM
Interpretation Transcriber 4008 010A PN
Interpretation Text 4008 010B ST
Interpretation Author 4008 010C PN
Interpretation Approver Sequence 4008 0111 SQ
Interpretation Approval Date 4008 0112 DA
Interpretation Approval Time 4008 0113 TM
Physician Approving Interpretation 4008 0114 PN
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Interpretation Diagnosis Description 4008 0115 LT
Interpretation Diagnosis Code Sequence 4008 0117 SQ
Results Distribution List Sequence 4008 0118 SQ
Distribution Name 4008 0119 PN
Distribution Address 4008 011A LO
Interpretation ID 4008 0200 SH
Interpretation ID Issuer 4008 0202 LO
Interpretation Type ID 4008 0210 CS
Interpretation Status ID 4008 0212 CS
Impressions 4008 0300 ST
Results Comments 4008 4000 ST
BlockID = "Applicare/Print/Version 5.1" 4101 0010 LO
DCM_PRINT_MASKSTATE: <internal> 4101 1001 UL
DCM_PRINT_ANNOTS: <internal> 4101 1002 SQ
DCM_PRINT_FONT: <internal> 4101 1003 LO
DCM_PRINT_FONTSIZE: <internal> 4101 1004 UL
DCM_PRINT_FONTRELSIZE: <internal> 4101 1005 FD
DCM_PRINT_OVERLAY: <internal> 4101 1006 US
DCM_PRINT_PIXELREP: <internal> 4101 1007 US
BlockID = "Applicare/RadWorks/Version 6.0" 4105 0010 LO
Annotation Type 4105 1001 CS
Annotation Value 4105 1002 DS
Cutline Image UID 4105 1003 UI
Cutline Group UID 4105 1004 UI
Annotation Color 4105 1005 US
Annotation Line Style 4105 1006 CS
Annotation Label 4105 1007 SH
Annotation Creator 4105 1008 PN
Annotation Creation Date 4105 1009 DA
Annotation Creation Time 4105 100A TM
Annotation Modification Sequence 4105 100B SQ
Annotation Modifier 4105 100C PN
Annotation Modification Date 4105 100D DA
Annotation Modification Time 4105 100E TM
Palette Color LUT Name 4105 100F LO
Annotation Number 4105 1010 US
BlockID = "Applicare/RadWorks/Version 6.0" 4107 0010 LO
Requested Palette Color LUT 4107 1001 SQ
Curve Dimensions 5000 0005 US
Number of Points 5000 0010 US
Type of Data 5000 0020 CS
Curve Description 5000 0022 LO
Axis Units 5000 0030 SH
Axis Labels 5000 0040 SH
Data Value Representation 5000 0103 US
Minimum Coordinate Value 5000 0104 US
Maximum Coordinate Value 5000 0105 US
Curve Range 5000 0106 SH
Curve Data Descriptor 5000 0110 US
Coordinate Start Value 5000 0112 US
Coordinate Step Value 5000 0114 US
Curve Activation Layer 5000 1001 CS
Audio Type 5000 2000 US
Audio Sample Format 5000 2002 US
Number of Channels 5000 2004 US
Number of Samples 5000 2006 UL

Sample Rate 5000 2008 UL
Total Time 5000 200A UL
Audio Sample Data 5000 200C OW
Audio Comments 5000 200E LT
Curve Label 5000 2500 LO
Referenced Overlay Sequence 5000 2600 SQ
Referenced Overlay Group 5000 2610 US
Curve Data 5000 3000 OW
Waveform Sequence 5400 0100 SQ
Channel Minimum Value 5400 0110 OW
Channel Maximum Value 5400 0112 OW
Waveform Bits Allocated 5400 1004 US
Waveform Sample Interpretation 5400 1006 CS
Waveform Padding Value 5400 100A OW
Waveform Data 5400 1010 OW
Overlay Rows 6000 0010 US
Overlay Columns 6000 0011 US
Overlay Planes 6000 0012 US
Number of Frames in Overlay 6000 0015 IS
Overlay Description 6000 0022 LO
Overlay Type 6000 0040 CS
Overlay Subtype 6000 0045 LO
Overlay Origin 6000 0050 SS
Image Frame Origin 6000 0051 US
Overlay Plane Origin 6000 0052 US
Compression Code (RET) 6000 0060 CS
Overlay Bits Allocated 6000 0100 US
Overlay Bit Position 6000 0102 US
Overlay Activation Layer 6000 1001 CS
Overlay Descriptor - Gray (RET) 6000 1100 US
Overlay Descriptor - Red (RET) 6000 1101 US
Overlay Descriptor - Green (RET) 6000 1102 US
Overlay Descriptor - Blue (RET) 6000 1103 US
Overlays - Gray (RET) 6000 1200 US
Overlays - Red (RET) 6000 1201 US
Overlays - Green (RET) 6000 1202 US
Overlays - Blue (RET) 6000 1203 US
ROI Area 6000 1301 IS
ROI Mean 6000 1302 DS
ROI Standard Deviation 6000 1303 DS
Overlay Label 6000 1500 LO
Overlay Data 6000 3000 OW
Comments (RET) 6000 4000 LO
BlockID = "GEIIS" 7FD1 0010 LO
GE IIS Compression ID 7FD1 1010 UL
GE IIS Multiframe Offsets 7FD1 1020 UL
Pixel Data 7FE0 0010 OW
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X Hazards: analysis & 

mitigation

Due to the clinical environment in which RadWorks is used, careful consider-
ation should be given to potential hazards when deploying RadWorks and how 
to mitigate these as far as possible. This appendix contains an analysis of haz-
ards along with actions which can be taken to minimize them. Those involved 
in setting up and administering RadWorks should read this appendix carefully.

Hardware hazards
Complete system failure due to power loss.

Run RadWorks from a computer on a place where power is always available, 
or use an uninterruptable power supply (UPS). If the system is used in critical 
situations, have a backup system and (auxiliary) power supply ready for 
immediate use.

Complete system out of operation due to the general failure of a hardware 
component of the system.

Trace malfunctioning hardware component and replace it or run RadWorks on 
another computer.

Have a backup system available and (auxiliary) power supply ready for imme-
diate use.

Graphics card displays fewer than 256 gray-levels, in contrast to what it 
reports. (During start up, graphics cards report how many gray levels they 
can display to the computer. Some graphics cards, however, report more gray 
levels than they can actually display.)

Replace graphics card with a card that meets the requirements.

 If you do not have the 
RadWorks sample stud-
ies installed on your sys-

tem, you can use a similar case 
which is available in your local 
database.



H A Z A R D S :  A N A L Y S I S  &  M I T I G A T I O N

RadWorks 6.0 installation and configuration guide

424 appendix C

Applicare provides all distributors/customers with a software utility called 
checkpal.exe which checks the ability of the graphics card to display 256 gray 
levels. Applicare also has a list of tested and approved graphics cards.

Inability to send or receive images over the network due to general network 
failure.

A network failure can have many different causes, including malfunctioning 
hardware. Examples of this are disconnected network cables and malfunction-
ing network cards or routers. It usually takes a skilled engineer to find the 
cause of the problems and resolve it. Images can be stored on a medium such 
as CD ROM.

Complete system out of operation and loss of data due to hard disk crash.

To have RadWorks up and running again, either the hard disk will have to be 
replaced or the RadWorks software will have to be run on another computer. 
The risk of losing data as a result of a hard disk crash can be minimized by 
regularly making backups. Most of the (image) data will, however, already be 
stored more than once (on the workstation of the originating modality for 
example).

Inability to work with peripheral device (such as a digitizer, archive, modality 
or laser imager) due to general failure of the device.

A failure of a peripheral device can be due to a number of causes and nor-
mally presents itself in the form of communication errors between the device 
and RadWorks system. It usually takes a skilled engineer to find out what 
caused the problem and take corrective measures. Standard tests normally 
include substitution of the device with a replacement that is known to work 
and replacing the RadWorks system with another system that can communi-
cate with the device. In addition, most peripheral devices contain status indi-
cators.

Whenever exchange of status information is supported by the peripheral 
device, the RadWorks system checks the status of the device when applicable.

Software hazards
Software problems can be categorized into problems that are related to other 
sources than RadWorks, such as the operating system, and problems that 
relate to RadWorks. In general, RadWorks has little or no effect on problems 
of the first category.

Software hazards not related to RadWorks
No longer being able to run RadWorks and/or incorrect functioning of the sys-
tem due to a general software failure such as an operating system failure.
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Run RadWorks on another computer or reinstall malfunctioning software if 
the cause of the problem is traceable.

No longer being able to run RadWorks due to a software configuration fail-
ure.

Reconfiguration or possibly complete reinstallation of all (or part) of the soft-
ware on the computer.

This manual describes how to configure the RadWorks software and other rel-
evant software.

Set proper configuration permissions.

Unpredictable functioning of the system due to virus attack.

Remove virus with the aid of special anti-virus software and/or possibly rein-
stall complete system. Another option is to work on another, virus free com-
puter.

Windows 2000/NT 4 is a stable and safe operating system, compliant with the 
US Department of Defense C2 security standard. The risk remains, however, 
that the security features of Windows 2000/NT 4 are not properly employed. 
Applicare describes how to use these features, but cannot prevent the system 
administrator from changing security settings.

There are numerous virus checkers on the market. System administrators 
should check their computer systems regularly to ensure they do not contain 
viruses.

Either malfunctioning or non- functioning of RadWorks or missing data due 
to unintentional deletion of program or data files.

If (parts of) the RadWorks software have been deleted, it must be reinstalled. 
If data is missing, it must be recopied from an archive. For many reasons, it is 
recommended that regular backup copies of the contents of the hard disk are 
made.

When RadWorks is run, it is launched by another program which first checks 
that all the files necessary for RadWorks to function properly are present. If 
one or more files are missing, RadWorks will not start.

One of the features of Windows 2000/NT 4 is its ability to start applications 
automatically after logging in. Permission to delete data sets is set (by the 
administrator) on a per user basis and administered and controlled by Win-
dows 2000/NT 4. If the administrator has set all permissions rights properly, it 
will only be possible for administrators to delete data sets.
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Software hazards related to RadWorks
In general, Applicare’s software development process guarantees as far as 
possible the avoidance of hazards. The process is a well documented in the 
Quality System Handbook.

Error in translation routine from DICOM to the Applicare format or vice 
versa.

Conversion to and from DICOM is based on documentation produced by 
ACR-NEMA. In addition, manufacturers of devices with DICOM capabilities 
have a DICOM Conformance Statement describing their exact implementa-
tion of the DICOM standard. Applicare makes use of this documentation.

A medical data set typically contains alphanumeric data (patient information) 
and numerical data (the image itself). All alphanumeric data can be displayed 
on the screen and thus be checked for correctness. Viewing the image itself is 
the main function of RadWorks and this can therefore also be checked.

Note that the information is translated (stored in another data structure). The 
information itself remains unchanged in this process.

Error in translation routine from non-DICOM source to the Applicare format.

Conversion of non-DICOM data sets to the Applicare format is based on 
information provided by the manufacturer of the device providing these data 
sets. Preventive measures are basically the same as described for DICOM data 
sets.

Transmission error while sending/receiving images from one RadWorks sys-
tem to another due to system hardware failure or receiving system out of 
resources.

When sending/receiving images from one RadWorks system to another, the 
results are validated by means of a CRC checksum. Data is only added to the 
database of the receiving system after the calculated checksum of the data 
matches that of the sending site.

If transmission is cancelled for one reason or another, such as a bad connec-
tion or shutdown of one of the computer systems, this has no effect on data 
sets on the sending and receiving systems because data is only accepted after 
the CRC check has assured complete and correct transmission. Intermediate 
results are stored in a separate working directory and are never stored together 
with the data already on the system.

A teleradiology error warning indicator, error message in log file and backup 
destinations are provided.

Incorrect data entry due to human error.
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At points in the RadWorks application users can enter data manually. Where 
applicable, user input is validated and only accepted when within specified 
bounds, though this only prevents users from entering syntactically incorrect 
data and not semantically incorrect data. It is not possible to automatically 
check that data is semantically correct.

Inability to write information to hard disk due to lack of free space.

If too many data sets are added to a RadWorks system, the hard disk could 
become full. Data can be added to a system from both local sources (when 
digitizing images) and remote sources (using the send/receive option).

If images are digitized and there is not enough free disk space, the user is 
warned that it is not possible to store the images. The user should manually 
delete images so that it becomes possible again to store new images on the 
system.

The user is not warned in real time if images from a remote system could not 
be received, since receiving images is a background task. The logging file 
does, however, contain warnings, so the administrator of the system will be 
able to tell if the hard disk is (almost) full.

The Data Selector includes a ‘gauge’, which graphically displays the free disk 
space left on the system.

The system is also capable of automatically deleting data using certain config-
urable rules.

Incorrect correspondence between data listed in the Data Selector and data 
actually on disk due to file being replaced or deleted by human intervention.

During start up and maintenance, the RadWorks system finds all data sets 
available on the system. Only those data sets are displayed in the Data Selec-
tor. It is possible to specify a time interval after which this check is repeated.

When working with the RadWorks system, the RadWorks software manages 
all operations that influence the contents of the Data Selector. These include 
updating the Data Selector, which is tested by means of system tests as 
described in the Software Test Plan.

Should the data in the Data Selector does not match the contents of the hard 
disk, then either data is listed although it is not available or data is not listed 
although it is available. In the former case, when the user wants to view the 
data set, the RadWorks system issues a warning that the data is not available. 
In the second case, the data set will be listed after the regular checks (such as 
after start up or a specified time interval) have been performed.
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Discrepancies between the Data Selector and the contents of the hard disk 
should be extremely rare, if they exist at all, because they can only occur due 
to actions outside the RadWorks application. The proper use of standard Win-
dows 2000/NT 4 security options makes this virtually impossible.

Error in the automatic deletion of data option due to configuration error. (One 
of the options of the RadWorks system is automatic deletion of data sets. 
Images can be deleted after a specified period of time, based on the amount of 
free disk space left on the system.)

The source code for this option is thoroughly examined in code review ses-
sions. Its functionality is tested as described in the Software Test Plan.

Algorithmic error with regard to image manipulation.

Industry-wide accepted algorithms are used for image manipulation (such as 
zooming in/out). These algorithms, when implemented in RadWorks, are 
checked during code reviews.

Images on disk are never manipulated directly. Only copies of these images in 
the computer memory (RAM) are manipulated to prevent unintentional cor-
ruption of data.

Image data is corrupt and lost after archiving images. (When archiving stud-
ies from the local database to a DICOM Part 10 Archive using the DICOM 
JPEG Lossless transfer syntax and not using the archive full verification 
option, the original study will be removed even if the copy is not completely 
lossless. The image data may be corrupt.)

Use the full verification option in the archive to ensure that the image data can 
be decompressed losslessly. 

Image data may be corrupt after exporting images (When exporting studies 
from the local database to a DICOM Part 10 Archive using the DICOM JPEG 
Lossless transfer syntax and not using the archive full verification option, the 
exported study may not be completely lossless. The image data may be cor-
rupt or distorted.)

Use the full verification option in the archive to ensure that the image data can 
be decompressed losslessly.

When performing computations on CR images, distances and areas measured 
are not correct due to stored image size differ from cassette size.

Use calibration/measurement tools.



GEMS IT Applicare

429

The system is unable to match automatically because it is unable to receive 
images. This is detected at the sending host because send actions fail. (Either 
the receiving system is out of order (power failure, breakdown, network error, 
etc.) or its Connection Service is not running or refusing the images.)

Provide a UPS to the system to prevent power loss.

Incoming study data is matched with the wrong patient information. (Either 
the rules that are entered into the RadWorks system are such that an incorrect 
but matching patient is selected from a Worklist. Or the HIS/RIS system that is 
responsible for filling the Worklist does not supply the correct data.).

Check the match process after changes are made to the system configuration. 
Verify the data that is received from the HIS/RIS system and check the match-
ing log.

The patient orientation of an image is not correctly adjusted. (Within the QC 
Module the user is allowed to change the patient orientation information in an 
image. The user might thus supply the system with incorrect data.)

Only allow authorized users to use the QC module.

Images in a study are irreversibly deleted. (Within the QC Module the user is 
allowed to delete images from a study. After the study is saved this action is 
irreversible.)

Only allow authorized users to use the QC module.

During a manual match incorrect patient information is inserted in the image. 
(Either the user selects an incorrect entry from a Worklist, or the HIS/RIS sys-
tem that is responsible for filling the Worklist does not supply the correct 
date.)

Verify the correctness of all information items on Worklists that are provided 
by the RIS/HIS system. Use a test case to verify this. Only allow authorized 
users to use the QC module.
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X Declaration of 

Conformity

medical devices class I annex VII
We hereby declare that the distributed CE marked products specified below 
conform to the required technical documentation in accordance with Annex 
VII of the ‘EC Directive’, the Council Directive 93/42/EEC of 14 June 1993, 
concerning medical devices.

In addition, we ensure and declare that the distributed CE marked products, as 
mentioned and falling within Class I, meet the provisions of the EC Directive 
which apply to them.

This Declaration of Conformity covers the complete RadWorks 6.0 release 
and is valid for all products concerned bearing the CE mark and manufactured 
at the following site:

GEMS IT Applicare B.V,
Sparrenheuvel 38
3708 JE Zeist,
The Netherlands

Harm-Jan Wessels
Managing Director

GEMS IT Applicare BV
March 2002
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X License agreement

Below are stated the licensing provisions of Applicare Medical Imaging B.V., 
owner of all intellectual property rights as vested in the software RadWorks 
medical imaging system for (medical) datasets and RadStore digital archiving 
software. The End User is bound to these conditions when using the Rad-
Works and/or RadStore software.

1 End-User shall mean the party which settled with a fully authorized 
distributor of Applicare (hereinafter “Distributor”) a delivery and/or 
support agreement in relation to the Software, as described hereinaf-
ter.

2 The term the “Software” has the following meaning: the commer-
cially available version of the software known as RadWorks, medical 
imaging system for medical datasets and/or RadStore, digital 
archiving software for (medical) datasets, supporting information, 
documentation and manuals. The source code of the Software will 
not be supplied.

3 The term the “Installation” has the following meaning: The date of 
the written notice in which Distributor notifies End-User that the 
agreed upon connectivity, the operational testing and verification of 
the Software at the location of End-User have been carried out satis-
factory.

4 Upon condition that all agreed license fees for the use of the software 
are paid to Distributor, Applicare hereby grants to End-User and 
End-User hereby accepts from Applicare a non-transferable and non-
exclusive license to use the Software on one processing unit as an 
end-user for the internal business of End-User, for the sole benefit of 
the End-User and at the location of End-User. End-User is not enti-
tled to use the Software for commercial purposes. Third parties shall 
not be permitted by End-User to use or have access to the Software. 
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End-User is only allowed to permit use to subsidiaries and affiliated 
companies after the prior written approval of Distributor. 

5 Licensee acknowledges that a license to use the Software can be 
bound up with a voluntary subscription to the support as delivered by 
Distributor for which a separate support fee has to be paid. Subscrip-
tion to the support has to be made for a minimum period of three (3) 
years.

6 End-User will not be entitled to sell, sub-license, let out or alienate 
the Software or transfer it by way of security, or to put it at disposal 
of any third-party in any way whatsoever.

7 In consideration of the rights as granted, End-User will pay to Dis-
tributor a license fee as agreed between Distributor and End-User. 
End-User will pay Distributor separately for the support as to the 
Software if a support subscription has been agreed upon.

8 In the event the Distributor takes care of the installation of the Soft-
ware on the hardware system of the End-User, the Distributor is 
responsible/liable for the proper installation of the Software on the 
hardware system according his warranty terms and conditions.

9 Whether or not the hardware system as described in paragraph 8 is 
delivered by Distributor, Distributor hereby refers to the warranties 
of the ancillary supplier/ manufacturer concerned of the hardware 
system. Applicare nor Distributor shall have any liability to End-
User on account of condition or operation of the hardware system 
warranties provided by the ancillary supplier/manufacturer con-
cerned. Applicare shall not be liable for warranty support which shall 
be the responsibility of the ancillary supplier/ manufacturer of the 
hardware system.

10 End-User shall not modify, adapt, dissemble, translate, vary, copy, 
reproduce or alter the Software in any way, without the prior written 
approval of Applicare. 

End-User is allowed to copy or reproduce the Software for the pur-
poses only of archive and for the back-up, provided that no more 
than two (2) copies per numbered version will be in existence at one 
time. End-User shall maintain the copyright notice on the Software 
and shall reproduce such copyright notice on any copy of the Soft-
ware.

11 Applicare warrants that the Software has been designed and devel-
oped with professional competence and in accordance with the tech-
nical engineering practices and standards commensurate with those 
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observed in the computer software industry and, when used in accor-
dance with the procedures specified in the related documentation and 
the applicable amendments and supplements thereto shall perform as 
specified therein.

12 If any failure to conform such specifications appears in the warranty 
period of twelve months as of Installation, Distributor shall, accord-
ing to the terms and conditions of the agreed support agreement, use 
its best efforts to provide valuable assistance (correction or replace-
ment). In case a correction is not possible within short time, Distribu-
tor and Applicare shall use its best endeavors to provide a provisional 
solution without any undue delay. Distributor and/or Applicare may 
charge the costs of repair in the event of errors made by End-User or 
any other cause for which Distributor/Applicare cannot be blamed. 
Recovery of any data which may have been lost will not be covered 
by the guarantee.

13 The warranty as indicated, shall be limited in such a way that Appli-
care nor Distributor shall not be liable for any malfunction or error 
resulting from a modification made with or without the prior written 
explicit approval of Distributor and/or Applicare or resulting from 
improper use of the Software.

14 In no event shall Applicare be liable for any loss, damage or expense 
whatsoever including, without limitation, time, money or good-will 
arising from or in connection with the use, non-use, performance or 
non-performance or inability to use, and operation of the Software. 

15 Distributor’s and Applicare’s sole and exclusive liability is to pro-
vide programming services to replace or correct defects in the Soft-
ware which cause the Software to fail to conform to Applicare’s 
warranty set forth in this Agreement. Applicare and Distributor dis-
claim any and all implied warranties, except to the extent that it is 
unlawful to exclude such liability.

16 RadWorks and RadStore are ‘software only products’, meaning that 
End-User is free to choose its own hardware and media (such as 
RAID and a DLT, CD or DVD library). In no event shall Applicare 
be liable to End-User for the proper installation of the Software, the 
choice of hardware by either End-User or Distributor and/or the 
proper installation and functioning of additional software (such as 
toolkits) necessary to obtain access to the hardware devices used to 
store the data. 

17 In no event shall Applicare/Distributor be liable to End-User for 
incidental, exemplary, punitive or consequential damages for any 
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reason whatsoever, except to the extent that it is unlawful to exclude 
such liability. End-User hereby waives, for itself and its successors 
and assigns, any and all claims for direct, special, incidental, or con-
sequential damages.

18 Applicare/Distributor expressly exclude any kind of liability for 
damages, including but not limited to death or bodily injury, incurred 
because of medical decisions or refraining of the same based upon 
use of the Software. End-User acknowledges that Applicare/Distrib-
utor is never responsible/liable for any consequence due to any med-
ical decision or refraining from any decision based upon use of the 
Software.

19 In the event that a limitation of liability in the above said warranty 
provisions (12-18) shall be held to be invalid for any reason and 
Applicare/Distributor becomes liable for loss or damage that would 
otherwise have been excluded, such total liability shall never exceed 
the amount of the license fee per event, a series of interconnected 
events being regarded as a single event. 

20 In the event Applicare or Distributor or their employees committing 
any tort for which Distributor and/or Applicare can be held liable in 
law, Distributor and/or Applicare will only be liable to make com-
pensation for any loss caused by death or bodily injury and for any 
other loss as far as these have arisen through wilful intent or gross 
negligence. In these cases damages will not exceed 1,000,000 Dutch 
Guilders per event causing a loss, a series of interconnected events 
being regarded as a single event.

21 The termination of the appointment of Distributor will not influence 
the effectiveness of this license. In such event, Applicare agrees to 
use its best efforts in order to continue the support to End-User.

22 End-User and its employees shall keep strictly confidential any and 
all information relating to the Software and other information, as 
confidentially disclosed. End-User shall take all necessary steps to 
ensure the confidentiality of the Software.

23 This license shall be governed by the laws of the Netherlands within 
the jurisdiction of the competent court of Amsterdam.

24 End-User confirms and acknowledges that any and all of the trade-
mark(s), trade names, copyrights, patents and other intellectual prop-
erty rights used or embodied in or in connection with the Software 
(including any future additions, releases, enhancements, updates, 
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translations or modifications) shall be and remain the sole property 
of Applicare.

25 Applicare may terminate this license by a one (1) month prior writ-
ten notice upon failure of End-User to remedy a breach of any of its 
obligations hereunder within ten (10) days of being notified of such 
breach. End-User shall discontinue all use of the Software and return 
the Software to Distributor and not keep any copies of the Software. 
Under no circumstances End-User shall be entitled to claim any 
indemnification as a result of the termination of this license. In the 
event of bankruptcy of End-User, this license is terminated automati-
cally with immediate effect and the Software shall be returned with-
out any undue delay.

The Netherlands, 2002
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